
 

ESSENTIAL MACLEOD 
Optical Coating Design Program 

 

 
 

 

USER’S MANUAL 
 





 

Information in this document is subject to change without notice and does not represent a 

commitment on the part of Thin Film Center Inc. The software described in this 

document is furnished under a license agreement. The software may be used or copied 

only in accordance with the terms of the agreement. 

 

 

Version 11.8 

Copyright © Thin Film Center Inc 1997 - 2022. All rights reserved.  

 

 

No part of this document may be reproduced or transmitted in any form or by any means, 

electronic or mechanical, for any purpose, without the express written permission of Thin 

Film Center Inc. 

 

The Thin Film Center logo, Essential Macleod, Optimac, Multicoat, and Function are 

trademarks of Thin Film Center Inc. 

 

CODE V is a trademark of Optical Research Associates 

FRED is a trademark of Photon Engineering LLC 

LinkSIM and OptSIM are trademarks of RSoft Design Group, Inc. 

VirtualLab is a trademark of LightTrans GmbH 

Zemax is a trademark of Zemax, LLC. 

 

Microsoft, Windows are registered trademarks of Microsoft Corporation 

 

Basic Scripting provided by Cypress Software Inc., Copyright © 1993 – 2001, all rights 

reserved. 

 

 

 

 

 

 

 

 

 

 

 

Thin Film Center Inc 

2745 E Via Rotunda 

Tucson AZ 85716, USA 

Tel: +1 520 322 6171 

Email: info@thinfilmcenter.com 

Web: thinfilmcenter.com

mailto:info@thinfilmcenter.com




 

THIN FILM CENTER INC 

ESSENTIAL MACLEOD SOFTWARE LICENSE AGREEMENT 

SINGLE USER 

 

The software in the Macleod package and the material in the accompanying manual are 

protected by United States copyright law and by international treaty provisions. 

The software itself continues to be the property of Thin Film Center Inc who retain 

ownership and all rights, including copyright. The purchaser is purchasing a license to 

use the software and owns only the physical media on which the program is supplied. 

Copying of any part of the package or manual is strictly forbidden except that the 

Licensee may load the package into a computer in order to make use of it, may make a 

print copy of the on-line manual for his or her own use, and may make archival copies of 

the package for safe keeping. 

The Licensee is limited to having the package in use in only one piece of single-user 

computer hardware at any one time. 

The package may not be exported nor reexported nor transferred except as permitted by 

the laws and regulations of the United States of America. 

We have used our best efforts to make the package run correctly and to be as versatile 

and useful as possible. Nevertheless the package is provided "as is" without warranty of 

any kind other than the replacement of defective disks or physical documentation as 

described above. The entire risk as to the results and performance of the package is 

assumed by the Licensee along with the entire cost of servicing, repair or correction. 

Furthermore no representation is made regarding either the use or the results of the use of 

the package in any terms including accuracy, reliability or correctness. In no event shall 

Thin Film Center Inc or any of its employees or associates be held liable for damages, 

including but not limited to, special or consequential damages, arising from use of the 

package. 

Use of the package implies acceptance of these terms. 

 

Note: 

We ask that the Licensee designate a User for the package and that the User be registered 

with us. Support for the package is provided to the registered User only. We permit the 

User to have the package installed on more than one computer, for example a laptop 

and/or a computer at home. We permit casual use of the program by other people but 

where the use is likely to exceed single-user level we ask that a license be obtained for 

each additional user. Please request details of our Terms and Conditions for Multiple 

Users.
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ESSENTIAL MACLEOD OPTICAL COATING 
DESIGN AND ANALYSIS  

PROGRAM 
FOR THE 

MICROSOFT®  WINDOWS®  OPERATING SYSTEM 

 

INTRODUCTION 
This manual describes the version of the Essential Macleod Thin-Film Design 

Package for the Microsoft® Windows® Operating System. 

Familiarity with the Microsoft Windows Operating System is assumed throughout the 

manual. In particular mouse actions like selection, dragging, clicking and so on will be 

used without further explanation. Where keystrokes are concerned, the notation <Enter> 
or <Return> is used to mean “press the key marked Enter (or Return)” similarly for 

<Ctrl> and <Esc>. <Fl>, <F2> etc. refer to the function keys. 

About The Program 
The Essential Macleod program contains all the essentials for the design and 

performance calculation of optical coatings. In particular it will calculate a wide range of 

performance parameters of a given coating design including the usual reflectance and 

transmittance magnitude and phase, but also color, ultrafast, ellipsometric quantities and 

from the zero’th up to the third derivative as a function of wavelength. It will estimate the 

effects of random errors in the layers. It will refine existing designs to improve their 

performance and it will synthesize designs that start with virtually no instructions other 

than the materials to be used and the performance that is targeted. It includes allowance 

for layer packing density. It has powerful design editors to make it very easy to create or 

change even the most complex designs. It also maintains the files that contain the optical 

constants of materials. The Essential Macleod will also calculate performance of series of 

different substrates, with or without associated coatings and it will perform a wide range 

of analytical functions such as generating admittance diagrams and electric field 

distributions. It has a completely flexible system of variable units. 

The Essential Macleod is equipped to export coating designs to the Zemax, Code V, 

FRED, and VirtualLab optical design packages. It will also export performance to the 

LinkSIM simulation tool. 

Optional enhancements add a virtually limitless range of possible performance 

functions, run sheets and monitoring curves with links to thin film monitors.  

The package is an integrated whole with the operation controlled almost entirely from 

menus. The menu commands are designed to permit the user to indicate what has to be 

done without needing to indicate how. To calculate an aspect of performance, for 

example, the user simply tells the package to produce a plot or a table. The underlying 

operation and organization is completely automatic. The description that follows, 
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therefore, concentrates on the menu commands, what they are and what they do. It is 

purely a description of the operation of the software package. It does not go into details 

of the calculation techniques nor does it discuss design technique. 

The Essential Macleod uses a Multiple Document Interface (MDI). A document can 

be a plot, a table, a design, a list of materials and so on. Multiple Document Interface 

means that many documents may be displayed at once. One document at a time is active. 

The menu bar changes as the active document changes so that the menu commands 

always apply to whichever of the open documents is the active one. For example, if a plot 

is active then the Edit menu will apply to the plot and will permit such things as changing 

the parameters of the axes. The user will find that it is often useful to be able to keep 

several designs open simultaneously. Should the capacity of Windows or of the computer 

be exceeded then the user will simply be requested to reduce the number of open 

documents. There is no need constantly to keep track of what is open. We do recommend, 

however, that unnecessary documents should be closed to avoid clutter. 

Throughout the operation of the package, designs and specifications are saved to 

various files. The principal files are known as design files and they contain not just the 

sequence of layers but also their materials and the calculation parameters that should be 

used to evaluate the design. If a design is passed to refinement, the refinement 

specification also becomes part of the design file. The operation of saving the design and 

parameters can be manually performed at any time by choosing the appropriate menu 

item but it is also automatically initiated at those stages where there is a danger that 

something might otherwise be lost. In spite of this automatic feature, we do recommend 

that the user acquire the habit of saving the work at intervals. In particular when moving 

from one design to another it often seems convenient just to write the new design over the 

old. However, if the existing design is important the editing process will change it 

perhaps beyond recovery. No automatic save is initiated whenever a design is edited - 

editing is a very simple and straightforward process. Before beginning major editing, 

where a design is going to be substantially altered, it is good practice to save the design 

twice, once in the existing design file, thereby preserving the current design for later 

recall, and once in a new design file, which can then be edited without fear of changing 

the original. You may find this approach useful in other applications such as word 

processors also. Should it happen that something was overwritten when it should not, 

there are powerful Undo and Redo commands that can help. 

In the Essential Macleod the optical constant information for the thin film materials is 

kept in separate files in one or more materials databases. In the designs, the materials of 

the films and substrate are referred to explicitly by name (normally the chemical 

formula). A material database consists of a set of materials files together with control 

files that are kept in a separate folder, the path being the identifier for the database. Many 

different material databases may exist together. This is a particularly useful feature of the 

Essential Macleod and we encourage the user to make full use of it. Separate databases 

could be used, for example, for infrared materials as distinct from visible materials with 

wavelength stated in microns rather than nanometres. Alternatively, different databases 

could be used for different customers or for different plants or processes. In order to keep 

track of the particular database that was used to generate a design, information on both 

the database and the number/name conversion for the materials used, is stored in each 

design file. This information is compared with the existing database when a design file is 

read and only if an exact match is found can the calculations proceed without 



Introduction  3 

intervention. The material database can easily be changed but only when there are no 

open documents. The General command in the Options menu opens the form that 

contains the necessary command for changing the material database. A number of 

facilities are provided to simplify the maintenance of many different material databases. 

These are described later in the manual. A comprehensive searchable list of materials is 

provided in the Materials Library. 

Then further help in organization is provided by the Jobs facility. This permits all 

files, materials and references as well as designs to be kept separately in a designated 

folder that can be removed to an archive when the particular task is complete. 
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INSTALLATION 
If the Essential Macleod program has already been correctly installed on the hard disk 

of the computer, you can skip this section on first reading, returning to it later if you want 

to alter the configuration data. However, if you are loading the Essential Macleod 

program for the first time you should read the section carefully. 

System Requirements 
The program is fully compatible with Microsoft® supported versions of the 

Windows® operating system. Although the space actually taken up by the program is 

much less, we recommend that some 20-25Mb of hard disk storage should be available. 

As the program is used, it is inevitable, and desirable, that design files, data files, text 

files and specifications will multiply. 

License System 
The Essential Macleod has a built-in licensing system that operates invisibly once 

authorization is obtained. The procedure for obtaining a full license is described in detail 

at the end of this manual.  The Macleod software is licensed automatically for an initial 

period of 15 days to allow use of the software immediately on installation and to allow 

time to obtain the full license.  It is possible to obtain the license via fax, e-mail or 

telephone and the procedure is simply an exchange of information. The customer must 

provide a Site Code to Thin Film Center. Thin Film Center then issues a Site Key to the 

customer which allows full licensing of the Macleod software to occur. These codes are 

simple alphanumeric strings. Note that with a transferrable license, transferring the 

license from one machine to another is very straightforward. 

Installing the Software 
Make sure that you are logged on with Administrator privileges. The taskbar will 

show if any other applications are running. Close any that are shown there. If they are not 

closed it may be impossible for the installation program to install necessary files. Place 

the installation CD in the appropriate drive. The setup program on the CD will 

automatically start. If this does not happen, then run setup.exe on the CD. 

The setup program will attempt to find any previous installation of the Essential 

Macleod. If it does then it will suggest that folder as the one in which the installation 

should be made otherwise it will suggest a default. Normally it will be sufficient just to 

confirm the choice of folder but it you do want the installation in a different folder or on a 

different drive then either use the browse button to search for the folder or simply type in 

its path, as, for example  

C:\Program Files\The Essential Macleod\ 

Note that you may enter any folder, not simply an existing one. If the folder does not 

already exist then it will be created. Should there be an existing installation that is to be 

upgraded by the current installation then one of the selectable options will be an upgrade 

rather than full installation.  
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Progress of the installation is now shown on screen with messages showing the names 

and folders of the files that are being installed. Some of these you will notice are going 

into the standard Windows folders. Along with all the program files, the setup program 

also creates a design folder with some demonstration designs and a materials folder with 

the standard materials supplied with the program. We have more to say about this below. 

When the installation procedure is over then the Essential Macleod program can be 

found by clicking the Start button and selecting Programs. Macleod is an item in the 

programs list. Selection of the item reveals the program itself, recognizable by the 

admittance logo and the title Essential Macleod, an online manual called Essential 

Macleod Manual and a help file called Essential Macleod Help. To start the program 

itself, click Essential Macleod. Note that once the Essential Macleod is installed, it is not 

necessary to have Administrator privileges to run it. 

Tools and Enhancements 
The Essential Macleod contains a vast number of tools. A brief summary of these 

tools is shown below. 

Core: Design Editors, Data, Target etc. editors, Import/Export, Materials 

management, Performance calculation, Refinement and synthesis, Export 

designs to various applications including Zemax, FRED, LinkSIM, VirtualLab 

and CODE V, Admittance loci, Electric fields, Design aids, Report generator 

vStack: vStack editor, vStack performance calculation – calculate performance of 

non-parallel-sided substrates and coatings 

Runsheet: Machine Configuration and Runsheet editor 

Monitorlink: Special Runsheet configuration, Export monitoring programs, Free 

standing tool to link with specific controllers 

Function: Operation editor and syntax checker, Function evaluator 

Simulator: Process deposition simulator 

DWDM Assistant: Generates bandpass filter designs to meet a given specification 

Which Tools Do I Have? 
To find out which tools are present in any installation of the Essential Macleod, select 

the menu item About the Essential Macleod in the Help menu. An information box 

similar to the following illustration appears. Any enhancements that are present will be 

listed under the heading Options and will consist of any or all of vStack, Runsheet, 
Monitorlink, Function and Simulator. If none of these is shown then only the Core 

module is present. 
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A QUICK TOUR OF THE PROGRAM 
Double-click the Essential Macleod icon and the program will begin to load. The 

initial screen is quite blank with four menu items, File, Tools, Options, Help. 

 
 

Select the File menu. It has several sections but the first carries the four principal 

items, New, Open..., Open Material..., Open Substrate... and Open Function…. 

Select New. The symbol, , at the end of the menu item shows that there is a 

submenu. The number of items depends on the configuration but there will be several, the 

first four being Design, Material, Optical Constant and Table. 

Select Design to open the Design window with a new design and a default design will 

appear. The idea of a default rather than a blank design is that all necessary parameters 

are initialized so that calculations can proceed without problems. The details of the 

default can be set by the user as described later in the manual but, if this is still the first 

time the package has been used the default will be a simple single layer coating. 

Right at the top of the design window is the heading Design1. This is a default name 

that has been given to this design and, if not changed, will be the name of the design file 

in which the design will be stored. Next, immediately below the title, is the incident 

angle. This is the angle, measured in degrees, between the direction of the incident light 

and the normal to the coating surface. Here we have zero entered and so we are at normal 

incidence. 
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The reference wavelength is shown next. This is 510nm. In the initial configuration as 

the program is normally supplied, all wavelengths are given in nm. We will discuss 

wavelength units in detail later but for the moment we retain nm. The actual design is 

shown next along with the incident medium and substrate. The default convention used 

throughout the package is that the incident medium is uppermost in design tables. The 

substrate is the emergent medium and is at the foot. The layers are numbered in turn from 

incident medium to substrate so that the layer nearest to the incident medium is numbered 

one and is listed at the top of the table immediately after the incident medium. The other 

layers, if any, follow in order through to the substrate. The columns are labeled in turn, 
Layer, Material, Refractive Index, Extinction Coefficient, Optical Thickness, Physical 

Thickness. Layer lists the reference number of the layer or indicates the incident 

medium or substrate. The next three columns give information on the various materials, 

name and optical constants. Since we are dealing with dispersive materials the values of 

refractive index and extinction coefficient are those at the reference wavelength, 0, 

(which is 510nm currently). The optical thickness is next. This is nd/0 where n is 

refractive index, d is physical thickness and 0 is the reference wavelength. 0.25, 

therefore indicates a quarterwave layer at the reference wavelength. [There are other 

options for the display of layer thickness and some other layer attributes (packing density, 

locked and linked) that are invisible for the moment, all of which we will consider later.] 

This design is therefore a quarterwave at 510nm of Na3AlF6 (cryolite) on glass in air and 

can be described as an antireflection coating. Let us examine the performance. 

Select Plot from the Performance menu. A new window entitled Design1: 

Transmittance appears. The transmittance of the coating is shown plotted against 

wavelength from 400nm to 700nm. 

 
 

The transmittance is everywhere very high. Since this is an antireflection coating, 

reflectance may be a more suitable parameter to plot.   
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The active window is the plot, however, and so the current menu bar refers to it. We 

must therefore make the design window active so that the menu bar displays the design 

menu. To do this, place the mouse cursor over any visible part of the design window and 

click, or use the Windows menu. The design window should come to the front showing 

that it is active. 

Before we change the plot, however, let us be sure that two plots may coexist. Select 

the Options menu and then General...The Essential Macleod Options dialog box will 

appear. Click the Windows tab. In this tab there is a check box labeled Keep Old Plots 

and Tables Displayed. Check this box if it is not already checked. Later you may wish 

to uncheck this box to automatically reduce clutter on your desktop. 

Now select the Parameters menu and the item Performance... The following dialog 

window opens. Note that some parameters apply only to certain choices of horizontal or 

vertical axis. Those that do not apply are shown in gray.  

 
 

We want reflectance so we click the Vertical Axis tab and then set the performance to 

Reflectance Magnitude (%). The vertical scale is listed as Maximum Value 100, 

Minimum Value 0 and Interval for Plot 20. Automatic Scale is checked and so the plot 

will be re-scaled to fit the data. Leave all other parameters unchanged and click the Plot 

button. 
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You can activate a cursor on the plot by holding down the <Alt> key and dragging the 

mouse over the plot with the left mouse button also pressed. A pair of markers will 

follow the curve nearest the mouse pointer and the (x,y) coordinates of the curve are 

displayed in a box beneath the plot. 

 
 

The cursor is removed by selecting Clear Cursor in the Edit menu, or by right-

clicking the mouse and selecting Clear Cursor from the menu that appears. 

It is a good idea at this stage to remove any unwanted plot that has been generated so 

far. Click in a plot to make it active and then click the close box at the upper right corner. 

Do not accept the invitation to save the plot. 

Now place the mouse over the performance curve and double-click.  A new dialog 

box appears. This controls the display of the curve. 

 
 

To change the thickness of the curve, enter a number into the Width box and click 

Close. This produces the plot below 
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It is important to realize, however, that editing the plot changes only the parameters 

of the plot. The data are unaffected. Thus the data cannot be changed from reflectance to 

transmittance just by altering the title of the vertical axis. Reflectance data remain 

reflectance whatever title is given to the axis. 

 

 
 

We will now save the plot. With the plot as the active window, select the File menu 

and then Save As... The Save Plot As dialog box appears. Note that there is a shortcut 

key, F12, that moves straight to the dialog box. Against File name type in one. Note that 

the extension for plot files will be .npl but that it is not necessary to add any extension. 

That will be done automatically by the package. Then select Save. The plot will be saved 

as file one.npl. 

Choose Performance... from the Parameters menu. In the dialog box that appears 

select the Vertical Axis tab and then choose Transmittance Magnitude (%) with 

Maximum Value 100, Minimum Value 95 and Interval for Plot 1. Clear the Automatic 

Scale check box. Click the Plot button. The result is shown below. 
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Now examine the Window menu. It lists the various windows that have been created. 

Select each in turn and see how they come to the front. This is another way of making a 

window active and it is particularly useful when a window is completely obscured behind 

others. 

Finally from the Performance menu select Table. The results are displayed in tabular 

form. 

 
 

Note that above the heading of the table are entries giving reference wavelength and 

incident angle. These entries are for reference only. It is possible to change these entries 

(the read-only status of the table must first be canceled) but such changes will have no 

effect whatsoever on the actual values of the parameters, neither will they affect the 

values of the data in the table. 

The table lists values of reflectance, transmittance and phase changes on transmission 

and reflection at intervals that are determined by Interval for Table under Horizontal 

Axis in the Performance Parameters dialog box. The table window may have to be 

adjusted by stretching with the mouse in the normal way. 

This current coating is not a particularly good one because the residual reflectance is 

too high for many applications. Also, although it has nothing to do with its optical 

properties, cryolite is not a rugged material. We will now examine a coating that is rather 

broader in its characteristic, and uses more resistant materials, but which is, at the same 

time, more complicated. This is the well-known quarter-half-quarter coating and the 

version we are going to examine consists of a quarterwave of magnesium fluoride 

outermost followed by a halfwave of zirconia, and then next to the substrate a 

quarterwave of alumina. The pattern of this coating is a low index quarterwave next to 

the incident medium and an intermediate index quarterwave next to the substrate which 

form an antireflection coating for the reference wavelength. These layers are separated by 

a flattening halfwave of high index, which gives added breadth to the characteristic. The 

names for the materials in the materials list are mostly based on the chemical formulae 

and the materials we are suggesting have names MgF2, ZrO2 and Al2O3 respectively. 

Save the design in a file named one. The name at the top of the design window will 

change to one. We want to keep this design. It is, however, still the active one. Any 

changes we make now will risk being incorporated in one.dds should an automatic save 

be initiated. To avoid this we immediately save the design yet again as two.dds. Press 

F12 and enter TWO (or two) in the File Name box and then select Save. 
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This is really good practice that is worth cultivating. It is all too easy to lose a design 

by overwriting it. It is usually impossible to recover a design once it has been overwritten 

although the Undo and Redo commands (in the Essential but not the Concise) may come 

to the rescue. This procedure is particularly useful also when many of the parameters 

remain unchanged. When you want to start a completely new design, use the New 

command in the File menu. The new design will then coexist with the previous one, 

which will not be automatically closed. Being able to edit several designs at the same 

time is a valuable feature of the Multiple Document Interface (MDI) of the program. 

We will now edit the design two.dds. 

There is only one layer in the current design and we need three. The first task is to 

increase the number of layers to three. Place the cursor over a cell in the row 

corresponding to the cryolite layer (Na3AlF6, Layer 1) and click. Now go to the Edit 

menu and select Insert Layers... In the resulting dialog box enter 2 as the number of 

layers to be inserted and then select the OK button. Now the design will show three 

similar layers of Na3AlF6. The material for layer 1, that next to the incident medium 

should be magnesium fluoride, MgF2 in the materials list. Place the cursor over the cell 

in layer 1 containing Na3AlF6 and click. The cell will be selected and a small arrow will 

appear at the right. A click on the arrow brings up a small scroll box with the names of 

the existing materials in it. MgF2 is a little way down the list. Click on it and 

immediately the name of the material for layer 1 will change to MgF2 and the scroll box 

will close. The insertion of the extra layers resulted in a thickness of zero for layer 1. This 

must be changed to the required 0.25. Place the cursor over the thickness cell for layer 1. 

Click once to select it. Then type 0.25. Note that as soon as we selected the thickness cell, 

deselecting the material, the value of refractive index changed to match the index of 

magnesium fluoride at the reference wavelength. Incidentally, a double-click in the 

thickness cell will place it in insert mode and then anything typed will be added to what 

is already there. If that happens then use the Delete key to remove the unwanted 

characters. Now we pass to layer 2. Here we need a halfwave of zirconia, ZrO2. The 

same process as before permits us to replace the Na3AlF6 material with ZrO2. The zero 

thickness must then be changed to 0.5. Finally we change the material for layer 3 to 

Al2O3. This time, instead of selecting the layers from the list, select the materials cell 

and type in Al2O3. Now select any other cell. The entered material will change to Al2O3 

denoting that the new material has been accepted by the program and the Refractive 

Index cell will display the appropriate value at the reference wavelength. Materials can 

be entered either manually or from the table. Sometimes manual entry can be quicker 

than looking up the table each time. The thickness of layer 3 is already 0.25 (if the 

insertion was performed exactly as described here) and so it needs no alteration. At this 

stage the design window should appear as reproduced below: 
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We added the layers by using the insert layers command. There are several other ways 

of performing this task and a particularly useful one is available when the INS (insert) 

mode is visible in the bar at the foot of the Essential Macleod window. (If OVR is shown 

then press the <Insert> key and the mode will change to INS.) Place the cursor in a cell 

on one of the layers. Press <Enter> repeatedly, each time making the cell to the right of 

the current one active. When the thickness cell is active, pressing <Enter> will create a 

new layer. A layer that is unwanted can be deleted very quickly by clicking in the little 

square selection box at the extreme left of the layer and then pressing <Delete>. This 

method of adding and deleting layers is very useful when a number of layers is being 

entered by hand. 

Now we plot the performance of this new design. In the parameters dialog, set the 

vertical axis to be Reflectance Magnitude and check the Automatic Scale box. Now click 

Plot 

 
 

Save this plot as plot file two using the same procedure as before, that is selecting the 

plot by making the plot window active and then using the Save As... command in the File 

menu, or, pressing <F12>. 
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It would be useful to compare these two plots in the same diagram. To illustrate how 

this can be done let us close all the plot and design windows. Now either go to the File 

menu and select Open..., or press <Ctrl><F12>. This brings up a dialog box with a list of 

files to open. 

A list of design files is shown but we want the plot files. Click the arrow to the right 

of the Files of Type: window and select Plots. The list of designs will disappear to be 

replaced by the list of plots that we have saved so far. Select one.npl. This is the plot 

corresponding to the single layer. The line thickness was made perhaps rather too large . 

Let us change that to a fine dotted line. With the mouse over the curve, double-click the 

left mouse button. In the dialog box that appears change the Pattern to be Dotted and then 

click Close. This changes the appearance of the curve. 

Now we want to add the three layer antireflection coating curve to the same diagram. 

Return to the File menu and select Add Line... This time there is no equivalent single key 

stroke but you can use <Alt><F> followed by <d>. The Add dialog box appears and this 

time the file two.npl can be selected. Both curves are now on the same diagram as shown 

below. This plot may in turn be stored for later recall or for adding further curves. 

An alternative way of combining plots is to drag one plot over another. Of course the 

plots should be compatible, especially the horizontal axis. 

 
 

It would be interesting to see how the three-layer coating operates at oblique 

incidence. Open the design named two. Let us choose an angle of 45°. This can readily 

be entered in the cell labeled Incident Angle right at the top of the Design window (or in 

the Performance Parameters dialog box). We decide we want to plot both s- and p-

polarizations together with the mean. We therefore select the Parameters menu and 

Performance... Down at the foot of the resulting dialog box there is a set of polarization 

check boxes. Check P, S and Mean. Select Plot either by clicking the plot button or 

selecting Plot from the Performance menu and the result is as shown below. 

In the normal configuration of the package, the curves will all be full lines but with 

different colors, red for p-polarization, blue for s-polarization and green for mean. In this 

version of the plot the s-polarization curve is the full line, the p-polarization the broken 
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line with broad dashes and the mean the broken line with short dashes. This is so that it 

can be printed in black and white if necessary. 

 
 

A Word about Data Files 
The program generates many different files containing data as it operates. You will 

want to preserve various designs that have been entered. Significant plots and tables will 

be stored. Specifications for refinement will be created. Text files with pasted-in design 

and performance details for incorporation in reports will be saved. The amount of 

material that can accumulate in one project is enormous and from time to time you will 

want to archive this data and start again. If all of this is preserved in a dedicated folder, 

then archiving and clearing out is straightforward. If, however, it is mixed in with 

program files and with other project files then there can be a real problem during 

archiving. The program is arranged so that many different design folders can be used. 

These must first be created in the usual way (Windows Explorer is simplest). Try to adopt 

a convention in naming the folders so that they have a clear and obvious meaning. This 

will help enormously in keeping things organized. The Jobs facility (see the section Work 

Data Management if the chapter The Essential Macleod Structure for more information) 

can be of great help in this. 

...about Materials Databases 
Many materials databases can be used. The only limitation is that only one database at 

a time may be active. The databases are completely separate entities and can contain 

duplicate names without any risk of ambiguity because the design files are linked to the 

materials database with which they were created. Thus a separate database with subtle 

differences in material properties could be maintained for each coating plant. Two 

databases, one labeled WET and the other DRY could permit rapid calculation of the 

effect of moisture on different filters. Although the coating design files are linked to their 

own materials databases, nevertheless it is very easy to change from one database to 

another with the same material names. It is simply difficult to do it accidentally. 
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It is also possible to vary variable units from one database to another. Coatings for the 

far infrared are better handled in microns that in nanometres, for example. 

A materials database is a collection of material files that are held in a separate folder 

together with control files. The collection can be as extensive or narrow as desired. The 

easiest way to create a material database is to type the name including path in the 

Materials Folder window in the Essential Macleod Options dialog box. Choose 

General... in the Options menu to activate the dialog box. If the name that has been 

entered is a new one then the program will automatically create the new database. 

Another way of creating a materials database is simply to copy an existing one into a new 

folder. It is most important that the control files should be kept in the same folder as the 

material files otherwise the material files cannot be used by the program. Rather like the 

design file folders, the names of materials databases are best chosen carefully so that they 

convey an idea of their content. IR, VIS and UV, for example convey immediately the 

idea of spectral regions and differences in wavelength units. PlantA, PlantB or ClientA, 

ClientB are also designations that convey an immediate meaning. Note that a separate 

materials database is automatically created as part of any new job. 

...and about Conventions 
There are conventions concerning designs and parameters that are dealt with in detail 

in the next section but some are so important that we mention them also here. 

The term, Medium, refers to the incident medium and Substrate to the emergent 

medium. In the default convention, designs are written with the flow of light from left to 

right or from top to bottom so that a formula representing a design is assumed to have the 

incident medium on the left and the substrate, or emergent medium, on the right. The 

designs shown in the design window have incident medium at the top of the table and 

emergent medium, or substrate, at the foot. This default convention can be changed. See 

the Options Menu section in the chapter APPLICATION WINDOW. [Note that 

throughout the Macleod packages there is just one exception to this rule and that is in 

Runsheet where the order of the layers is necessarily that in which they are deposited, 

that is with the layer next to the substrate first - although there is provision for 

accommodating a coating where the incident medium might be a prism with a coating on 

its hypotenuse.] 

Layer thicknesses may be specified in four principal ways. Optical thickness is given 

by 𝑛𝑑/𝜆0 or by 4𝑛𝑑/𝜆0 (QWOT), geometric by 𝑑/𝜆0 and physical by 𝑑 where 𝜆0 is the 

reference wavelength, 𝑛, the real part of refractive index, and 𝑑, the physical thickness of 

the film, that is the thickness that would be measured by a conventional ruler. 

There is a hierarchy that determines the way in which thicknesses in a design change 

when the reference wavelength is changed. If optical thicknesses are displayed, then they 

remain constant when the reference wavelength is altered. This implies that the physical 

thicknesses will change. If, however, optical thicknesses are missing, but physical 

thicknesses are displayed, then the physical thicknesses will remain constant. 

Geometrical thicknesses will remain constant only if the other two conventions are 

missing. The item Display Setup in the File menu governs what is displayed. 
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However, when layers are copied and pasted, it is the physical thickness that remains 

constant in that operation because it is assumed that the properties of the pasted layer 

should be exactly those of that copied. 
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CONVENTIONS 
Conventions are important because they define the frame of reference used for the 

results and when comparing results from two different sources they become vital. We 

therefore discuss in this section the primary conventions that are used in this package. 

Note that these conventions are applied uniformly throughout the Essential Macleod and 

package so that results obtained in any section are completely compatible with those 

obtained in any different section. If, therefore, you will be confining yourself to use of the 

Essential Macleod and no other thin film packages then you may wish to omit this 

somewhat tedious section on, at least, a first reading. It is here should you ever need it. [If 

you are going to be involved in the calculation of relative phase shifts between s- and p-

polarized light then it could be useful to skim through the part dealing with the 

convention for the calculation of .] 

The term, Medium refers to the incident medium and Substrate to the emergent 

medium. This terminology is the usual one in thin-film coating design. The default 

convention is that the medium is at the top of a design and the substrate at the foot. Then 

the layers are numbered from 1 at the outer surface next to the incident medium to the 

total number of layers at the substrate (i.e. emergent medium) interface. This default 

convention is followed throughout the package with one exception - Runsheet. The 

convention in Runsheet is that the layer next to the substrate is always layer number 1. 

Note that the conversion from the default layer numbering convention to the Runsheet 

layer numbering convention is automatic, you do not, and indeed, must not alter the 

design before loading it into Runsheet. 

Not everyone prefers this default convention. It can be changed in the General item in 

the Options Menu. More details are in the Options Menu section of the APPLICATION 

WINDOW Chapter. 

Designs, in the default convention, are written with the flow of light from left to right 

or from top to bottom. A formula representing a design is assumed to have the incident 

medium on the left and the substrate, or emergent medium, on the right. This, too, can be 

changed as explained in the Options Menu section. 

Layer thicknesses may be specified in four ways. Thicknesses may be either full-wave 

optical thickness (FWOT) or quarter-wave optical thickness (QWOT) or geometrical or 

physical. Physical thickness is just the thickness of the film as it would be measured by a 

ruler calibrated in physical thickness units, nanometres unless they have been changed by 

the user. In interference calculations the most important quantity associated with a layer 

is its effect on the optical phase of light that traverses it. The phase change depends on 

the optical path and the vacuum wavelength. Full-wave Optical thickness, therefore, is 

the physical thickness multiplied by the refractive index of the material (that is the optical 

path) and divided by the reference wavelength. Because of its fundamental role in 

calculations, it is frequently used in preference to the other thickness conventions. 

QWOT thickness is another type of optical thickness. 1 QWOT is equal to 0.25 optical 

thickness units. Geometrical thickness is the ratio of physical thickness to reference 

wavelength. 

One of the reasons we often use the ratio of the thickness of a layer to a reference 

wavelength is that dimensionless quantities are usually to be preferred over dimensioned 
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ones with units. Many of the layers in the designs considered so far have optical 

thicknesses (FWOT) of 0.25. This means that the optical path for one traversal is one 

quarter of a vacuum reference wavelength. The material for one layer, listed as 

Na3AlF6,is cryolite or Na3AlF6, and the refractive index of this material is shown as 1.35. 

This is the value at the reference wavelength which is 510nm in this case. We can tell that 

the geometrical thickness would be 0.25/1.35 that is 0.185185. Physical thickness would 

be 94.444nm. 

The reference wavelength, 0, is simply, as the name suggests, a reference value of 

wavelength to which parameters such as optical thickness are referred. It is usually 

chosen as a meaningful wavelength, that at which the layers are quarterwaves, for 

example. As far as changing the value of the reference wavelength is concerned, we can 

do this at any time by activating the design window, selecting the Reference Wavelength 

cell by clicking within it and typing in the new value. 

Layer numbering can be set in the Design tab of the General Options window to run 

either from the substrate or from the incident medium. In Runsheets, the displayed order 

is always in deposition order and so there the top layer, numbered 1, is the one next to the 

substrate. 

The aspects of performance that are principally addressed in the Essential Macleod are 

connected with the specular reflection, transmission and absorption of light. The system 

that is assumed in all of the calculations is a smooth, flat surface of a substrate, or 

emergent medium, over which has been applied a layer or series of layers of different 

material such that the interfaces are smooth and parallel both to each other and to the 

surface of the substrate. The materials are generally isotropic but may be biaxially 

birefringent and, in much of the package, homogeneous. (These are all quite normal 

constraints). There is an incident medium in which a collimated beam of monochromatic 

light is directed at the coated substrate. The incident medium must be isotropic. The light 

is partially reflected, transmitted and absorbed by the system. The layers are considered 

to support interference and so the calculations involve all the interfering beams that are 

reflected backwards and forwards within the layer system. 

The materials are characterized by their optical constants n and k. There are two 

physical aspects of the optical constants, refractive index and optical admittance. These 

quantities are numerically equal at optical frequencies but physically different. Refractive 

index is the ratio of the velocity of light in free space to that in the medium and is purely 

a property of an optical material while optical admittance is the ratio of the magnetic field 

amplitude to the electric field amplitude. Optical admittance may be either an attribute of 

a material when it is known as the characteristic optical admittance and is the ratio of the 

amplitudes of a progressive harmonic wave, or an attribute of a thin film structure when it 

is known as the admittance of the structure and is the ratio of the total fields of the 

interfering waves. Refractive index is a pure number and may be written as (n-ik) while 

the characteristic optical admittance is (n-ik) free space units. [A free space unit is 1/377 

siemens] There is a convention involved in the minus sign before the ik. In some 

publications a plus sign may be shown and this is an indication of the opposite 

convention for the progressive wave considered below. The terminology for n and k is 

somewhat unfortunate because n is usually called refractive index while k is known as the 

extinction coefficient. When it is necessary to differentiate between n and (n-ik), the 

former is referred to as refractive index or sometimes real part of refractive index while 
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the latter is the complex refractive index. In the package refractive index is used to refer 

to n and extinction coefficient to k. The package handles all conversions into complex 

numbers and optical admittances automatically and discretely. The extinction coefficient, 

k, is an indicator of any absorption in the material. When it is zero the material is 

completely free from absorption. Dielectric materials have small or zero values of k, 

while metals have very large values. 

Where materials are biaxially birefringent., three sets of optical constants are required. 

The principal axes of the birefringent material are parallel or perpendicular to the 

surfaces and to the principal plane. In the material editor these axes are labeled x, y and z. 

The x-axis and y-axis will be in the plane of the films. The z-axis will be normal to the 

film plane and into the system in the direction of the incident light. We associate the x-

axis with p-polarization and the y-axis with s-polarization. The direction of incidence will 

be in the x-z plane rotated in the incident medium through ϑ0 about the positive y-axis.  

The system is assumed to be completely linear in its response and so the performance 

may be described in terms of dimensionless quantities that are normalized with respect to 

the appropriate attribute of the incident light. Reflectance is the ratio of the reflected 

irradiance to the incident irradiance. (Irradiance is the mean power per unit area 

transported by the wave. In the SI system of units it is measured in watts per square metre 

[Wm-2]. An older term for irradiance is Intensity). Transmittance is the ratio of 

transmitted irradiance to incident irradiance. For these ratios to be meaningful, the 

incident medium must be free from absorption. This is not a serious limitation because it 

is impossible to make a measurement of reflectance in a medium that has even slight 

absorption. The program will not accept an extinction coefficient other than zero for the 

incident medium, any non-zero extinction coefficient in the material file for the incident 

medium is ignored. [We emphasize that this is not an inherent limitation of the program 

but a well-founded result in fundamental optics. Incident and reflected irradiances can no 

longer be separated because of a varying coupling between them. If they cannot be 

separately measured then reflectance cannot be defined.] In interference calculations 

especially, and also in many other applications, changes in the amplitude of the light are 

important. Light is electromagnetic and so there are strictly two amplitudes associated 

with it, the magnetic field amplitude and the electric field amplitude. At optical 

frequencies direct magnetic effects may be neglected and any interaction with matter is 

overwhelmingly associated with the electric field. The accepted convention, therefore, is 

that the word amplitude, with no qualifier, is always taken to indicate the electric field 

amplitude. Both the magnitude and the phase of the amplitude are equally important. The 

magnitude can readily be derived from reflectance and transmittance data, so the primary 

performance is usually left in terms of reflectance and/or transmittance. The phase of the 

light must be calculated separately, but to do this unambiguously we need to define the 

form to be used for the progressive wave. As is usual this is written in the complex form 

and we adopt the normal convention in thin film optics for a progressive wave in the z-

direction as 

   

𝐸 = ℇ exp 𝑖 [𝜔𝑡 −
2𝜋(𝑛 − 𝑖𝑘)𝑧

𝜆
+ 𝜑] 

which can be written 
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𝐸 = {ℇ exp [−
2𝜋𝑘𝑧

𝜆
] exp[𝑖𝜑]} exp [𝜔𝑡 −

2𝜋𝑛𝑧

𝜆
] 

   

where our minus sign in the complex refractive index is seen to be necessary for the wave 

amplitude to exhibit a decrease with propagation distance in an absorbing medium. The 

part of the wave expression in the curly brackets is known as the complex amplitude and 

it includes the relative phase. The final exponential is known as the phase factor of the 

wave. When the superposition inherent in interference calculations is concerned it is 

usual to arrange that the phase factors for all waves are exactly in that form so that they 

can be eliminated from the calculation that then proceeds in terms of the complex 

amplitudes only. 

Phase change on reflection is the change in phase  that is suffered by the light on 

reflection. There is a problem in that the reflected beam is propagating in the opposite 

direction so that the phase factor has the form 

 

exp 𝑖 [𝜔𝑡 +
2𝜋𝑛𝑧

𝜆
] 

   

and does not cancel with the phase factor of the incident wave. The phase difference 

between the waves is a function of z. The convention used virtually universally is to 

define the origin of the z-axis as the interface where the reflection is taking place, 

normally the front interface of the multilayer. Then z is zero in both waves and the phase 

factors are then equal and can be eliminated. Reflected phase shift, therefore, is by 

convention the difference in phase measured exactly at the point where the reflection is 

taking place. Throughout the package this point of reference is the front surface of any 

thin film system, that is the interface with the incident medium. This is particularly 

important in the calculation of the influence of uniformity on wavefront, for example. 

There is less of a problem in transmitted phase and no clear consensus on a definition. 

The phase factors have the same form and can be made exactly equal by including any 

relative shift in z in the phase difference. In this package the phase change is calculated as 

between the emergent beam at the point it enters the emergent medium or substrate and 

the incident beam where it enters the coating and leaves the incident medium. This means 

that it includes a phase change corresponding to a displacement along the z-axis equal to 

the total thickness of the coating. Again this is important if calculations of the 

consequences of coating uniformity on a wavefront are being performed. 
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The normal thin film convention for electric 

field directions in reflection and transmission. 

This convention is used in the package for all 

calculations with the sole exception of  in 

reflection. 
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The convention for electric field directions for 

calculations of  in reflection and for all 

calculations including  in transmission. 

At oblique incidence the performance depends on the state of polarization of the 

incident light. There are two eigenmodes of polarization called s-polarization (electric 

field normal to the plane of incidence) and p-polarization (electric field parallel to the 

plane of incidence). [An eigenmode of polarization is simply a mode where the state of 

polarization is not changed in either reflection or transmission and so any general case 

can be expressed as a combination of given proportions of the eigenmodes which can 

then be computed separately.] There is often interest in the difference in phase between 

the p-polarized and s-polarized components of a beam. This is given the term delta or . 

 is nominally given by Δ = (𝜑𝑝 − 𝜑𝑠) but there is a slight complication. The normal 

convention for phase shifts on reflection in thin film calculations is that shown in the first 

of the two preceding figures. The normal convention for the calculation of , however, 

reverses the direction of the electric field in the p-polarized reflected beam. Calculations 

of the phase difference between s- and p-polarized light on reflection therefore follow the 

normal convention in the first figure while the calculation of  follows the convention in 

the lower figure. This involves a difference of 180° or  in the value of  compared with 

(𝜑𝑝 − 𝜑𝑠). 

The angle of incidence is always referred to the incident medium throughout the 

package. [In the Stack editor the substrate for one coating may be the incident medium 

for another but the overall angle of incidence for the entire structure is likewise in the 

incident medium.] This incident medium is a dielectric because of the theoretical 

limitations mentioned above. This implies that the incident wave in all calculations is 

always homogeneous although the waves in absorbing films or substrates will be 

inhomogeneous (planes of constant phase and planes of constant amplitude are not 

coincident). The user need not be aware of this complication which is handled completely 

automatically by the package.





The Essential Macleod Structure  23 

THE ESSENTIAL MACLEOD STRUCTURE 
The Core of the Essential Macleod is an integrated set of tools for carrying out the 

operations involved in the design and analysis of optical coatings. In this there are five 

main tasks. 

 

1 The calculation of the performance of a given design 

2 The derivation of a coating design given a desired performance 

3 The maintenance of optical constant data for the materials 

4 The analysis of the design for improving understanding 

5 The incorporation of the design as a component of a complete filter 

 

Adding tool groups known as Enhancements further extends the capabilities of the 

Essential Macleod. There are currently five such groups, Function, Runsheet, Simulator, 

vStack and DWDM Assistant. These are the subjects of later sections of the manual. 

Briefly, Function is concerned with extending the range of capabilities by enabling a 

wide range of additional operations on data produced by the core tools. Runsheet is 

concerned with the conversion of design data into production control programs. 

Simulator is concerned with modeling the production of optical coatings. vStack 

calculates the performance of systems of coatings that are not parallel but have coplanar 

normals. DWDM Assistant designs narrowband filters primarily for telecom applications 

and made up entirely of quarterwaves and exact multiples of quarterwaves. An additional 

tool, Monitorlink, that communicates with one supported controller is supplied on 

request. 

Performance Calculation 
Reflectance, transmittance, phase change on reflection, phase change on transmission, 

absorptance, density, the ellipsometric parameters  and  in reflection and transmission, 

their derivatives up to third order with respect to , the ultrafast parameters, group delay 

(GD) group delay dispersion (GDD) and third order dispersion (TOD), and color 

coordinates are the major parameters calculated in the Essential Macleod. These can be 

examined over a range of wavelengths, frequencies and angles of incidence and also 

thickness variation of a chosen layer all with completely flexible units for the 

independent variables. The results can be presented in the form of tables or of plots that 

can be stored for later recall and manipulation or can be cut and pasted into other 

applications. 

The effects of layer thickness errors can also be calculated so tolerance estimates may 

be made. 

The designs may be exported to the Zemax lens design package produced by Zemax 

LLC, to the Code V lens design package produced by Optical Research Associates, to the 

FRED optical modeling package produced by Photon Engineering, or to a filter file for 

LinkSIM produced by Rsoft Design Group Inc. 
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Thermal Model 
The Essential Macleod provides a model for estimating the effects of temperature 

variation on the optical performance of a coating that is based on the model that was 

developed by Haruo Takahashi (H. Takashashi, “Temperature stability of thin-film 

narrow-bandpass filters produced by ion-assisted deposition”, Applied Optics, Vol 34, 

No. 4, Feb 1995 pp667-675). The model assumes linear behavior of single-phase 

material. Strain-induced changes in refractive index are assumed to be isotropic through a 

packing density mechanism. The important parameters of the model are the linear 

expansion coefficient, the temperature coefficient of refractive index and Poisson’s ratio. 

These parameters may be specified for each material with the Material editor. Changes in 

layer properties are assumed sufficiently small so that second-order effects may be 

neglected. Interdependence of any of the important film parameters is also neglected. 

A temperature is entered as an offset from an unspecified reference temperature. At 

the reference temperature, materials have the optical properties defined in the materials 

tables and zero strain is assumed in all layers and the substrate. For non-zero temperature 

offsets, strain is introduced into the layers by the differential expansion of the substrate 

and the layers. This causes the thickness of each of the layers to change and also the 

packing density. The refractive index of each of the layers also changes due to the 

temperature coefficient of the refractive index of the material. 

The thermal model is implemented in the Design editor and in Simulator. In the 

Design editor, performance can be calculated for a specified temperature offset.  

Simulator models the effect of changing temperatures during manufacture. A 

temperature profile defines how the temperature changes during deposition. At the start 

of deposition of a layer, the substrate and layers already deposited are raised to the 

deposition temperature of the layer. The layer is then deposited at the temperature offset. 

Layer thickness is determined by the monitoring method used taking into account the 

changes to the optical properties of the coating caused by the temperature offset. Once 

deposition of the layer has completed, the substrate and layers are returned to the 

reference temperature in preparation for the next layer. 

When you use non-zero temperature offsets, you will be warned if thermal data is 

missing from any of the materials. 

Uniformity Model 
A coating machine will typically show a variation in deposited thickness across the 

area where parts may be coated. The magnitude and form of the variation depends upon 

the construction of the coating machine. The variation depends upon the location and 

form of the material sources and so the magnitude and variation will typically be different 

for each material source. In the coating machine (when properly calibrated and neglecting 

production errors) there will a location where the manufactured part will have the 

designed thicknesses. We will call this the Reference Location. Parts at some distance 

from this reference location will have thicknesses that are not the designed thicknesses 

caused by the non-uniformity of the coating machine. Some layers may be thicker than 

the design thickness and some other layers may be thinner. This will cause changes in the 

performance of the design. The Essential Macleod provides a simple one-dimensional 

linear model of uniformity that allows the impact of non-uniformity to be investigated. 
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Each material has a Taper Factor parameter. In uniformity calculations, a Taper Distance 

is specified. During the performance calculation, the thicknesses of the design are 

modified as follows: 

NewThickness = (1 + Taper Distance * Taper Factor) * Layer Thickness 

Where Taper Distance is in arbitrary units. 

Taper Distance may have negative as well as positive values. Taper Factor may also 

be positive or negative. Uniformity calculations are available in 3D plots (choose Taper 

Distance for the x or y parameter) and in Active Plots for Designs (add the Taper 

Distance variable). 

Coherence, Cone and Bandwidth 
Coherence is a system parameter expressing the strength of interference effects. 

Interference effects can be reduced by variations in parameters such as wavelength, angle 

of incidence, thickness, and so on. When interference effects are completely 

undiminished we describe the process as coherent, or, sometimes, as exhibiting complete 

coherence. When interference is completely suppressed we use the term incoherence. 

Intermediate processes where interference fringes are reduced, but not eliminated, are 

described by the term partial coherence. In the Essential Macleod the two principal 

conditions are complete coherence or incoherence. We assume in normal calculations that 

films in a design exhibit complete coherence, that is interference effects are completely 

undiminished. We likewise assume that elements that we call media, and are thick slices 

of material described as parallel or wedged, exhibit complete incoherence, that is where 

no fringes are present. In incoherent calculations, multiple beam summations involve 

addition of irradiances with no attention paid to relative phase. These selections are 

automatic and are usual in optical coating calculations. 

What of partial coherence? Here we have two tools that help us, Cone and Bandwidth. 

These tools appear whenever a parallel or wedged medium is declared in a Design 

document or whenever we use a Stack document. They are available in the vertical axis 

parameters. 

Bandwidth assumes a rectangular response function with a constant width in units of 

wavelength. Digital calculation of the response cannot be continuous but must involve a 

wavelength step that can be set in the Cone tab of the General Options dialog. However, 

whatever the setting there will always be a minimum number of steps in the calculation. 

Note that when the fringes are completely regular, as from a single thick film or foil, 

there may be a type of beating visible in the response. This is a natural interaction 

between a scanning function with width constant in wavelength and a scanned repeated 

feature with width constant in frequency. 

The cone can be Lambertian, when it is expressed in terms of semi angle, focal ratio 

or numerical aperture, or it can be Gaussian when it is expressed in terms of beam 

divergence or beam waist. It is also possible to specify through a text file the variation of 

power density in the cone. 

A Lambertian cone mimics illumination from a Lambertian radiator, that is one that 

has the same radiance at any angle. Black bodies, for example, are Lambertian radiators. 

The illumination is defined as Lambertian within the cone but zero outside it. However 

the surface of the coating is specular, not Lambertian, and so there is a cosine effect at the 
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illuminated surface of the coating and this is taken into account in the calculation. The 

Lambertian cone includes the effects of polarization that must be unambiguously defined. 

We imagine a plate polarizer inserted in the cone and normal to its axis. The polarizer 

permits passage only of that light that has its electric vector is in the permitted direction. 

The permitted direction is everywhere parallel in the polarizer. When that direction is 

aligned parallel to the principal plane of incidence, defined by the cone axis and the 

surface normal, the polarization is defined as p-polarization. When the permitted 

direction is normal to the principal plane, the polarization is defined as s-polarization. 

Calculated mean polarization in this particular case is actually unpolarized light, but the 

term mean is retained for consistency. Under some circumstances unpolarized results can 

differ very slightly from the mean of s and p-polarizations. The Lambertian cone mimics 

the illumination occurring in many optical instruments where there is a light source and a 

condensing system. 

A Gaussian cone is similar to a Lambertian cone in terms of the way its polarization is 

defined but the irradiance in the cone falls off from the cone axis as a Gaussian function 

and there is a phase correspondence amongst the various rays in the cone. The cone apex 

semi angle (Gaussian Semi Angle in the Essential Macleod) then defines the asymptotes 

of the cone, which are defined as the angle where the irradiance has dropped to 1/e2 of its 

axial value. Because of the phase correspondence, the cone converges to a Gaussian spot 

and then expands. The spot diameter, still defined by the asymptotes, is known as the 

beam waist, or in the Essential Macleod Performance Parameters dialog, as the Gaussian 

Spot. The Gaussian Spot is inversely proportional to the apex angle of the Gaussian cone 

and so the two are not independent. There is strictly no actual limit to the Gaussian 

function but the irradiance does decay rapidly outside the asymptotes of the cone. 

However the lack of a definite limit makes calculations at large angles of incidence 

coupled with large apex angles, exceeding 90° in total, problematic and they should be 

avoided. The Gaussian cone calculations are intended to mimic the illumination from a 

laser or the effects of a small illuminated spot. 

Then there is the ability to model a cone with arbitrary illuminating distribution of 

power density. The source can be considered to be a sphere at a large distance and 

centered at the coating and emitting unpolarized light. The power density of the 

illumination from the sphere is defined as a function of the angle measured from the cone 

axis, the axis being at zero angle, but there is no variation with azimuth angle. This 

calculation option is indicated by Profile in the list of cone options in the Performance 

Parameters dialog. The power density distribution is defined in a reference file that lists 

power density against angle. The angle need not be defined at constant interval and the 

power density value will be extrapolated as constant at either end (the normal 

extrapolation method in the Essential Macleod). If a truncated set of angles is to be used 

with no input outside the angular range, then the terminating values must be set to zero. 

The extrapolation will use the terminating values. The cone shares its definitions of 

polarization with the Lambertian and Gaussian versions and can be tilted to any angle of 

incidence. As an example, a reference file with two entries, 20° with 1.00 relative power 

density, and 70° with 1.00 relative power density, and set at zero angle of incidence, will 

yield an answer indistinguishable from a Lambertian Cone with zero incidence and 90° 

Semi Angle. We can truncate the range to be calculated by inserting 19.999° with zero 

power density before the 20° entry and 70.001° with power density zero after the 70° 

entry. It is important to note that the power density distribution in the reference file 
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should be that that would be measured normal to the beam. The cosine effect that is due 

to the specular nature of the coating will be automatically included in the calculation. 

Scattering and Surface Roughness 
Incoherent scattering is a phenomenon where light is lost to the system in non-

specular directions. The major culprit in optical coatings is surface roughness and there 

are some tools that help in calculating the magnitude of the effect. Because roughness is 

random and fractal it is impossible to specify it precisely, and statistical measures are 

used. A common one is the root mean square deviation from a perfect surface, denoted by 

σ. To improve the characterization of the surface we can add an idea of the correlation 

length of the roughness.  

There are two tools that yield some idea of the effect of roughness. The simplest 

assumes that the roughness is extremely small and either very short range with a 

correlation length much less than a wavelength, or rather longer range, with correlation 

length rather greater than a wavelength. Both are handled by introducing a transition 

layer at the rough surface that is 2σ in thickness. The layer is given the Medium attribute 

and is entered as Scatter(s) for the short range condition or Scatter(l) for the long range. 

Scatter(s) represents the condition simply as a graded layer with no incoherent loss, but 

Scatter(l) includes loss to represent what is lost to the system through the scattering. Note 

that the model is very approximate and may be still less reliable at oblique incidence.  

The second tool is available in the Analysis collection and performs some limited 

calculations of the angular distribution of scattered light following the model of J. Merle 

Elson. More details are given in the Analysis and Design Tools chapter. 

We emphasize again that calculations involving surface statistical parameters are 

necessarily very approximate and can never present an accuracy similar to that for 

specular interference effects. The results should be treated as no more than a very rough 

indication. 

Polarization Maintenance 
In some applications it is important that an optical coating will not perturb the 

polarization of an incident beam in either reflection or transmission. At normal incidence, 

a thin-film coating on a surface, where all materials are isotropic, will not perturb the 

incident polarization beyond changing its handedness in reflection. This is no longer 

generally true at oblique incidence. If there is any difference between the p and s-

performance then the polarization state of the incident light will be perturbed in both 

reflection and transmission unless it is linearly polarized parallel to either the p or s-

direction. This perturbation implies that a fraction of linearly polarized incident light will 

appear in an orthogonal mode. This phenomenon is sometimes called polarization 

leakage but this is a term that is already used in the Essential Macleod in respect of a ray 

out of the principal plane of incidence and calculated in vStack. We therefore term this 

effect polarization coupling. A complementary term that is a measure of the extent to 

which the polarization of the incident beam is preserved, is polarization maintenance. 

These parameters are typically measured by placing a polarizer in the incident beam 

aligned at 45° to the p and s-directions, and an analyzer in the emergent beam. The 

analyzer is first aligned parallel to the input polarization to give the signal level and then 
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orthogonal to it to give the leakage. The leakage irradiance, in the second orientation, 

divided by the sum of the leakage and the signal in the first, expressed as a percentage, is 

then the measure of polarization coupling. The irradiance in the signal orientation divided 

by the sum of the irradiances, again expressed as a percentage, is then the measure of 

polarization maintenance.  

The polarization maintenance parameter can be calculated for Designs (without thick 

layers) and for vStacks by selecting Transmittance PM or Reflectance PM in the 

parameter dialogs. It can also be used as a target for refinement. 

Coating design derivation 

There are two principal reasons for the derivation of a design to be required. The first 

is the straightforward need for a coating that must perform a given task. The second is 

sometimes called reverse engineering. An actual coating performance has been measured 

and the structure of the coating must be determined. Frequently this is associated with 

difficulties that have occurred in the attempted production of a known coating design. 

Both of these are quite similar operations. 

Calculation of the properties of a given design is straightforward because performance 

is a single-valued calculable function of the parameters. Derivation of a design, however, 

is much more difficult because there is no direct path back from performance to design 

parameters and no single-valued result. How then can we proceed? 

We recognize that knowledge, skill, judgment, experience, instinct and luck are all 

attributes of the successful designer. Most of these are subjective and therefore difficult 

to replace by a computer no matter how efficient and powerful. However the computer 

can help to remove those parts of the task that do involve intensive or tedious calculation 

and the speed at which evaluations can be performed make automatic design feasible in 

many cases. 

The computer can carry out performance evaluations very quickly. Imagine that the 

computer makes changes in the layers of a design and each time a change is made the 

performance is evaluated. A change that results in improved performance can be retained 

while a poorer one is discarded. In this way a given design may be gradually improved. 

From the pattern of results it may be possible to increase the rate of improvement. This is 

the technique of refinement where a starting design that is short in performance can be 

improved to meet a requirement. Now imagine that we have a design that is much more 

remote from an acceptable result but we have, however, a method of increasing the 

complexity of the design by adding layers in such a way that the successively refined 

performance continually improves. Eventually we build a design that is much more 

involved than the starting design but that meets the requirements. This is the process of 

synthesis. Refinement and synthesis have great similarities. Refinement can usually be 

relied on to achieve its potential, while synthesis rather less certain but can, on occasions, 

achieve an astonishing degree of success. Processes classified as refinement would be 

ones that we would use routinely, while synthesis would be for times when we are hard 

pressed and without much inspiration. Reverse engineering will make much use of 

refinement and rather less of synthesis. 

The Essential Macleod is well supplied with synthesis and refinement techniques. 

Two synthesis methods are supplied. The first is based on a method we call Optimac that 
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incorporates many different procedures for increasing design complexity. The program 

constantly evaluates itself and quite ruthlessly discards procedures that are proving 

ineffective as the synthesis proceeds but encourages those that are working well. Clearly 

the volume of calculation in a synthesis procedure is greater than that required in 

refinement, and so the time involved in the achieving of a design must be rather longer. 

For routine work therefore, refinement based on the nonlinear simplex technique is 

recommended. For rather less easy refinement problems where time is not so pressing 

there is simulated annealing. Then there are two techniques that include guidance from 

derivatives. Conjugate Gradient and Quasi-Newton can often present surprisingly fast 

convergence on an optimum design. Optimac itself can also be used for refinement and it 

is very efficient in that role. 

The second synthesis method is Needle synthesis. This method looks for a place to 

insert a new layer by calculating the derivative of the merit figure with respect to layer 

thickness for a zero thickness layer. The zero thickness layer is moved throughout the 

existing layers. The point at which the merit figure derivative reaches its largest negative 

value is the insertion point of the new layer. After all the new layers have been inserted 

(the needle method may insert more than one layer), Conjugate Gradient refinement is 

performed. This increases the thicknesses of the new layers to non-zero values. Also, the 

other layers will have their thicknesses adjusted by the refinement as would happen if a 

design was being refined.  

None of these methods removes the need for skill, and it is easy to show that there is 

no procedure that can do that at the present stage of development of computers. 

Nevertheless the techniques supplied here are powerful tools and they help enormously. 

It is clear, though, that we are a very long way from the day when ability, interest and 

application will become irrelevant. 

 

Work Data Management 
In normal use of the Essential Macleod, you typically work with a single materials 

database, and a single set of reference data (including scripts if the Function option is 

installed). For various reasons, you may want to separate your data into different regions. 

This may be, for example, because you are a consultant and need to keep all data for one 

client completely separate from data for another client. The Jobs facility provides this 

capability. A Job is represented by a folder name and contains a Materials folder, a 

References folder (including scripts) and a Designs folder. A Job can be created, opened 

and closed. When a Job is created, you enter a folder name – this is the name of the Job. 

Typically this folder will be stored in the My Documents\Thin Film Center\Jobs folder, 

but you can locate it anywhere on the computer including a removable drive. A new 

empty materials folder is created. A new references folder is created and all reference 

data and scripts are copied from the main references folder to the new folder. A new 

designs folder is also created. The Essential Macleod’s parameters are set so that these 

new folders are the default folders for loading and saving information. To show that a Job 

is open, the title bar of the Essential Macleod shows the name of the open Job. 

A Job can also be closed. This means that the Essential Macleod will be reset so that it 

uses the normal materials folder and the normal references folder. The default location 

for designs etc. will be changed back to what was last used when no Job was open. The 
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Essential Macleod title bar will just show “Essential Macleod” to show that no Job is 

open. 

Maintenance of Materials Data 
The thin films that make up the coating and the incident and emergent media are all 

characterized by a refractive index, n, and an extinction coefficient, k. These are 

discussed in greater detail under Conventions above. 

Real materials, with the exception of free space, suffer from dispersion that is a 

variation of n and k with wavelength. This variation must be taken into account whenever 

the wavelength is changed during a calculation. Ideal dielectric materials in their 

transmittance region exhibit what is known as normal dispersion. Normal dispersion is 

predictable from straightforward harmonic oscillator theory and there are several 

expressions that can be used to fit the behavior. Ideal metals have quite different behavior 

that depends largely on free rather than bound electrons although again there are ideal 

expressions that exhibit ideal metallic behavior. Real materials, and especially thin film 

materials, are somewhat more complicated than these ideals and the validity of the 

various formulae that exist is limited.  

Refractive index data may be stored in several different ways: as Sellmeier 

coefficients, as Cauchy coefficients, as Drude coefficients, as Lorentz coefficients, as 

Drude-Lorentz coefficients, or a table of data. The extinction coefficient part may be 

stored as a table, a set of Cauchy coefficients, a pair of exponential coefficients or may be 

declared as always zero. For Drude, Lorentz, Drude-Lorentz, the extinction coefficient 

information in an integral part of the coefficient set, so there is no separate extinction 

coefficient definition. When tabular data are used, values needed during calculations are 

derived by linear interpolation. The data can be given at any series of wavelengths which 

do not need to be equally spaced. Where the values are changing rapidly, for example, the 

density of data can be greater. 

Maintenance of the material optical constant data is therefore an important task that is 

the function of a major division of the package. Data may be examined and displayed. It 

may be edited, added to or deleted. Fresh materials may be introduced. The optical 

constants may be automatically derived from spectrometric measurements. Many 

different independent databases of materials may be maintained, even with different 

systems of units, and with easy transfer of data from one to the other. 

Analysis and understanding 
Often the sequence of layers that make up a design is not enough. We need also to 

understand how the design works and where the critical regions lie where particular 

attention to detail like roughness or contamination is required. This is the purpose of the 

group of tools known as Analysis. Admittance loci, electric field plots, potential 

transmittance, symmetrical periods, and the like are included. 

Combinations of coatings 
Frequently the final product will not be one single coated surface but a combination of 

surfaces, some coated, some uncoated. For example a filter with a cemented cover over it 
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will consist of four surfaces separated by optical material, only one of which is coated. Or 

perhaps there will be antireflection coatings on the outer surfaces. There may be as many 

as forty surfaces in a compound lens consisting of elements of different optical constants, 

all with antireflection coatings. Both the Stack editor and Design editor deal with this 

situation. A virtually limitless, within the capacity of the computer of course, number of 

different media, each bounded by two surfaces, either parallel or wedged, can be 

accommodated. 

Packing Density 

Materials in thin film form rarely have bulk properties. The primary reason for this is 

their microstructure that is seldom bulk-like but usually exhibits a pronounced columnar 

morphology. The most unfortunate features of the columnar microstructure are the pore-

shaped voids between the columns and they are the main culprits in reducing film 

packing density, which in turn affects the optical, and other, properties. The Essential 

Macleod uses packing density as a vehicle both for simulating the effects of a change in 

packing density, in practice this could be due to a change in deposition conditions, but 

also as a convenient way of introducing variable refractive index. 

The model that is used for the variation of optical constants as a function of packing 

density is a very simple empirical relationship first proposed by K Kinosita and M 

Nishibori. (Porosity of MgF2 films - evaluation based on changes in refractive index due 

to adsorption of vapors. J. Vac. Sci. Technol., Vol 6, pp 730-733, 1969) that has since 

been shown to represent very well the behavior of many dielectric films. (Since the 

relationship is single-valued and continuous it would be straightforward to calibrate the 

packing density so that it represented a more involved relationship.) 

 

 𝑝 =
𝑉𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑠𝑜𝑙𝑖𝑑 𝑝𝑎𝑟𝑡 𝑜𝑓 𝑓𝑖𝑙𝑚

𝑇𝑜𝑡𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑓𝑖𝑙𝑚
 

 

and the refractive index of the film is given by 

 

𝑛 = (1 − 𝑝)𝑛𝑣 + 𝑝𝑛𝑠 

  

where n is the composite index, nv is the index of the material filling the voids and ns is 

the index of the solid part of the films, the columns.  

In the Essential Macleod nv is given by a void material and a void density. That is, the 

void material can be specified, and it can be defined to occupy a certain proportion of the 

void space (the remainder of the void space is occupied by air, n = 1.0). This allows 

effects such as partial saturation with water to be modeled. The refractive index of the 

complete void is given by 𝑛 = (1 − 𝑝)𝑛𝑣 + 𝑝𝑛𝑠, where nv is the refractive index of the 

unoccupied void (1.0), ns is the refractive index of the void material and p specifies the 

amount of void space occupied by the void material. When p = 1, the whole void space is 

occupied by the material. When p = 0, there is no void material in the void space. The 

refractive index of the layer is therefore given by 
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𝑛 = (1 − 𝑝)[(1 − 𝑓) + 𝑓𝑛𝑣] + 𝑝𝑛𝑠 

   

where n is the composite index, p is the packing density of the layer material, f is the 

packing density of the void material, nv is the refractive index of the void material and ns 

is the refractive index of the layer material. 

As well as permitting refinement in terms of refractive index, packing density is 

particularly useful in reverse engineering and in simulating inhomogeneous layers. 

The packing density can be applied to both the real and imaginary parts of the 

complex refractive index (refractive index and extinction coefficient), or to just the 

refractive index leaving the extinction coefficient unchanged. This is controlled by 

selecting General from the Options menu. Next, click on the Designs tab. To have 

packing density control the extinction coefficient as well as the refractive index, check 

“Use Packing Density to adjust Extinction Coefficient”. By default, extinction coefficient 

is not adjusted by the packing density. 

Units in the Essential Macleod 
Most of the variables in the Essential Macleod, wavelength, frequency, magnitude 

etc., have units. These units can be chosen virtually at will. 

Since the same user may sometimes want to work in terms of wavelengths in microns 

and sometimes in terms of nanometres and so on, the units are tied to the materials 

database. Each different database may have completely different units. Since materials 

data are actually held in generic units (although the user need not know this - more about 

it later in this section) there is no need to convert the materials data when modifying the 

working units. 

The package can be thought of as calculating in terms of the fundamental set of SI 

units. Wavelength is a unit of length therefore it is in metres. Frequency is in hertz. Time 

is in seconds. Physical thickness is in metres. Using appropriate factors, these 

fundamental units may then be converted into a set of display units. The convention for 

the factors is that they should be expressed as the ratio of the desired unit to the 

fundamental unit., and they are therefore known as scale factors. 

A list of scale factors for most of the possibilities is given in a following table but it 

may also be helpful to work through several of them to illustrate how they may be 

derived. 
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Useful constants and prefixes 

Velocity of light 2.99792458108 metre per second 

Planck's constant 6.62607004010-34 joule second 

Electron volt energy 1.602176620810-19 joule 

Some prefixes Factor of 10-18 : atto with symbol a 

 Factor of 10-15 : femto with symbol f 

 Factor of 10+12 : tera with symbol T 

 Factor of 10+15 : peta with symbol P 

 Factor of 10+18 : exa with symbol E 

 

The first and most important rule is that the conversion must be through a linearly 

proportional relationship. Thus wavelength may be converted only into those quantities 

that are linearly proportional to wavelength and so on. 

Wavelength units are very straightforward. For example, 1nm is 10-9 metre and so the 

scale factor for nm is 10-9m divided by 1m, that is 10-9. 

Next we consider conversion from frequency in Hz to wavenumber in cm -1. This is a 

little more involved. Wavenumber is short for the number of waves per unit of length. 

This is linearly proportional to frequency so that the conversion is possible. Light travels 

a distance equal to its velocity in unit time and the number of waves in this distance is 

given by the frequency. Light with one wave per centimetre, therefore, has 100 waves in 

one metre and 1002.99792458108 = 2.997924581010 in 2.99792458108 metres. That 

is its frequency must be 2.997924581010 Hz. The scale factor is therefore this quantity 

divided by 1Hz, i.e. 2.997924581010. 

Now we look at conversion from frequency in hertz to photon energy in electron volts. 

One electron volt has an energy of 1.602176620810-19 joule. We divide this by Planck's 

constant to find the frequency in hertz, that is 2.41798926231014 Hz. The scale factor 

for Hz to eV is therefore 2.41798926231014. 
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Category Name Scale Factor Symbol 

Wavelength Wavelength 1E-09 Nm 

Wavelength Wavelength 1E-10 Å 

Wavelength Wavelength 1E-06 µm 

Frequency Wavenumber 2.99792458E+10 cm-1 

Frequency Energy 2.4179892623E+14 eV 

Frequency Frequency 1E+15 PHz 

Frequency Frequency 1E+12 THz 

Frequency Frequency 1E+09 GHz 

Frequency Angular Frequency 1.59154943092E+14 rfs-1 

Time Time 1E-15 Fs 

Physical Thickness Thickness 1E-10 Å 

Physical Thickness Thickness 1E-09 Nm 

Physical Thickness Thickness 1E-06 µm 

Physical Thickness Thickness 1E-03 Mm 

Note: key codes for the symbol µ  Alt+0181 

 key codes for the symbol Å Alt+0197 

 

Angular frequency may also be useful at times, particularly when dealing with short 

pulses. We can use units of radians per femtosecond, rfs-1, for example. In hertz this is 

(1/2)1015Hz. 

Access to the definitions of the general units is available only when no files are open. 

The Options menu for the Application window has an item General Units.... General 

units are those that are used in the performance calculations.  

 
 

Once the units have been defined for a particular database they will remain as defined 

until intentionally changed. Materials data are stored in terms of generic wavelength 

units.  

Several units have a selection of pre-defined units available. Click the dropdown 

arrow of the Pre-defined Units list to see the options available for the particular unit. 
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You can copy the unit definitions from a materials database into the current materials 

database by clicking the Import… button. A folder chooser will be displayed. Select the 

folder containing the desired units, and click OK. The units in the selected database will 

be copied into the form. You will not be able to select OK in the folder chooser if the 

selected folder does not contain units definitions. 

The materials database holds the optical constants of materials in terms of wavelength 

(but can display the data in terms of frequency). As the wavelength or frequency units are 

changed from one type to another the display of optical constants and the calculations all 

follow. No changes need be made to the materials database. Similarly when one material 

is imported into another database, any necessary unit conversion is completely automatic. 

The data is actually stored in generic units and the program converts backwards and 

forwards between these generic units and the current display ones. Any new material that 

is entered should have data given in terms of the current wavelength units, whatever they 

are, and then the conversion to the generic units of the database will be completely 

automatic. It may be, however, that data to be imported is given in some alternative units. 

The current ones might be microns and the data might be in terms of nanometres for 

example. Conversion before entry is tedious and therefore it is possible to enter data in 

any wavelength units. If the units are not the current ones then a scale factor must be 

given. Use the Wavelength Scale... command in the Edit menu for an individual 

material. The scale factor should be exactly that that would be entered in the General 

Units dialog. It is one unit of wavelength expressed in metres. 

 
 

Line styles in the Essential Macleod 
The default appearance of all plotted lines is consistent throughout the package. As 

drawn, all lines are full lines. They are color coded as black for normal incidence, blue 

for s-polarization at oblique incidence, red for p-polarization at oblique incidence and 

green for mean polarization at oblique incidence. The style and color can be changed in 

the normal way and broken lines are included in the available choices. 

Color 
The color of any object is a subjective response that varies from one individual to 

another. In order to permit unambiguous quantitative determination of color, standard 

observers have been defined. Color measurements and comparisons are therefore 

normally made with respect to the standard observers, that in turn have been created after 

many different measurements on many real observers. The two most common observers 

have been defined by international agreement and consist of three color matching 

functions that are measures of the amount of three defined primary colors that are 

necessary exactly to match pure spectral colors, each of 1W radiant power, across the 
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visible region. These functions are known as x , y  and z  and they correspond to color 

matching using the red, green and blue primaries respectively. There are two 

internationally agreed sets of standard observer color matching functions, the CIE 1931 

set and the CIE 1964 set. These sets are quite similar but the 1964 set is intended better to 

represent fields subtending angles of 10° while the CIE 1931 set corresponds to 2°. 

Given the color matching functions for spectral lines, the amounts of the three primary 

colors required to match any light source can be calculated simply by decomposing it into 

its spectral distribution, multiplying by the appropriate tristimulus values and integrating. 

These amounts of primary colors are known as the tristimulus values. Since thin film 

coatings are not self-luminous they must first be illuminated by a light source and then 

the tristimulus values of either the light reflected by the coating or that transmitted, can 

be calculated. Coating color calculations therefore begin by finding the tristimulus 

values, X, Y, and Z, for the coating and the light source. Then the raw tristimulus values 

may be manipulated into sets of three coordinates in various defined versions of color 

space. Simple normalization to give a sum of unity yields the Chromaticity Coordinates, 

for example. 

The different coordinate systems presently available for calculation by the Essential 

Macleod are Tristimulus, Chromaticity, CIE L*a*b*, CIE L*u*v*, CIE L*u’v’, Hunter 

Lab, CIE1960 uv, Correlated Color Temperature and  Dominant Wavelength. These 

coordinate systems are hard coded in the program and can not be changed by the user. 

Color Rendering Index is also calculated. Color difference in the CIE L*a*b* coordinate 

system can also be calculated using either the CIE76 method or the CIEDE2000 method. 

Standard light sources that are supplied with the program are CIE defined and consist 

of illuminants A, B, C, D55, D65, D75 and equal energy. Standard observer color 

matching functions supplied are the CIE 1931 observer and the CIE 1964 observer. 

The light sources and the standard observers are not hard coded and can be 

supplemented or changed by the user. They consist of a series of reference files in the 

reference folder (defined in the General Options dialog box). The light sources are 

defined by the file sources.src in the reference folder and the observers are defined by the 

file observers.obs also in the reference folder. These files are maintained using the 

General command in the Options menu. The sources are maintained on the Sources tab 

and the Observers are maintained on the Observers tab. You can add, delete, edit and 

change the order of appearance of sources and observers. 

To add a source, place the spectral response in a reference file in the reference folder. 

The format consists of a header 

WAVELENGTH<Tab>REL OUTPUT 

followed by records each consisting of a wavelength in nm and relative output separated 

by a tab character. Note that the wavelength should always be in nm even if the general 

units being used are different. An easy way of entering the information is by setting it up 

first as a table and then creating a reference file from it using the Create Reference... 

command in the File menu. 

Once the reference file has been created, select General from the Options menu and 

click on the Sources tab: 
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Click the Add button.  

 
 

In the Source Name field enter the name of the source as you would like to see it 

displayed. In the Source Filename field, select the reference file that contains the new 

source data, and then click OK.  
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The Add Source dialog will now close and the Source list will be updated with the 

new source. Click OK to save the new source information and close the General Options 

dialog. 

More information is required for Observers. Three files must be defined which give 

the x, y and z color matching functions. Optionally a plot file showing the boundary of 

chromaticity space can be defined for the observer and also a plot file showing the 

boundary of CIE 1976 UCS space can also be defined. Wavelengths for the x, y and z 

color matching functions must be in nm.  Select General from the Options menu and then 

click on Observers. 

 
 

Select the CIE 1964 observer and click Edit. 

 
 

The Edit Observer form allows you to specify the files needed to define an Observer. 

For Color Rendering Index, the test color sample files are held in the References 

folder. The standard files supplied with the software are named CIE TCS01.ref to CIE 

TCS14.ref. The calculation uses up to 14 test color samples when calculating Color 

Rendering Index. The samples used for determining the general Color Rendering Index 

may be specified by the user, and are normally the first eight test color samples. 
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Use the Browse button to select the reference file that defines the reference source 

spectrum for the color rendering index calculation. To change the file used for a test color 

sample, double-click in the Reference File cell and select the file in the file chooser that 

appears. To include or exclude a sample from the general coloring rendering index 

calculation, click on the cell in the Use In General CRI column. 

 

Derivatives in the Essential Macleod 
Derivatives up to the third order of most performance parameters can be calculated in 

the Essential Macleod simply by entering the appropriate order number against derivative 

in the Vertical Axis section of the Performance Parameters dialog box (described later). 

These derivatives are with respect to wavelength. 

The derivatives are calculated from analytic expressions for each of the performance 

parameters. The derivatives of the optical constants defined by tables are determined 

numerically. The optical constants in the package are linearly interpolated from tables 

and so there can be sudden changes in slope that would show up clearly in the derivatives 

of performance. Therefore the slope of the optical constants is smoothed around the 

corners to avoid any sudden change within the calculation range. The region over which 

this smoothing takes place is defined by the Wavelength Delta Factor. The first derivative 

of the optical constants is given by the difference between the optical constant at (1 + 

WavelengthDeltaFactor) * Wavelength and the optical constant at (1 – 

WavelengthDeltaFactor) * Wavelength divided by WavelengthDeltaFactor * 

Wavelength. 

To modify the definition, select General from the Options menu and then select the 

Designs tab.  Wavelength Delta Factor gives the interval used for determining the first 

derivative of the optical constants. It is difficult to determine reliable values for the 

second and third derivatives and so these values are set to zero. Generally, the optical 

constant derivatives have negligible effect on the derivatives of the performance 

parameters 
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Exporting coating designs to Zemax 
Coatings are important features of optical components and systems and the Zemax series 

of lens design packages includes coatings in its performance assessments. Zemax does 

not have any facilities for generating or editing designs. It stores and reads the designs 

together with data on materials from a special coating file that has a prescribed format. In 

particular, the layers in the designs must be specified in terms of optical thicknesses at a 

given reference wavelength, or in terms of physical thicknesses. Zemax also provides the 

ability to use the performance of a coating rather than the definition of a coating. The 

Essential Macleod includes an editor for the Zemax file that makes the transfer of coating 

designs or their performance to Zemax extremely simple and straightforward, and, more 

important, reliable. The user need not be concerned about the special formats that are 

required nor about the constraints on total numbers of layers or material information. All 

of this is checked automatically. 

To activate the Zemax coating file editor the current file must be opened. The 

command for this is Load Zemax Coating File... in the Tools menu for most documents.  

A new Zemax coating file can be created by selecting New Zemax Coating File in the 

Tools menu. The appearance of the main window of the Zemax editor is shown below. 

 
 

The window has seven tabs, materials, tapers, coatings, tables, ideals, ideal2s and 

encrypted. The coatings are defined by the name of the design file from which they were 

exported. The materials are defined by the names that they had in the materials database 

from which they were originally extracted. Tapers, ideals and encrypted files are defined 

by editing the file directly. Design, material and table names are converted to upper case 

before the data are written to the Zemax file. Once they have been written, these names 

may not be edited. The editing operations are limited to deletion or addition. This is 

intentional. The data are intended for use in another application and have been exported. 

Editing existing data may invalidate already performed calculations so editing should be 

carried out only under special circumstances with an understanding of the extent of the 

consequences. 

To examine, but not edit, the data stored for any of the materials, tapers, designs, 

tables or ideals either double-click on the appropriate name or select the item and click 

View. A table will appear listing the stored information. 
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To add a new design, first make the design window active. Then select Add to Zemax 

File in the Export submenu of the File menu. 

There are five options in the submenu, Relative Thicknesses Without Substrate, 

Relative Thicknesses With Substrate, Absolute Thicknesses Without Substrate, 

Absolute Thicknesses With Substrate, and As Performance Table…. 

Choosing one of the Relative Thicknesses options will export the design with 

thicknesses defined as optical thicknesses. The actual design will be given by the 

combination of the layer thicknesses and the reference wavelength defined in Zemax. 

Designs can only be exported this way if they are defined in terms of optical thicknesses 

in the Essential Macleod. Choosing one of the Absolute Thicknesses options will export 

the design with thicknesses defined as physical thicknesses. The coating will have the 

same performance regardless of the reference wavelength defined in Zemax. Choosing 

the As Performance Table option will export the reflectance and transmittance 

magnitude and phase data for s and p polarization for a user-defined range of incident 

angles and wavelengths. 

Opaque layers and substrates can be included in the Zemax coating designs but in a 

way that is a little different from the Essential Macleod and needs some explanation. 

The normal Zemax coating design is a series of thin and reasonably transparent films 

only. These structures are essentially transmitting assemblies and the substrate is 

automatically designated in the Zemax system design so it is not required as part of the 

coating. However, if the coating contains an opaque metallic film such as a thick layer of 

aluminum then it will have zero transmittance and its function will be that of a reflector. 

Such thick opaque films require special treatment. In the Essential Macleod special 

algorithms are activated automatically when necessary without the user even being aware 

of them. In the Zemax calculations, such opaque layers are treated as a massive opaque 

substrate, but the opaque substrate must be included as a final dummy layer in the design. 

In the Essential Macleod the design of a front surface mirror based on, for example, 

aluminum, may be specified in two different ways. Either the aluminum may be defined 

as the substrate or the final layer of the design may be a thick aluminum layer. In Zemax 

this design will be handled in the former way but the design will be specified in the latter 

way. 

When passing designs of reflectors to Zemax, then, if the films include the opaque 

layer as the final layer, then the submenu choice should be Without Substrate. If the 

layers are essentially transparent and the substrate is opaque then the submenu choice 

should be With Substrate. 

Since it may not always be obvious whether or not the substrate should be included it 

is arranged that an included substrate has zero thickness so that if passed incorrectly as a 

film to Zemax rather than a substrate, it will have no influence on the performance of the 

design. 

Once the command is activated, several things happen. First, the materials list in the 

design is checked against the materials already in the Zemax coating file. The list 

together with the name of the coating is presented in a dialog box that appears. The 

coating name can be edited at this stage. The edited name will be used in the Zemax file 

but this will not change the existing design name. Clicking the Save button saves the 

coating together with any materials that are not already in the Zemax file. Should, 
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however, the name of the design correspond to one already in the Zemax file then a 

warning message will appear and the design will not be written until the name is edited to 

something unique. Materials, too, that already exist in the Zemax file are checked more 

thoroughly at this stage. If their data does not correspond to that in the current material 

file then, again, the file will not be written. There are now two choices. The Zemax name 

may be altered - type in the new name in the list over the old - and this altered name will 

appear in the Zemax file. Alternatively, the existing material may be overwritten. 

 
 

Zemax coating designs are limited to a maximum of 400 layers and coating materials 

to a maximum of 120 points. These limits are also checked at this stage and appropriate 

warnings generated if necessary. 

It is a good plan to maintain a special materials database for Zemax alone. Quite a few 

of the materials in the regular Macleod databases have more than 120 wavelength points 

and must be edited down to this number before they can be passed to Zemax. This is best 

done in a dedicated database. 

When a design is exported As Performance Table, you will be asked to enter the set 

of incident angles and wavelengths for calculating performance in the following form: 

 
 

Incident angles and wavelengths do not have to be equally spaced. Once you have 

entered the information, click OK. This will cause the performance data to be calculated 

and added to the Zemax coating file. 
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Exporting data for CODE V 
CODE V is a lens design package produced by Optical Research Associates. A CODE 

V model can include coatings. The Essential Macleod generates sequence files that 

contain definitions of coatings. These sequence files can be read by CODE V and cause 

the coating definition to be loaded into CODE V. For information on using sequence 

files, please consult the CODE V user’s manual. 

To export a design for use in CODE V, select CODE V Sequence File from the Export 

menu in the File menu of a design. A form will appear as shown below. 

 
 

There are three parameters for the Export: The title to be used for the coating, the list 

of wavelengths for which n and k data are to be provided and the filename for the 

sequence file. CODE V permits definition of up to 100 wavelengths for refractive index 

dispersion data. Since the Essential Macleod is unlimited in the number of data points for 

refractive index data, you are required to specify the individual wavelengths for which 

refractive index is to be generated. Reset from Design will create a list of 100 equally 

spaced wavelengths from the max and min values of the wavelength axis used for 

performance calculations. This list can then be edited to produce the required 

wavelengths if necessary. Once the parameters have been completed, click OK to export 

the data. 

Exporting data for FRED 
FRED is an optical system modeling package that can include the effects of coatings. 

To export a coating design to FRED, select FRED from the Export sub-menu of the File 

menu of the Design window. You will be asked to provide a filename for the file that will 

contain the coating data. Material data is automatically included in the file. Please see the 

FRED user manual for information on loading the coating data into FRED. 

Exporting coating designs to VirtualLab 
The VirtualLab package integrates several toolboxes allowing the analysis of systems, 

design of diffractive optical elements, design of beam shapers, analysis of gratings, 

analysis of laser resonators as well as the shaping and homogenization of LED light. To 
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export a design to VirtualLab, make sure the design is active and then select Export in the 

File menu. This will export a VirtualLab Coating Data File (*.vlct) containing layer 

parameters and materials data. Importing the design into VirtualLab uses the Import 

Macleod Coating Data item in the VirtualLab Tools menu of the Coating Catalog. 

Exporting data for LinkSIM 
LinkSIM is an optical communication system simulation package which includes an 

object-oriented topology layout facility, a waveform simulation engine, and display and 

analysis tools. It is used to design optical communication links and simulate them to 

determine their performance given various component parameters. The Export feature 

permits the performance of a coating design or stack to be included in the simulation. 

To export the data, click LinkSIM Filter File in the Export sub-menu of the File menu. 

This will display the dialog shown below: 

 
 

The data file can contain the reflectance or transmittance data. The wavelength range 

for the data are specified by Start Wavelength, End Wavelength and Wavelength Interval. 

The data will be generated for the specified Incident Angle. For Designs, you can choose 

to include phase information as well. Click Browse to use a file chooser for selecting the 

destination file. For data at oblique incidence, the export will generate two files, one will 

have “_p” added to the filename and the file will contain p-polarization data. The other 

will have “_s”added to the filename and the file will contain s-polarization data. 

When data is being exported from a Stack, the calculations will include any 

bandwidth and cone settings as specified for the Vertical Axis parameters.  

Please see the LinkSIM documentation for instructions on how to use the file data in a 

LinkSIM simulation. LinkSIM has now been incorporated into the OptSIM software 

package 

Importing Data 
When data are imported from external text sources, a data import tool is used. This 

tool allows you to specify the structure of the data, exclude unwanted from the import 

and specify the meaning of the data to be imported. The settings used in the import data 
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window can be saved as a template for future use. This makes repeated data import from 

the same data source much quicker. Multiple templates can be saved so that layout of 

different data sources can be retained in the Essential Macleod. The data import tool is 

triggered in many ways including opening a file with an extension that is not of the 

Essential Macleod set of file extensions and pasting textual data into an Essential 

Macleod window. The figure below shows the first screen shown when opening a text 

file containing tab-separated data. The import data window can be resized to show more 

data if desired. 

 
 

On this screen, you can exclude unwanted data from the import. Typically, this will be 

unwanted headers. In this case, we are going to keep the headers for use later. You can 

either select the rows that are to be included or select the rows that are to be excluded. 

Inclusion/Exclusion is controlled by selecting the appropriate option above the table.  

At the top of the screen, a previously saved template can be selected, or, if a template 

was previously saved with the default option checked (see later) it will automatically be 

selected. When a template is selected is can be deleted used the Delete Template button. 

Otherwise, the template can be used by clicking the Next > / Finish button. If the Pause 

option is checked, the button will be labeled Next > and the import will pause at the final 

screen. If the Pause option is unchecked, the button will be labeled Finish and the import 

will complete without further interaction. 

When no template is selected, click Next to move to the next screen. 
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This screen is used to specify the separators between the columns of data. If the data is 

fixed width, you can specify where the data is to be separated by clicking at the 

appropriate location on any of the data rows. Once you have clicked, the data will be 

reformatted with one extra column. If a column is incorrect, double-clicking in the header 

of a column will merge it with the column to the right. 

Once the columns are correctly separated, click Next to move to the next screen. The 

next screen depends upon the import being performed. In this example, a data file is 

being opened and the next screen allows you to specify that one or more rows in the file 

contain header information. 

 
 

The headers are specified by selecting the rows containing the header information. 

Click Next to continue. 
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The next screen allows you control which columns are imported. For each column, 

select the column by clicking in the column header. In Set Column Type, choose Import 

or Ignore. If you choose Ignore, the column header will be set to Ignore. You can also 

edit the column headers by double-clicking on the column header. This will display an 

edit box where you can change the header text. Click Finish to complete the import. The 

figure below shows the completed import after the blank columns were ignored. 

The Template section allows the previously defined formatting of the import data to 

be saved for later use. You can either type in a name for the template or overwrite an 

existing template. Checking the Pause option will cause Pause to be automatically 

selected when the template is selected on the first screen. Checking the Default option 

will cause the template to be automatically selected when the import editor is started. 

 

 
 

For data that are to be pasted into editors where the columns have specific meanings, 

the import process is slightly different. Here we show the import of the same data into the 

Design Targets editor. The data have been placed on the clipboard and Paste All Targets 

has been selected from the Edit menu of the Target editor. 
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In this case we do not want the headers from the file, so the header line has been 

selected so that it will be excluded from the import. After clicking Next to set the column 

separators and then clicking Next again, the type of the data in each column is specified. 

 
 

As we are importing data into the target editor, the columns of data on the clipboard 

must be matched to the specific columns in the target editor. To match each column, click 

in the header of the column, and then choose the appropriate column type in Set Column 

Type. The figure above shows the first column has been set to Wavelength. 

After setting the second column to Required Value and then clicking Next, the data 

reduction screen is displayed. 
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Data reduction is useful when importing target data from spectrometer files. Having a 

large number of target points slows the optimization processes, but it is usually possible 

to achieve the same result with far less target points. This screen allows you to specify 

that a fixed number of rows are ignored between each imported data row.  

The template section allows you to save the formatting information for use again later 

if desired. 

 
 

The figure above shows the Target Editor after the import was completed. 
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APPLICATION WINDOW 
When the Essential Macleod is started, the Application Window appears. The 

application window is always present and forms the background to the package. The 

window title is always Essential Macleod. Below the title bar is the menu bar and 

toolbars. While the Essential Macleod window is blank, there are four available menus, 

File, Tools, Options, and Help. 

During the operation of the program, the various designs, results, plots and so on 

appear in document windows within the application window. The document windows do 

not carry their own menu bar. Following standard Windows practice, they share the 

application window menu bar. Thus the Essential Macleod menu bar continually depends 

on the particular document window that is active. If it is a design window then the menu 

items refer to the design, if a material window, then they refer to material parameters, and 

so on. Clicking in a different document window to make it active automatically changes 

the menu bar. 

 
 

This manual considers the various types of document window in turn and lists the 

choices available in their menus. This may seem complicated when reading the manual, 

but in actual use the choice is usually obvious and there is a help command, discussed 

shortly, that gives on-line information. This on-line information is intentionally compact. 

There is nothing worse than wanting a simple answer while, instead, screen after screen 

of detailed information pours out. The detailed information is, therefore, in this manual. 

You may never actually read it. We rarely read manuals either. 

In accordance with standard Windows practice the menus and their items may be 

called either by a mouse click on the appropriate choice or by keystrokes. The keystroke 

for accessing any of the menus is a combination of the <Alt> key and the letter that is 

underlined in the menu title. The File menu, for example, can be accessed by pressing 

<Alt> <F> or <Alt><f>. The case is not important. Once the menu is activated then an 

individual choice of menu item may be made by pressing the underlined key by itself or 

with <Alt>. For example, once the File menu has been activated, the choice of New... 

may be made by pressing <n> or <N> or <Alt><n> or <Alt><N>. To close the menu 

without making any choice press <Alt>. Control menus can be accessed in different ways. 

For a dialog box press <Alt><Space bar>. For a document window press <Alt><-> 
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(hyphen or minus). Quick closing is <Alt><F4> for dialog boxes and <Ctrl><F4> for 

document windows. Clicking the close button, provided it is available, will also give 

quick closing. Most of these choices are obvious from the structure of the package. In 

dialog boxes with simple choices, use the arrow keys to change the selected option. In a 

document window the <Tab> key or the <Enter> key, will usually pass to the next cell 

for data entry. 

A window can be reduced to an icon by selecting the Minimize button. Alternatively, 

it can be maximized by selecting the Maximize button. Both of these buttons are at the 

top right corner of the window. The form of the icon denotes the type of window that it 

represents. 

The package is entirely compatible with standard Windows practice and the 

instructions outlined above represent only an abbreviated set of what is available. They 

will be assumed in everything that follows and will not be repeated. 

Menu Customization 
The Essential Macleod features a user customizable menu. The features of the menu 

system includes creating toolbars, deleting toolbars, adding icons and removing icons. 

The menu bar and toolbars can be docked to any edge of the Essential Macleod desktop 

window, or they can be placed anywhere on the screen. To move the menu bar or any 

tool bar, put the mouse over the grab handle at the left end of the bar and drag the bar to 

the desired location. 

 
 

Toolbars 

Add a Toolbar 

Right-click in an empty part of the menu bar  
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and select Customize…  On the Toolbars tab, click on New… and enter a name for the 

toolbar. The new empty toolbar will appear. To add items to the toolbar, click on the 

Commands tab. Drag the desired commands from the Commands list to the toolbar. If the 

command has an associated icon, the icon will be displayed in the toolbar; otherwise the 

command text will be displayed. 

Delete a Toolbar 

Right-click in an empty part of the menu bar and select Customize… On the Toolbars 

tab, select the toolbar to be deleted and click the Delete button.  

Adding Commands to a Toolbar 

Right-click in an empty part of the menu bar and select Customize… Click on the 

Commands tab. Drag the desired commands from the Commands list to a toolbar.  Click 

Close to complete the operation. 

Removing Commands from a Toolbar 

Right-click in an empty part of the menu bar and select Customize… In the toolbar 

from which you want to delete the command, select the command and drag it off the 

toolbar. When the cursor changes to a cross, release the mouse button and the command 

will be removed from the toolbar. 

Icons 

Add Icon to a command 

Icons can be added to any command in the menu bar. When a command is added to a 

toolbar, the associated icon will be displayed. If the command has no associated icon, the 

command text will be displayed. To add an icon, from the Options menu, select Icons and 

then Add Icon. Click OK to the message and then click on the menu command that will 

be associated with the icon to be added. Next on the Choose Icons form, click on the 

Browse buttons and select the file names of the icons to be used for the Normal and 

Disabled states. The Normal state icon is displayed when the command is available for 

use. The Disabled state icon is displayed when the command cannot be used (e.g. if the 



54  Application Window 

clipboard is empty, pasting from the clipboard is not possible and so the disabled state 

icon would be displayed). The Disabled state icon is optional. If a disabled state icon is 

not provided, the program will generate a Disabled state icon from the Normal state icon. 

When each icon file has been selected, it will be displayed on the form. Click OK to 

complete the icon addition. 

Icons may be bitmap files (*.bmp) or icon files (*.ico). The dimensions of the icons 

may be any size; the program will fit the image in the selected file into a 16 x 16 pixel 

icon. Icons can be created by an icon editor or by using a program such as Windows 

Paint. If the icon file is a bitmap, the top left pixel of the bitmap is assumed to be the 

background color of the icon. When the icon is displayed, all pixels of that color will 

have the actual background color in use when the program is running.  

Removing an Icon from a command 

Icons can be removed from a command. If the command was originally associated 

with an icon, this original icon can be restored to the command. 

To remove an icon, from the Options menu, select Icons and then Remove Icon. Click 

OK to the message and then click on the menu command that is associated with the icon 

to be removed. The Remove Icon form will be displayed. The current icons will be 

shown and the original icons will be shown if available. Click Remove to remove the 

current icons. Click Restore to reset the icons to the original icons shown. 

 

The Application Menu 
The common commands are described below. 

File Menu (Application) 

New... 

Selection of New reveals a submenu. There is a minimum of six choices, Design, 

Material, Optical Constant, Table, Stack, and Substrate. Depending on the 

Enhancements that are present there may also be vStack, Operation, Machine 
Configuration, Run Sheet and Simulator. Each selection produces an appropriate dialog 

box or document window that refers to the choice made. The selection can be made with 

the Mouse in the usual way or by pressing any of the arrow keys. 

Design brings up a design window with the default design contained in it in the form 

of a table of media and layers. This is considered further below in the Design Window 

chapter. 

Material brings up a document window headed Material that contains a blank table for 

entry of new optical constants and wavelength data. More details are given in the 

Material Window chapter. 

Optical Constant brings up a new window for deriving optical constants from 

transmittance and reflectance data. See the section on Optical Constant Extraction for 

more information. 
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Table creates a new table after the user has indicated the number of columns required 

in an initial dialog box. The table is blank and the Read Only status is not set so that it 

can immediately be edited in the usual way. For more details, see the later section on Edit 

Menu (Table). 

Stack brings up a new document window for the design and analysis of combinations 

of substrates and coatings. See the Stack section for more information. 

vStack brings up a new document window for the design and analysis of 

combinations of substrates and coatings that are not parallel. See the vStack chapter for 

more information. 

Substrate brings up a document window headed Substrate that contains a blank table 

for entry of new internal transmittance and wavelength data. More details are given under 

the heading of Stack. 

Operation creates a new Operation document. The Operation is the collection of 

instructions needed for a calculation by Function. 

Machine Configuration creates a document where details of the machine to be used 

by Runsheet when generating deposition instructions. 

Run Sheet creates a blank run sheet where design information and a designated 

machine configuration will be used to generate the monitoring signals for the 

manufacture of the coating specified by the design. 

Simulator creates a blank document for entry of the parameters such as signal noise, 

monitoring type, specifications of errors required for the simulation of the production of a 

coating specified by a given run sheet. 

Report Template creates a blank document where the instructions for a report can be 

entered. See the Report Generator chapter for more information on the contents of a 

Report Template. 

Open... 

Open brings up a dialog box that permits any of the files that have been created by the 

program to be reopened. File types include designs, performance plots, performance 

tables, and data for optical constant extraction. These types can be selected in the drop 

down list at the foot of the box. 
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Open a Copy of... 

The Open a Copy of command is similar to the Open command except that the 

opened item does not retain the name of the file from which it was opened. This means 

that the first time the item is saved, it will need to be given a file name. It is as though a 

new design was created and the design was copied from the existing file.  

For example, use the Open a Copy of command to open an existing design. Now 

change the design in some way and then select Save from the File menu. The Save As 

file dialog box will appear because the design does not know the filename from which it 

was loaded. If the Open command had been used to load the design, selecting Save from 

the File menu would have saved the design back to the filename from which it was 

opened. 

Open Material... 

Open Material brings up a dialog box containing a list of all available materials for 

selection. 
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When a material is selected, a material window with the optical constants and 

wavelength data appears ready for editing, plotting or printing. 

New Job... 

New Job... creates a new Essential Macleod Job folder and populates it with a new 

empty materials folder, a new empty designs folder and a new references folder. Data 

from the standard references folder is copied to the new references folder. The first action 

upon selecting this command is to choose the new folder. The folder can be created 

anywhere in the computer, but it is recommended that the folder be created in the My 

Documents\Thin Film Center\Jobs folder. When the New Job command is selected, a 

folder chooser will appear. The folder containing the most recently created jobs folder 

will be selected. 

 
 

To create a folder in the current selected folder, click the Make New Folder button. 

The selected folder will expand and show the newly created folder which will be named 

“New Folder”. You can edit the name of the new folder either by selecting it and then 

pressing the F2 key, or you can right-click on the folder name and click the Rename 

command. After entering the name, click the OK button. This will return you to the 

Create New Job window. 

 
 

 If you change your mind about the Job folder name or location, you can click the 

Choose Job Folder button to go back to the folder chooser. When the new Job folder is 

created, the Materials folder will be empty. You can check the Show Materials Library 

box to cause the materials library to be displayed after the job has been created. This 
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allows you to easily add materials from the materials library to the Job’s materials 

database. You can also do this at any other time when the Job is open as well as import 

materials from other materials databases. To create the new Job folder, click the Create 

New Job button 

When Create New Job has completed, the title bar of the Essential Macleod will be 

changed to show that a Job is open. For example, if the new Job was named “Thin Film 

Center”, the title bar would show “Essential Macleod: Thin Film Center” The default 

location for saving designs etc. will be the Designs folder inside the new Job folder. The 

materials database will be changed to the Materials folder inside the new Job folder and 

the references folder will be changed to the references folder inside the new Job folder. 

Keeping everything in the Job folder tree makes it easy to create an archive copy of all 

information by making a copy of the Job folder.  

Open Job... 

Open Job... is used to open an existing Job. When this command is selected, a folder 

chooser will appear with the folder containing the last created Job folder selected. Click 

on the “+” symbol to the left of the selected folder to expand the list of Job folders. To 

open the desired Job, select the folder name and then click OK. The Essential Macleod 

will then be reset that it uses the materials database and references folder contained in the 

Job folder. The default location for saving designs etc. will be changed to the folder last 

used when the Job was previously open. The title bar of the Essential Macleod will be 

changed to show the name of the open Job. 

Close Job 

Close Job resets the Essential Macleod so that it uses the materials database and 

references folder that were last used when no Job was open. The default location for 

saving designs etc. is reset to the folder that was last used when no Job was open. The 

Title bar of the Essential Macleod is also changed so that it only reads “Essential 

Macleod” This serves as a reminder that a Job is not open. 

Open Reference... 

Open Reference activates a dialog box like the Open command but it is for reference 

files. Reference files contain data that is required by the program for certain calculations 

like the assessment of color. They are therefore treated differently from regular data files 

and are kept separately from them. Alteration or modification should be undertaken only 

with extreme caution. Data files can be converted into reference files and vice versa. 

Page Setup... 

Page Setup... allows the page margins to be set in a dialog box. 

Printer Setup... 

Printer Setup... opens a dialog box offering a choice of available printers and access 

to the printer options. 
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1 

2 

3 

4 

These menu items correspond to the most recently opened files. 

More… 

Opens a window showing a longer list of recently used files. 

Exit 

Quits and unloads the Essential Macleod. If entered or generated data are unsaved the 

program will display an alert box asking for instructions. 

Tools Menu (Application) 

Materials 

This item is similar in many ways to the Open Material... command of the File menu. 

There whenever a material was selected, the dialog box closed. Here however the 

command brings up a materials list that is permanently visible until closed. This means 

that many material windows can be opened and displayed at the same time. The display 

of optical constants at the wavelength shown can be toggled by the Show Optical 

Constants command in the Edit menu for this window. To change the display 

wavelength, edit it in the window. 

  
 

Double-clicking any of the materials brings up a window displaying the stored optical 

constants. These can be edited if required, as discussed later in the manual.  

 

Load Zemax Coating File 

The Essential Macleod includes the capability of exporting coating designs to the 

Zemax series of lens design packages, created by Zemax LLC, to be included in 
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performance assessments. Zemax reads these designs together with data on materials 

from a coating file. The Load Zemax Coating File command loads the Zemax coating 

file into the Essential Macleod where it can then be edited.  

New Zemax Coating File 

The New Zemax Coating File command creates a new Zemax coating file in the 

Essential Macleod where it can then be edited.  

 

Options Menu (Application) 

General... 

The Essential Macleod Options dialog box that is activated has several features, and 

is divided into tabs. Selecting a tab displays a group of options. 

Data Sources Tab 

The upper text box contains the path and name of the current Materials Folder. This 

can be changed and the new folder will then be the one automatically used. A record of 

material databases that have been used by the package is maintained and these paths are 

available in a dropdown list activated by the arrow to the right of the folder name. Since a 

change in materials folder could have serious consequences for an existing design, it is 

arranged that the Materials Folder option is available only when there is no open design 

file. 

 
 

It can be very useful to have different material files for different applications. For 

example, the default wavelength units in the package as provided are nm and these 

should be changed to microns if much infrared work is to be done. One material database 

can then be completely in microns and one completely in nm. It is helpful to give the 

materials folder a meaningful name such as IR or Visible or UV. Sometimes in the early 

stages of a design, nondispersive materials are used. A special folder with nondispersive 

materials may then be useful, called, perhaps "Non Dispersive". 
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Later in the manual you will find that it is very easy to create new material databases 

and to import materials into them. A useful way of working is to create a new materials 

database at the start of any new project. Only those materials that apply to the project 

need be imported into it. The database folder can also be used to store the design, plot 

and table files. Although there is no design folder in the list of options, the package will 

return to the same design folder each time it is loaded until another is used to store files. 

The data and design files are completely separated from the material files by their 

extensions. At the end of the project the folder will contain all the files necessary to 

resurrect it and it can be saved to an archive and then deleted. This technique insulates 

the standard materials from changes that are made only in connection with a particular 

project yet the special set of units that may have been used, the particular materials, the 

designs and so on are all preserved. 

Reference files are stored in a reference folder. These are files containing data 

necessary for the operation of the package. In the Essential Macleod the important files in 

the reference folder are those containing definitions of color matching functions and of 

source output for the color calculations. The reference folder is also used extensively in 

the Function enhancement to the Essential Macleod. The Options dialog box includes a 

field that gives the folder where the reference files are located.  Once this has been 

defined it will seldom be necessary to change it but the possibility does exist. 

Legacy Tab 

The Legacy tab provides a checkbox that permits the display of the Substrate items in 

the various menus so that any older substrate files can be accessed and edited. 

Windows Tab 

When Cascading Close is checked any plots and tables in open windows that are 

associated with a given design will be closed when the design window is closed. When it 

is not ticked then windows will not be automatically closed.  

If the Prompt to save old Tables and Plots before closing box is checked then the 

user will be asked if any plots or tables that have been changed from the version that is 

stored on disk should be saved before being closed. 

Keep old Plots and Tables displayed is a useful option. It is very easy to accumulate 

many opened plots and tables. These do use up memory and should be closed as soon as 

they are no longer immediately needed. If this option is not checked then a new table or 

plot will simply replace any older one. If the option is checked then the new plot or table 

will coexist with the older. 
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Plotting Tab 

 
 

The plots can be produced with either ticks on the axes or a complete grid. Show Grid 

on Plots decides which is to be used. Note that the plots saved by the program are stored 

as data rather than images. If this option is changed then all plots that are recalled from 

store will follow the current choice even though they may have been created with the 

other in force. Note that it is very easy to remove a grid from an individual plot or to 

restore it once removed. 

Nominal Plot Segment Length has an important role in plotting. The package uses a 

special adaptive technique. Plots are drawn with variable spacing of successive values of 

the independent variable so that closely packed fringes will be reproduced without having 

to use a very small and inefficient interval on smoother parts of the characteristic. An 

algorithm calculates a starting interval from the thickness of the coating, the wavelength 

range and the size of the plot. During plotting, the interval is continuously varied. The 

nominal plot segment length is a parameter that defines the closeness of points required 

for the plots in general. It should rarely need to be altered. However, if you find that the 

kind of plot that is normally being produced is fairly flat but is taking a long time because 

there are too many points, then this number may be increased. If, on the other hand, the 

fringes are so closely packed that the program is jumping across them, then this number 

should be reduced. The number should be adjusted in very small increments. Halve it or 

double it at the most with each adjustment. It is very easy to set it so that an impossibly 

large number of points is required. 

When the axes for plots are automatically selected, the X-axis range is scanned to 

estimate the total Y-axis range. This range is then used to drive the adaptive plotting 

algorithm. If the Y-axis range is very small, then this will force the adaptive plotting 

algorithm to look for very fine changes in the calculated Y values. Such plots will take a 

long time to calculate but they will not add any useful information.  To prevent this, a 

minimum range can be specified. If a Y-axis is being automatically generated, then the 

estimated Y range is constrained to be no less than the minimum range for the 

performance parameter. If the Y-axis has been defined and is not automatic, the 

minimum range values do not apply. If you wish to modify the default minimum range 
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values, the Minimum Ranges button displays a form where you can specify the 

minimum range to be used for each of the available performance categories.  

Plots can be generated with two Y-axes. Sometimes it may not be clear which Y-axis 

is used for a particular trace. Y-axis identification defines the default method by which 

axes are identified. If Identify Y Axes is checked then the titles for the Y-axes will be 

prefixed by the appropriate identifier and each trace will have its legend prefixed by the 

identifier for its Y-axis. Y-axis identification can also be manually performed in the Plot 

window. 

A default appearance (background color, font characteristics etc.) can be specified for 

all plots. To set the default appearance, save a plot that has the desired appearance, then 

open the Plotting tab in General Options, click Choose and select the saved plot. To 

remove a previously chosen plot file, click Delete. Note that Delete does not delete the 

plot file. 

Cone Tab  

This tab provides control over the cone calculation provided by the Stack Editor. 

Nominal Cone Segment Length controls the adaptive calculation used by Cone when 

calculating the cone response at a particular wavelength, frequency or incident angle. It is 

similar to Nominal Plot Segment Length described above. 

Bandwidth Step controls the step size when the bandwidth is non-zero.  

Gaussian beams do not have a distinct cutoff where there is no irradiance. The beam 

intensity falls off with a Gaussian distribution. When calculating the performance of a 

coating illuminated with a Gaussian beam, the Essential Macleod will not calculate 

performance beyond a specified ratio of the Gaussian beam’s semi-angle. This has the 

effect of truncating the edges of the beam. When the ratio is sufficiently large, the effect 

on the calculations will be negligible. The default value for the ratio is 2. At this limit, the 

intensity of the beam has fallen to 0.0003 times the on axis intensity, which should be 

satisfactory for most applications. To change the value of this ratio, modify the Gaussian 

Calculation Scale Factor value. Making the value larger improves the calculation results 

at the expense of a greater calculation time. 

Designs Tab  

This tab provides control over the order in which layers are displayed, the formula 

ordering convention and the intervals used for derivative calculations.  

For the Display Order, there are two possible options: Medium at Top and Substrate 

at Top. When Medium at Top is selected, designs are displayed with the incident 

medium at the top of the list. When Substrate at Top is selected, designs are displayed 

with the substrate at the top of the list. Layers can be numbered either with the layer next 

to the medium numbered 1 or from the substrate. 

The Formula Order is used to specify which end of the formula is next to the incident 

medium.  Medium at Left specifies that the incident medium is at the left end of the 

formula string. Medium at Right specifies that the incident medium is at the right end of 

the formula string. The formula editor indicates which convention is in effect so that you 

do not have to remember. 
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Wavelength Delta Factor defines the interval used for calculating the first derivative 

of the optical constants. The default value has been selected to give the best performance 

for the majority of designs.  

Optical Thickness Convention controls the display of optical thickness values. There 

are two options: FWOT and QWOT. When FWOT is selected, the optical thickness of a 

quarterwave thick layer is reported as 0.25. When QWOT is selected, the optical 

thickness of a quarterwave thick layer is reported as 1. 

When Use Packing Density to adjust Extinction Coefficient is checked, the packing 

density value will be applied to the Extinction Coefficient data as well as the Refractive 

Index data. When unchecked, only Refractive Index will be modified by the Packing 

Density. 

 

Update Tab  

This tab provides control over the automatic checking for updates.  

If automatic checking has been enabled, then, each time the Essential Macleod is 

started, it will first check to see if the specified number of days has elapsed since the last 

time a check for updates was made. If it has, then the program will connect to the Thin 

Film Center web site to determine if a new update is available. If there is a new update, 

you can choose to download and install the update now or just continue using the 

Essential Macleod. If you choose to download the update, the Essential Macleod will 

close so that the program file can be modified. 

If Automatically check for updates is checked, then the Essential Macleod will 

check for updates at the specified interval. The interval is specified by entering the 

number of days in the box after Check for updates every.  

Color Tab 

This tab specifies the wavelength intervals to be used when calculating color 

parameters. The Wavelength Interval for Performance is used when requesting a color 

calculation from the menu. The Wavelength Interval for Refinement is used when 

calculating the value of a color target during refinement or synthesis. Specifying larger 

values increases the speed of color calculations but the accuracy is reduced. 

Print Tab 

This tab specifies the default header and footer to be used for printed output. The 

header and the footer may be multi-lined and have three sections: left, middle and right. 

A bar (“|”) character is used to separate the sections. 

For example, the header definition: 

Left|Middle Section 

on more than 

one line|Right 

would appear as follows on printed output: 

 

Left Middle Section Right 

 on more than 
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 one line 

 

Several symbols may be used in the header and footer. These are: 

%o The type of document being printed. For example in a design this will be 

replaced by “Design” 

%f The name of the file being printed as displayed in the title bar of the window. 

%t The date when the document was printed. This will be formatted according to 

the date format specification at the bottom. 

%d The current page number 

%% Inserts the “%”  character. 

There are several pre-defined date formats available. These are: 

Format Name Description 

General Date 

Display a date and/or time. For real numbers, display a date 

and time, for example, 4/3/93 05:34 PM.If there is no 

fractional part, display only a date, for example, 4/3/93. If 

there is no integer part, display time only, for example, 05:34 

PM. Date display is determined by your system settings. 

Long Date Display a date according to your system's long date format. 

Medium Date Display a date using the medium date format . 

Short Date Display a date using your system's short date format. 

Long Time 
Display a time using your system's long time format; includes 

hours, minutes, seconds. 

Medium Time 
Display time in 12-hour format using hours and minutes and 

the AM/PM designator. 

Short Time Display a time using the 24-hour format, for example, 17:45. 

You can also design your own date format using these formatting commands: 

Character Description 

(:) 

Time separator. In some locales, other characters may be used to 

represent the time separator. The time separator separates hours, 

minutes, and seconds when time values are formatted. The actual 

character used as the time separator in formatted output is 

determined by your system settings. 

(/) 

Date separator. In some locales, other characters may be used to 

represent the date separator. The date separator separates the day, 

month, and year when date values are formatted. The actual 

character used as the date separator in formatted output is 

determined by your system settings. 

c 

Display the date as ddddd and display the time as  

ttttt, in that order. Display only date information if there is no 

fractional part to the date serial number; display only time 

information if there is no integer portion. 

d Display the day as a number without a leading zero (1 – 31). 

dd Display the day as a number with a leading zero (01 – 31). 

ddd Display the day as an abbreviation (Sun – Sat). 
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dddd Display the day as a full name (Sunday – Saturday). 

ddddd 

Display the date as a complete date (including day, month, and 

year), formatted according to your system's short date format 

setting. The default short date format is m/d/yy. 

dddddd 

Display a date serial number as a complete date (including day, 

month, and year) formatted according to the long date setting 

recognized by your system. The default long date format is mmmm 

dd, yyyy. 

Aaaa The same as dddd, only it's the localized version of the string. 

W 
Display the day of the week as a number (1 for Sunday through 7 

for Saturday). 

Ww Display the week of the year as a number (1 – 54). 

M 

Display the month as a number without a leading zero (1 – 12). If m 

immediately follows h or hh, the minute rather than the month is 

displayed. 

Mm 

Display the month as a number with a leading zero (01 – 12). If m 

immediately follows h or hh, the minute rather than the month is 

displayed. 

Mmm Display the month as an abbreviation (Jan – Dec). 

Mmmm Display the month as a full month name (January – December). 

Oooo The same as mmmm, only it's the localized version of the string. 

Q Display the quarter of the year as a number (1 – 4). 

Y Display the day of the year as a number (1 – 366). 

Yy Display the year as a 2-digit number (00 – 99). 

Yyyy Display the year as a 4-digit number (100 – 9999). 

H Display the hour as a number without leading zeros (0 – 23). 

hh Display the hour as a number with leading zeros (00 – 23). 

n Display the minute as a number without leading zeros (0 – 59). 

nn Display the minute as a number with leading zeros (00 – 59). 

s Display the second as a number without leading zeros (0 – 59). 

ss Display the second as a number with leading zeros (00 – 59). 

t t t t t 

Display a time as a complete time (including hour, minute, and 

second), formatted using the time separator defined by the time 

format recognized by your system. A leading zero is displayed if 

the leading zero option is selected and the time is before 10:00 

A.M. or P.M. The default time format is h:mm:ss. 

AM/PM 

Use the 12-hour clock and display an uppercase AM with any hour 

before noon; display an uppercase PM with any hour between noon 

and 11:59 P.M. 

am/pm 

Use the 12-hour clock and display a lowercase AM with any hour 

before noon; display a lowercase PM with any hour between noon 

and 11:59 P.M. 

A/P 

Use the 12-hour clock and display an uppercase A with any hour 

before noon; display an uppercase P with any hour between noon 

and 11:59 P.M. 

a/p 
Use the 12-hour clock and display a lowercase A with any hour 

before noon; display a lowercase P with any hour between noon 
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and 11:59 P.M. 

AMPM 

Use the 12-hour clock and display the AM string literal as defined 

by your system with any hour before noon; display the PM string 

literal as defined by your system with any hour between noon and 

11:59 P.M. AMPM can be either uppercase or lowercase, but the 

case of the string displayed matches the string as defined by your 

system settings. The default format is AM/PM. 

Here are some examples of user-defined date formats: 

Format Display 
m/d/yy 12/7/58 
d-mmm 7-Dec 
d-mmmm-yy 7-December-58 
d mmmm 7 December 
mmmm yy December 58 
hh:mm AM/PM 08:50 PM 
h:mm:ss a/p 8:50:35 p 
h:mm 20:50 
h:mm:ss 20:50:35 
m/d/yy h:mm 12/7/58 20:50 

In addition to the text header and and footer, graphics may also appear in the header 

and footer. To specify the graphic files to be used, click the Graphics… button at the 

right of the Header and Footer text boxes. A dialog will appear allowing you to choose 

the files containing the graphic data for the left, center and right images. At the right, the 

selected graphic is shown. It is resized to fit the display box and so may appear distorted. 

The image in the display box is only to confirm that the correct file has been chosen and 

does not show how the graphic will appear on the printed page. 

The images are placed on the page so that in the header, the bottom of the header 

images are aligned with the bottom of the header and the top of the footer images are 

aligned with the top of the footer. If both graphics and text have been specified for the 

same location, then the text will overprint the graphic. 

JPEG Tab 

Plots created in the Essential Macleod can be exported as JPEG images. This tab 

provides controls for creating the JPEG data. Quality (1 – 100) controls the image 

quality. The higher the number the better quality picture will be produced, but the size of 

the JPEG file will also be increased. When Gray Scale is checked, the JPEG picture will 

not be in color. Optimize Compression improves the file size produced without reducing 

picture quality. When Progressive is checked, the JPEG will be generated so that a low 

quality image is displayed quickly and improves as the rest of the JPEG is loaded. This 

option is primarily used when the picture is to be displayed by a remote user 

downloading the picture file over a slow link. 

3D Plot Tab 

A default appearance (background color, font characteristics etc.) can be specified for 

all 3D plots. To set the default appearance, save a 3D plot that has the desired 

appearance, then open the 3D Plot tab in General Options, click Choose and select the 
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saved plot. To remove a previously chosen plot file, click Delete. Note that Delete does 

not delete the plot file. 

Targets Tab 

The targets tab contains a single option Remove Duplicates Immediately. When 

checked, duplicate targets will be removed as they are detected. For example, if the target 

generator adds duplicate targets, they be removed at completion of the Generate 

Command. If Remove Duplicates Immediately is not checked, then duplicate targets 

will not be removed, and it is the responsibility of the user to remove the duplicates. The 

command Remove Duplicates in the Edit menu will remove duplicate targets. 

Random Tab 

The random tab is used to reset the random number generator to a known state. To reset 

the random number generator, enter a value into the Random Number Seed box and 

click Initialize. Each time that you perform this action, the random generator will 

generate the same sequence of numbers for the same random number seed. 

Observers Tab 

This tab is used to specify the Observers that are available for color calculations. For 

more information on specifying observers, please see the Color section on page 35. 

Sources Tab 

This tab is used to specify the Sources that are available for color calculations. For more 

information on specifying sources, please see the Color section on page 35. 

CRI Tab 

The CRI tab is used to specify the files containing the sample spectra to be used in Color 

Rendering Index calculations. For more information on specifying the sample files, 

please see the Color section on page 35. 

Active Plot Tab 

The Active Plot tab is used to specify the default ranges for variables in Active Plot. The 

ranges are set according the type of variable. The Angle tab specifies the default range for 

Incident Angle. The Wavelength tab specifies the range as a multiplier of the current 

wavelength (reference wavelength, calculation wavelength) value. So, if the variable to 

be added to an active plot was reference wavelength with a current value of 510 and the 

multiplier for the maximum value was 2, the upper limit of the reference wavelength 

range will be 1020. The thickness limits are also specified as multiples of the current 

layer thickness. The same multipliers are used for all thickness types (optical, physical, 

geometric).  Layer Packing Density limits are also specified as multiples of the current 

layer packing density values. The Link scale factors, Material Packing Densities and 

Taper Distances are all specified as absolute ranges. 

The speed and change increments can also be controlled. When the >, <, >>, << 

buttons are held down, the Minimum Delay specifies the minimum time period in ms 

before the variable is incremented and the plot then updated. If the plot update takes 

longer than the Minimum Delay, then the next plot update will start immediately after the 

completion of the current plot update.  
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Each time the > and < buttons increment the value, the value is changed by Increment 

Proportion of the difference between the maximum and minimum values shown on the 

Active Plot. The default value is 0.01. That is, the value will change by 1% of the range 

between the minimum and maximum values.  

Each time the >> and << buttons increment the value, the value is changed by Fast 

Increment Proportion of the difference between the maximum and minimum values 

shown on the Active Plot. The default value is 0.1. That is, the value will change by 10% 

of the range between the minimum and maximum values.  

 

Set as Default Design 

When a new design is created, a default design is used. The design that is generated 

by the program may not be completely suitable for all users. For example, someone who 

normally works in the infrared may wish to have a design with parameters suitable for the 

infrared rather than the visible region. It may also be that there could be a number of 

different standard designs that could be varied according to the particular project. This 

option makes it particularly easy to change from one standard design to another. It copies 

the active design to a default design file in the current materials database. Thus the 

default design will change when the database is changed. 

 

General Units... 

General units defines the units that are used when displaying information. This 

permits you to work in the units of your choice such as nanometres or microns, % 

transmittance or absolute transmittance. For more information, see the section on units in 

this manual (Page 32). 

Chart Styles… 

Chart Styles defines the styles of plotted data in the Essential Macleod. For various 

different types of plotted data, you can define the color, line style, and thickness of the 

line that will be plotted. You can also control the symbol style, color and size. 



70  Application Window 

 

Register 

This option displays the built-in registration form. Please use this form to tell us about 

yourself and request a site key 

License 

This option displays the current license and allows you to transfer a license from one 

computer to another. You can also enter a site key here. 

Change Password 

This option allows you to change the password required when transferring a license 

out from the computer. See the section on licensing for more information. 

Help Menu (Application) 

Contents 

The Help menu is always available to the right of the other menus. Contents brings 

up the contents list which contains broad categories rather like the contents page of a 

book. The items in the contents list can be selected by clicking with the mouse in the 

normal way. 

Search For Help On... 

Selection of this menu item presents the user with the help’s search dialog. After 

entering a word and clicking List Topics, you can click on one of the listed topics for 

more information. 
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Obtaining Technical Support... 

This item lists the address, fax number and telephone number for receiving support. 

About The Essential Macleod... 

This gives information about the program including its version and the installed 

enhancements. 

Check for Updates... 

This command checks for available updates to the Essential Macleod via the Internet. 

If an update is available, you can then download and apply the update by clicking the 

Download button. 

Insert/Overstrike 

The bar at the foot of the Application Window displays two information boxes. The 

first of these will be blank at this stage. The second will contain the words Insert or 

Overstrike. Pressing the insert key, <Ins> will toggle from one to the other. These two 

parameters indicate the behavior of a design table when the <Enter> key is used to move 

from one cell to the next. In insert mode, pressing <Enter> at the end of a row will cause 

a new row to be inserted. In overstrike mode the cursor will move to the next existing 

row. 
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DESIGN WINDOW 
An example Design Window is shown below. As the name suggests, it contains a 

coating design. The window is separated into two pages that are displayed by clicking on 

the tabs at the top of the window. The Design tab shows the design. The Context tab 

specifies the contexts available for the design. The use of context in a design is described 

later in this chapter in the Context section. The Notes tab provides an area for you to 

enter other information about the design. This design is listed following the convention: 

incident medium at the top of the table and substrate or emergent medium at the foot. The 

various layers are listed in order in between these two entries with numbers that start at 1 

for the layer nearest the incident medium or substrate depending upon the design display 

order setting. 

 
 

Above the design is listed the Incident Angle and the Reference Wavelength. To 

change completely either of these quantities click in the appropriate cell and type in the 

new value. To alter only part of the value double-click in the cell and use the arrow keys 

and delete keys to remove only the unwanted part and type in the corrections. 

The incident angle is always referred to the incident medium. By convention the 

incident angle is always measured as the angle between the direction of the incident wave 

and the normal to the surface and is zero for normal incidence and always in the range 

0°90°. 

The reference wavelength, 0, is used as a standard for optical or geometrical 

thicknesses. The units for the reference wavelength will be whatever units are standard in 

the current material database. The optical constants displayed in the tables for the various 

materials are also referred to the reference wavelength and it is these values that will be 

used by the program when it converts internally from optical thicknesses to the phase 

thicknesses used in the calculations. 

In the thickness columns at the bottom of the Design window, the total thickness of 

the design is displayed. In the example given above only optical thicknesses are 

displayed. There are two other options, geometrical and physical thicknesses. Any of 

these may be displayed by using the Display Setup command in the File menu. This is 

detailed below. 
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The table may be stretched in the usual way by the mouse and it may be reduced to an 

icon by selecting the minimize button at the top right of the window. 

The editable values, Material and Layer Thickness can be edited by choosing the cell 

with the mouse and then modifying the contents. A single mouse click will select the cell 

in such a way that subsequent entered values will completely replace the cell contents. A 

double-click in the cell will highlight the contents and then any entered values will be 

inserted at the cursor position without altering the existing values. The cursor can be 

moved within the cell using the arrow keys and the delete keys will delete the character 

next to the cursor, either before or after depending on the key. If many cells are to be 

altered, then <Enter> will move from one cell to the next and will select the contents so 

that any keyboard entry will replace the cell contents. <Enter> will then move to the next 

cell and the procedure can be repeated. If the cell contents cannot be edited, the optical 

constants for example, then keyboard entry will have no effect. If an entire table is to be 

entered from the keyboard then the Insert mode of entry may be useful. This will be 

indicated by the word Insert in the status bar at the foot of the Essential Macleod 

Window. In Insert mode when the current cell is at the end of a row and <Enter> is 

pressed then a new row will be inserted in the table. If new rows are not to be generated 

then the mode should be changed to Overstrike by pressing <Ins>. Then if the current 

cell is at the end of a row <Enter> will cause the cursor to pass to the cell at the start of 

the next existing row and no new rows will be created. 

The following sections describe the commands that are available for the design window. 

File Menu (Design) 

New... 

This is the same command as New... under the File menu for the application window. 

It brings up a submenu that includes the choice of Design, Material and Table. These 

imply a new design, a new material or a table. Other choices may be available depending 

upon the installed enhancements. 

Open... 

This command presents the user with the usual dialog box showing a file list for 

opening. The file type can be changed so that designs or plots, or tables can be presented. 

Open a Copy of... 

This command presents the user with the usual dialog box showing a file list for 

opening. The file type can be changed so that designs or plots, or tables can be presented. 

Open Material... 

This command presents a list of the materials in the current materials database for 

opening. Note that another way of opening materials data files is provided by the 

Materials command in the Tools menu. 

Open Reference... 

This command presents a list of the reference files in the current reference folder for 

opening. 
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Close 

Close closes the active window. If the information in the window has not been saved 

since the most recent changes then an alert box will offer the choice of saving, discarding 

or aborting the close. If the close operation concerns a design then if Cascading Close 

has been selected as a standing option, all windows that present results connected with 

the design will also be closed. 

Save 

Save saves the active window contents in the file from which it was either read or last 

saved. 

Save As... 

Save As... permits the active window contents to be saved in a new file or an existing 

file that is not necessarily the file from which the data was read or where it was already 

saved. A dialog box asking for a file name is presented and either a new name can be 

entered or an existing one selected from the list. Note that the appropriate extension will 

be added to the file name quite automatically. It is not necessary to type it in. Further, 

once the name has been correctly entered then pressing the <Enter> key is sufficient to 

initiate the save operation. 

Save All 

This command is most useful when a number of windows are open and all have to be 

closed. If they have not been saved since the last alteration then the usual alert box will 

be presented for each in turn. 

Export 

The Essential Macleod can export designs for use in Zemax, FRED, LinkSIM and 

CODE V. 

The submenu Add to Zemax File converts designs to Zemax format for use with the 

Zemax lens design program. See page 40 for more information on this command.  

The Command FRED File is used to export the design for use with the FRED optical 

modeling program. See page 44 for more information on this command. 

The command LinkSIM Filter File is used to export the design for use with the 

LinkSIM  simulation program. See page 43 for more information on this command. 

The command CODE V Sequence File is used to create a sequence file for CODE V.  

See page 43 for more information on this command. 

The command Spektrum Design... is used to create a file that can be read by the 

Spektrum program from Laser Zentrum Hannover. After selecting the command, the only 

information required is the file where the data will be stored is entered. 

There may also be entries for Monitorlink enhancements that export the design 

formatted for the deposition controller being used. For more information, see the 

Monitorlink chapters. 
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Page Setup... 

Page Setup... applies to the printed page not the screen. (The screen equivalent is the 

Display Setup > command below.) The dialog box shows the columns that will be 

printed when the Print command is chosen. Access to the margin settings is given. 

 
 

Printer Setup... 

A typical example of the dialog box is shown below. A printer can be chosen and the 

paper orientation changed. The Options... button gives access to the parameters that 

apply to the active printer. 
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Print 

Print prints the design table to the current Windows printer. The format of the printed 

output is controlled by the report template DefaultDesign.rpx stored in the current 

materials folder. See the Report Generator chapter for more information on the formats of 

the report template. 

Print Preview 

This command shows you, in a separate window, how the design would appear if it 

were printed out. 

Print Report 

Print Report prints the design table to the current Windows printer formated 

according to the selected report template. After selecting this command a file chooser will 

appear that allows you to select the report template to be used, See the Report Generator 

chapter for more information on the formats of the report template. 

Preview Report 

This command shows you, in a separate window, how the design would appear if 

were printed using the selected report template. 

Display Setup > 

The default display has a limited number of columns that represent the information 

that is required for most applications. These are shown in the design table reproduced 

above. Layers, however, may have a packing density other than unity assigned to them 

and they may be either locked or linked in the refinement processes. (See the note on 

packing density in the earlier section on the Structure of the Essential Macleod). There 

are several ways in which packing density may be altered. For straightforward manual 

entry the packing density column in the design display may be edited in the same way as 

any of the other columns. To reveal the column so that the entries may be changed, the 

item simply has to be checked in the sub-menu that is opened by this command.  

Locking and linking are described in detail below. Although they can be edited by 

activating the appropriate columns there are other ways involving the Link/Lock menu 

that will usually be easier. 

When layers have a non-unity packing density, a material can be specified for the void 

and the packing density of the material within the void can also be specified. The 

columns used are Void Material and Void Density. They may be displayed by selecting 

the appropriate sub-menu items. 

Layers may also have an inhomogeneity factor.  This specifies a change in refractive 

index through the layer. This is described in the Inhomogeneity Factor section below. 

During refinement, minimum and maximum limits can be placed on the thickness of 

each layer. Selecting the Minimum Physical Thickness and Maximum Physical 

Thickness items displays the columns for defining the limits in terms of physical 

thickness. Selecting the Minimum Optical Thickness and Maximum Optical Thickness 

items displays the optical thickness limit columns. For Simplex refinement, limits can 

also be placed on the packing density of each layer. Selecting the Minimum Packing 
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Density and Maximum Packing Density items displays the packing density limit 

columns. 

The sub-menu will remain open until either the Close item is selected or the mouse is 

clicked outside the sub-menu. 

1 

2 

3 

4 

The last four files that have been opened or saved by the program are displayed here. 

Any of these files can be opened simply by selecting the file. It is not necessary to use the 

regular Open... command. 

More… 

More opens a dialog showing a longer list of recently opened files. Double-click on a 

file in this list to open it. You can also change the displayed order of the files and remove 

files from the list. Selecting a file and clicking Move Up moves the filename towards the 

top of the list. Similarly, clicking Move Down moves the filename towards the bottom of 

the list. Clicking Remove will remove the filename from the list. 

 

Exit 

Exit unloads the Essential Macleod inviting first the saving of any open files that have 

been altered since the last save. 

Edit Menu (Design) 
The Edit menu helps in the editing of designs by cutting layers, copying them, 

copying parts of designs and so on. It also permits the entry of a design from a formula 

and the changing of the way in which layers are displayed. Some parameters that are used 

in refinement can also be set or canceled from this menu. Note particularly that the 

commands in this menu cannot be undone. Save the design before major editing! 

Undo and Redo 

Changes in the structure of the design are remembered and can be undone and/or 

redone by these commands. All changes since the design was opened are remembered but 

are lost when the design is closed. 

Cut Layers 

Layers that are selected in an active design window are cut out and placed on the 

clipboard. From there they can be pasted into another design, into a different part of the 

same design, or pasted into a text document for editing by a word processor. In fact the 

clipboard is the normal vehicle for importing or exporting data to or from the program. 

A word about selecting layers is necessary. To select a range of layers, first select one 

of the layers at the extreme end of the range. Then move the cursor to the selection box 

for the layer at the other end of the range and press <Shift> this time while clicking in the 
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box for the second time. The entire range of layers between the two limits will now be 

selected. To deselect a layer or range of layers, first select one of the boxes belonging to 

one of the selected layers. Then click once in the box and all layers will be deselected. It 

is sometimes useful to be able to select layers that are not contiguous. To select an 

additional layer that is separated from the others press <Ctrl> while clicking in the 

selection box. 

Copy Design 

This command will copy an entire design and place it on the clipboard. 

Copy Layers 

This command is similar to the Cut Layers command except that the layers are not 

removed but only copied. 

Copy Thicknesses 

This command copies the entire set of layer thicknesses from the design and places 

them on the clipboard. The thickness convention (optical, geometric, physical)  is 

specified by selecting the convention from the sub-menu.  The reason for this is to make 

systematic alteration of the thicknesses possible. It may be required, for example, to 

change the thicknesses gradually from one end of the design to the other to simulate, say, 

a gradual change in the pattern of distribution. This command extracts just the 

thicknesses and a companion command, Paste Thicknesses will return them. Note that 

noncontiguous layers can be selected for copying and pasting. Press <Ctrl> when 

clicking in the selection box to select a noncontiguous layer. 

Paste Design 

This command pastes a design from the clipboard into a selected design window or 

selected design icon. The design may have been copied from another design file. The 

format of the design on the clipboard will then be a private format that exactly 

corresponds to the new design window and the pasting operation will proceed 

automatically and accurately. The pasted design will replace completely the existing 

design. 

The Paste Design command may be used, however, to paste a design imported from 

elsewhere. A typical example is a design in text form in a text processor. The design 

should be in the form of tabulated data. Each row in the table corresponds to a layer in 

the design and each column in the table corresponds to a property of a layer such as 

thickness. The character used for delimiting columns is not important, it can be specified 

when the design data is imported. When the Paste Design command is activated the data 

import tool is displayed. Using this tool you specify the layout of the table by choosing 

the column delimiter and identifying the data contained in each column. At the end of this 

process, the data will be imported into the design editor. The section Importing Data on 

page 44 describes the use of the data import tool. After the table data has been imported, 

the materials used in the table need to be identified. A second dialog box will appear. In 

the example below, the copied design used materials numbered 1 and 2. They must now 

be translated into materials in the current database. The converted names may be typed in 

or the arrow at the end of the cell used to activate a drop down list for selection. Should 

the materials in the database not correspond to what is required the materials should be 

converted into different arbitrary, but existing, materials. This way the design can be 
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imported. It is easy to change the materials later to those in a new database or to ones that 

have been added to the current database. See the Edit Materials... command below. 

 
 

Paste Layers 

This command pastes layers from the clipboard into an active design window. The 

layers are pasted into the design immediately before whichever layer has been selected, 

that is, has an active cell. 

Paste Thicknesses 

This command permits manipulations of layer thicknesses outside the package and 

adds flexibility to the design editor. It pastes a set of thicknesses from the clipboard into a 

design. The convention of the pasted thicknesses (optical, geometric, physical) is 

specified by selecting the convention from the sub-menu. 

Should the number of layer thicknesses to be pasted not correspond exactly with the 

number of layers in the design, then a dialog box will ask whether the updating process 

should continue. If continued then the thicknesses will be applied, in order, to the layers 

starting with layer 1 and stop when either the number of entries on the clipboard or the 

final layer of the design is reached. 

The flexibility of the command can be increased if it is used along with other Edit 

Menu commands such as Copy Layers and Paste Layers. For example, create a 

temporary design as a holding area and paste thicknesses into it. Then use Copy Layers 

and Paste Layers to place the layers anywhere in the actual design. 

Note that no information on the thickness convention is carried with the thickness 

values on the clipboard. Such information is, of course, included when Copy Layers and 

Paste Layers are used. 

The format of the thicknesses on the clipboard must be correct and especially 

important is that there should be no final formatting character such as an end of line or 

paragraph marker. When copying them to the clipboard it is best to avoid including the 

line terminator for the final thickness. Place the cursor immediately after the last digit of 

the final thickness and drag to the start of the column to select it. If, when attempting to 

paste the thicknesses, a message: "The data on the clipboard are not suitable for updating 

the thicknesses of the layers" is displayed, it will usually mean that the copying to the 
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clipboard has included some extra control characters and another attempt at selecting and 

copying will usually succeed. Note that some word processors do not place the data on 

the clipboard in a compatible format. If difficulty with such processors or other systems 

is experienced then an intermediate step of pasting the contents into either Notepad or 

Wordpad and then recopying them to the clipboard will usually strip off the offending 

characters. Sometimes too, the command Paste Design will function when Paste 

Thicknesses fails. Since Paste Design with only one column of results will lose any 

material information that is present in the existing file, it is better to paste the layers first 

into a new, temporary design and then to use the copy commands to move them to the 

correct place. 

Insert Layers... 

A dialog box asks for the number of layers required. They are then inserted in the 

design immediately before the currently selected layer. The thickness of the inserted 

layers is zero and the material is nominal, usually Na3AlF6. Once the layers have been 

inserted they should be edited as required. Note that insertion of a small number of layers 

is most easily carried out by first making sure that the editor is in insert mode shown by 

Insert on the bar at the foot of the application window. If Overstrike is shown then press 

<Ins> once to change it. Click anywhere in the layer before the place where the new layer 

is to be inserted. Press <Enter> repeatedly until the active cell becomes the last one in the 

row. The next press of <Enter> will create a new layer in the correct place. 

Delete Layers... 

This deletes a specified number of layers starting with the currently selected layer and 

working towards the substrate.  

Reverse Layers 

This could be the most important menu item in the package. The convention 

throughout the package for the order of layers in a design is is set by the user. In the 

default mode layer 1 is the layer next to the incident medium. In the Formula the layers 

run from incident medium at the left to substrate at the right (this is the same convention 

usually used in simple optical systems) unless this too has been specified. There is, no 

universal agreement on either direction or numbering arrangement. The difficulties are 

compounded because the convention is not always clearly stated and it is only when a 

design is calculated that it becomes obvious that the order is incorrect. It is quite possible, 

therefore, that a laboriously entered design might have been placed in the tables in 

reversed order. This menu item affords a simple remedy. Reverse Layers immediately 

reverses the order of the layers without altering the position of substrate and incident 

medium. If a contiguous set of layers is selected, then Reverse Layers will modify only 

those layers. 

Reverse Design 

Reverse Design reverses the order of the layers, swaps the substrate and incident 

medium and changes the incident angle  

Formula 

Formula permits designs to be set up or edited using shorthand notation and handles 

the definition of the symbols used. The shorthand notation is a particularly convenient 
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way to enter layer data. The design is represented in terms of basic layers, of differing 

materials, which are represented by symbols such as H, L, A, B, c, d etc. The Formula 

command does not differentiate between upper and lower case characters. The basic layer 

definition is given by the material, the layer thickness (either physical or optical), the 

packing density, lock and link specifications for refinement, the void material and the 

void material density, inhomogeneity factor, minimum and maximum physical thickness 

limits for refinement. Layer thicknesses other than the basic thickness are represented by 

multiples of the basic thickness, as in, for example, 2.5H or 0.4L (representing 2.5*0.25 = 

0.625 full waves and 0.4*0.25 = 0.1 full waves respectively, if the basic thickness were 

0.25). The symbols can be combined into a formula using a simple sequence as in 

A2LB2LA or repeated sequences can be included in brackets with an exponent or 

replication factor, e.g. 

 (HL)^6 3.4H2.1L 

or 

 ((H1.2L2B)^2 HL)^3 (LBH)^2 

Note the space between the exponent and what follows. If it is omitted the program 

will reject the formula. Multiplying factors outside brackets can be used. They will be 

applied to all layers inside the brackets. For example 2.3(HL)^3 would be interpreted as 

(2.3H 2.3L)^3 and 1.1(A 2.3(HL)) would be interpreted as 1.1A 2.53H 2.53L. The 

incident medium may either be at the left end or the right end of the formula and depends 

upon the setting specified in the Design tab of the General command in the Options 

menu. There are some keyboards where the caret symbol ^ is not readily available 

(German keyboards for example), and the asterisk, *, can be used as an alternative. 

Brackets can be nested within brackets with almost no limit on depth. 

Selection of the option brings up a dialog box for the entry of the basic layer 

definitions. Any existing symbols are retained and presented first in the list. To delete an 

entry, select the symbol and press <Del>. Once the symbols have been defined, the 

formula can be entered in the Formula box. For clarity, the formula may be entered on 

more than one line to show, for example, structure in the design. Arrow keys or the scroll 

bars can be used to scroll to either end of the formula if it is too large to be displayed 

completely in the box. Select the OK button to replace the current design with the design 

given by the formula. Should there be an error in the syntax of the formula it will be 

flagged at this stage with an indication of the specific error. A corrected formula can then 

be entered. 
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The text box in which the formula is entered accepts the usual copy, cut and paste 

commands. These can also be used to transfer part or all of a formula to a different 

design. 

Note that the interpretation of the entered formula does take account of the match 

angle. Match angle is described below. If Formula… ever appears to be operating in a 

curious way, check the match angle option to make sure it has not been set inadvertently 

to an incorrect angle. 

Generate Rugate… 

This command allows you to easily generate models of rugate coatings. The 

continuously varying refractive index of a rugate coating is modeled by a sufficiently 

large number of layers with a discretely varying refractive index. The variation in 

refractive index is achieved by varying the packing density of each layer. The Generate 

Rugate command allows you to easily specify the index variation and control the number 

of layers that are used to model the rugate structure. See the section “Modeling Rugate a 

Coating” below (page 105) for more information on modeling rugate coatings. 

Generate Design… 

This command allows you to generate more complex designs than can be produced by 

the Formula command. For example, chirped reflector models may be produced using 

this command. See the section “Generating Complex Designs” below for more 

information. 

Scale Thicknesses... 

Occasionally layers of a particular material or that have the same link number should 

have their thicknesses changed in the same way. This would happen most commonly in 

reverse engineering when investigating the effects of lack of uniformity but there are also 

times when slight adjustments must be made to the width of a pass or stop band. It is also 

sometimes necessary to retain the value of a particular reference wavelength but to 

change all layer thicknesses in the same ratio so that the characteristic is shifted but 

otherwise essentially unchanged. The Scale Thicknesses... command makes all this 

particularly easy. 

 
 

The dialog box that appears will show either the materials that are used in the design, 

or the links that are used. Click on the Materials tab to show the materials or click on the 

Links tab to show the links used. The scale factor that is entered applies to all selected 

materials when the OK button is clicked and the Materials list is visible. If the Links list 

is visible, then the scale factor is applied to the layers with the selected link numbers.  
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Match Angle... 

All the parameters listed in the design table and the output of the Formula... command 

assume normal incidence. But whenever a multilayer is tilted, the phase thicknesses of 

the layers vary with the cosine of the angle of incidence in the layer and this effect is 

responsible for the shift in the characteristic towards shorter wavelengths. A coating that 

is actually to be used at oblique incidence should have the thicknesses of the layers 

adjusted accordingly. The lower the refractive index of the material the greater is the 

necessary adjustment. Layers that have been corrected for a particular angle of incidence 

are said to be matched for that angle. The Match Angle... menu item makes the 

calculations and adjustments automatically. 

Metals and dielectrics behave differently, although the same fundamental principles 

are involved. High performance metals, because they have very low refractive index and 

high extinction coefficient, do not exhibit the appreciable shift of dielectrics and should 

not be corrected. In order to classify materials either as metals or dielectrics an arbitrary 

dividing line uses a preset level of extinction coefficient. This level is normally unity but 

can be changed by the user. If the actual extinction coefficient is higher than the limit, 

then the material is classed as a metal and no correction is made. If the extinction 

coefficient is lower, then the dielectric correction is implemented. 

Note that the correction changes the normal incidence thickness to correct the 

behavior at oblique. The design table values still apply to normal incidence. Any pasting 

operation ignores the match angle. Formula..., however, does recognize the match angle 

and does correct layers accordingly. If Formula… ever appears to be operating in a 

curious way, check the match angle option to make sure it has not been set to an incorrect 

angle.  

 
 

Changing the match angle is straightforward. The new value is entered in the dialog 

box. The operation first returns the layers to normal incidence and then applies the new 

angle. The current match angle can always be found by selecting the match angle menu 

item and looking at the displayed value. 

Global Edit… 

This command changes either all layers in the design or selected layers only, if at least 

one layer has been selected to values entered on the Global Edit form. 
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If a value is entered into one of the fields, then the layers will be updated with the new 

value. If the field is left blank, then the value held in the layer will be not altered. For the 

layer parameter limits fields, there is the additional option of specifying that the entered 

value is a scale factor. When Scale Factor is checked, the value entered into the 

appropriate limit cell in the Design will be the product of the scale factor and the 

corresponding layer parameter. For example, if a Minimum Physical Layer Thickness of 

0.95 is entered and Scale Factor is checked, the minimum physical thickness of each 

layer will be set to 0.95 * the layer’s physical thickness. This makes it easy, for example, 

to set thickness limits as a percentage of the current layer thickness. Click OK to cause 

any changes to be made. Clicking Cancel causes the edit operation to be aborted. In the 

example the material of the layers will be changed to MgF2, the packing density will be 

set to unity and the void density will be set to zero. 

Edit Materials... 

Edit materials offers a simple way of changing the materials in a design. The user 

simply inserts the translation in a dialog box. When Update Formula & Synthesis 

Materials is checked, the material names in the formula and synthesis materials list will 

be changed to the new materials. If it is not checked, only the materials in the design will 

be changed. 
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Create Design  

Create Design creates a new design consisting of only thin film layers from the 

current design. A design may contain thick as well as thin layers. Some performance 

calculations such as phase and analysis calculations cannot be performed when a design 

contains thick layers. This command takes a set of contiguous thin film layers in the 

design and creates a new design using those layers. The incident medium of the new 

design is set to be the same material as the thick layer at the incident medium end of the 

contiguous thin layer set (or the incident medium if there is not a thick layer).  The 

substrate of the new design is set to be the same material as the thick layer at the substrate 

end of the contiguous thin layer set (or the substrate is there is not a thick layer).  

To create the new design, select any thin layer in the contiguous layer set and then 

click Create Design. 

Parameters Menu (Design) 
 

Performance... 

The performance parameters consist mainly of the choice of the quantities and scales 

of the axes in the performance plots that are to be produced. One or two Y axes may be 

defined. Tables will use the same parameters and range of independent variable and just 

the independent variable interval for the tables needs to be separately specified. The 

content of the table will be defined by the performance requested in the Vertical Axis tab. 

A typical dialog box for entry of the performance parameters is shown below and is 

reasonably self-explanatory. Items not available for the particular choice of dependent 

quantity are gray and cannot be accessed. The parameters described here only apply to 

designs that consist solely of thin layers. When a design includes one or more thick 

layers, a modified performance parameters dialog is shown. This dialog excludes the 

phase related options, but adds cone and bandwidth calculation options. See the 

Coherence, Cone and Bandwidth section of the Essential Macleod Structure chapter for 

more information. 



Design Window  87 

 
 

The package computes the response, the dependent variable, in terms of a variable 

parameter, the independent variable. Except for a very few special cases, throughout the 

package the vertical axis in the plots corresponds to the dependent variable while the 

horizontal axis corresponds to the independent variable. 

The dependent variable, the performance, may be chosen from the scrolling list under 

Vertical Axis. This list comprises 

Transmittance Magnitude (%) 

Reflectance Magnitude (%) 

Transmittance Phase (deg) 

Reflectance Phase (deg) 

Back Reflectance Phase (deg) 

Back Reflectance (%) 

Density 

log(Transmittance) (dB) 

log(Reflectance) (dB) 

Absorptance (%) 

Reflectance GD (fs) 

Reflectance GDD (fs^2) 

Reflectance TOD (fs^3) 

Transmittance GD (fs) 

Transmittance GDD (fs^2) 

Transmittance TOD (fs^3) 

Transmittance Delta (deg) 

Transmittance Psi (deg) 

Reflectance Delta (deg) 

Reflectance Psi (deg) 

Transmittance CDC (fs/nm) 

Reflectance CDC (fs/nm) 

Transmittance PM 

Reflectance PM 

The phase parameters may be calculated in two ways depending on whether Unwrap 

Phase is checked or not. If Unwrap Phase is checked, the phase values will not be 

constrained to a principal angle range but allowed to continuously increase (or decrease) 

beyond the principal angle limits. If Unwrap Phase is not checked, the phase values will 
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be constrained to the principal angle range. For example if the Phase limits have been set 

to –180 to +180 degrees and Unwrap Phase is checked, the resultant value of a phase 

calculated as –179 degrees where the previous value is +179 degrees will be 181 degrees. 

This form of phase plot will show the phase characteristic as a continuous line, whereas 

the wrapped form will have discontinuities where the phase crosses the principal angle 

boundaries. 

GD indicates Group Delay, GDD, Group Delay Dispersion and TOD is Third Order 

Dispersion. These quantities are important in components for ultrafast applications and 

are directly related to the derivatives of phase shift with respect to the angular frequency 

of the light. 

CDC indicates Chromatic Dispersion Coefficient. This quantity is similar to Group 

Delay Dispersion in that it indicates pulse spreading. It is more commonly used in the 

communications field. 

PM indicates Polarization Maintenance. This parameter calculates how much the 

coating changes the polarization state of the incident beam. Polarization maintenance is 

typically measured by placing a polarizer in the incident beam aligned at 45° to the p and 

s-directions, and an analyzer in the emergent beam. The analyzer is first aligned parallel 

to the input polarization to give the signal irradiance and then orthogonal to it to give the 

leakage irradiance. The irradiance in the signal orientation divided by the sum of the 

irradiances, expressed as a percentage, is the measure of polarization maintenance. 

Derivatives with respect to wavelength of those quantities that are not already 

derivatives can be specified by entering the appropriate derivative order in the derivative 

field. For example, the first derivative can be specified by entering unity in the box. 

Please note the comments under Derivatives in the Essential Macleod earlier in this 

manual.  

The independent variable is specified in a similar scrolling list under Horizontal Axis. 

There are essentially four different types of independent variable, wavelength, frequency, 

incident angle and layer thickness. The actual terms displayed in the scrolling list follow 

the names that have been entered in the General Units dialog box.  

The thickness of a chosen layer may be used as the independent variable. This is 

immediately applicable to the case of an etalon with variable spacer layer but there are 

often cases where the sensitivity of performance to variations in the thickness of a 

particular layer is in question. 

Plots and tables using the current values of the parameters can always be initiated 

from the Performance menu. However, the Performance Parameters dialog box gives 

immediate access to either plots or tables without the necessity of returning to the menu. 

If the OK button is chosen then the only immediate action taken will be to change the 

current values of the parameters to those entered so that they will then be used by the plot 

and table commands in the Performance menu. They will not be stored permanently in 

the design file until it is actually saved. 

To aid in identifying traces on a plot, plot parameters may be automatically added to 

the plot legend by checking the Add to Label box next to each parameter. If the Plot 

Targets box is checked, then the targets will be added to the plot if the performance type 

of the targets matches the performance specification of the plot. 
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Refinement 

Choosing Refinement in the Parameters menu brings up a submenu that gives access 

to the various parameters that must be set before effective refinement and synthesis is 

possible. There are two aspects of the parameters that need definition. First there are the 

specifications of the desired performance levels. These are called Targets and they are 

common to all the various techniques. Then there are various attributes that must be set 

correctly for the particular technique that is to be used. The principal technique in the 

Essential Macleod is Optimac, a powerful synthesis method that can also carry out 

refinement. Five further refinement techniques are Nonlinear Simplex, called nonlinear to 

distinguish it from a similarly named but different technique used in the solution of linear 

equations, a statistical method known as Simulated Annealing, two derivative methods: 

Conjugate Gradient and Quasi-Newton and an evolutionary method: Differential 

Evolution. Additionally, the Needle synthesis method is available for generating designs. 

Refinement and synthesis are discussed in a later dedicated section. 

3D Performance... 

The 3D performance parameters consist mainly of the choice of the quantities and 

scales of the axes in the 3D performance plots that are to be produced. A typical dialog 

box for entry of the 3D performance parameters is shown below and is reasonably self-

explanatory. Items not available for the particular choice of dependent quantity are gray 

and cannot be accessed. 

 
 

The package computes the response, the dependent variable, in terms of two variable 

parameters, x and y.  

The dependent variable, the performance, may be chosen from the scrolling list under 

Z Axis. This list is the same as in the Vertical Axis in the Performance Parameters dialog. 

The independent variables are specified in similar scrolling lists under X & Y Axes. 

There are essentially four different types of independent variable, wavelength, frequency, 

incident angle and layer thickness. The actual terms displayed in the scrolling lists follow 

the names that have been entered in the General Units dialog box.  

The thickness of a chosen layer may be used as the independent variable. This is 

immediately applicable to the case of an etalon with variable spacer layer but there are 
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often cases where the sensitivity of performance to variations in the thickness of a 

particular layer are in question. 

The surface computed in a 3D plot is calculated at a fixed number of equally spaced 

points in the x and y directions. The Number of Intervals parameter specifies then 

number of points calculated. 

3D Plots using the current values of the parameters can always be initiated from the 

Performance menu. However, the 3D Performance Parameters dialog box gives 

immediate access to a plot without the necessity of returning to the menu. If the OK 

button is chosen then the only immediate action taken will be to change the current 

values of the parameters to those entered so that they will then be used by the 3D plot 

command in the Performance menu. They will not be stored permanently in the design 

file until it is actually saved. 

Yield Specification... 

A Yield Specification is used in conjunction with the Errors tool to calculate the 

proportion of perturbed designs generated by the Errors tool that meet the Yield 

Specification. This proportion is an estimate of the number of manufacturing runs that 

will result in acceptable parts. 

The Yield Specification is very similar to the Targets used by refinement except that 

for Standard performance parameters a wavelength range is specified rather than 

individual wavelengths. Additionally, the operators available are >= and <=.  This allows 

the creation of a test where a performance value must lie within a certain range where one 

row provides the upper bound and another row provides the lower bound. For a perturbed 

design to be acceptable, all entries in the Yield Specification must be satisfied. 

For example, the Yield Specification below requires that reflectance be less than 0.5% 

over the wavelength range 425 to 650 nm. The reflectance is tested at 5 nm intervals 

throughout that range. 

 
 

 If, for example, the requirement is that the average reflectance be less than 0.5%, this 

is entered using the Avg Reflectance type in the Yield specification. 
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Performance Menu (Design) 
The Performance menu controls the calculation of performance figures by the 

package. Access to the menu items is possible only when a design window is active and 

the calculation initiated by the choice of one of the items will refer to the design in the 

active window. There are two principal ways in which the results of a calculation may be 

presented. They may be plotted or tabulated and either may be chosen from the menu. 

Another aspect of performance of a design is its susceptibility to errors, also available 

from this menu. 

Plot 

Plot initiates the plotting of performance in a plot window. The aspects of 

performance and the range over which they are to be plotted have already been chosen 

under the item Performance in the Parameters menu. 

The Plot window is now the active one and so the menu bar changes to reflect that. 

The principal changes are that the Performance and Parameters menus disappear and 

the choices under the others are limited. 

Many aspects of the plot can be modified. The section on the Plot Window later in this 

manual describes how plots may be modified. Note that the performance data do not 

change when the plot parameters are altered. If a change is made to the wavelength 

region outside the range of the original calculations then the altered plot will simply be 

blank over the new part of the region. To extend the wavelength region outside the 

original limits it is necessary to return to the design window and select Performance in 

the Parameters menu. The dependent variable is not limited in this way. 

Plot Over 

Plot Over permits the plotting of a second curve to be made over a first. The first 

curve must have been made using the current design. Once the first curve has been 

produced, then an adjustment to the design or a change in the calculation parameters, 

such as angle of incidence, may be made and then the performance of the new 

arrangement plotted over the first. 

Plot Over will be grayed out if the design file is changed. To plot the results of a 

different design over those of a first, the Add command in the File menu should be used. 

Plot the results of the first design. Save the plot as a plot file using the Save As... 

command (the short cut key <F12> is the quickest and most convenient way of doing 

this). Change to the alternative design. Plot the results. While the plot window is active, 

choose Add Line... from the File menu (<Alt><f> followed by <d>) and select the plot 

just saved. The plots will be combined. 

Table 

Table produces a table of results according to the options selected in the Performance 

menu item in the Parameters menu for the design window. 

The table has the usual cells with individual results but as it is produced the table has 

the attribute read only and so is protected from change. This is a safety feature to guard 

the integrity of the data. 

There may be occasions when some editing of the data is necessary. The legend 

against Design right at the top of the table is a good place to put a very short note, for 



92  Design Window 

example. For this reason the read only nature of the file can be changed. With the table 

window active select the Edit menu. There are two active items, Copy Table and Read 

Only. The read only status will be indicated by a tick to the left of the menu item. Select 

Read Only to toggle the status. When the tick is not visible, the table may be edited. It is 

good practice to return the status to read only after editing and immediately save the 

table. 

Copy allows the table to be copied to the clipboard and pasted subsequently into any 

other suitable application, especially a word processor. 

More information about the table menus will be found in a later section. 

Errors... 

One of the most difficult areas in the design of optical coatings is the assessment of 

the sensitivity of the coating to errors. The errors in manufacture are generally rather 

larger than the first order approximations that can be readily handled by analytical 

techniques and so the most successful ones involve Monte Carlo modeling of the 

deposition process. Random errors drawn from suitable infinite populations are 

introduced and their effects over a large number of simulations are assessed. This is the 

technique on which the Errors... menu item is based. 

Errors calculates successive performance curves for the design with thickness errors 

and refractive index errors drawn from a normal population. The parameters dialog box 

appears first. 

 
 

Errors may be specified for both thickness and refractive index for each material in 

the design. For thickness errors, there are three parameters: Thickness Mean Error, 

Thickness Standard Deviation and Minimum Thickness. The Thickness Mean Error 

and Thickness Standard Deviation specify the statistical properties of the normal 

population from which the random numbers for thickness errors will be drawn. For layers 

that are thicker than the Minimum Thickness, the error will be applied as a proportion of 

the layer thickness. For example, to apply a thickness error where the standard deviation 
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is 2% of layer thickness and there are no systematic thickness errors, the following 

parameters are used: 

Thickness Mean Error: 0 

Thickness Standard Deviation: 0.02 

Minimum Thickness: 0 

In this case the thickness including error will be calculated as 

ErrorThickness = LayerThickness + LayerThickness * RandomNumber 

Another case is to apply an absolute error to the layer thickness that does not depend 

upon the thickness of the layer. For example, to apply a thickness error where the 

standard deviation is 2nm the following parameters can be used (providing no layer is 

thicker than 1000nm): 

Thickness Mean Error: 0 

Thickness Standard Deviation: 0.002 

Minimum Thickness: 1000 

In this case, the thickness including error will be calculated as: 

ErrorThickness = LayerThickness + MinimumThickness * RandomNumber 

With the values above, the standard deviation of the amount added to the layer 

thickness will be 1000 * 0.002 = 2 nm. 

A combination of proportional and absolute errors can be achieved by correct setting 

of the minimum thickness. For example, to specify 2% thickness errors with a minimum 

thickness error standard deviation of 2nm, the following parameters would be used: 

Thickness Mean Error: 0 

Thickness Standard Deviation: 0.02 

Minimum Thickness: 100 

For layers thicker than 100nm, the thickness error will be calculated as 

ErrorThickness = LayerThickness + LayerThickness * RandomNumber 

For layers thinner than 100nm, the thickness error will be calculated as: 

ErrorThickness = LayerThickness + MinimumThickness * RandomNumber 

For layers thinner than 100nm, the standard deviation of the amount added to the layer 

thickness will be 100 * 0.02 = 2 nm 

For refractive index errors, there are two parameters: Index Mean and Index 

Standard Deviation. The Index Mean Error and Index Standard Deviation specify the 

statistical properties of the normal population from which the random numbers for index 

errors will be drawn. For refractive index errors, the random number is added to the 

packing density of the layer to generate the perturbed refractive index for the layer, i.e. 

ErrorPackingDensity = Packing Density + RandomNumber 

Two checkboxes control the application of thickness and index errors. If Include 

Thickness Errors is checked, then thickness errors will be calculated. If Include Index 

Errors is checked, then refractive index errors will be calculated. Both types of error can 

included at the same time.  
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If Include Locking is checked, then only the layers that are not locked will have their 

thicknesses altered. If Include Links is checked, then the thickness of one of the layers in 

each set of linked layers will be randomly altered and then the other layers in the link set 

will have their thicknesses adjusted so that they have the same ratio of thicknesses to the 

randomly altered layer as in the original unperturbed design. For example, if layer 1 is 

15nm thick and layer 2 is 30nm thick, and these layers are linked, then during Errors, 

layer 1 will be randomly altered and layer 2 will be set to be twice as thick as layer 1 

If Independent Index Errors is not checked, then all layers of the material will have 

the same packing density error applied to them. If Independent Index Errors is checked, 

then different refractive index errors will be applied to each layer. 

The Number of Cases is just the number of different curves with different random 

errors drawn from the specified populations.  

Sometimes it is useful to look at the worst designs generated where “worst” means has 

the largest merit figure. To keep the worst designs, check Keep Worst Designs and enter 

the maximum number of designs to be kept in Number to Keep. When the process is 

started a window will appear with a list of merit figures. These are the worst designs 

generated. Double-click on a merit figure to open the design that has that merit figure. 

When the list of merit figures window is closed, the worst designs that are not open or 

have not been saved will be discarded. 

A numerical estimate of the yield given the random errors can be made by checking 

Estimate Yield. When the error calculations are performed a yield window will appear 

indicating the number of perturbed designs that meet the yield specification (the yield 

specification is created using the Yield Specification command in the Edit menu of a 

Design). For yield specifications with several tests, it will be difficult to determine where 

the designs did not meet the yield specification. Checking Show Details will change the 

output of Estimate Yield from showing the proportion of designs meeting the yield 

specification to a table showing, for each perturbed design the results of each yield 

specification. A yield specification that is not met by the design is highlighted in red. 

Double-clicking on an entry in the details table will open the corresponding perturbed 

design. 
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Once the correct parameters have been entered click the Plot button. The program will 

draw a series of curves each of which represents the performance of the coating with a 

different set of errors all drawn at random from the specified infinite populations with the 

parameters that have just been entered. By varying the error parameters and replotting an 

assessment of manufacturing tolerances can readily be made. 

To see a table of statistics, click the Statistics Table button.  

 
 

A new set of errors will be generated and the statistics of the resulting performance 

data will be calculated and displayed as shown in the table above. The statistics 

calculated are Mean, Standard Deviation, Median, Maximum and Minimum. If a 

filename is entered in the Statistics Table spectra stored in box, the calculated 

performance data will be stored in the file in CSV format. This data can then be 

manipulated by any program that reads csv files. The Choose button next to the box 

displays a file chooser for easier entry of the filename. If a filename is entered in the 

Statistics Table color data stored in box, the color parameters selected in the Table list 

of the color dialog (see below) will be stored in the file in CSV format. This data can then 

be manipulated by any program that reads csv files. The Choose button next to the box 

displays a file chooser for easier entry of the filename. 

For convenience, the Errors dialog also has a Color button. Clicking this button will 

display the Color dialog (see below) with the error parameter part also displayed. 

Color 

The following color parameters are available: Tristimulus, Chromaticity, CIE L*a*b*, 

CIE L*u*v*, CIE L*u’v’, Hunter LAB, CIE1960 u,v, Correlated Color Temperature 

(CCT), Reciprocal Correlated Color Temperature (RCCT), Dominant Wavelength (Wd), 

Complementary Wavelength (Wc), Excitation Purity (Pe) and Colorimetric Purity (Pc). 

For the CIE L*a*b* color space, the hue and chroma correlates are also calculated. For 

the CIE L*u*v* color space, the hue, chroma and saturation correlates are also 

calculated. Color difference in the CIE L*a*b* color space can be calculated, CIE76 and 

CIEDE2000 methods are available. The Coloring Rendering Index for a coating 

combined with a light source can also be calculated. 

The dialog box that appears has several fields for completion. 
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Source lists the sources. The standard sources are CIE A, B, C, D55, D65, D75 and 

equal energy. Black body and other sources can readily be added especially if the 

Function Enhancement is present. Instructions are in the earlier section on Color. 

Observer lists the sets of tristimulus values that are to be used. As supplied, these are 

CIE 1931 and CIE 1964. Again other observer definitions can be added if required. 

Mode specifies whether the transmitted or reflected color will be calculated.  

Polarization specifies the polarization to be used for oblique incidence calculations. 

Context specifies the coating context to be used for the calculations. 

Incident Angle contains a set of three parameters that specify the range of incident 

angles and interval to be used in the calculation. 

Show White Point places a symbol on the plot or creates a table entry that shows the 

coordinates of the source.  

Show Color Patch creates a window that displays a visual impression of the color(s) 

of the coating.  

The Plot tab allows you to choose a standard plot or select two color parameters to 

plot. The standard plots available are: Tristimulus XY,  Chromaticity xy,  CIE 1976 UCS,  

CIE 1976 h*c*(ab), CIE 1976 h*c*(uv). The Chromaticity xy plot is plotted on a 

chromaticity diagram. The CIE 1976 UCS plot is plotted on a UCS diagram. The CIE 

1976 h*c*(ab) and CIE 1976 h*c*(uv) plots are plotted on a polar diagram. If a Custom 

plot is selected, then the X Axis Parameter and Y Axis Parameter specify the color 

parameters to use in the plot. Clicking the Plot button causes the selected parameters to 

be plotted.  Clicking the Active Plot button causes the parameters to be plotted in an 

Active Plot window. If Show Color Patch is checked, the color patch will also be active. 

See the Active Plot chapter (page 137) for more information on Active Plots. 

The Table tab allows you to choose the color parameters to be included in the table 

output. Parameters are selected by clicking on them. Each selected parameter is 

highlighted in the list. In the figure below, the table will contain three parameters: 

Tristimulus X with Chromaticity x and y. 
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The Difference tab permits the calculation of color difference in the CIE L8a*b* color 

space. The reference color can be entered as either L*a*b* coordinates or the hue and 

chroma correlates L*c*h*. Clicking on Table will display the CIE76 and CIEDE2000 

color differences. 

 

Errors >> drops down an extra part of the form that allows you to see the effects of 

random thickness errors on the color of a coating in the same manner as the Errors 

command. 

 
 

Please see the Errors command described earlier in this chapter for information on the 

error parameters. 
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If you do not wish to include the error variation in the color output, click the Errors 

<< button to close the error parameters part of the form. Plotting or generating a table 

with the errors part closed will calculate the color of the coating design without random 

variation. 

Active Plot 

This command starts an Active Plot using the current plot parameters. For more 

information on active plots, see the active plot chapter (page 137). 

3D Plot 

3D Plot initiates the plotting of performance in a 3D plot window. The aspects of 

performance and the range over which they are to be plotted have already been chosen 

under the item 3D Performance in the Parameters menu. 

The 3D Plot window is now the active one and so the menu bar changes to reflect that. 

The principal changes are that the Performance and Parameters menus disappear and 

the choices under the others are limited. 

Many aspects of the plot can be modified. The section on the 3D Plot Window later in 

this manual describes how 3D plots may be modified. Note that the performance data do 

not change when the 3D plot parameters are altered.  

Polarization… 

The Polarization tool allows you to visualize the effect of a coating on the polarization 

state of an incoming beam. The polarization state is specified as a ellipse with major and 

minor axis amplitudes together with a tilt angle that specifies the rotation of the ellipse 

major axis from the s-polarization plane For polarization states with a non-zero minor 

axis, the rotation of the polarization vector can be specified as either left-handed or right-

handed. This rotation direction is specified looking in the direction of propagation of the 

beam.  

As an example, we will use the Cube polarizer design that is supplied with the 

software. The performance of the polarizer is: 

 
 

With the Design active, selecting Polarization from the Performance menu displays 
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For the input state, we will enter a left-circularly polarized beam, that is, equal major and 

minor axis magnitudes. Tilt angle does not apply to a circularly polarized beam so this 

parameter will be left at zero. We will consider transmittance at 45 degrees incident angle 

at a wavelength of 510nm. After entering the values and clicking Calculate, the 

following will be displayed. 
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As expected, transmission through the coating converts the circularly polarized beam into 

a relatively p-polarized beam. Clicking Copy copies the beam picture so that it may 

easily be inserted into a document: 

 

 
 

Lock/Link Menu (Design) 
Locking and Linking are constraints that are used in some of the refinement and 

synthesis procedures. A locked layer is excluded from any variation and remains constant 

Input:
Major: 1.000
Minor: 1.000
Tilt Angle: 0.00
Left-handed

Output:
Major: 0.868
Minor: 0.026
Tilt Angle: -89.61
Left-handed
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in both index and/or thickness. Layers that are linked together vary as a group in exactly 

the same manner. These constraints are useful both in the creation of a design where the 

structure is largely known but fine tuning has to be carried out on various parts and in 

reverse engineering for the investigation of possible process defects. There are also cases 

where coatings are to be designed to be deposited over already existing structures, the 

hard coating on spectacle lenses is an example. 

Lock 

Locking affects the way that the layers are treated in some of the refinement 

techniques. Layers may have their thickness locked, their packing density locked or both 

thickness and packing density locked. If a layer is thickness locked it retains its initial 

thickness throughout the operation. Similarly, if a layer is packing density locked, it 

retains its initial packing density throughout the refinement. To lock a group of layers 

they should first be selected by clicking in the selection box. <Shift> click will select a 

contiguous group of layers while <Ctrl> click will select a noncontiguous layer. Once the 

layers are selected, each successive use of the Lock command cycles the lock state of the 

layer through the three possible options: thickness locked (indicated by d), packing 

density locked (indicated by n) or thickness and packing density locked (indicated by d, 

n). Note that once the locking column appears in the design table, locking or unlocking of 

individual layers is probably more easily achieved simply by clicking on the locking cell 

to toggle the locking status. Thickness locking is very useful when it is known that the 

core of a coating should be unchanged. A good example is a quarterwave stack that is to 

be converted into an edge filter. Only the few outermost layers need be involved in any 

refinement. 

Unlock 

Unlock unlocks the selected layers. The remarks under Lock apply here also. It is easy 

to check that all layers are unlocked because then the lock column in the design table 

automatically disappears. 

Link 

Layers that are linked move together during refinement. There may be several 

different groups of layers in a particular design that are linked together. One linked group 

is distinguished from another by having a different reference number for the link. Layers 

with the number zero against them in the link column are unlinked. Those that are labeled 

1 move together as a group. Those labeled 2 also move together but as a different group 

from those labeled 1, and so on. The number given to the link is that of the first layer that 

is involved in the linked group. Locked layers cannot form part of a link and a link must 

have more than one member. Sometimes a linked design may be edited so that the links 

move away from their original positions. Then a new and separate link may automatically 

be given the same designation as an existing link. In that case the new link numbers can 

be easily altered manually so that they can be distinguished from the earlier set. 

Unlink 

This cancels any links that apply to the selected group of layers. A good indication 

that all layers in a design are unlinked is that then the link column automatically 

disappears. If it does not then a residual link must exist somewhere in the design. 
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Lock All 

This command changes the lock state of all layers. This is useful when just a few 

outermost layers are to be unlocked. Successive use of this command causes the lock 

state of all layers to cycle through the three possible options. All may be locked using this 

command and then the few that are to be refined may be manually unlocked. 

Unlock All 

This unlocks all layers in a design. 

Link All Materials 

For each material used in a design, this command links all the layers in a design that 

use the same material. It is very useful in reverse engineering applications where, for 

example, you want to look at the effect of variations in tooling factor on the performance 

of a design. 

Tools Menu (Design) 
The Tools menu gives access to several devices for altering the coating design and 

also is a useful route to the editing of layer materials. 

Compact Design 

Compact Design will remove all layers of thickness less than a defined limit and 

close up the design. The layers are removed in a way that has minimum impact on the 

performance. The thinnest that meets the removal criterion is removed first and then the 

design is closed up. Then the design is resurveyed and the thinnest layer meeting the 

criterion removed, and so on. 

 
 

Refine Design 

The techniques available in the Essential Macleod are Simplex, (often called nonlinear 

simplex to distinguish it from a similarly named technique in linear programming), 

Optimac, Simulated Annealing, Conjugate Gradient, Quasi-Newton, Differential 

Evolution and Needle synthesis. Optimac can accomplish synthesis or refinement. 

Simplex and Simulated Annealing also have the facility to refine in terms of layer 

thickness or of packing density, or of both. Packing density can be used in different ways 

either to simulate inhomogeneous layers or other production variations in reverse 

engineering, or simply to refine in terms of refractive index instead of thickness or even 

both simultaneously. 

Selection of any of the techniques in this menu immediately initiates the refinement or 

synthesis process, unlike the corresponding command in the parameters menu that brings 

up first a parameters dialog box. 



Design Window  103 

Refinement and synthesis are considered in greater detail below. 

Index Profile... 

This produces a plot of refractive index against thickness in the chosen thickness 

units. Start Layer and End Layer are optional and, if the entire design is to be shown, a 

short length of substrate and incident medium are also optional. The following figure 

shows a quarter-half-quarter antireflection coating. In the index profile the incident 

medium is on the left and the emergent medium, or substrate, on the right 

 

 
 

Thickness Profile... 

This produces a plot of thickness against layer number in the chosen thickness units. 

Start Layer and End Layer specify the layer range to be plotted. The following plot 

shows a chirped thickness modulated coating where the modulation frequency increases 

with layer number.  
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The modulation is readily apparent in the plot. 
 

Materials 

Selection of this item displays and activates the 

materials window for the current material database. 

The materials window and the operations that can 

be carried out on materials will be detailed below. 

Here we give just a brief account. 

Materials may be chosen from this window for 

further examination, for editing, display and 

exporting. 

Material names can be dragged in the window 

to change their order. For example the materials 

used most often may be arranged near the head of 

the list. Since this list determines the order in the 

small lists that are used for design editing it can be 

very useful in speeding up the design entry and 

editing process. 

 

Options Menu (Design) 
The Options Menu permits changes in certain aspects of the configuration of the 

package. These items are listed in greater detail above in the Applications Window Menu 

section. 

General… 

A dialog box permits the alteration of some of the details of the operation of the 

program. Note that although the materials folder is displayed, this is for reference only. 

The arrow to the right of the text box and the name of the materials folder within the box 
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are both grayed out. It is not permitted to change the current materials folder when a 

design is open. This dialog also permits you to change the display order of the layers. 

Set as Default Design 

The default design is the one that is created by the New... command under the File 

menu. Selecting this command copies the active design to the default design file for the 

current materials database. If the database is changed the default design will change with 

it. This means that the default design can always be appropriate to the particular database. 

Window Menu (Design) 
The Window menu has the same function throughout the package where it appears. It 

permits the organization of the presentation of the various open windows to be rearranged 

or to be switched from cascade to tile. The icons indicating reduced windows can be  

straightened up into rows. The various open windows are listed and can be brought to the 

front and activated by selecting the correct menu item. 

Help Menu (Design) 
This menu is identical throughout the package. It gives access to the on-line help 

facility and also displays a box with information about the program and about the 

installation. More information is given earlier under Essential Macleod Application 

Window. 

Modeling a Rugate 
 

In the Essential Macleod, a rugate coating is modeled as a set of layers where the packing 

density of each layer is varied through the set to provide the desired index profile. The 

Generate Rugate command in the Edit menu is a tool that simplifies the generation of 

the set of layers. 
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The limits of the index variation may easily be established by setting the Material 

parameter to a material that represents the highest refractive index that is present in the 

coating, setting the Void Material to a material that represents the lowest refractive index 

that is present in the coating and setting the Void Density to 1. As the packing density 

varies from 1 to 0, the refractive index will vary from the Material refractive index to the 

Void Material refractive index. Since the layer refractive indices are calculated using the 

packing density function, other relationships between packing density and refractive 

index can also be used (for example the valid packing density range may be 0 to 2 instead 

of 0 to 1). 

The total thickness of the rugate structure is specified in optical by the Total 

Thickness value. The Reference Wavelength must also be specified. Number of 

Layers specifies the number of layers that are used to model the rugate structure. 

Increasing the number of layers improves the accuracy of the calculations at the expense 

of increased calculation time. A good starting point is to set the number of layers so that 

each layer is about one eighth of a wave thick at the shortest operating wavelength of the 

structure. To check the quality of the performance calculations, increase (or reduce) the 

number of layers and calculate the performance again. If there is little or no change in 

performance, then the number of layers is sufficient. 

The Packing Density Formula is used to enter a set of statements that specify how the 

packing density varies through the set of layers. The formula consists of one or more 

statements. Each statement consists of an optional Condition, and an Assignment. A 

Condition is specified by an Expression followed by a colon (“:”) An Assignment is a 

Variable name followed by an equal sign (“=”) followed by an Expression and ends with 

a semi-colon (“;”). Any text after an exclamation point (“!”) is ignored up to the end of 

the line.  
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When a rugate structure is being generated, the statements in the Packing Density 

Formula are executed in order from top to bottom. If a statement has a Condition, then 

the Assignment is only executed if the value of the Expression in the Condition is not 

zero. If the statement does not have a Condition, then the Assignment is always executed. 

The Assignment calculates the value of the Expression and stores the value in the 

Assignment Variable. Variables are automatically created if they do not already exist. 

There are several special variables: 

L The current layer number. This variable cannot be modified. 

The first layer is numbered 1 and the last layer has the value N. 

N The number of layers as entered in the Number of Layers box. 

This variable cannot be modified. 

TotalThickness Total Thickness as entered in the Total Thickness box. This 

variable cannot be modified. 

LayerThickness The Thickness of one layer: (TotalThickness / N). This 

variable cannot be modified. 

Thickness Cumulative Thickness to center of current layer: (L-1) * 

LayerThickness + LayerThickness / 2. This variable cannot 

be modified. 

ReferenceWavelength Reference Wavelength as entered in the Reference Wavelength 

box. This variable cannot be modified. 

PackingDensity The Packing Density of the current layer. After all the 

statements have been executed, the current layer’s packing 

density will be the value of this variable. This variable can be 

modified. 

 

The following operators are supported in Expressions: 

 

 ()     sub-expressions 

^     power 

*, /     multiplication, division 

%     modulus (remainder) 

\     integer divide 

+, -    addition, subtraction 

>, >=, <, <=, <> logical comparison 

&, |     logical "and", logical "or" 

 

An operator that is listed on a line above another operator has a higher precedence. 

The following functions are also supported (they are not case sensitive): Abs, Sin, Cos, 

Tan, ACos, ASin, Atn, Log, Log10, Exp, Sqr, Int, Frac, Ceil, and Floor. Trigonometric 

functions accept and return angles expressed in radians or degrees, depending on the 

setting of Angle Units. 

For example, the formula: 
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PackingDensity = (1 + sin(360 * L/N))/2; 

generates a rugate structure consisting of a single period of a sine wave. 

Click Preview to generate an index profile plot of the rugate structure. This allows 

you to verify that the correct structure has been generated. The rugate structure can be 

made available to the design in two ways: Clicking Generate will put the layers of the 

rugate structure onto the clipboard. These layers can be pasted into any design in the 

normal way. Clicking Replace Design will cause the current design’s layers to be 

completely replaced with the layers of the rugate structure. Selecting a variable name in 

the Packing Density Formula and then clicking Plot Value will display a plot showing the 

value of the variable as a function of thickness. This is useful for making sure that the 

variable’s value is set correctly during rugate generation. 

Here is a more complicated example. In this example, we want to generate the 

following refractive index profile: 

 
 

There are three parts to this rugate. The first part is the rise in refractive index from 

1.0 to 1.7. This is achieved by the first 90 degrees of a sine wave profile. The second part 

is a sine wave profile of 32 cycles modulated by a half sine wave profile. The last part is 

a fall in refractive index from 1.7 to 1. This is achieved by the following Generate Rugate 

form: 
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The first four lines set up the three parts of the rugate. The first and last parts are each 

one tenth of the total thickness and the second part is eight tenths of the total thickness. 

InFirstPart is 1 during the first tenth and 0 elsewhere. InLastPart is 1 during the last 

tenth and 0 elsewhere. InMiddlePart is 1 when both InFirstPart and InLastPart are 0 

and 1 elsewhere. Selecting InMiddlePart and then clicking Plot Value gives the 

following plot: 

 
 

ProportionOfFirstPart, ProportionOfMiddlePart and ProportionOfLastPart start 

at 0 and linearly increase to 1 in each appropriate part. 

The envelope for the middle part is generated by a sine function that uses 

ProportionOfMiddlePart to generate an angle that varies from 0 to 180 degrees. 
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The periodic component is generated by another sine function whose period is one 

half an optical thickness. The periodic component is scaled so that it varies from –0.5 to 

+0.5 – a total range of 1. 

The last three statements generate the packing density variation. These statements use 

the Condition component to control which statement provides the packing density as a 

function of thickness. For the first part, the first 90 degrees of the sine function are used 

to raise the packing density from 0 to 0.5 (the midpoint of the packing density range used 

here). In the middle part, the periodic component is multiplied by the envelope and the 

result is then shifted up by 0.5 to give a packing density that varies from 0 to 1. The last 

part is generated by a sine function starting at 90 degrees and reducing to 0. 

Generating Complex Designs 

In the Essential Macleod, the Formula tool is used to generate designs with regular 

features. Some designs have more complex features that cannot be expressed by using 

Formula, such as chirped reflectors. For these designs, the Generate Design tool can be 

used to generate the layers in the design. 

 
 

A Generate Design definition consists of default layer parameters represented by 

single letter symbols, the number of layers in the design and a Formula that specifies the 

parameters of each layer as a function of layer number. 

The Formula is used to enter a set of statements that specify how the layer parameters 

vary through the set of layers. The formula consists of one or more statements. Each 

statement consists of an optional Condition, and an Assignment. A Condition is specified 

by an Expression followed by a colon (“:”) An Assignment is a Variable name followed 

by an equal sign (“=”) followed by an Expression and ends with a semi-colon (“;”). Any 

text after an exclamation point (“!”) is ignored up to the end of the line.  

When a design is being generated, the statements in the Formula are executed in order 

from top to bottom. If a statement has a Condition, then the Assignment is only executed 

if the value of the Expression in the Condition is not zero. If the statement does not have 

a Condition, then the Assignment is always executed. The Assignment calculates the value 

of the Expression and stores the value in the Assignment Variable. Variables are 

automatically created if they do not already exist. There are several special variables: 
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L The current layer number. This variable cannot be 

modified. The first layer is numbered 1 and the last 

layer has the value N. 

N The number of layers as entered in the Number of 

Layers box. This variable cannot be modified. 

OpticalThickness The total optical thickness of the design excluding the 

current layer. This variable cannot be modified. 

PhysicalThickness The total optical thickness of the design excluding the 

current layer. This variable cannot be modified. 

LayerOpticalThickness The optical thickness of the current layer. 

LayerPhysicalThickness The physical thickness of the current layer. 

LayerLocked The lock state of the current layer. A value of 0 means 

the layer is not locked. A value of –1 means the layer is 

locked. 

LayerLink The link number of the current layer. 

LayerPackingDensity The Packing Density of the current layer. 

LayerVoidDensity The Void Density of the current layer. 

LayerN The refractive index of the current layer. This variable 

cannot be modified. 

LayerK The extinction coefficient of the current layer. This 

variable cannot be modified. 

MaterialN The refractive index of the current layer material. This 

variable cannot be modified. 

MaterialK The extinction coefficient of the current layer material. 

This variable cannot be modified. 

VoidMaterialN The refractive index of the current layer void material. 

This variable cannot be modified. 

VoidMaterialK The extinction coefficient of the current layer void 

material. This variable cannot be modified. 

Layer This is used to initialize the parameters of the layer. It 

should be used before any layer parameters are 

modified. 

Thickness Cumulative Thickness to center of current layer: (L-1) 

* LayerThickness + LayerThickness / 2. This 

variable cannot be modified. 

ReferenceWavelength Reference Wavelength as entered in the Reference 

Wavelength box. This variable cannot be modified. 
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PackingDensity The Packing Density of the current layer. After all the 

statements have been executed, the current layer’s 

packing density will be the value of this variable. This 

variable can be modified. 

InhomogeneityFactor The Inhomogeneity Factor of the current layer. After all 

the statements have been executed, the current 

inhomogeneity factor will be the value of this variable. 

This variable can be modified. 

MinimumPhysicalThickness The Minimum Physical Thickness for the current layer. 

After all the statements have been executed, the current 

layer’s minimum physical thickness will be the value of 

this variable. This variable can be modified. 

MaximumPhysicalThickness The Maximum Physical Thickness for the current layer. 

After all the statements have been executed, the current 

layer’s maximum physical thickness will be the value 

of this variable. This variable can be modified. 

MinimumOpticalThickness The Minimum Optical Thickness for the current layer. 

After all the statements have been executed, the current 

layer’s minimum optical thickness will be the value of 

this variable. This variable can be modified. 

MaximumOpticalThickness The Maximum Optical Thickness for the current layer. 

After all the statements have been executed, the current 

layer’s maximum optical thickness will be the value of 

this variable. This variable can be modified. 

 

The following operators are supported in Expressions: 

 

 ()     sub-expressions 

^     power 

*, /     multiplication, division 

%     modulus (remainder) 

\     integer divide 

+, -    addition, subtraction 

>, >=, <, <=, <> logical comparison 

&, |     logical "and", logical "or" 

 

An operator that is listed on a line above another operator has a higher precedence. 

The following functions are also supported (they are not case sensitive): Abs, Sin, Cos, 

Tan, ACos, ASin, Atn, Log, Log10, Exp, Sqr, Int, Frac, Ceil, and Floor. Trigonometric 

functions accept and return angles expressed in radians or degrees, depending on the 

setting of Angle Units. 

For each layer generated, the formula must perform a layer initialization as follows: 

 Layer = <symbol> 
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Where symbol is a defined symbol in the table shown at the top of the form. 

For example, the formula: 

Odd = ((L % 2) =1); 

Even = ((L % 2) = 0); 

Odd: Layer = L; 

Even: Layer = H; 

will generate an design of alternating H and L layers with no modifications to the 

layer parameters. 

Click Preview (Optical) to generate an index profile plot of the design as a function of 

optical thickness. Click Preview (Physical) to generate an index profile plot of the design 

as a function of physical thickness.  These commands allow you to verify that the correct 

structure has been generated. The design can be made available in two ways: Clicking 

Generate will put the layers of the design onto the clipboard. These layers can be pasted 

into any design in the normal way. Clicking Replace Design will cause the current 

design’s layers to be completely replaced with the layers of the formula. Selecting a 

variable name in the Formula and then clicking Plot Value (Optical) or Plot Value 

(Physical) will display a plot showing the value of the variable as a function of optical 

thickness or physical thickness respectively. This is useful for making sure that the 

variable’s value is set correctly during design generation. 

This example shows the implementation of an amplitude thickness modulated design 

presented in Chapter 3 of “Thin Film Design Modulated Thickness and Other Stopband 

Design Methods by Bruce E. Perilloux ISBN: 0-8194-4525-8 Pub SPIE Press 2002. The 

function for modulating the thickness is given as: 

𝑇(𝐿) = 𝑇𝐴𝑉𝐺 [1 + 𝑘′ sin(2𝜋𝑓1𝐿) cos(2𝜋𝑓𝐿)] 

In the Generate Design tool, this function appears as:  

Pi = 3.1415926; 
k = 0.5; 
f = 0.358; 
f1 = 0.02; 

(L % 2) = 1: Layer = H; 
(L % 2) = 0: Layer = L; 

LayerOpticalThickness = LayerOpticalThickness * (1 + k* sin(2 * Pi * f1 * L) * cos(2 * Pi * f* 
L )); 

The first four lines define constants for the formula. The next two lines specify that 

the design is made from alternating layers of H and L material. H material is used on the 

odd numbered layers and L material is used on the even numbered layers. The final line 

performs the modulation function. The optical thickness of the layer is modified by the 

modulation function. 

A 50 layer design using Ta2O5 for the H material and SiO2 for the L Material, with 

the optical thickness in the table set at 0.25 at a reference wavelength of 1000nm 

produces the following reflectance performance: 
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Contexts 
Contexts are used to specify the behavior of Agile Materials. An Agile Material is a 

material whose optical constants depend upon the Context. An Agile Material has a name 

and for each Context, a material name. When a calculation is performed using a particular 

Context, the optical constants of the agile material are those of the corresponding material 

in the Context. 

Contexts are used during performance calculation and during refinement. Using 

Contexts, it possible to refine designs for production on multiple substrates, refine 

designs for production using a range of different real materials. This includes producing a 

single design for manufacture in coating plants that produce different optical constants 

for the same raw material. 
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The design above is an antireflection coating that has been optimized for Glass and 

Silica substrates. This Design has one agile material: Substrate. To see the specifications 

for Substrate, click on the Context tab. 

 
 

The Context that is shown is the Normal context. In this Context, the Agile Material 

Substrate has the optical constants of the material Glass. You can use the dropdown 

arrow to select a different Context.  

 
 

In the Context named Alternative, the Agile Material Substrate has the optical 

constants of the Material SiO2. By specifying different contexts, the properties of the 

coating on Glass and on SiO2 can be calculated. The performance parameters dialog 

(Parameters menu -> Performance) allows you to specify a Context when calculating 

performance, so, for example, you can display the performance of the coating on both 

substrates on a single plot. 
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A Context can also be specified for each target in a refinement specification. To show 

the Context, select Display Setup from the File menu when the Targets window is active. 

Select the Context item and then click Close. You can now set the Context for each 

target.  

A Design always has one Context. When a design is created, this Context is named 

Normal. You can add Contexts to a design by clicking the Add button in the Context tab. 

Enter the name of the new Context in the dialog that appears and click OK. Agile 

Materials are entered by typing the desired name in the Agile Material column. The 

optical constants to be used for the displayed Context are selected by choosing from the 

drop list in the Material column. There is no restriction to the number of Agile Materials 

that may be defined in a design. 

In the Design editor, the Agile Materials are displayed at the top of the materials list.  

The displayed optical constants are those of the first Context. Contexts are only used in 

the Design editor. In the rest of the Essential Macleod where a design file is used, the first 

Context is used to specify the optical constants of the Agile Materials., the other Contexts 

are not used. 

Inhomogeneity Factor 
Inhomogeneity is a variation of optical properties across the film, most commonly in 

terms of the refractive index. There is no general analytical solution to the calculation of 

the effects of inhomogeneity. Accurate calculation involves the representation of the 

variation as a series of thin discrete layers of appropriately varying properties. Two tools 

that assist in preparing for such precise calculations are Graded Layers and Generate 

Rugate… However, implicit in the use of these tools is the existence of many additional 

layers, hidden in the case of Graded Layers, that add time to the calculations. There are 

many occasions when the inhomogeneity represents only a quite small correction to the 

properties of a discrete layer and a calculation technique with no reduction in speed is 

appropriate. This is the purpose of the inhomogeneity factor. The use of this factor 

involves a small modification to the basic characteristic matrix for the thin film rather 

than its replacement by a series of layers. This permits rapid calculation in Reverse 

Engineer and in the refinement and synthesis tools. 
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The change in refractive index across the layer is given by Inhomogeneity Factor * Layer 

Refractive Index. The refractive index at the medium end of the layer is given by Layer 

Refractive Index * (1 - Inhomogeneity Factor/2). The refractive index at the substrate end 

of the layer is given by Layer Refractive Index * (1 + Inhomogeneity Factor/2). A 

positive inhomogeneity factor indicates that the refractive index is increasing in the 

direction of the substrate. A negative inhomogeneity factor indicates that the refractive 

index is falling in the direction of the substrate. 

The model used to calculate the effects of the inhomogeneity is based on that given 

by: Abelès F., 1950 “Recherches sur la propagation des ondes electromagnetiques 

sinusoïdales dans les milieus stratifies. Application aux couches minces.” Ann Phys. 5 

pp596-640. It must be emphasized that this model involves some important limitations. 

The effect of the inhomogeneity must be small compared with the other interference 

properties of the layer and the variation of index through the layer should be slow and 

uniform to avoid any additional influence of the actual profile. Then the Abelès model 

cannot handle inhomogeneities in layers less than a quarterwave in optical thickness and 

so our model must accommodate a switch when a layer becomes less than that. A 

discontinuity that appears at around a quarterwave thickness of the appropriate layer is a 

sign that the model is being used outside its range of validity and that one of the 

alternative and precise techniques already mentioned must be used instead. In most cases 

an inhomogeneity factor in the range ±0.2 will be found to work well. Care should be 

exercised with larger factors. 

Thick Layers  
In a design, thin layers support coherent beam combination. Thick layers support 

incoherent beam combination, that is, there is no interference between the beams in a 

thick layer. A thick layer in a Design is identical to a medium in a Stack (see the Stack 

chapter for more information). In a Stack, it is possible to specify a Substrate – this 

defines the internal transmittance of the medium. The name of the substrate need not be 

the same as the name of the medium material. When a thick layer is used in a design, the 

name of the Substrate must be the same as the name of the Material. During calculations, 

if a Substrate of the same name as the Material cannot be found, a warning message is 

displayed and the thick layer will be assumed to be lossless, that is, it has an internal 

transmittance of 100%. A thick layer may be either Parallel or Wedged. A Parallel thick 

layer includes the complete infinite series of backward and forward propagating beams. 

A Wedged thick layer only includes the beam that passes straight through and the beams 

that are reflected just once at each surface. When a design contains one or more thick 

layers the calculations available are restricted to those available for a Stack and the 

Analysis functions are no longer available.  

To create a thick layer in a Design, the Medium Type and Medium Thickness columns 

must be visible. To display these columns, use File -> Display Setup -> to make them 

visible. If the Medium Type is blank, this means that the layer is a normal thin layer. 

When Medium Type shows Parallel or Wedged, then the layer is treated as a thick layer 

with the appropriate beam combination. The thick layer thickness is entered in the 

Medium Thickness column. Note that a thick layer of zero thickness breaks the beam 

coherency between any surrounding thin layers, that is, it can be regarded as being 

lossless with a thickness whose actual value is unimportant. 
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As an example the design below shows the Four Layer AR design on a Glass substrate 

with Air as the emergent medium. 

 
 

This models a slab of glass 1mm thick with the AR coating applied to one side. To 

model the coating applied to both sides of the thick layer, the thin layers can be copied 

and pasted to the other side of the thick layer. To correctly orient the pasted layers they 

will need to be selected and reversed using the Reverse Layers command in the Edit 

menu. 

 
 

The plot below shows the transmittance of the three designs. The “No second surface” 

curve shows the performance of the design only with no thick layer, that is, it shows the 

transmittance into the substrate. The “Coated on one side” curve shows the transmittance 

of the glass substrate with the coating applied to one surface. This is the transmittance 

you would expect to measure. The “Coated on both sides” curve shows the glass 

substrate with the coating applied to both surfaces. 
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To extract a contiguous set of thin layers from a design containing thick layers, select 

a layer in the contiguous set and then select the Create Design command in the Edit 

menu. This will create a new design containing the contiguous layers. The Medium and 

Substrate are set to the surrounding thick layers in the original design. The design below 

shows the result of Create Design when layer 8 of the double-sided design above was 

selected. Note that the orientation of the layers is the same as in the source design. To 

change the orientation of the design, use the Reverse Design command in the Edit menu. 

With the thick layers removed, the Analysis commands and phase calculations can now 

be performed. 

 
 

Graded Layers  
A graded layer provides a smooth transition in refractive index (and optionally 

extinction coefficient) from one layer to the next. This smooth transition can be used to 

model inter-layer diffusion and rough surfaces provided that the scale of the roughness is 

much smaller than the shortest wavelength of interest. The only parameter that can be 

specified for a graded layer is its thickness. The thickness may be specified as a physical 

thickness, an optical thickness or a geometric thickness. The layers surrounding the 
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graded layer define the optical constants at each end of the graded layer. The optical 

constants vary linearly with physical thickness from one end of the graded layer to the 

other. 

A layer is specified as graded in the Medium Type column. If this column is not 

visible in the Design window, use File -> Display Setup -> Medium to make it visible. 

To make a layer graded, select Graded in the Medium Type cell. For example, the 

Design window below shows a silicon substrate with a 40nm thick graded interface to air. 

 
 

 

The plot below compares the reflectance of the graded interface to the simple abrupt 

interface. 

  
 

Scatter Layers  
A scatter layer models the effect of rough layers on the specular performance of a 

design. There are two type of scatter layers available: a short range scatter layer denoted 

Scatter(s) and a long range scatter layer denoted Scatter(l).  

The short range scatter layer models scattering that would be seen where the 

roughness of the layer is very small compared to the wavelengths of interest. This is 

achieved by using a graded layer. The difference between the Scatter(s) layer and the 
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graded layer described above is that during calculations, the thickness of the Scatter(s) 

layer is removed from the preceding layer (in the direction of the substrate). Thus you do 

not have to alter the non-scattering part of the design when adding the scatter layers. 

Accordingly, the thickness of the scatter layers does not appear in the total thickness for 

the design.  

The long range scatter layer models scattering according to “Single-layer model for 

surface roughness” by C. K. Carniglia and D.G. Jensen in Applied Optics Volume 41 

Number 16 June 2002. In this model, the scatter layer uses an intermediate material with 

extinction coefficient to reduce both transmittance and reflectance. Again the thickness of 

the scatter layer is removed from the thickness of the preceding layer during calculations. 

A layer is specified as a scatter layer in the Medium Type column. If this column is 

not visible in the Design window, use File -> Display Setup -> Medium to make it 

visible. To make a layer a scatter layer, select Scatter(s) in the Medium Type cell for a 

short range scatter layer and Scatter(l) for a long range scatter layer. For example, the 

Design window below shows a quarterwave stack with scatter layers at each layer 

interface. The thickness of each scatter layer should be set to twice the rms roughness. 

The Edit menu for the Design window contains commands for quickly adding and 

removing scatter layers from a design. 

 
 

The plot below compares the reflectance of the quarterwave stack with short range 

scatter and long range scatter using an rms roughness of 5 nm (that is a layer thickness of 

10 nm) for each layer 
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PLOT WINDOW 
The Plot window is where the plots are produced. Several of these may be open at any 

one time. They may also be reduced to icons by using the minimize button. 

The package uses adaptive plotting so that it tries to include all the fringes, even very 

tight ones, in a plot.  

When the plot window is active you can hold down the <Alt> key and use the left 

mouse button to display markers on the plot and have x -and y- coordinates of the 

markers displayed on the plot. If you wish to remove the markers, click Clear Cursor in 

the Edit menu, or right –click on the mouse when it is over the plot and select Clear 

Cursor from the menu that appears. 

A plot can be dragged from one plot window to another. Dragging a plot and dropping 

it onto another plot window adds the dragged plot to the plot contained in the destination 

window. Columns of tables can also be dragged onto a plot. See the table window chapter 

for more details. 

Plot Zoom 
To zoom in to a particular area of a plot, hold the <Shift> down and whilst holding 

down the left mouse button, drag the mouse to define the zoom area. When you release 

the left mouse button, the plot will be redrawn so that the zoom area fills the plot. To 

reset the plot so that it shows all the data, press the letter ‘r’ on the keyboard. 

Modifying the Plot 
The appearance of an individual trace can be modified by placing the mouse over the 

trace and then double-clicking. This will display the Edit Trace window. 

 
 

The Line Style box controls the appearance of the trace on the plot. The pattern, width 

and color of the line may be altered here.  
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The Symbol Style box controls the appearance of symbols on the plot. There is a 

symbol for each data point of a trace. In general it is not useful to display symbols for 

lines generated by the software, there will be too many of them and they will obscure the 

display.  

In the Trace box Label allows you to edit the text data displayed in the legend. 

Selecting Hidden causes the trace to be removed from the display. If the axes are 

automatically scaled, then the data from the hidden trace will still be used in determining 

the scales. All hidden traces can be restored by selecting Show all Hidden Traces in the 

Edit menu of the plot. 

Selecting Excluded causes the trace to be removed from the display and for 

automatically scaled axes excludes the data from being used to determine the scales. All 

excluded traces can be restored by selecting Show all Excluded Traces in the Edit menu 

of the plot. 

Selecting Y2 causes the trace to be attached to the second axis, and selecting Y1 

causes it be attached to the first axis. 

The plot title can be edited either by double-clicking on the title, or by right-clicking 

the mouse when it is in the plot and then selecting Edit Header. The following window is 

displayed: 

 
 

The plot can also have text at the bottom of the plot. This can be modified either by 

double-clicking on it or by right-clicking on the mouse when it is in the plot area and then 

selecting Edit Footer. A window similar to the Edit Header window will appear. 

A plot may also have a legend. The legend provides extra textual information about 

each trace on the plot. The appearance of the legend may be controlled by either double-

clicking on the legend, or by right-clicking the mouse when it is in the plot area and 

selecting Edit Legend from the menu that appears. 
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A title can be given to the legend. The position and layout of the legend are controlled 

by the Anchor and Orientation settings. 

Labels can be added to the plot in two ways : A label can be added by moving the 

mouse to the location in the plot area where the label is to appear, then right-clicking will 

display the context menu. Selecting Add Label… will show the Add Label dialog. 

 
 

The Add Label dialog allows you to enter the text to be displayed in the Label box, 

adjust the x and y location and control the label position with respect to the x and y 

location. The x and y location are given in terms of the plot’s axes. If the plot has two Y 

axes, then the Y Axis drop down list can be used to choose the Y axis to which the Y 

value refers. The label position is controlled by Offset Direction and Offset. Offset 

Direction controls the direction in which the label is moved and Offset controls the 

distance. If Label is Connected is checked, a line is drawn from the label to the x,y 

location. Click the Apply button to add the label to the plot. Once the label has been 

added to the plot, you will be able to change the font. 

When the plot cursor is active, you can also right-click in the plot and select Add 

Cursor as Label… This will add a label to the plot showing the current cursor co-

ordinates. 
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Labels can also be edited once they have been added to the plot. To edit a label, 

double-click on the label. The Edit Label dialog will appear. It has the same appearance 

as the Add Label dialog. 

The position of a label can also be changed by dragging it on the plot. To drag, move 

the mouse over the label and then hold the left mouse whilst moving the label to the 

desired position. For labels that have an Offset Direction of Home, the label can be 

dragged anywhere in the plot area. For other labels, the label is restricted to lie along one 

of eight compass directions (North, South, East, West, Northeast, Southeast, Northwest, 

Southwest) from the point that it is labeling, but the distance is continuously variable. 

 

Statistics 
Statistical properties of the traces displayed on the plot can be calculated by right-

clicking on the plot and selecting the Statistics command.  First the X-axis range over 

which the statistics will be calculated must be selected. To do this, move the mouse to 

one end of the desired range.  As you move the mouse around the plot, the bottom of the 

plot will show the current x co-ordinate. When the mouse is in the correct position, drag 

the mouse using the left button to the other end of the desired range. As you are dragging 

the mouse, the bottom of the plot will show the current x co-ordinate. Also a rectangle 

will appear on the plot. The vertical sides of the rectangle show the current x axis range. 

The horizontal sides of the rectangle are not used by the statistics command. When the 

mouse is in the correct position, release the mouse button. 
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The Statistics dialog will now appear. The selected x range is shown at the top of the 

dialog. If the values are not correct or need some adjustment, you can change the values. 

 
 

The statistics to be calculated are selected beneath the range dialog. Maximum Value, 

Minimum Value and Average Value calculate the maximum Y value, minimum Y value 

and mean Y value respectively over the X range for each trace on the plot.  

Absolute Points will find all the locations on each trace where the trace has the value 

Y Value. If Create Attached Labels is checked, each absolute point will be marked with 

a label showing the co-ordinate of that point; otherwise each x-axis value will appear in 

the statistics results. 

Bandwidth will calculate the bandwidth of a pass-band region on the plot. The Y 

value at which the bandwidth is calculated is a function of the Measure At value. When Y 
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has  Log Scale is not checked, the Y Value is calculated by multiplying the maximum Y 

value in the range by the Measure At value. Thus, to calculate the FWHM value, the 

Measure At value should be 0.5. When Y has Log Value is checked, the Y value is given 

by the difference between the maximum Y value and the Measure At value. So to 

calculate FWHM on a log plot where the Y axis is in dB units, the Measure At value 

should be -3 (the sign of the Measure At number is ignored). 

Once the desired statistics options have been set, click Calculate to generate the 

statistics. If Absolute Points has been selected and Create Attached Labels has been 

selected, the absolute point labels will appear on the plot. The results of the other 

statistics calculations will appear in the Results box. The information in this box can be 

edited. Click the Create Label button to add the contents of the box to the plot. The 

information will placed in the top right corner of the plot, but can be dragged to any other 

location after the Statistics dialog has been closed. 

 
 

File Menu (Plot) 
The Plot Window File Menu is similar to the Design Window File Menu except that 

there are three additional items, Add Line..., Add Point.... and Export. 

 

Add Line... 

This command is used to add to the plot a further curve derived from an existing plot 

or a table column. The plot or table must be already saved in a plot or table file. Selection 

of the command presents a dialog box for selection of the file for plotting. If a plot file is 

concerned the program will then plot the curve or curves over the existing one. If a table 

is chosen then it will first be presented for selection of the particular column. (See Plot 

Column below for more information). The plot derived from a table will always first be 

presented with symbols to mark the points. An alternative to the Add Line command is to 

drag and drop a plot from one window to another. In this case, neither plot needs to have 

been saved beforehand. 
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Add Point... 

Add Point... is similar to Add Line but the file to be selected is a table file that 

contains a set of single values (chromaticity coordinates for example). The program 

assumes that the first two points are, respectively, the horizontal (independent) coordinate 

and the vertical (dependent) coordinate. These define a point that is plotted provided it 

lies within the axes. Should the table file have several columns, the column selection box 

will be presented. The point will then take the first value and second value in the column 

and plot the corresponding point. The principal use of this procedure is in plotting single 

results from the Function Enhancement such as chromaticity coordinates. 

Export 

Export has a sub-menu with two entries Tab separated text and Comma separated 

values.  Both of these options create files containing the data shown in the plot, The Tab 

separated plot form uses a tab character in between the values and the Comma separated 

value form uses a comma to separate the values. The comma separated value form is best 

used when the data are to be imported into a spreadsheet. 

Edit Menu (Plot) 

Parameters... 

The Parameters... menu item presents a dialog box that applies to the active plot. 

This dialog provides control over the presentation of the plot. Many aspects of the plot 

may be modified. A help system is provided to guide you through the various options. 

Any changes made to the plot do not alter the data corresponding to the plot. There is no 

recalculation. For instance if the horizontal axis corresponds to incident angle then even 

though the title of the axis is changed to wavelength, the data will still refer to incident 

angle and the plot will not change. If the values along the axes are changed then the data 

will be replotted according to the new values. Again it will not be recalculated. If data 

does not exist corresponding to some of the values then that part of the plot will be 

missing.  

Copy 

This command, as it does with other windows, copies the contents of the window to 

the clipboard from which it can be pasted into any other application. Note that what is 

stored on the clipboard is the plot itself and not the data. The plot file produced by the 

program stores the actual data used to create the plot. 

One to One Aspect Ratio 

One to One Aspect Ratio is used only in plots where it is important to have the axes 

with the same scale factor. These are primarily in some of the Analysis tools where it is 

important that circles should remain circles and not be converted to ellipses. In the bulk 

of the core Essential Macleod the checking of the box has no effect. 

Clear Cursor 

If the cursor has been enabled by holding down the <Alt> and dragging the mouse 

with the left button pressed, then selecting this command will remove the cursor from the 

plot. 
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Apply Template… 

This command applies the background and font parameters of a previously saved plot 

to the current plot without affecting the data in the plot.  

For example, the picture below shows a reflectance plot from a Quarter-Half-Quarter 

AR design. 

 

 

The next picture shows a saved plot with modified background and title font. 

 

 

The final picture shows the result of applying the template to the QHQ plot. 
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Identify Y Axes 

Selecting this menu option will cause the y axes to be identified using the identifiers 

defined on the Plotting tab of the General Options window (from the Options menu, 

select General) 

Unidentify Y Axes. 

Selecting this menu option will cause any recognized axis identifiers to be removed 

from the Y-axis titles and from the legend 
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3D PLOT WINDOW 
3D plots are shown in a 3D Plot window. Several of these may be open at any one 

time. They may also be reduced to icons by using the minimize button. 

When the plot window is active you can hold down the <Alt> key and use the left 

mouse button to display x -, y- and z- coordinates of the nearest point on the plotted 

surface to the current cursor position. If you wish to remove the co-ordinate display, click 

Clear Cursor in the Edit menu, or right –click on the mouse when it is over the plot and 

select Clear Cursor from the menu that appears. 

Plot Rotate 

To rotate the plot, hold both mouse buttons down (or the middle button on a 3-button 

mouse) and move the mouse in the desired direction. The rotation can be constrained to 

be about a particular axis by holding down the x or y or z or e key and then moving the 

mouse perpendicular to the axis. 

Plot Translate 

The position of the plot in the window can be moved by holding down the <Shift> 

key, holding down both mouse buttons down (or the middle button on a 3-button mouse)  

and moving the mouse to the new location. To reset the position of the plot back to its 

default location, press the ‘r’ key on the keyboard. 

Plot Scale 

The size of the plot in the window can be changed by holding down the <Ctrl> key, 

holding down both mouse buttons down (or the middle button on a 3-button mouse) and 

moving the mouse down to increase the chart size or up to decrease the chart size. To 

reset the position of the plot back to its default location, press the ‘r’ key on the keyboard. 

Plot Zoom 

To zoom in to a particular area of a plot, hold the <Ctrl> down and whilst holding 

down the left mouse button, drag the mouse to define the zoom area. When you release 

the left mouse button, the plot will be redrawn so that the zoom area fills the plot. To 

reset the plot so that it shows all the data, press the letter ‘r’ on the keyboard. 

 

The plot title can be edited either by double-clicking on the title, or by right-clicking 

the mouse when it is in the plot and then selecting Edit Header. The following window is 

displayed: 
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The plot can also have text at the bottom of the plot. This can be modified either by 

double-clicking on it or by right-clicking on the mouse when it is in the plot area and then 

selecting Edit Footer. A window similar to the Edit Header window will appear. 

A plot may also have a legend. The legend provides extra textual information about 

each trace on the plot. The appearance of the legend may be controlled by either double-

clicking on the legend, or by right-clicking the mouse when it is in the plot area and 

selecting Edit Legend from the menu that appears. 

 
 

A title can be given to the legend. The position and layout of the legend are controlled 

by the Anchor and Orientation settings. 

File Menu (3D Plot) 
The 3D Plot Window File Menu is similar to the Design Window File Menu except 

that there is an additional item, Export. 

 

Export 

Export has a sub-menu with two entries Tab separated text and Comma separated 

values.  Both of these options create files containing the data shown in the plot, The Tab 

separated plot form uses a tab character in between the values and the Comma separated 

value form uses a comma to separate the values. The comma separated value form is best 

used when the data are to be imported into a spreadsheet. 
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Edit Menu (3D Plot) 

Parameters... 

The Parameters... menu item presents a dialog box that applies to the active plot. 

This dialog provides control over the presentation of the plot. Many aspects of the plot 

may be modified. A help system is provided to guide you through the various options. 

Any changes made to the plot do not alter the data corresponding to the plot. There is no 

recalculation. For instance if the horizontal axis corresponds to incident angle then even 

though the title of the axis is changed to wavelength, the data will still refer to incident 

angle and the plot will not change. If the values along the axes are changed then the data 

will be replotted according to the new values. Again it will not be recalculated. If data 

does not exist corresponding to some of the values then that part of the plot will be 

missing.  

Copy 

This command, as it does with other windows, copies the contents of the window to 

the clipboard from which it can be pasted into any other application. Note that what is 

stored on the clipboard is the plot itself and not the data. The plot file produced by the 

program stores the actual data used to create the plot. 

Clear Cursor 

If the co-ordinate display has been enabled by holding down the <Alt> and dragging 

the mouse with the left button pressed, then selecting this command will remove the co-

ordinate display from the plot. 

Apply Template… 

This command applies the background and font parameters of a previously saved plot 

to the current plot without affecting the data in the plot.  

For example, the picture below shows a reflectance plot from a Quarter-Half-Quarter 

AR design. 
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The next picture shows a saved plot with modified background and title font. 

 

 

The final picture shows the result of applying the template to the QHQ plot. 
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ACTIVE PLOT WINDOW  
The Active Plot window is an extension of the capabilities of the Plot window. It is 

available for performance and analysis parameters of Designs. The Active Plot window 

allows you to immediately observe the effects of changing parameters of the design. To 

use the Active Plot, you first add variables to the Active Plot window. These represent 

the Design parameters that you wish to be able to change. You can then use the buttons 

associated with each variable to adjust the value of the variable. The plot will be updated 

each time a variable changes value. The Active Plot allows you to save the current 

Design back into the design window or copy it to the clipboard. You can also freeze the 

current plot. This means that the next time a variable changes value a new set of curves 

will be drawn on the plot rather than changing the existing curves. 

Start Active Plot by clicking the Active Plot button. The Active Plot button is located 

on the Performance dialog in the Parameters menu of the Design window and the 

Analysis parameters dialogs in the Analysis sub-menu of the Tools menu of the Design 

window. You can also start an Active Plot from the Performance menu of the Design 

window.  

Active Plot supports multiple plot windows. Starting another Active Plot will create 

another Active Plot window. This window does not include the variables. Changing the 

variables in the first Active Plot window will update the additional Active Plot windows 

as well as the first Plot Window. 

The additional capabilities of the Active Plot window are described below. The Active 

Plot window also supports the capabilities of the Plot window. See the Plot Window 

chapter for more information on the Plot window capabilities. 

Active Plot Display 
There are two sections to the Active Plot display. The top section contains the plot and 

the bottom section contains the variables. When the Active Plot is opened for the first 

time for a design, the bottom section is empty. 
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The Active Plot window has two extra menu items when compared to the Plot 

window. These are the Add menu and the Active Menu. 

Variables are added to the window by selecting items from the Add menu (the Add 

menu is described in detail below). The figure below shows the Active Plot window after 

Incident Angle and Reference Wavelength variables have been added. 

 
 

For each variable added, a row is created in the bottom section of the window. The 

row contains several buttons and three text boxes. The left box shows the lower limit of 

the variable. The center box shows the current value of the variable. The right box shows 

the upper limit of the variable. The buttons provide the following actions: 

|< Moves the current value to the lower limit 

<< Moves the current value towards the lower limit by 10% of the difference 

between the limits (Fast Down). 

< Moves the current value towards the lower limit by 1% of the difference 

between the limits (Down). 

> Moves the current value towards the upper limit by 1% of the difference 

between the limits (Up). 

>>  Moves the current value towards the upper limit by 10% of the difference

 between the limits (Fast Up). 

>| Moves the current value to the upper limit 

Reset Changes the current value to the value that is in the design. 

Delete Removes the variable. 

After the current value of a variable has been changed, the plot will be updated to 

reflect the new performance. Note that changing the values of variables does not affect 
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the design in the Design window. The design is only modified when the Update Design 

command in the Active menu is selected (see below). 

You can change the values of the limits and the current value by typing in new values. 

When changing the current value, press <Enter> or click outside of the current value box, 

to update the plot. 

To change the size of the bottom section, move the cursor to the line between the two 

sections. The cursor will to a double-headed arrow. Now click and drag the line to the 

desired position. 

Add Menu 
This menu contains all the options for adding variables to the Active Plot window. 

Variables are always added to the end of the existing variables. 

Incident Angle 

Adds Incident Angle. As this variable is changed, the incident angle of the plot 

calculation will be changed. 

Reference Wavelength 

Adds Reference Wavelength. As this variable is changed, the reference wavelength of 

the design will be changed. 

Calculation Wavelength 

Adds Calculation Wavelength. As this variable is changed, the calculation wavelength 

of the plot calculation will be changed. 

Selected Layer Thicknesses 

This command will add a layer thickness variable for each selected layer in the 

Design. You do not have to have selected the layers before opening the Active Plot. You 

can go back to the Design window and change the selection before using this command. 

You can also use this command several times to add different groups of layers. 

All Layer Thicknesses 

This command will add a layer thickness variable for each layer in the Design. 

Selected Layer Packing Densities 

This command will add a layer packing density variable for each selected layer in the 

Design. You do not have to have selected the layers before opening the Active Plot. You 

can go back to the Design window and change the selection before using this command. 

You can also use this command several times to add different groups of layers. 

All Layer Packing Densities  

This command will add a layer packing density variable for each layer in the Design. 

Selected Layer Void Densities 

This command will add a layer void density variable for each selected layer in the 

Design. You do not have to have selected the layers before opening the Active Plot. You 
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can go back to the Design window and change the selection before using this command. 

You can also use this command several times to add different groups of layers. 

All Layer Void Densities  

This command will add a layer void density variable for each layer in the Design. 

Selected Layer Links 

This command will add a link variable for each selected layer in the Design. You do 

not have to have selected the layers before opening the Active Plot. You can go back to 

the Design window and change the selection before using this command. You can also 

use this command several times to add different groups of layers. Each link is only added 

once to the variable list, even though the link may have selected many times. This 

variable operates by multiplying the thicknesses of all the layers in the link by the current 

value. This is useful for examining, for example, the effect of tooling factor changes on a 

design’s performance. 

All Layer Links  

This command will add a link variable for each link in the Design. 

Selected Layer Material Densities 

This command will add a material packing density variable for each different material 

used in the selected layers of the Design. You do not have to have selected the layers 

before opening the Active Plot. You can go back to the Design window and change the 

selection before using this command. This variable operates by multiplying the packing 

densities of all layers using the material by the current value. This is useful for 

examining, for example, the effect of refractive index changes on a design’s performance. 

All Layer Material Densities  

This command will add a material packing density variable for each different material 

used in the Design. 

Selected Layer Void Material Densities 

This command will add a material void density variable for each different material 

used in the selected layers of the Design. You do not have to have selected the layers 

before opening the Active Plot. You can go back to the Design window and change the 

selection before using this command. This variable operates by multiplying the packing 

densities of all layers using the material by the current value. This is useful for 

examining, for example, the effect of refractive index changes on a design’s performance. 

All Layer Void Material Densities  

This command will add a material void density variable for each different material 

used in the Design. 

Taper Distance  

This command will add a taper distance variable. This is used to show how the design 

performance will change with uniformity errors. See the uniformity model (Page 24) for 

more information. 
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Active Menu 

Freeze 

The Freeze command saves the current plot curves and starts a new set of curves the 

next time a variable changes value.  

Update Design 

This command updates the design in the Design window with the design that has the 

performance shown in the Active Plot window. 

Copy Design 

This command copies the design that has the performance shown in the Active Plot 

window to the clipboard. 
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TABLE WINDOW 
The Table Window displays the results of a calculation in tabular form. The tables 

result from selection of the Table command in the Performance menu of the Design 

Window. By clicking on the Notes tab, you can add other textual information that will be 

stored with the table. Most of the menu items are ones that are already familiar. Some 

deserve further explanation. 

File Menu (Table) 

The File Menu is similar to that for the Design Window but there is one extra item, 

Plot Column.  

Plot Column 

Plot Column activates the plotting of results from a column in the table that is active. 

Select the column that is to be plotted by clicking in the header of the column, then select 

Plot Column from the File menu. 

 
 

The major difference between the plot produced from a table and a corresponding plot 

produced directly from a design is that the table interval may not be completely suitable. 

For example, fringes may be missed. To emphasize this the table data points are marked 

with crosses in the plot.  

At this stage the axes have been automatically assigned scales that correspond to the 

extent of the data. The plot is in a normal plot window with the normal plot window 

menu.  

Data from tables can be added to existing plots also by use of the Add command 

under the File menu when the plot window is active. For this operation the table must 

first have been saved as a table file. 
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A column of a table can also be added to a plot by using drag and drop. First, select 

the column to be added to a plot by clicking in the header for the column as for Plot 

Column. Next, move the cursor into the data of the selected column and drag to the plot 

that is to have the plotted data. When the cursor is inside the plot, release the mouse 

button to drop the column onto the plot. 

Edit Menu (Table) 
The Edit Menu is similar in most respects to other Edit Menus in the package. 

Commands that are significantly different either in name and/or function are listed below 

with a description of their action. 

Copy Table 

Copy Table places the table data onto the clipboard. Note that the data is held on the 

clipboard as tabular data and the format will depend on the nature of the application into 

which the results are pasted.  

Read Only 

Tables represent data that have been calculated and so there is a presumption that the 

data in a table are a true representation of performance as calculated. Editing of the table 

entries is something that should be entered into with extreme caution. The tables as they 

are generated are, therefore, arranged to be read only to discourage casual alteration. 

However, it may be necessary actually to alter some of the entries. This menu item 

permits the toggling of the read only status of the file. When a table is created by the 

New command the read only status is not set until the table is saved for the first time. 

Sort Ascending 

Sort Descending 

These commands sort the table rows into ascending or descending order for the 

selected column. This is especially useful for importing data where, for example, 

wavelength data is in descending order, and ascending order is required. To perform the 

sort, select a column by clicking in the column header and then select the appropriate 

command from the Edit menu. 
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Transpose… 

Sometimes the contents of a table of imported data might have the data arranged in 

rows instead of columns. The Transpose command can be use to swap the rows and 

columns. Selecting Transpose presents the following dialog box. 

 
 

Checking Column 1 contains headers will cause the data in the leftmost column to 

become the column header in the transposed table. Checking Include table headers will 

cause the column header data to be placed in column 1 of the transposed table. Both 

options cannot be selected at the same time. 

Columns... 

This menu item presents a dialog box where the nature of the data to be stored in each 

column may be specified. The read only status will determine whether or not any changes 

will be implemented. Do check it first. 

Three entries are required for each column. 

The first is the column heading. This can be any suitable text expression. 

  
 

The second is the column format. If the format is empty then the number or text is 

displayed without any formatting. For numbers, the format uses 0 (zero), #, ., E -, +. The 

0 (zero) indicates a digit position where either a digit will be displayed, or if there is no 

digit in the number, a zero will be displayed, while # indicates a position where a digit 

will be displayed only if there is a corresponding one in the number. As usual the E 

indicates scientific number formatting. The E must be followed by a + or – symbol. A 

following - indicates that negative exponents will be displayed with a minus sign, while 

positive exponents will be displayed with no sign. The + indicates that all exponents will 

be displayed with an appropriate sign. For example the number 43.568434 is displayed as 

follows for each of the example formats: 
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Format Displayed Number 

##0.0000 43.5684 

000.0000 043.5684 

0.000E-000 4.357E001 

 

Text strings are formatted using the @ character. The number of @ characters in the 

format determines the number of characters displayed. For example with a format of @, 

the string DEF is displayed as D and with a format of @@@ it is displayed as DEF 

The third entry is the type of the data. Particularly in the full Essential Macleod 

package, the data must sometimes be of a specific type in order to be recognized 

elsewhere in the package. Tooling factors in Runsheet are examples. Available types are 

given in a scrolling list. The type "Unknown" is included. 

There are two buttons, Previous and Next that transfer the editing to the columns on 

either side of the current one. Either button may be grayed out if the current column is at 

the limit of the table. 

Once the table has been completed and saved it will be designated Read Only and that 

status must be changed in the Edit menu if any reediting is to be carried out. 

The entry Format Syntax in on-line Help gives details of the various methods that may 

be used to define the format. Look up Format Syntax in Search for Help on... in the 

Help menu. 

Tools Menu (Table) 
The Tools Menu is similar in most respects to other Tool Menus in the package. This 

menu contains one item that is unique to tables. 

Color 

Color calculates the color co-ordinates of the selected column. The column is assumed 

to contain a transmission or reflection spectrum and the leftmost column is assumed to 

contain the wavelength points for the spectrum. The wavelength data must be in 

nanometres. To use this function, select the column that contains the data for which color 

is to be calculated. The leftmost column is assumed to contain the wavelength data. 

Select Color from the Tools menu. A simpler version of the Color parameters window 

will appear. This allows you to select the parameters for the color co-ordinates to be 

calculated. Click Plot to produce a plot and click Table for a table of data. 
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REFINEMENT AND SYNTHESIS 
Refinement and synthesis are automatic processes for the improvement of design 

performance. They are quite similar in their operation. Refinement essentially implies 

improvement by application of, usually slight, modifications to an already existing 

starting design and synthesis involves an element of construction, which in extreme form 

can operate with virtually no starting design whatsoever. 

To permit automatic assessment of improvement, an objective measure of 

performance is required which must be a single number. This is known as the figure of 

merit. The derivation of a figure of merit requires first of all that a target performance be 

defined. Then the actual performance is compared with the targets and the gap between 

actual and required performances is expressed by the function of merit as a single 

number. The function of merit is simply a set of rules that governs the conversion of the 

performance gap into a single figure. This may be accomplished in many different ways. 

In the Essential Macleod the target performance consists of a series of independent 

requirements known as targets. These might be the reflectance at a particular wavelength, 

the Group Delay Dispersion at another, or the ellipsometric parameters at a third, or the 

chromaticity coordinates of the light reflected from the coating at normal incidence under 

illumination by an equal energy source, or combinations of these or any of the other 

calculable performance parameters. Polarization and angle of incidence may also be 

specified. The relative importance of each target can be indicated by an assigned weight. 

The conversion of the gap between actual and target into a component of the merit 

function involves taking the absolute difference between them and then raising it to a 

specified integer power and multiplying by the assigned weight. Some complications of 

the merit function involving target linking are possible and are described under Targets 

later in this manual. 

Refinement techniques differ largely in the way in which they use the history of 

gradual improvement in the figure of merit to plan further improvements. Synthesis 

techniques add to efficient refinement the possibility of increasing the number of 

adjustable parameters, that is, complicating the design, once refinement has apparently 

reached an impasse. Refinement is then re-launched. The complicating process may be 

arranged to operate periodically. The way in which the design is complicated 

differentiates the various forms of synthesis. 

The Essential Macleod provides eight distinct classes of technique for refinement 

and/or synthesis. Simplex, sometimes called Nonlinear Simplex to distinguish it from a 

linear programming technique with the same name, is a very fast refinement technique 

that makes for the nearest merit function minimum. It is very stable – there is virtually 

zero probability of making things worse – and so it is particularly suitable for the 

adjustment of an already useful design. Tuning the outer layers of an edge filter to assure 

good performance in the pass region is a good example of a task ideally suited for 

Simplex. The implementation of Simplex accommodates packing density as well as film 

thickness permitting refinement in terms of index as well as assisting in reverse 

engineering. Optimac is a technique that has been developed by Thin Film Center Inc. It 

is both a refinement and a synthesis technique, but it has great strength in synthesis where 

it is capable of building a design virtually from scratch. Conjugate Gradient and Quasi-

Newton are two refinement techniques that make use of derivative information when 
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determining the next move. Simulated Annealing is an intermediate technique that has 

some attributes of synthesis and is rather more than refinement. It ranges widely over 

parameter space, avoiding shallow local minima. It does not add layers like Optimac but 

it has few constraints and it has no need of a good starting design. All it requires is a 

sequence of layer materials, a range of thicknesses and/or packing densities, and plenty of 

time. Needle Synthesis is a technique for adding layers to a design. Needle Synthesis 

determines where to insert new layers by calculating the derivative of the merit figure for 

a layer with zero thickness as it is moved throughout the existing layers. New layers (up 

to the number specified) are inserted at the points where the merit figure derivative has its 

most negative values. Conjugate Gradient refinement is then used to expand the newly 

inserted layers from their initial zero thickness values to some positive values. Conjugate 

Gradient refinement may also adjust the thicknesses of other layers if this results in an 

improvement of the design. Differential Evolution is an evolutionary algorithm for 

finding an optimal design. The Differential Evolution algorithm is discussed in 

“Differential Evolution A Practical Approach to Global Optimization” by Kenneth Price, 

Rainer M. Storm and Jouni Lampinen. Finally Non-Local Refinement attempts to find 

better designs by randomizing the starting point for refinement and calling the selected 

refinement method many times. 

The various techniques share the same targets but there are also other attributes that 

must be set correctly for the processes to proceed and differ from one technique to the 

other. They are discussed under the Parameters heading.  

For applications where the thickness of the layers must lie within some range, the 

upper and lower limits in physical thickness can be specified in the design in the 

Minimum Physical Thickness and Maximum Physical Thickness column. 

Targets for refinement 
Targets are grouped into four categories: Standard, Color, Thickness and Script 

(Script targets require the Function enhancement). All the Standard targets require a 

wavelength to be defined and include parameters such as Reflectance Magnitude, 

Transmittance Phase, Transmittance GDD and Reflectance Delta. The Color targets 

contain all the color parameters that may be used as targets. The Thickness targets allow 

total thicknesses for materials to be specified as targets. Script targets call functions 

written in the scripting language. 

Standard Targets 
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A new refinement standard targets window contains only four columns, wavelength or 

frequency, operator, required value and type. Frequently these are all that is required. 

Other attributes of the targets are set to default values. Incident angle is zero, weights are 

all unity and tolerances have their default values. Targets may be either equality targets 

or inequality targets. This is specified by the operator.  

The other target attributes can be activated by the menu item, Display Setup > in the 

File menu. The sub-menu that appears has the following entries, Context, Incident 

Angle, Weight, Tolerance, Derivative, Link and Current Value. Note that Context only 

appears for Design Targets. 

Selecting all of these gives a window similar to the following. 

 
 

Context specifies the design context in which the target applies.  

Incident Angle is measured in the current incident angle units and when the incident 

angle column is present the polarization column (Pol) is also automatically activated.  

The Weight column controls the relative importance of each target. The larger the 

value of the weight of a target relative to others, the more the refinement will be driven 

by the performance at that target. 

The Target Tolerance column indicates the relative acceptable error magnitude of 

each target. For each target, the difference between the required value and actual value is 

divided by the tolerance. When the Type of a target is changed, the default tolerance for 

the target type will be inserted in Target Tolerance column. The default tolerance values 

may be edited by selecting Tolerances from the Options menu. 

The Derivative column lists the order of the derivative of the target type with respect 

to the independent variable that is either wavelength or frequency, whichever is listed in 

the first column. An order of zero indicates that no derivative is involved. 

Link permits the assignment of relationships between targets. For example, it might be 

required that the reflectance at 525nm should be 4% greater than that at 550nm but that 

the absolute level of the reflectance be unimportant. To arrange this we first of all link the 

two targets together by giving each the identical link number, in this case unity. Note that 

as the link numbers are entered so the Required Value against the second linked target 

disappears and also that the number unity appears by default in the Link Multiplier 

column. Now we want the difference between the values to be 4% and so we set the 

multiplier for 550nm to -1 and the Required Value against 525nm to be 4%. By default 

the weight given to the combination is unity. It can be adjusted by forcing the appearance 

of the Weight column. 

More than two values can be linked. The links are interpreted in this way. 
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𝐿𝑖𝑛𝑘𝑒𝑑 𝑉𝑎𝑙𝑢𝑒 = ∑(𝐿𝑖𝑛𝑘 𝑀𝑢𝑙𝑡𝑖𝑝𝑙𝑖𝑒𝑟 × 𝑉𝑎𝑙𝑢𝑒 𝑜𝑓 𝑔𝑖𝑣𝑒𝑛 𝑇𝑦𝑝𝑒)

𝐿𝑖𝑛𝑘

 

  

𝑀𝑒𝑟𝑖𝑡 𝑓𝑢𝑛𝑐𝑡𝑖𝑜𝑛 𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 = 𝑊𝑒𝑖𝑔ℎ𝑡 ×  |𝑅𝑒𝑞𝑢𝑖𝑟𝑒𝑑 𝑣𝑎𝑙𝑢𝑒 −  𝐿𝑖𝑛𝑘𝑒𝑑 𝑉𝑎𝑙𝑢𝑒|𝑃𝑜𝑤𝑒𝑟   

 

If all the types involved in a particular link are phases then the principal values of the 

phases will be used and the result will be expressed as the principal value. If only some of 

the values involved in a single link are phases (this may not make any physical sense) 

then the principal values of the individual phases will be derived but from then on the 

phases will be considered as simple numbers and the final result will be completely 

untreated. 

As an example of a refinement operation that uses linking we can imagine that we 

want to derive a beam splitter coating with 50% reflectance at normal incidence over the 

region 400 to 700nm. We use ZnS and Na3AlF6 (cryolite) as materials on glass with air 

as incident medium. We use a starting design of nine layers of optical thickness 0.15 at 

510nm with Na3AlF6 outermost. 

We first set up a conventional set of targets, that is reflectance 50% from 400 to 

700nm at intervals of 25nm. We use simplex with a starting thickness increment of 0.01. 

The simplex during the refinement process eliminates two layers to yield a seven-layer 

design with Na3AlF6 outermost and a performance given by the thinner line (red) in the 

following plot. 

Next we construct a set of targets that consist of absolute values of 50% at 400, 450, 

500, 550, 600, 650 and 700nm, but we add separate links of 400 with 425nm, 525 with 

575nm and 675 with 700nm each requiring zero difference between the values of 

reflectance. The link multipliers, in other words, are set to 1 and -1. The weights are set at 

three, larger than the unity values for the individual targets, to emphasize the links. The 

arrangement is shown in the following table. 

 
 

This maintains the nine layers of the design during the course of the simplex 

refinement with identical parameters and a much flatter performance is obtained. In the 
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plot below, the heavier line shows the performance of the design refined with linked 

targets. 

Links give an added dimension to the refinement and synthesis specifications and 

increase greatly the power of the technique. However, a word of caution is appropriate. A 

performance specified with links can often be more difficult to achieve than one without, 

and so the convergence will take longer. It is also very easy to demand a completely 

unreasonable performance and in such a case the process will be very slow and the result 

disappointing. 

 
 

Links can also be used for calculating average values. Average value calculations are 

available for magnitude related targets. The link calculations are performed in the same 

way except that the final value is divided by the sum of the link multipliers. That is: 

𝐴𝑣𝑒𝑟𝑎𝑔𝑒 𝑉𝑎𝑙𝑢𝑒 =
∑ (𝐿𝑖𝑛𝑘 𝑀𝑢𝑙𝑡𝑖𝑝𝑙𝑖𝑒𝑟 × 𝑉𝑎𝑙𝑢𝑒 𝑜𝑓 𝑔𝑖𝑣𝑒𝑛 𝑇𝑦𝑝𝑒)𝐿𝑖𝑛𝑘

∑ (𝐿𝑖𝑛𝑘 𝑀𝑢𝑙𝑡𝑖𝑝𝑙𝑖𝑒𝑟 )𝐿𝑖𝑛𝑘

 

An unweighted average will be calculated when all link multipliers have the same 

value. A weighted average can be calculated by setting the link multipliers to the desired 

weights. Note that the average calculation is only performed at the specific wavelengths 

in each set of linked targets. If there are significant excursions between the target points, 

more targets will need to be added to bring the calculated average value closer to the 

average value of the spectrum. 

The Current Value and Contribution columns provide data on the performance of the 

design for the current set of targets.  
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The Current Value column shows the actual design performance value for the target. 

The Contribution column shows the % contribution of the target to the total merit figure. 

The principal menu item that concerns us when the target window is active is the Edit 

menu. The other items are the usual general ones concerning the package as a whole.  

Color Targets 

 
 

A color targets window contains different columns to the standard targets window.  

Required Value, Type and Operator have the same meaning as for the standard targets 

except that types are all color parameters. Each target also specifies a source distribution, 

and an observer. The mode specifies whether transmitted or reflected color is to be 

calculated.  For stacks, an additional mode is Back Reflectance. This calculates the 

reflected color from the emergent medium side of the stack. For vStacks, only throughput 

is available for the Mode. To avoid taking too much screen space, the target types have 

been abbreviated as follows: 

 

X Tristimulus X 

Y Tristimulus Y 

Z Tristimulus Z 

x Chromaticity x 

y Chromaticity y 
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z Chromaticity z 

L* CIE 1976 L* 

a* CIE 1976 a* 

b* CIE 1976 b* 

u* CIE 1976 u* 

v* CIE 1976 v* 

u’ CIE 1976 u’ 

v’ CIE 1976 v’ 

c*(ab) CIE 1976 chroma correlate of L*a*b* 

h*(ab) CIE 1976 hue correlate of L*a*b* 

c*(uv) CIE 1976 chroma correlate of L*u*v* 

h*(uv) CIE 1976 hue correlate of L*u*v* 

s*(uv) CIE 1976 saturation correlate of L*u*v* 

CIE2000 CIEDE2000 color difference 

CIE76 CIE76 color difference 

L Hunter L 

A Hunter A 

B Hunter B 

u CIE 1960 u 

v CIE 1960 v 

CCT(K) Correlated Color Temperature (Kelvin) 

RCCT(RMK) Reciprocal Correlated Color Temperature 

(Reciprocal Mega Kelvin) 

Wd Dominant Wavelength 

Wc Complementary Wavelength 

Pe Excitation Purity 

Pc Colorimetric Purity 

Ra General Color Rendering Index 

R1 – R14 Specific Color Rendering Index 

DC Chromaticity Difference 

 



154  Refinement and Synthesis 

Other color target attributes such as Incident Angle, Weight, Tolerance,  Link and 

Current Value may be displayed by using the Display Setup command in the File menu. 

These attributes have the same meanings as for standard targets. The Display Setup 

command applies to all of the different target windows, but only the columns appropriate 

for the window are displayed. 

The color difference targets (CIE2000, CIE76) require reference L*a*b* or L*c*h* 

color coordinates for the calculation. These color coordinates are attached to the color 

difference by using the same link number for each target. For convenience, when adding 

a color difference target, reference color coordinates will be automatically added by the 

program with a unique link number. The figure below shows a single color difference 

target with its associated reference color coordinates. 

 
 

Thickness Targets 

 
 

The thickness targets window normally only shows the material, operator and the 

desired total thickness of the material. When one or more total thickness targets are 

present, refinement will attempt to move the total thicknesses of the materials to the 

required values at the same time as attempting to meet the other targets. Thickness targets 

are only available for designs. 

Other columns that are controlled by the Display Setup command that apply to the 

thickness target window are Weight, Tolerance, Link and Current Value. These columns 

have the same meaning as for standard targets. 
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Script Targets 

 
 

The script targets window normally only shows the filename, and entry point 

columns. During the evaluation of a design, each script target is calculated by calling the 

entry point in the filename. The entry point returns a number indicating how well the 

design meets the requirement expressed by the script target. The result of the entry point 

corresponds to the portion of the merit function that computes: 

 

|𝑅𝑒𝑞𝑢𝑖𝑟𝑒𝑑 𝑉𝑎𝑙𝑢𝑒 − 𝐴𝑐𝑡𝑢𝑎𝑙 𝑉𝑎𝑙𝑢𝑒|

𝑇𝑜𝑙𝑒𝑟𝑎𝑛𝑐𝑒
 

 

The Required Value and Tolerance are to be provided by the script and do not appear 

in the Script Targets table. The result is combined with the other target results in the same 

using the Merit Function Power and Weight. Detailed information on script targets is 

provided in the Scripting Language Help in the online Help system. 

 Script targets are only available for designs and can only be used with Simplex, 

Optimac and Simulated Annealing refinement. The Function enhancement is required to 

use Script Targets. 

The Weight and Current Value columns are controlled by the Display Setup 

command.. These columns have the same meaning as for standard targets. 

 

Edit Menu (Targets) 

Some of the items in the menu may not be available until the corresponding 

parameters in the targets window are selected. 

To select a row in the window, place the cursor over the small selection box on the 

extreme left and click once to select the box and a second time to select the row. To 

select a block of rows, select the first and then with the shift key depressed select the last. 

To deselect a block, place the cursor on any of the selection boxes and click once. 

Cut Rows 

Once rows are selected in the same manner as rows in the design window then they 

can be cut from the targets and placed on the clipboard. 

Copy Targets 

Copy targets copies all of the targets and stores them on the clipboard so that they can 

be pasted into another design. If you copy the targets and then paste them back into the 
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current design no change will be observed. Use Copy Rows and Paste Rows to 

duplicate parts of the current targets. 

Copy Rows 

Copies the selected rows onto the clipboard. 

Paste Targets 

Pastes the set of targets stored on the clipboard to the current target window. This 

operation replaces the current set of targets. 

If the target data was placed on the clipboard by an application other than the 

Essential Macleod, then the Import Data tool (See page 44) will be used so that you can 

specify which columns on the clipboard correspond to the various target window 

columns. Additionally you can specify every n'th line is read. This is typically used to 

reduce the number of target points when the data on the clipboard is the output of a 

spectrometer scan. 

Paste Rows 

Pastes the rows that are stored on the clipboard into the current targets. The point of 

insertion will be the currently selected row. 

Insert Rows... 

This command inserts a given number of rows above the current insertion point. The 

rows are interpolated so that the values in the Wavelength/Frequency column form an 

arithmetic or linear progression. Other attributes of the targets are also linearly 

interpolated. 

Delete Rows... 

This command deletes the selected rows. Note that clicking the selection box at the 

extreme left and using <Del> deletes a line. 

Sort 

Sort places the targets in order.  When the Sort command is selected, you are asked to 

specify the sort order with the following window: 

 
 

Targets may be sorted by the contents of up to three columns in either ascending or 

descending order. Once the columns have been selected, click OK to sort the targets. This 

command is particularly useful in conjunction with the Global Edit command where it 

used to group together the targets that are to be globally edited so that they may easy be 

selected prior to starting the global edit. 
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The Sort command applies to the current target window. For example, if the standard 

targets are displayed, then sorting will only apply to the standard targets. 

Global Edit...  

This command changes either all targets or selected targets only (if at least one target 

has been selected), to values entered on the Global Edit form. 

 
 

If a value is entered into one of the fields, then the targets will be updated with the 

new value. If the field is left blank, then the value held in the targets will be not altered. 

Click OK to make the changes. Clicking Cancel causes the edit operation to be aborted. 

Scale Targets... 

This command is similar to the Global Edit command except that it multiplies the 

value in the target field by the value in the corresponding field of the Scale Targets form. 

The command changes either all targets or selected targets only (if at least one target has 

been selected). 

 
 

For example, if 0.01 is entered into the Required Value field, then when OK is 

selected, the Required Value of the targets that are to be modified will be multiplied by 

0.01. 
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Generate... 

Generate helps in the setting up of a set of targets. The dialog box permits a range of 

wavelengths and/or a range of incident angles to be set with a particular performance 

specification. Add or New buttons are provided so that the results can just be added to the 

existing set of targets or can replace them. 

The basic mode of operation is that each wavelength is given the range of angles 

specified. Be careful! This can generate a very large array of targets. For example, a 

range of wavelengths from 400 to 700 at steps of 20 together with a range of angles of 

incidence from 0 to 45 at intervals of 5 will give 160 separate targets. An alternative to 

specifying the step size is to specify the number of targets over the range by entering a 

number in the #points box.  

To set a range of angles at one wavelength set the starting and ending wavelengths to 

the same value and similarly with specifications at just one angle. 

The target generator can also create pairs of linked targets. To change to this mode, 

click Linked Targets (To change back to the basic mode, click Regular Targets). In this 

mode, there are two types of target: Primary and Secondary. The Primary target is the 

same as would be generated in the basic mode but with the addition of a Link Multiplier. 

The Secondary target is specified as an offset from the primary target in wavelength and 

incident angle. The two targets are linked together during target generation. 

Display Wavelength 

This command causes the targets to be displayed in terms of the wavelength parameter 

as defined in General Units on the Options menu. 

Display Frequency 

This command causes the targets to be displayed in terms of the frequency parameter 

as defined in the General Units on the Options menu. 

Remove Duplicates 

This command causes duplicate targets to be deleted. The default action is for 

duplicate targets to be automatically deleted, but in some cases it is preferable not to 

delete the duplicate targets as soon as they are detected (for example if you are pasting in 

a common range of values but want to change the polarization). The Remove Duplicates 

Immediately option in the Targets tab of the General options controls the automatic 

removal of targets. If this option is unchecked, then duplicate targets will not be 

automatically deleted. If duplicate targets are present when refinement is selected, a 

warning message will be displayed and refinement will be stopped.  

Refinement and Synthesis 
The eight classes of technique provided for refinement and/or synthesis are Simplex, 

Optimac, Simulated Annealing, Conjugate Gradient, Quasi-Newton, Needle Synthesis, 

Differential Evolution. and Non-Local Refinement. Simplex provides straightforward 

refinement, Optimac refinement and/or synthesis, Simulated Annealing refinement but 

over a wide region of parameter space, Conjugate Gradient and Quasi-Newton are 

refinement methods that use derivative information when determining how to modify the 

design. Needle synthesis is a method of adding layers to a design based upon the 
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derivative of the merit figure for a zero thickness layer. Differential Evolution attempts to 

evolve a population of designs towards a better solution. It also has the ability to search 

for designs that are less sensitive to independent errors. Differential Evolution potentially 

evaluates a substantially larger number of designs than the other techniques, and so can 

take much more time to find a solution. Non-Local Refinement repeated creates a random 

design (subject to specified constraints) and runs a specified refinement method on the 

randomized design. The best designs are kept in a history list for later examination.  

The techniques can be selected from the Design Window Tools or Parameters menu. 

Selection through Tools activates the process directly. Selection through Parameters 

permits adjustment of the parameters of the appropriate process. 

We first consider the various parameters that must be set and to help in understanding 

them we include a brief description of each technique. 

Refinement Parameters 

Simplex 

Simplex refinement is very fast. A family of designs, the simplex, is set up by 

perturbing the layers and/or the packing densities of the starting design. Usually the total 

number of designs will be one more than the number of layers and packing densities with 

a minimum of five for very small numbers of layers. The refinement technique then 

consists of a process of exchanging the poorest design for a better one at each iteration. 

The better design is generated by reflecting the worst one in the center of gravity of the 

simplex, or, if that is not successful, by moving towards the center of gravity. 

Simplex Parameters 

Simplex parameters are set in a parameters dialog box (see next page). 

Either or both Refine Thicknesses and Refine Index may be selected. In order that 

dispersive materials may be accommodated, the model used for the variation of refractive 

index is that of variable packing density. The model is detailed in the subsection Packing 

Density in the Essential Macleod Structure earlier in the manual. The starting thickness 

increment is the amount by which each layer is perturbed to set up the original simplex of 

designs. The packing density increment is likewise shown but there is an additional check 

box, Common Scaling. If this box is checked then the packing densities of all layers of 

the same material move together. This is useful in reverse engineering where deposition 

conditions may have caused all the layers of a particular material to vary in the same way 

from ideal. In reverse engineering the packing density range will be quite restricted. In 

index refinement the range can be made large. Inhomogeneity can be simulated by 

splitting each possibly affected layer into at least two parts each with its own packing 

density. The number of iterations determines the absolute limit to the refinement process. 

It should be set fairly large.  
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Simplex is very fast and each iteration is quickly over so a large number, several 

thousand, is recommended. It is always possible for the user to terminate the process 

earlier. For more complicated designs, the convergence can often be improved by 

recycling the simplex during refinement. The Recycle Interval parameter specifies the 

number of iterations between each automatic recycle. If this parameter is set to zero, then 

automatic recycling does not happen. Try Alternate Paths is used to make Simplex take 

into account the effect of a path selection on the next iteration. Sometimes the next 

iteration will achieve a better result if the best path is not taken in the current iteration. 

Try Alternate Paths allows Simplex to not take the current iteration’s best path in this 

case.  

Progress of the refinement is automatically displayed as a plot of performance. The 

plots will be produced each time the performance is improved by the amount in Minimum 

Merit Function Improvement To Update Plot since the last plot.  

Use Custom Merit Function, Source File, and Browse… only apply to Designs and 

are only available when the Function enhancement is licensed. Information on the use of 

custom merit functions is included in the Scripting Language manual that is installed on 

your computer. 

Optimac 

Optimac has many facets. It possesses some aspects of a direction set technique but 

with a large number of different ways of constructing the conjugate search sets which are 

constantly changing in response to the progress of the refinement. As soon as one 

construction technique appears to be giving diminishing returns, another takes over. The 

method is appropriate for both synthesis and refinement. In synthesis there are rules for 

altering the design at the end of each refinement cycle by splitting layers, inserting layers, 

adding layers and even periodic random perturbation. The changes, however, are only 

provisional until proved to be useful by the subsequent progress of the process. If the 

promised improvements are not maintained then the current changes are dropped and a 
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different way of introducing the changes adopted. The process, therefore, is constantly 

altering itself in response to progress. 

Optimac Parameters 

 
 

Optimac has no limits on layer thickness, except that they may not become negative, 

although thicker layers are more likely to be subdivided in the course of the synthesis. 

The parameters editor determines whether or not refinement or synthesis is involved by 

the value set for Number of Synthesis Cycles. If this is zero then only refinement will be 

performed. If synthesis is to be carried out then the value to insert depends very much on 

whether or not there is a good starting design. With virtually no starting design then a 

value of 50 or so is reasonable. With a good starting design, a lower figure can be used. 

The Synthesis Step represents the thickness of layers that are inserted in the synthesis 

process. This should normally be set quite large and 0.1 to 0.3 are good values. The 

Synthesis Parameter determines whether the changes will be retained in the synthesis 

operation. When a design is changed by adding or perturbing layers, the merit figure 

usually rises. A short process of adjustment then begins and continues as long as the 

improvement in the merit function continues to be satisfactory as defined by certain 

conditions on the relative improvement. If the resulting figure of merit is poorer than the 

old nevertheless the new design will be accepted provided the fractional increase in the 

figure of merit is not greater than the synthesis parameter. A value of around 0.2 or so is 

quite a good starting value. The Initial Search Step is the search interval for the first 

quick scan of the search direction. The initial search takes place over a width that is given 

by the current value ± the Initial Search Width. If convergence is good, this value can be 

set equal to the initial search step. If convergence is slow and performance improves only 

slowly then the search region can be greatly extended. During refinement, however, the 

interval is constantly adjusted on the basis of progress. Try Alternate Paths is used to 

make Optimac take into account the effect of a layer insertion method on the next 

iteration. Sometimes the next iteration will achieve a better result if the best layer 
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insertion method is not taken in the current iteration. Try Alternate Paths allows 

Optimac to not take the current iteration’s best insertion method in this case.  

The Number of Iterations refers to the refinement between each synthesis operation. 

This should be set to 40 or 50. The Maximum Number of Layers should not be set too 

large if the process is to be completely automatic, otherwise there may be a tendency to 

continue to add thin layers. If the process is to be monitored and stopped manually at an 

appropriate point then this can be large. Progress of the refinement is automatically 

displayed as a plot of performance. The plots will be produced each time the performance 

is improved by the amount in Minimum Merit Function Improvement To Update Plot 

since the last plot.  

Use Custom Merit Function, Source File, and Browse… only apply to Designs and 

are only available when the Function enhancement is licensed. Information on the use of 

custom merit functions is included in the Scripting Language manual that is installed on 

your computer. 

Click on the Synthesis Materials tab to control the materials that will be used by 

Optimac when inserting new layers.  

 
 

Initially, all the materials in the design will be used for synthesis. Some of these 

materials may be removed or others not in the starting design may be added to the list. 

Clicking OK will save the parameters for future use. Clicking Refine will start synthesis. 

Simulated Annealing 

Simulated Annealing is not a particularly new technique but it has not been much 

applied to thin film coatings. It consists of a design that is randomly perturbed to wander 

over the merit function surface. At each fresh perturbation, a new figure of merit is 

computed. Better designs are always accepted but poorer designs are sometimes accepted 

with a probability that is gradually reduced as the process continues. It attempts to mimic 

a real annealing process and the probability of accepting a poorer result is determined by 



Refinement and Synthesis  163 

a random number drawn from a Boltzmann distribution, exp(-E/kT) where E represents 

the random increase in the merit figure and kT represents an "annealing temperature." 

(The k here represents the Boltzmann constant and not the extinction coefficient). The 

design gradually relaxes towards a minimum figure of merit. The longer the process is 

permitted to take usually the better the eventual minimum. Simulated annealing is at its 

best when there is no obvious starting design. It responds well to specifications that 

involve angle of incidence effects, especially ones where the other techniques are 

sluggish. 

Annealing Parameters 

The parameters that are to be specified are shown in the reproduction of the dialog 

box below.  

 
 

The parameters, standard deviation and initial temperature, are specified separately. 

The standard deviation for the layer thickness fluctuations has a starting and a finishing 

value. Near the start of the operation the fluctuations should be fairly large but at the end 

large fluctuations tend to be nonproductive because they move the design to an extent 

that is unacceptable. It can be arranged, therefore, that the ending value is different from 

the starting. Similarly, the index variation has its own standard deviation, so that the 

index variations do not have to follow the same profile as the thickness variations. The 

annealing temperature is measured in degrees, each degree being 1/10000 of the starting 

figure of merit. Good starting values are in the hundreds or even thousands. The 

annealing process will gradually reduce the temperature to the end value which can 

conveniently be zero. The fall in temperature is not linear. The rate of decrease is 

somewhat greater at the start of the process than at the end, and it is the same with the 

standard deviation.  

Absolute or relative changes determines how the random variations will be applied. 

For absolute changes in thickness the fluctuations are treated as absolute layer thickness 

changes, that is a fluctuation of 0.2 is treated as 0.2 x 0 added to the current thickness of 

the layer. If the changes are relative, it means that the layer thickness will be increased by 

0.2 of its current value. Absolute is a better choice, at least for starting, otherwise thin 

layers will scarcely move. For absolute changes in packing density, the fluctuation is 
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added to the current packing density value, a fluctuation of 0.2 is treated as adding 0.2 to 

current value of packing density. For relative changes the packing density will be 

increased by 0.2 of its value. 

In simulated annealing, the random walk process can very quickly move layers out 

against their constraints even when they are set very large. This creates problems. The 

technique used here, therefore, ensures that the layers are reflected in the constraints 

rather than simply being restrained by them. Because of this reflection the constraints can 

and should be set at a reasonable value. If they are set too large then, particularly at the 

early stages, the corresponding thick layers lead to tightly spaced fringes and sometimes 

quite wild oscillations of the figure of merit.  

Progress of the refinement is automatically displayed as a plot of performance. The 

plots will be produced each time the performance is improved by the amount in Minimum 

Merit Function Improvement To Update Plot since the last plot.  

Use Custom Merit Function, Source File, and Browse… only apply to Designs and 

are only available when the Function enhancement is licensed. Information on the use of 

custom merit functions is included in the Scripting Language manual that is installed on 

your computer. 

Conjugate Gradient 

The Conjugate Gradient refinement method belongs to the class of methods that use 

derivative information to determine the local slope of the Merit Function surface. This 

information is then used to change the design parameters (typically layer thicknesses) in 

an attempt to improve the design.  

Conjugate Gradient Parameters 

 
 

For Conjugate Gradient, the Merit Function Power must be a positive even number. 

The larger this is made, the more refinement works on the parts of the design that are 

furthest from the targets. In general, a value of 2 works well.  Limiting Range for Merit 

Function is one of the termination criteria for Conjugate Gradient refinement. If the 

merit figure falls below this value, then Conjugate Refinement will terminate and return 

the refined design. Maximum Iterations is another termination criterion. If Conjugate 

Gradient refinement has made Maximum Iterations attempts to improve the design, then 

it will stop and return the refined design. The Minimum Merit Function Improvement 

To Update Plot (%) controls how often the progress plot is updated. Plotting can take a 

significant amount of time and if the merit figure has not significantly changed, then the 

plot will be very similar to the previous plot. To avoid unnecessary plots, a plot will not 
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be generated until the merit figure has decreased by the specified percentage amount 

from the merit figure value at the previous plot. The Conjugate Gradient progress 

window includes a Plot Now button so that you can look at changes before the necessary 

improvement has been made. Conjugate Gradient refinement also includes termination 

criteria based on the merit figure slope. If the slope value becomes small, the refinement 

will terminate because it assumes that it has found the best design. For some designs, 

however, this termination is too early. There can be long periods where the slope is very 

small, but after a while, the refinement finds a much larger slope that it then descends. 

For this reason, the Termination Match Count can be used to specify the number of 

consecutive times that the small slope requirement must be met before refinement 

terminates. If the Termination Match Count is set to less than zero, then refinement will 

never terminate because of a small merit figure slope. 

Quasi-Newton 

Quasi-Newton refinement also belongs to the class of methods that use derivative 

information to determine the local slope of the Merit Function surface. This information 

is used to change the design parameters (typically layer thicknesses) in an attempt to 

improve the design.  

Quasi-Newton Parameters 

The parameters for Quasi-Newton refinement are similar to the Conjugate Gradient 

refinement parameters. The exception is an extra parameter Recycle Interval. The 

convergence rate of Quasi-Newton can often be improved by restarting the refinement. 

The recycle interval parameter restarts the refinement every Recycle Interval iterations. 

The base value for this parameter is difficult to determine, but a value between 15 and 20 

often works well. Setting the value to 0 stops automatic recycling. 

Needle Synthesis 

Needle synthesis uses derivative information from the merit figure surface to 

determine where to insert new layers. The derivative of the merit figure with respect to 

layer thickness for a zero thickness layer is calculated as the zero thickness layer is 

moved through the existing layers. The best places to insert new layers are given when 

the merit figure derivative is most negative. More than one zero-thickness layer can be 

inserted at a time. After all zero-thickness layers have been inserted, Conjugate Gradient 

refinement is used to expand the thicknesses of the new layers to non-zero values. During 

refinement, other layer thicknesses may also change thickness if it improves the merit 

figure. The process is repeated until the desired design is achieved or the process reaches 

some limit such as total number of iterations. 
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Needle Synthesis Parameters 

 
 

The Number of Synthesis Cycles parameter specifies the number of times that 

Needle Synthesis will attempt insert layers. When this parameter has been exceeded, 

Needle Synthesis will stop. The Merit Function Limit is another parameter that controls 

when Needle Synthesis stops. When the merit figure falls below this value, Needle 

Synthesis will stop. If after Conjugate Refinement has completed, the newly inserted 

layers have a thickness less than the New Thickness Value, then Needle Synthesis will 

add extra material to either the layer next to the incident medium or the layer next to the 

substrate. This gives Needle Synthesis extra material to search when looking for a place 

to add a new layer. If the merit figure has not improved by the amount specified by 

Minimum Improvement, then again, extra material will be added to the design to provide 

more search space. Maximum Number of New Needles specifies the maximum of new 

layers that will be added at each iteration. When Compact Interval is greater than zero, 

every Compact Interval iterations, Needle Synthesis will compact the design, removing 

layers whose thicknesses are less than Compact Thickness. If Compact Interval is zero, 

then the design is never compacted. Minimum New Thickness and Compact Thickness 

are always in units of nanometres. Try Alternate Paths is used to make Needle Synthesis 

take into account the effect of needle insertions on the next iteration. Sometimes the next 

iteration will achieve a better result if the best set of needles is not taken in the current 

iteration. Try Alternate Paths allows Needle Synthesis to not take the current iteration’s 

best needle set in this case. 

The Conjugate Gradient Parameters tab contains the same parameters as described for 

Conjugate Gradient above in this manual. 
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The Synthesis Materials tab lists the materials that are to be used when inserting 

layers into the design. By default, the materials to be used are all the layer materials in 

the design that are not in locked layers. You can add or remove materials from the list, by 

selecting each material and then clicking Add or Remove. 

Differential Evolution  

Differential Evolution is an evolutionary optimization algorithm. It attempts to find 

better solutions to a problem by modifying a population of designs through mutation and 

selection of the best designs. The process begins by creating a population of designs with 

random thicknesses and/or packing densities and/or materials based on the starting 

design. The limits on thicknesses and densities are specified either by the maximum and 

minimum limits in the design or by the error parameters. Materials are chosen from a 

specified list of materials. 

The process then repeatedly creates a new generation of designs from the previous 

generation until either the maximum number of generations has been created or a design 

with a sufficiently small merit figure has been found. The process will also end if the 

difference between the merit figures of the best and worst designs in the current 

generation falls below a user-specified value. This allows the process to stop if it has 

converged on a single design, but that design does not meet the sufficiently small merit 

figure requirement. 

In the standard method the next generation is formed by considering each design in 

the population in turn. A new design is created from the previous generation by randomly 

selecting three designs. The first of these designs is modified by taking each parameter in 

turn. A Crossover probability determines if the parameter will be modified or not. If the 

parameter is to be modified then the modification is performed by taking the difference of 

the same parameter in the second and third designs, multiplying that difference by a scale 

factor and then adding the result to the parameter in the first design. The complete 

mutated first design is then compared with the design under consideration. If the mutated 

first design has a lower merit figure than the design under consideration, then the design 

under consideration is replaced by the mutated design, otherwise the design under 

consideration is kept in the new generation. The new generation is complete when all 

designs in the population have been considered, 

If any of the stopping criteria have been met, the process ends, otherwise it will start 

creating the next generation. 
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The Differential Evolution technique also supports searching for designs that are less 

sensitive to independent errors. Normally a merit figure is calculated for a single design 

and that figure represents how well the design matches the targets. When searching for 

designs that are less sensitive to errors, the single design is perturbed several times in the 

same way that the independent errors tool perturbs a design. The merit figures of each of 

these perturbed designs are calculated. The worst merit figure calculated is the merit 

figure of the single design. This sensitivity reduction feature is not available in vStack. 

Differential Evolution potentially evaluates a substantially larger number of designs 

than the other techniques and so can take much more time to arrive at a solution. 

Differential Evolution Parameters 

 

 

The Population Generation section controls the size of the design population. The 

size of the population is constrained to be at least Minimum Size members and no greater 

than Maximum Size members. Subject to these constraints, the population size is 

calculated from Scale Factor x number-of-parameters where number-of-parameters is 

the sum of the number of different thicknesses to be refined and the number of different 

densities to be refined. A Scale Factor of 10 is a useful starting point. 

The Thickness section controls refinement of thicknesses. Check Refine 

Thicknesses to allow thicknesses to take part in the refinement. Range controls the 

limits from which the initial random population is drawn. When Range is set to 

Thickness Limits, the thickness limits are given by the Minimum and Maximum 

Physical or Optical Thickness Limits in the Design window. When Range is set to 2 x 

Error Limits, the thickness limits are given by the parameters in the Errors tool. The 

minimum thickness will be given by the thickness 2 standard deviations below the mean 

error and the maximum thickness will be given by the thickness 2 standard deviations 
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above the mean error. When Range is set to 3 x Error Limits, the minimum thickness 

will be given by the thickness 3 standard deviations below the mean error and the 

maximum thickness will be given by the thickness 3 standard deviations above the mean 

error. 

The Index section controls refinement of packing density. Check Refine Index to 

allow packing densities to take part in the refinement. Range controls the limits from 

which the initial random population is drawn. When Range is set to Density Limits, the 

density limits are given by the Minimum and Maximum Density Limits in the Design 

window. When Range is set to 2 x Error Limits, the density limits are given by the 

parameters in the Errors tool. The minimum density will be given by the density 2 

standard deviations below the mean error and the maximum density will be given by the 

density 2 standard deviations above the mean error. When Range is set to 3 x Error 

Limits, the minimum density will be given by the density 3 standard deviations below the 

mean error and the maximum density will be given by the density 3 standard deviations 

above the mean error. When Common Scaling is checked, layers of the same material 

will always have the same packing density. 

The Evolution Parameters section controls the strategy used. When Maximum 

Number of Generations has been reached, the refinement will stop. Crossover 

Probability controls the proportion of parameters in each design that will be modified. 

0.9 is a good starting point. Scale Factor controls the random variability of designs. A 

larger Scale Factor generates design populations with more variability. Generally the 

Scale Factor should be value a between 0 and 1 but it can be larger than 1. 0.8 is a good 

starting point. When the Strategy is Random per Generation Dither, 0.3 is a good 

starting point. The Strategy controls the method used to generate new designs. The 

Random strategy is the method described above and is probably the best to try first.. 

Local to Best is a modification that attempts to balance robustness in finding the best 

solution with fast convergence. Best is designed for small population sizes and fast 

convergence. The number of layers to be refined should not be too large. Random per 

Vector Dither uses the same strategy as Random, but the Scale Factor has a small jitter 

applied to it. The Scale Factor is randomly altered each time a design is generated. In 

Random per Generation Dither the Scale Factor is randomly altered at the beginning of 

each generation. Random Either Or randomly alternates between using the difference of 

two parameters as in the Random strategy and using three parameters. 

The Merit Function tab controls the properties of the Merit Function. The refinement 

will stop when the merit figure reaches a value of End When Merit Figure < or less. The 

refinement will also stop when the difference between the best and worst merit figures in 

the current generation is less than End When Merit Figure Range <. This value is 

normally very small so that refinement will stop when all the population members have 

the same parameter values, that is, they all represent the same design. 

Progress of the refinement is automatically displayed as a plot of performance. The 

plots will be produced each time the performance is improved by the amount in Minimum 

Merit Function Improvement To Update Plot since the last plot.  

When Number of Trials is 0, Differential Evolution will calculate a merit figure based 

solely on the trial design as is performed with the other refinement methods. When 

Number of Trials is greater than zero, Number of Trials perturbed designs will be 

created from the trial design. The merit figures of each of these designs will be calculated 
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and the worst merit figure will be assigned to be the merit figure of the trial design. This 

causes the refinement to prefer designs that are less sensitive to errors. The perturbed 

designs are created in the same way as the Errors tool and use the parameters in the 

Errors tool dialog to control the perturbations. Re-randomize controls the generation of 

the random numbers used to create the perturbed designs. When set to Never, the set of 

random numbers is generated once and used for the whole refinement. In this case, the 

same design will have the same merit figure throughout the refinement. When set to 

Each Generation, a new set of random numbers is generated at the beginning of each 

generation. In this case the same design will have the merit figure within a generation, 

but could have different merit figures in different generations. When set to Each 

Mutation, a new set of random numbers is created each time a design is mutated. In this 

case, the same design could have different merit figures within the same generation. 

These parameters cannot be set in Differential Evolution for vStack. 

Use Custom Merit Function, Source File, and Browse… only apply to Designs and 

are only available when the Function enhancement is licensed. Information on the use of 

custom merit functions is included in the Scripting Language manual that is installed on 

your computer. 

The Materials tab specifies if Differential Evolution is permitted to alter the layer 

materials during optimization and if so, which materials can be used for each layer. When 

Change Materials in Layers is checked, the materials used for each layer can be changed 

during optimization. The Materials to Use list specifies the materials that can appear in 

the design.  

Non-Local Refinement 
The refinement techniques above except for Differential Evolution and Optimac move 

the design to a nearest minimum. The path to the minimum is potentially different for 

each technique and so it is possible for each technique to finish at a different minimum. 

In general, there are many minima for a design and so where a design is far from a 

potential good minimum it is possible that refinement might not finish in the best 

minimum. That is, the refinement is sensitive to the starting point of the design. 

Ways of improving the chance of finding the best minimum include using statistics-

based techniques such as Simulated Annealing and Differential Evolution. Another way 

is to use the other refinement methods with many different starting points. Non-local 

refinement implements this method.  
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Non-Local Refinement Parameters 

 
 

The parameters for non-local refinement are divided into three parts: specifying the 

starting points with refinement technique to be used, specifying the criteria that determine 

if two designs are the same, and specifying if materials can be changed and which 

materials to use.. Number of Starts defines the number of starting designs that will be 

created. Thickness Strategy controls the limits of the random thickness generation. 

When Thickness Strategy is set to Thickness Limits, the thickness limits are given by 

the Minimum and Maximum Physical or Optical Thickness Limits in the Design window. 

When Thickness Strategy is set to 2 x Error Limits, the thickness limits are given by the 

parameters in the Errors tool. The minimum thickness will be given by the thickness 2 

standard deviations below the mean error and the maximum thickness will be given by 

the thickness 2 standard deviations above the mean error. When Thickness Strategy is 

set to 3 x Error Limits, the minimum thickness will be given by the thickness 3 standard 

deviations below the mean error and the maximum thickness will be given by the 

thickness 3 standard deviations above the mean error. 

Index Strategy controls the limits of the random packing density generation. When 

Index Strategy is set to Density Limits, the density limits are given by the Minimum and 

Maximum Density Limits in the Design window. When Index Strategy is set to 2 x 

Error Limits, the density limits are given by the parameters in the Errors tool. The 

minimum density will be given by the density 2 standard deviations below the mean error 

and the maximum density will be given by the density 2 standard deviations above the 

mean error. When Index Strategy is set to 3 x Error Limits, the minimum density will be 

given by the density 3 standard deviations below the mean error and the maximum 

density will be given by the density 3 standard deviations above the mean error.  

Plotting the progress of designs during refinement can consume a significant amount 

of time. Checking the Do Not Plot Progress option prevents design performance from 

being plotted and can significantly improve refinement times. 

Whether or not the thickness values are refined and whether or not the packing density 

values are refined depends upon the capabilities of the selected Refinement Method and 

how the parameters for the particular method have been set. The methods available are: 
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Simplex, Optimac, Conjugate Gradient and Quasi Newton. When Optimac has been 

selected, the Number of Synthesis Cycles is always treated as zero regardless of the 

value set in the Optimac Refinement Parameters. 

The termination criteria for each of the refinement methods will generally allow the 

refinement to end when the design is near the minimum. If refinement approaches the 

same minimum from different directions, it is likely that it will terminate at slightly 

different designs. Thus when comparing if two designs are equal, it is necessary to allow 

for some tolerances in different thicknesses, packing densities and merit figures. This is 

the purpose of the Design Similarity section. For each of the top three parameters a 

maximum difference is specified. If any of the layer thicknesses, layer packing densities 

or merit figures of a pair of designs exceed these differences then the designs are not 

considered to be identical. 

The Materials tab specifies if non-local refinement  is permitted to alter the layer 

materials during the creation of the starting point and if so, which materials can be used 

for each layer. When Change Materials in Layers is checked, the materials used for each 

layer can be changed when the starting design is being created. The Materials to Use list 

specifies the materials that can appear in the design.  

A history of designs is maintained. The history list retains up to Maximum Number of 

Designs designs that are considered different according to the Design Similarity criteria. 

For each retained design, the history list shows the number of times refinement has 

finished at that design and the merit figure of the design. Double-clicking on the row in 

the history list will open the design for inspection and optional saving. The design history 

list cannot be saved. When the design history list is closed, all the designs in the list will 

be lost (except for those previously saved). 

 

Refinement and/or synthesis progress 
All displays give a graph of the best current performance. The scales for the graph are 

taken from the design’s performance parameters. Where appropriate, the values of the 

targets are indicated on the graphs. 

Above the graph there is a data window that presents details of the refinement 

progress and it is here that the various displays differ. 

Once the refinement or synthesis is under way it will terminate without supervision 

when criteria set in the parameters editor are satisfied. These depend on the particular 

technique but they involve a target figure of merit, or a certain number of iterations or 

cycles, or a certain range of the figures of merit. However, some control can be exerted 

on it as it proceeds and this may be of benefit to the process. The control involves 

selecting the pause button that is at the top right of the display. This presents the user 

with a number of options that depend to some extent on the technique. All include the 

option to terminate the process either accepting the best design so far or returning to the 

starting design. It is also possible to recycle the process. This means simply resetting a 

number of the parameters so that the refinement is effectively restarted from the 

beginning but adopting as starting design the best current one. This works very well in 

Simplex where a periodic disturbance of this type helps to improve the convergence and 

is recommended. In some of the processes it is possible to change a number of the 
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parameters of the refinement. Finally it is possible to resume the process with no changes 

at all.  

Simplex Progress 

The display below shows the current range of figures of merit together with the results 

of the current assessment of a replacement design. The first choice is the design reflected 

in the center of gravity and this is indicated by the letter A. Should A be acceptable then a 

further assessment of a design that goes even further (twice as far) in the same direction 

is shown as B. The better of A or B is accepted. Should A be unsatisfactory then a design 

that is half way from the existing design to the center of gravity is assessed as design C. 

If this is better it will be accepted. Should neither A nor C be acceptable it is a sign that 

the extent of the simplex is greater than a simple merit function minimum and so the 

simplex should be reduced in size. All designs are then moved towards the best design 

and the process then continued.  

 
 

The plot of the performance of the current design uses the parameters that have 

already been set up for performance calculations. 

The pause button at the upper left brings up a pause box with a number of options. 

The refinement may be terminated with either the preservation of the best design or a 

return to the starting design. The refinement parameters may be changed without 

terminating the process. The recycle command starts up a completely fresh simplex based 

on the current best design and helps to revitalize the convergence if it has become 

sluggish. In fact it is recommended that recycle should be activated at least once towards 

the end of the process.  
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Optimac Progress 

Optimac shows a number of entries in a window displaying the performance curve. 

The particular entries depend on the stage of the process. A typical display might be as 

shown. 

 
 

The upper line shows the cycle and iteration numbers. On the next line are the current 

number of layers and the search number. A cycle number indicates that this is synthesis. 

Optimac refinement is indicated by the term Optimac Progress instead of Optimac Cycle. 

Refinement rather than synthesis is selected by entering zero for the number of synthesis 

cycles in the parameters dialog box. The iteration number gives the number of iterations 

so far completed in the current synthesis cycle, that is in the refinement that follows a 

change in the number of layers.  

At each iteration, a number of directions in parameter space equal to the number of 

layers is searched. These directions are set up in different ways and the search number 

indicates which direction is currently being searched. The progress of the search is 

indicated in the small display box at the top right of the progress window. This shows the 

various evaluations of the merit function as vertical lines that are either green or red 
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plotted against the magnitude of the current displacement vector. Green indicates a 

negative vector and red a positive. Note that this does not mean that the layers are 

necessarily thinner or thicker. The vector positive direction in parameter space is quite 

arbitrary. The dark line across the lower part of the progress box indicates the current best 

figure of merit and gives an idea of scale. The vector scale is simply arranged so that the 

width corresponds to the searched region. Sometimes it will be clear that the region 

actually searched is smaller and this indicates that over the missing part at least one of the 

thicknesses involved became negative.  

Starting, current, and best figure of merit are self-explanatory. The vector shown 

corresponds to the best value for the particular search direction. The improvement 

displayed is unity if the current reduction in the figure of merit represents 1% of the 

limiting range for the merit function scaled to take account of the current merit function. 

For example, if the limiting range is 0.1 then RI of 1.0 indicates an improvement of 

0.001, or 0.1%, in the current figure of merit. If the relative improvement falls below 1.0 

then the current direction set is considered to be failing and, after an evaluation 

procedure, a different technique is substituted unless the procedure indicates that it is 

worth continuing with the current one. The particular procedure is indicated in 

parentheses after the improvement figure. G (standing for gradient) is the simplest and 

represents changes in just one single layer at a time. If the changes in the layers are small 

then G reproduces roughly the same alterations as does one of the gradient methods. C 

indicates that the directions within the set are being changed. The way in which they are 

changed ensures the generation of a conjugate set. A indicates no change in the set. B and 

BMod represent a number of alternative sets, BMod being not just one but several 

different sets and Rand represents a completely random but mutually orthogonal set. All 

of these are either changed, based on the current results when the letter C is displayed, or 

retained unchanged, when the letter A is displayed. The details of the sets are 

unimportant from the user's point of view but the technique can be thought of as 

constantly probing and searching in new directions to reach deeper and deeper levels of 

the merit function. 

The synthesis is made up of a number of phases. These are indicated by Phase, just 

below Improvement. Refinement indicates a period of refinement with the number of 

layers remaining constant. At the end of each set of iterations that make up a synthesis 

cycle the Inserting Layers phase is entered. Here, layers that are not useful in 

maintaining the figure of merit are removed and others are added. The added layers at 

this stage have thicknesses corresponding to the synthesis step. A number of different 

techniques based on experience are used for adding the layers and several may be 

involved. Sometimes the design is also deliberately perturbed. Immediately after the 

additions the merit figure, and the number of layers, will usually show increases. The 

effect of the changes is then assessed in an operation known as Initialization that 

measures the rate of merit improvement and accepts the changed design only if the rate is 

considered satisfactory. Then the refinement portion of the cycle will recommence. 

Otherwise an alternative systematic phase known as a Screening Search will be 

initiated. This screening search begins by discarding useless layers and then explores a 

large number of alternatives but is triggered only when the normal processes of addition 

and perturbation fail. 

The process may terminate in several ways. If the merit figure falls below the set 

range or if the number of cycles exceeds the number entered then the termination will be 
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automatic. Often, however, the process may be terminated manually. This can be done by 

selecting the pause button which brings up a pause box similar to that for simplex. 

When the process terminates it may be, if the synthesis parameter is large or if the 

termination occurs during an initialization, that an earlier cycle had a better figure of 

merit. If so this will be pointed out and the opportunity given to accept the better earlier 

design rather than the poorer later one. 

Annealing Progress 

Simulated Annealing has a similar display, shown below, although the various entries 

are different in detail.  

 
 

The current figure of merit is that calculated for the latest perturbation of the design. If 

this figure of merit is an improvement on the existing one then it will be accepted and the 

improvement item will show briefly a positive figure. If the figure of merit is worse than 

the current one then it may be accepted with a probability determined by the Boltzmann 

function. Then the improvement will show briefly a negative value. The best figure of 

merit indicates the lowest merit figure so far which is being held until a still better figure 

is achieved 

Conjugate Gradient Progress 

The Conjugate Gradient display is relatively simple. The figure of merit at the start of 

refinement is displayed together with the current figure of merit.   
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Clicking the Pause button displays the following options: 

 
 

Selecting Save Best Design stops the refinement and stores the best design in the 

design editor. Continue closes the window and continues refinement. Plot Now causes 

the progress display plot to be updated with the performance of the current design. Abort 

Refinement stops refinement but does not change the contents of the design window. 

 

Quasi-Newton Progress 

The Quasi-Newton display is relatively simple. The figure of merit at the start of 

refinement is displayed together with the current figure of merit.   
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Clicking the Pause button displays the following options: 

 
 

Selecting Save Best Design stops the refinement and stores the best design in the 

design editor. Continue closes the window and continues refinement. Plot Now causes 

the progress display plot to be updated with the performance of the current design. Abort 

Refinement stops refinement but does not change the contents of the design window. 

Needle Synthesis Progress 

The Needle Synthesis display is shown below. The figure of merit at the start of 

refinement is displayed together with the current figure of merit.  The current synthesis 

cycle number is also displayed together with the current phase of synthesis. The 

displayed phases are Adding Layers shown when Needle Synthesis is determining where 

to add layers, Refining when Needle Synthesis is performing Conjugate Gradient 

refinement and Compacting when Needle Synthesis is removing thin layers. 
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Clicking the Pause button displays the following options: 

 
 

Selecting Save Best Design stops the synthesis and stores the best design in the 

design editor. Continue closes the window and continues synthesis. Next Cycle causes 

synthesis to begin the next synthesis cycle by adding new layers. Add Material forces 

Needle Synthesis to add extra material to one end of the design. Plot Now causes the 

progress display plot to be updated with the performance of the current design. Abort 

Synthesis stops synthesis but does not change the contents of the design window. 

Differential Evolution Progress 

The Differential Evolution display is shown below. The current generation is 

displayed together with the current population member being evaluated. Finally the 

current best and worst merit figures in the current generation are also shown. 
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Clicking the Pause button displays the following options: 

 
 

Selecting Save Best Design stops the refinement and stores the best design in the 

design editor. Continue closes the window and continues refinement. Abort Refinement 

stops refinement but does not change the contents of the design window. 

Non-Local Refinement Progress 

The Non-Local Refinement display is shown below 



Refinement and Synthesis  181 

 
 

The display of data depends to some extent on the refinement method used. Simplex is 

shown. Because of the possible volume of calculation it is possible to suppress the 

plotting of the characteristic altogether. Then the display is as shown, but with a blank 

plot area. The Pause button activates the following dialog. Save Best Design saves the 

current best design and continues refinement with a subsequent design. Abort Refinement 

saves the current design and stops the process. 

 

 

Archival Synthesis 
A problem with virtually all synthesis techniques, not only in the thin-film coating 

field, is to decide when the process should be stopped. A more complex design gives 

improved performance, but there comes a point where the increase in complexity may be 

no longer worth the corresponding gain in performance. The recognition of this point is 

very much a subjective process that is almost impossible to program automatically into 

an automatic procedure. An advantage that the synthesis methods in the Essential 

Macleod have over many other current techniques is that there is a steady progression of 
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optimized designs characterized by increasing levels of performance accompanied by the 

expected increase in complexity.  

 
 

During synthesis, the complete record of all optimized designs is retained and 

presented in summary form in a table. The example shows the record of an antireflection 

coating with target performance of a reflectance of zero over the region 400 to 1200nm. 

Materials used are specified as MgF2 and ZrO2. The Synthesis History window shows 

the figure of merit against the number of layers. The figure of merit shows a continuous 

fall while the number of layers fluctuates. This behavior is quite normal. The most 

attractive design from the point of view of performance against complexity is probably 

that of 11 layers with figure of merit 0.52791. Simply by double-clicking in the 

appropriate cell, the design can be recalled.  

Any or all of the designs can be recalled and saved in regular design files so that they 

are preserved, but once the Synthesis History window is closed, any archived designs that 

have not been recalled and saved will be lost. 
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MATERIALS MANAGEMENT 
Like real thin film materials those used in the package are absorbing and dispersive. 

The refractive index component of the optical constant data is held in one of several 

models: Sellmeier coefficients, Cauchy coefficients, Drude coefficients, Lorentz 

coefficients, Drude-Lorentz coefficients, Hartmann coefficients or tabular data. The 

extinction coefficient component is either held as a table or can be declared to be zero. 

For Drude, Lorentz, and Drude-Lorentz, the extinction coefficient component is part of 

the model and so there is no separate extinction coefficient model. 

The Sellmeier model is defined as: 

𝑛(𝜆) =  √1 + ∑
𝐴𝑞𝜆2

𝜆2 − 𝐵𝑞
𝑞

 

Where 𝑛 is the refractive index, 𝜆 is wavelength, 𝐴 and 𝐵 are the Sellmeier 

coefficients and 𝐵 is always in units of µm2. 

The Cauchy model is defined as: 

𝑛(𝜆) =  ∑
𝐴𝑞

𝜆2𝑞

𝑞

     𝑞 = 0,1,2, … 

Where 𝑛 is the refractive index, 𝜆 is wavelength, 𝐴 is the set of Cauchy coefficients 

and is always in units of µm2q. 

The Drude model is defined as: 

𝑛2(𝜆) = 𝐴 −
𝜆2

𝐵2(1 − 𝑖𝜆𝐶)
 

Where 𝑛 is the complex refractive index, 𝜆 is wavelength, 𝐴, 𝐵, 𝐶 are the Drude 

coefficients. 𝐴 is theoretically unity (but may be greater than unity for real materials). 𝐵 

is the plasma wavelength in nm and 𝐶 represents frictional loss. 

The Lorentz model is defined as: 

𝑛2(𝜆) = 𝐴 + ∑
𝐵𝑖𝐶𝑖𝜆

2

𝜆2 − 𝐶𝑖
2(1 + 𝑖𝜆𝐷𝑖)

𝑖

 

Where 𝑛 is the complex refractive index, 𝜆 is wavelength, 𝐴, 𝐵𝑖 , 𝐶𝑖, 𝐷𝑖  are the Lorentz 

coefficients. 𝐴 is theoretically unity (but may be greater than unity for real materials 

especially when high frequency oscillators are not included in the summation). 𝐵𝑖  is a 

combination of the plasma wavelength and the contribution of the ith term to the 

refractive index. 𝐶𝑖 is the resonant wavelength of the ith term and D is the frictional loss 

of the ith term. 

The Drude-Lorentz model is defined as: 

𝑛2(𝜆) = 𝐴 −
𝜆2

𝐵2(1 − 𝑖𝜆𝐶)
+ ∑

𝐵𝑖𝐶𝑖𝜆
2

𝜆2 − 𝐶𝑖
2(1 + 𝑖𝜆𝐷𝑖)

𝑖

 

Where the parameters have the same meanings as above. 



184  Materials Management 

The Hartmann model is defined as: 

𝑛(𝜆) =  𝐴 +
𝐵

𝜆 − 𝐶
 

Where 𝑛 is the refractive index, 𝜆 is wavelength, 𝐴, 𝐵 and 𝐶 are the Hartmann 

coefficients and 𝐶 is always in units of µm. 

 

When the refractive index model is not Drude, Lorentz, or Drude-Lorentz, the 

extinction coefficient is either held as a table of values or a Cauchy model or an 

exponential model or declared to be zero. 

The Cauchy model for extinction coefficient is defined as: 

𝑘(𝜆) =  ∑
𝐴𝑞

𝜆2𝑞

𝑞

     𝑞 = 0,1,2, … 

Where 𝑘 is the extinction coefficient, 𝜆 is wavelength, 𝐴 is the set of Cauchy 

coefficients and is always in units of µm2q. 

The exponential model for extinction coefficient is defined as: 

𝑘(𝜆) =  𝐴𝑒
𝐵
𝜆  

Where k is the extinction coefficient and 𝐴 and 𝐵 are constants. 

For isotropic materials, there is one set of data. For anisotropic materials there are 

three sets of data, one set for each principal axis. The same data model must be used for 

each axis. 

In calculations, for the Sellmeier, Cauchy, Drude, Lorentz, Drude-Lorentz and 

Hartmann models, the refractive index is calculated from the coefficients. For the table 

model, the required values are read from the tables. If necessary the values are 

interpolated or extrapolated. Interpolation is linear. Extrapolation keeps the last value 

from the table. The wavelengths do not need to be equally spaced. Where the values of n 

and/or k are changing rapidly, for example, the density of values can be greater. Similarly 

for the Cauchy and exponential models the extinction coefficient is calculated from the 

coefficients. 

Tables are provided as well as the dispersive formulae because of the wide range of 

different materials and conditions that are involved. Some metals, for example, cannot be 

represented by the common normal dispersion formulae that are useful only for very well 

behaved dielectric materials over limited spectral regions. Any material can be 

represented by a table. 

The tables of values need to be maintained. It must be possible to extract and examine 

the values that are stored. Changes may be necessary. New materials may have to be 

added. Unnecessary materials may have to be deleted. A new database of materials based 

on an existing one, perhaps a subset, may need to be constructed. All of these operations 

are included in the package. 
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The Materials Database 
Each materials database consists of a collection of material files, with an index, in a 

separate folder. The number of databases is limited only by the capacity of the hard drive. 

Only one materials database can be active at any one time but a need for a design to use 

materials from several databases can be very easily accommodated by importing the 

relevant materials files, a simple and rapid operation. 

The active database is set in the Essential Macleod Options dialog box activated by 

the General... menu command in the Options menu. To change the active database all 

files including designs and materials must first be closed. Then the Materials Folder 

selection box will be unlocked and either a database in the list chosen or a new one 

entered by clicking the Browse button and using the Make New Folder button when an 

appropriate location has been selected. If a new folder is created and a corresponding 

database does not exist then the option of creating a new database is given. This will be 

an empty database except for one material, Air, and one substrate Lossless 

The Maintain Folders button allows you to control the display order of the materials 

databases, add new databases and remove databases from the list. Removing a database 

from the list does not delete the database from your computer.  Clicking the Maintain 

Folders button displays the dialog below: 

 
 

Click the Add button to add a new materials database to the list. The new database 

will be added to the bottom of the list. Select a database by clicking on it and the click 

Edit to change the materials database. This will replace the database in the list with the 

new database. With a database selected, use Move Up and Move Down to change its 

position in the list. Clicking the Remove button will remove the database from the list. 

Note that the current materials database is not displayed in this list.  

Displaying list of materials in database 

The Tools menu for most windows carries the item Materials. This activates a list of 

materials that are in the database together with their optical constants at the wavelength 

specified at the top of the table. To change the wavelength, edit the value in its cell at the 

top of the table. 
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The order of the materials in the table is identical to that in the popup lists in design 

tables. This order can be changed. The Sort option under Edit offers criteria under which 

the entire list can be ordered. Alternatively, to move a material name individually, click 

once in the box containing it then use the mouse to drag the name to its new position. If 

the name is dragged out of the current limits of the table then no change will be made. 

Importing materials from the Materials Library 

The Essential Macleod is supplied with a Materials Library.  The Materials Library is 

a collection of material data organized by groups (for example, metals, dielectrics) but is 

displayed in a single hierarchical list format. To open the materials library, select Browse 

Materials Library… in the Tools menu. 
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A newly opened materials library window appears as above. The materials in the library 

are contained in several groups. Double-click on a group name to show the members of 

the group. 

 
 

Here, the first few members of the Metals group are visible. Refractive index information 

is not displayed because a wavelength has not been entered. Enter a wavelength value 

into the wavelength box and press <Enter>. 

 
 

Refractive index values will appear for the entered wavelength. You can open more than 

group at a time. Double-click on another group name and its members will also appear. 

Double-clicking on a group name that has its members displayed will close that group.  

The materials can be sorted in different orders. Double-clicking in a header will first sort 

the list into ascending order for that header. Double-clicking again in the same header 

will change the sort into descending order. Here a part of the Metals and Dielectrics 

groups has been sorted into order of ascending n.  
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To load a material from the library into the current materials database, you can either 

double-click on the material name, or select the material name and click the Open button. 

If a material of the same name does not already exist in the materials database, then 

material will be opened and given the same name as in the library. If the material name 

already exists in the materials database, then the material name will be opened and given 

a modified name that does not already exist in the database. Where available, the library 

also contains internal transmittance data in the material definitions. When materials are 

opened from the library, they have a temporary status. They can be used in designs etc. 

but they are not permanently saved in the materials database. Closing a material without 

saving it will cause the material to be deleted after the last item using it is closed. If you 

close the material before it is saved, you will receive a warning about the temporary 

status of the material. 

   
 

Importing materials from another database 

To import materials from other databases, first use the Materials command in the 

Tools menu to activate the Materials window where the materials list is displayed. Then 

use the Import command in the Edit menu. The materials database from which materials 

are being copied is selected in the usual dropdown list. Multiple materials, including 
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noncontiguous ones, can be selected by clicking on them. To deselect a material click on 

it again. This makes it very easy to create a new materials database for a new project, 

particularly useful when some changes in the system of units are expected, such as 

moving to the infrared and working in terms of microns instead of nanometres. 

 
 

Should a material be selected for import that exists already in the active database then 

a dialog box appears asking if the current material should be overwritten. If the answer is 

negative then a further dialog asks for a new name for the material. The operation can be 

canceled at this stage. 

The materials database dropdown list has a limited capacity. Should the database from 

which the materials are to be imported not be in this list, its path and name can simply be 

typed into the database field. The Browse button can also be used to display a folder 

browser. The material database can be selected from the list of folders. As soon as it has 

been correctly entered, the materials from it appear in the scrolling selection list. If this 

does not happen and it appears impossible to leave the database field, then it is an 

indication that the path or database name as entered is incorrect. Although a final 

backslash is shown in the diagram, it is optional. 

The list of materials also shows the optical constants for the material at the 

wavelength specified above the list. This wavelength can be changed if desired. After 

entering the wavelength, press the <Enter> key or click in another box to update the 

optical constants. You can also plot the optical constants against wavelength or 

wavenumber (frequency) in the current units by clicking the Wavelength or 

Wavenumber buttons.  

To support older materials databases where substrate data is kept is separate files, if 

Import Matching Substrate is checked before materials are imported, then substrate 

definitions with the same names as the materials will also be imported into the current 

materials database. 
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Exporting and Importing Individual Materials 

Individual materials may be exported from one copy of the Essential Macleod and 

imported by another copy.  To export a material for import by another copy of the 

Essential Macleod, open the material either by using the Open Material… command in 

the File menu, or by double-clicking on the material name in the Materials window 

(Tools menu -> Materials). From the File menu, select Export and then Material. You 

will be prompted to choose a filename and location to store the data. The filetype for 

exported material data is “mtx”. This is a text file and may easily be sent as an attachment 

to an email. 

To import a material in an mtx file into the current database, you can either drag-and-

drop the mtx file onto the Essential Macleod desktop, or you can use Open in the File 

menu. Set the filter to All files (*.*). If there are many files in the folder, you can type 

*.mtx into the filename box to show only the mtx files. Open the mtx file and the data 

will be loaded into a new material window. If a material of the same name does not 

already exist in the materials database, then material will be opened and given the same 

name as in the source copy of the Essential Macleod. If the material name already exists 

in the materials database, then the material name will be opened and given a modified 

name that does not already exist in the database. The new material will have a temporary 

status. It can be used in designs etc. but it is not permanently saved in the materials 

database. Closing the material without saving it will cause the material to be deleted after 

the last item using it is closed. If you close the material before it is saved, you will 

receive a warning about the temporary status of the material. 

 

Display of Materials Data 
The material data can be displayed simply by using the Open Material... command 

under the File menu. An alternative is to double-click the material name in the materials 

list displayed by the Materials command in the Tools menu. This displays material data 

in a material window. Once the material window is active, the Plot menu permits the 

plotting of optical constants against wavelength or frequency. 

The data displayed depend upon the model being used. For refractive index there are 

several possible models: Cauchy, Sellmeier, Table, Drude, Lorentz, Drude-Lorentz and 

Hartmann. For extinction coefficient, there are four possible models: k = 0, Table, 

Cauchy and Exponential. When the refractive index model is Table, the extinction 

coefficient model is always Table. The models to be used are selected by the drop down 

lists at the top of the Material window.  
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For the non-tabular models (see below), the parameters are supplemented with 

increments. These increments are only used by Reverse Engineer. 

For Table data, the refractive index and extinction coefficient are entered as triplets of 

wavelength, refractive index and extinction coefficient. Values in between the 

wavelengths are derived using linear interpolation. For wavelengths less than the first 

value or greater than the last value, the first and last values are used respectively. 

For Sellmeier data, the A and B parameters are entered as pairs, one pair for each term 

in the model. A minimum of one term must be entered. The number of terms available is 

essentially unlimited. In addition to the terms, the wavelength limits must also be 

specified. For wavelengths less than the minimum wavelength or greater than the 

maximum wavelength, the refractive index at the minimum wavelength and the refractive 

index at the maximum wavelength are used respectively. 

  
 

For Cauchy data, the A parameters are entered for each q. A minimum of one term 

must be entered. The number of terms available is essentially unlimited. In addition to the 

terms, the wavelength limits must also be specified. For wavelengths less than the 

minimum wavelength or greater than the maximum wavelength, the refractive index at 

the minimum wavelength and the refractive index at the maximum wavelength are used 

respectively. 
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For the Drude model, there are just three parameters, A, B and C. Wavelength limits must 

also be entered. 

 
 

For the Lorentz model, each oscillator can be entered on a single row. The single 

oscillator model below is representative of MgF2: 
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In the case of the Drude-Lorentz model, both the Drude and Lorentz components are 

entered. The model below is representative of gold: 

 
 

For the Hartmann model, there are just three parameters, A, B and C. Wavelength limits 

must also be entered. The coefficients below represent SiO2. 
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For tabular extinction coefficient data associated with a Sellmeier or Cauchy model, 

the extinction coefficient data are entered as pairs of wavelength and extinction 

coefficient values. Values in between the wavelengths are derived using linear 

interpolation. For wavelengths less than the first value or greater than the last value, the 

first and last values are used respectively 

  
 

Manual Entry 
Entry of new information or editing of existing values can readily be performed in the 

same way as with any other table of parameters. Data can also be pasted in from the 

clipboard. The operation of the insertion command for tabular refractive index data is a 

little different from other parameter tables and will now be described in greater detail. 

Insert Points for Tabular Data 

In the calculations throughout the package, whenever values of the optical constants 

are required at wavelengths for which there is no entry in the table, they are linearly 

interpolated from the existing data. Any other form of interpolation requires values 

beyond the nearest wavelength points in the table. It may be that a more involved form of 

interpolation is appropriate in particular cases where there is a sudden change in the sense 

of variation of the optical constants. This is the purpose of the special insertion command 

for optical constant data. It uses a cubic spline interpolation procedure that operates on 
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the entire data table. If, therefore, there is a gap in a table where the sudden changes in 

optical constants suggest that linear interpolation would not be the best form then the gap 

may be filled in using the cubic spline method and the results stored in the material table. 

Then the calculations will simply linearly interpolate these new values and any problems 

are completely avoided but the speed advantages of linear interpolation are retained. 

We can illustrate this by an example, admittedly contrived. The following table shows 

a set of refractive index values against wavelength. They oscillate sharply between 2 and 

4 and the plot of the refractive index values in the following diagram shows very sharp 

peaks and troughs. 

  
 

 
 

In the table we now insert four points between each of the primary wavelengths. The 

resulting table has the appearance shown in the next figure. 
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Wavelengths have been inserted but the inserted refractive index and extinction 

coefficients are indicated by asterisks showing that the corresponding values will be 

determined by a cubic spline interpolation once the window is closed or whenever a plot 

is required. Values can however be manually entered into any of the cells with asterisks 

and will be treated as valid data. 

Now we select Plot and Plot on Wavelength Scale from the menu. The plot that 

appears is given in the next figure followed by the new table of values. 
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Wavelength Scale... 

Materials data are held in generic units (actually nanometres) and converted 

automatically to whatever display units are in force. There is therefore normally no need 

to alter the wavelength scale of a material. However, there may be occasions when it is 

realized that a material wavelength scale is off in some respect. Maybe it was entered 

incorrectly or has not been properly converted from a database of an earlier type. If the 

data for entry is of a different scale it is nevertheless often convenient to enter it first and 

then to make any necessary corrections. This is the purpose of the Wavelength Scale... 

menu item. The Wavelength Scale...  command is only available when the Refractive 

Index Model is Table. 

The option should be used with caution. It asks for the Wavelength Units of This 

Material. If the material has just been entered then the wavelength units box should have 

the Scale Factor for the current material wavelength scale. If the units are microns, for 

example, then the number entered in the box should be 1E-06. If the material has been 

entered previously and it is only now realized that the wavelength scale is incorrect then 

it may be a more complicated operation because the wavelength scale may not now be 

that originally entered. Examine the current wavelength entries. Decide on the factor that 

must be used to convert them into correct values. For example, if the wavelength value 

shown in the table is 1000 and the correct value should be 1.0, then the conversion factor 

is 10-3. Write down the scale factor for the correct current wavelength units. If the current 

scale units are microns then the scale factor is 1E-06 or 10-6. Multiply this scale factor by 

the conversion factor to give the number that must be entered in the dialog box. In the 

present example this will be 10-310-6=10-9 or 1E-09. 

Should it happen that all the materials in a database are incorrect by the same factor 

then correction on an individual basis can become exceedingly tedious. In such a case it 

is better to scrap the units definition file. First calculate the necessary scale factor as 

detailed above. Make a note also of the various units in the General Units box. Close the 

Essential Macleod. Find the folder with the relevant materials database. Rename the file 

Units.tfp to Units.tmp. Open the Essential Macleod and enter the universal correction 

factor, calculated as in the previous paragraph, You will need also to reenter the general 

units. Check that all is well and if so then dispose of the file Units.tmp. 

Packing Density... 

The refractive index of a thin film depends not only on the material but also on the 

packing density. Even if two films were constructed from exactly the same material, their 

refractive indices would be different if their packing densities were different. Thin films 

rarely have the same refractive index as similar bulk materials, for example. This menu 

item allows the indices of a stored material to be altered as though the packing density 

had changed. It is useful in, for example, the correction of bulk material values more 

closely to agree with what might be expected from a thin film. It can also be used to 

adjust the material constants in an alternative database to represent materials deposited at 

a different substrate temperature. The model used for the relationship between index and 

packing density is discussed in greater detail earlier in this manual. It is a linear one 

simply because many materials have been shown empirically to obey a linear law. The 

dialog box that appears asks for a new value of packing density. This value assumes that 
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the current packing density is unity. Alternatively, since the law is linear, the entry is 

equivalent also to a proportional change in packing density. For example an entry of 0.9 

followed later by an entry of 1/0.9=1.111111 will restore the indices to their original 

values. The Packing Density … command is only available when the Refractive Index 

Model is Table. 

Exercise caution in the use of this command. Once the change has been made there is 

no indication that the values are anything other than normal. The command should not be 

used unless it is very clear and unmistakable that the material is now different from 

standard. Thus the name of the database should reflect the situation or the name of the 

material should be changed in some way. 

 

Internal Transmittance Data  

Internal transmittance is described in greater detail in the Stack chapter of the manual. 

Briefly it is used in the calculation of transmittance through a thick medium in a Stack or 

in a Design. Extinction coefficient, k, is often very small and not known with sufficient 

precision for reliable calculations of thick material properties, and internal transmittance, 

the parameter usually published by material suppliers, is safer. 

Previously internal transmittance was published in separate substrate files but is now 

incorporated in the material files along with the n and k values. To reveal the Substrate 

menu items, now not present by default, use the Legacy tab in the General Options 

dialog, accessible through General... in the Options menu. 

The Internal Transmittance Model field in the Material document presents four 

choices, Undefined, Lossless, Table and Use k. Undefined means that there is no 

internal transmittance data in the Material file and if a legacy substrate file exists it 

should be used. Lossless means that the internal transmittance is 100% for all 

wavelengths. Table means that internal transmittance is specified as a table of values 

against wavelength. Use k means that internal transmittance values will be derived from 

the extinction coefficient values. This method is not recommended but is provided for use 

where no other information exists and the k values are considered reliable.  

Tabular data can only be entered when the Internal Transmittance Model is set to 

Table and the Tint tab has been selected. Also under this condition any existing Substrate 

document can be copied and pasted into the Material document. 
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It is possible to change the display to one of optical density against wavelength by 

selecting Density Display in the Edit menu. Again the optical density corresponds to 

internal transmittance. It does not include any reflection losses at the interfaces. To 

restore the transmittance select Transmittance Display in the Edit menu. 

 
 

The substrate data can readily be plotted. Select the appropriate option from the Plot 

menu. 

 
 

The graphs are, like those from tables, plotted initially with scales that are taken from 

the maximum and minimum values in the table. To change these the plot window should 

be active and then Parameters... in the Edit menu should be selected. 

Editing the internal transmittance data is quite similar to the editing of the refractive 

index data but there are some slight differences. Since density and transmittance are 

directly related analytically they cannot be entered independently. Therefore the display 

shows either transmittance or density but not both together.   

There are many different types of interpolation that could be used for calculating the 

inserted values but the great range of values, sometimes many orders of magnitude, leads 

to unsatisfactory performance. Polynomial and spline interpolation although they give 

nicely smoothed curves have a pronounced tendency under such circumstances to 
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produce spurious peaks and these peaks can often exceed 100% transmittance or take 

negative values. The insertion of values in this editor, therefore, is accomplished by linear 

interpolation. Values can then be adjusted manually if they appear to need it. When 

points are inserted the transmittance and density values are not calculated. Instead a series 

of asterisks, ***, is shown. These can be replaced by manually inserted values if desired. 

Linear interpolation of any values that are still represented by asterisks will take place if a 

plot is initiated or if the substrate is saved. The interpolation will be in terms of the 

particular parameter that is currently being displayed. 

Linear interpolation, however, can also lead to difficulties when there are wide 

differences at the ends of the interval. We illustrate this by a notional substrate file. We 

constructed this by inserting the density figures. The corresponding transmittances are 

shown on the right. 

               
 

Now we insert four points between 250 and 300, first making sure that transmittance is 

displayed. We insert the rows and the new transmittance values are shown simply as a set 

of asterisks. Next we trigger the interpolation by selecting a plot. The asterisks change to 

the interpolated values that are simply shown as zero transmittance. In terms of density, 

however, we see that there is a rather unrealistic plateau on the curve. 
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Under such circumstances it is better to interpolate so that the density values form a 

linear progression. We can do that by deleting those we have just entered and switching 

to density before interpolating. The resulting linear progression in density corresponds to 

an exponential increase in transmittance that appears much more realistic. 

 
 

Inserting values, therefore, is a linear interpolation process. The linear values will be 

in terms of transmittance if it is transmittance that is displayed, or density if density is 

displayed. In most cases transmittance is better if the values are high so that the material 

is fairly transparent. Density is better if transmittance is low and especially if there are 

order of magnitude changes. For intermediate values some experimentation may be 

required. This type of interpolation is preferable to, and avoids the problems inherent in, 

other forms. 

Once the editing has been completed, we can save the revised data either as a new 

material or as a modification to the original by selecting Save or Save As... from the File 

menu. 
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Thermal Model 
To enter the thermal properties for a material, click on the Properties tab.  

  
 

The three thermal parameters for the material can then be entered in the top three 

boxes. The units for the Linear Expansion Coefficient and dn/dT are fixed. The 

parameters after the three thermal parameters are used by the stress model (see page 243) 

and the uniformity model (see page 24) 

Birefringent Materials 
The default material window allows entry of optical constant data for isotropic 

materials. Select Birefringent from the Edit menu to change the material display to the 

birefringent data form.  

  
 

For birefringent materials, optical constants for each of the three principal axes are 

required. The three principal axes are labeled x, y and z. The x axis is parallel to the 
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surface of the films and parallel to the plane of incidence. The y axis is parallel to the 

surface of the films and normal to the plane of incidence. The z axis is normal to the 

surface of the films. 

Generating Refractive Index Models  
Sellmeier and Cauchy terms can be derived from tabular data. This is performed 

through the Derive Cauchy… and Derive Sellmeier… commands in the Edit menu. 

Selecting Derive Cauchy… displays the following dialog. 

  
 

Number of Terms specifies the number of terms in the derived model. The Max 

Wavelength and Min Wavelength specify the limits of the data to be used in the 

derivation.  By default, these encompass the entire data in the Material table, Where the 

wavelength is very broad and includes, for example, resonances, it may be necessary to 

restrict the wavelength range to the part of the data where the refractive index dispersion 

is well-behaved otherwise a good fit will not be achieved. Wavelength Interval specifies 

a sample interval to be used on the tabular data. By default this is blank and this means 

use the data points in the table without sampling. If a value is entered, the data are re-

sampled using the specified interval by linear interpolation. Re-sampling may be 

necessary to improve the fit in regions where there are relatively few data points, for 

example, a region where the dispersion is relatively linear. In the Extinction Coefficient 

box, you can choose to Copy k values to k table. If checked, the k values associated 

with the tabular refractive index values will be copied to the extinction coefficient table 

for use with the Cauchy model. 

Clicking the Advanced… button will display more parameters associated with the 

derivation. 
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The derivation uses non-linear simplex optimization to fit the model to the tabular 

data. These are parameters that control the Simplex optimization and have same meaning 

as in Refinement. Generally, these parameters will not need to be altered. 

Clicking OK in the Derive Cauchy Model dialog will start the derivation. A progress 

window will appear and at the finish of derivation it will show the Phase as Finished and 

also show the final merit figure. This is the rms deviation of the model from the (possibly 

re-sampled) data points. Smaller numbers indicate a better fit. 

 

Click OK to complete the derivation process. To see the results, select Cauchy in the 

Refractive Index Model list in the Material window. 

 

If Copy k values to k table was checked in the Extinction Coefficient box, then 

make sure that the Extinction Coefficient Model is set to Table. To keep the model data 

and use it in future calculations, save the Material. The original tabular data are not 

deleted, it is simple to return to using the tabular data by simply changing the Refractive 

Index Model back to Table and saving the Material. 

The Sellmeier derivation proceeds in a similar manner. The difference between the 

Cauchy and Sellmeier derivation is in the advanced parameters. For most materials the 

starting values shown below work well, however, for more unusual materials, these 

parameters may not result in a good fit and the fit might be improved by modifying the 

starting values.  
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Generating Extinction Coefficient Models  
Cauchy and Exponential terms can be derived from tabular data. This is performed 

through the Derive Cauchy (k)… and Derive Exponential (k)… commands in the Edit 

menu. Selecting Derive Cauchy (k)… displays the following dialog. 

 
 

 Number of Terms specifies the number of terms in the derived model. The Max 

Wavelength and Min Wavelength specify the limits of the data to be used in the 

derivation.  By default, these encompass the entire data in the Material table, Where the 

wavelength is very broad and includes, for example, resonances, it may be necessary to 

restrict the wavelength range to the part of the data where the extinction coefficient 

dispersion is well-behaved otherwise a good fit will not be achieved. Wavelength 

Interval specifies a sample interval to be used on the tabular data. By default this is blank 

and this means use the data points in the table without sampling. If a value is entered, the 

data are re-sampled using the specified interval by linear interpolation. Re-sampling may 

be necessary to improve the fit in regions where there are relatively few data points, for 

example, a region where the dispersion is relatively linear. 

Clicking the Advanced… button will display more parameters associated with the 

derivation. 
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The derivation uses non-linear simplex optimization to fit the model to the tabular 

data. These are parameters that control the Simplex optimization and have same meaning 

as in Refinement. Generally, these parameters will not need to be altered. 

Clicking OK in the Derive Cauchy Model dialog will start the derivation. A progress 

window will appear and at the finish of derivation it will show the Phase as Finished and 

also show the final merit figure. This is the rms deviation of the model from the (possibly 

re-sampled) data points. Smaller numbers indicate a better fit. 

 
 

Click OK to complete the derivation process. To see the results, select Cauchy in the 

Extinction Coefficient Model list in the Material window, after changing the Refractive 

Index Model from Table. 

 
 

To keep the model data and use it in future calculations, save the Material. The 

original tabular data are not deleted, it is simple to return to using the tabular data by 

simply changing the Refractive Index Model back to Table and saving the Material. 

The exponential model used is: 

𝑘(𝜆) =  𝐴𝑒
𝐵

𝜆⁄  
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A and B are determined by a least squares fit of the exponential model to the k data. 

To aid the fitting process and avoid problems where the k value is zero, a minimum k 

value can be set. Values of k less than this value are not used in the calculation.  Selecting 

Derive Exponential (k)… causes a fit to be performed to the data and the rms difference 

is displayed. 

 
 

If the fit is not satisfactory, changing the Minimum k value might improve the fit. 

After changing the value, click Calculate Again to recalculate the A and B parameters. 

Click OK to copy the parameters to the Material window. To see the results, select 

Exponential in the Extinction Coefficient Model list in the Material window, after 

changing the Refractive Index Model from Table. 

 
 
 

Deleting Materials 
Deleting a material is discouraged because of future compatibility problems when 

reading a design that may have used that material. It is far better just to create a new 

material database and import the materials with the exception of the one that is to be 

removed. However there may be occasions when deleting a material is necessary. 

First the menu item Materials under the Tools menu should be selected which presents 

the materials window with the list of materials in the current database. Select the material 

that you wish to delete by clicking on the name, then select Delete in the Edit menu.  If 

you need to recover a deleted material, select Undelete in the Edit menu. A window will 

appear listing the deleted materials in the database. Select the materials that you wish to 

restore and click Undelete. The materials database will recycle deleted materials. If you 

have added materials to the database since deleting a material, it may not be possible to 

recover the deleted material. 
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We emphasize once again that the best practice is never to make alterations except 

adding new materials to an existing materials database. This preserves compatibility with 

all previous designs that have used that particular database. If changes other than 

additions of materials are to be made then it is better to create a new database, to copy 

only the desired materials from the existing one to it and then to make any alterations 

before creating any designs. This preserves integrity. It is fairly easy to devise a naming 

convention that keeps track of what is happening. The designs, too, should be kept in 

separate design folders or even in the appropriate materials folder. Archiving is then a 

simple matter. 

Optical Constant Extraction 
Optical constants can be extracted from reflectance and transmittance data using a 

variant of the envelope technique. The films should be essentially dielectric with 

thicknesses such that there are extrema within the wavelength range of interest. 

Absorption may be included provided that it is not so great that the fringes are washed 

out. The films may also be inhomogeneous provided that the variation of index through 

the film is monotonic and the index contrast at the boundaries between film and 

surrounding media is larger than the inhomogeneity. 

The technique used is of the class known as envelope methods. Such methods focus 

on the maxima and minima of reflectance and/or transmittance and the first stage of the 

calculation involves the interpolation of the maxima and minima to generate the 

envelopes. The ideal envelopes consist of the substrate transmittance or reflectance and 

the ideal quarterwave transmittance or reflectance. When the layer is absorbing, or 

inhomogeneous, the maxima and minima depart from these ideal envelopes by an amount 

that increases with thickness but, when absorption and/or inhomogeneity is not too high, 

the envelopes can still serve to launch the n and k calculations. An advantage of the 

method is that layer thickness is not, initially, required. It is calculated later in the 

process. The Essential Macleod technique gives a best fit to the level of the extrema but 

the technique concentrates on the level rather than position of the extrema in the first 

instance. This avoids the major discontinuities that can occur in other techniques. The 

variation of absorption in the film with wavelength is determined but at first in terms of a 

parameter that contains extinction coefficient and thickness together. Once thickness has 

been determined then a value can be placed on the extinction coefficient. Films are often 

inhomogeneous and so the method includes the possibility of inhomogeneous films. The 

technique, like all others, does have multiple solutions and has to ensure that the correct 

one is adopted. This means reducing the range that is searched by giving additional 

information. First, the user is asked to identify each extremum as a quarterwave or a 

halfwave condition. This reduces the number of solutions for a weakly absorbing film to 

two. Then the user is asked to give a rough estimate of film index. The solution nearest to 

this estimate is chosen. 

If the positions of the extrema are accurately determined then they do give useful 

information about the dispersion of the optical constants although they tell nothing about 

the absolute levels. We can choose to accept the absolute level determined by the 

envelopes and correct the dispersion to agree with the extrema positions. This can be 

useful, for example, when there are problems with noise or absolute accuracy over part of 

the region concerned. 
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The particular method has been compared with others in common use and was chosen 

over them because of its great stability. In many methods, errors committed in the 

determination of the reflectance and/or transmittance figures can have serious 

consequences for the extracted optical constants, sometimes making it impossible to 

derive physically possible results at all. Of course measurement errors will lead to optical 

constant errors because it is impossible to derive exactly correct results from incorrect 

measurements, but the consequences of errors can be magnified enormously in the 

derived results. Such magnification is largely avoided by the method adopted here. 

The input consists of the maxima and minima of transmittance and/or reflectance. For 

transmittance data, the measurement must be taken with an uncoated rear surface and 

include the multiple reflections generated by the rear surface. The reflectance 

measurement may be made under the same conditions, or the rear surface may be treated 

so that the reflections from the rear surface are eliminated. There are tools to assist in 

extraction of the necessary data from raw spectrometer records described later. 

Accuracy estimates for the input should be provided and will be used by the program 

to modify the results if a good fit cannot otherwise be obtained. Two possible results 

usually exist and that nearest the estimated value of film index will be accepted. When 

measurements are transmittance only then either an inhomogeneous non-absorbing model 

or a homogeneous absorbing model may be chosen. Reflectance only results use an 

inhomogeneous non-absorbing model and reflectance and transmittance results use an 

inhomogeneous and absorbing model. Extrema wavelengths are not usually fitted exactly 

but the reflectance or transmittance figures are matched as well as possible and then the 

thickness is chosen for best fit wavelengths. If the extrema wavelengths are judged most 

important an option that first fits the reflectance or transmittance figures and then alters 

the optical constants to fit the wavelengths of the extrema may be selected. Note that the 

positions of the extrema influence the dispersion of the indices rather than their absolute 

level. 

To launch this extraction process select Optical Constant from the New submenu of 

the File menu. You will then be directed to enter the measurement data and the 

measurement conditions. 
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The first step is to enter the measurement conditions: Incident Angle, Polarization 

(when the incident angle is not zero) and Tolerance (the uncertainty in the 

measurement). Clicking Next then prompts you to import the transmittance data. This 

will be a measured spectrum in a text file. Click Choose Data to select the file. The 

Import Editor will be used so that you can define the data in the file.  

 
 

When the file has been imported, a confirming plot will be displayed. 

If you only have reflectance data, click Next without choosing any transmittance data. 

Clicking Next prompts you to import reflectance data. The process is the same as for 

importing transmittance data. If you only have transmittance data, click Next to proceed 

to defining the substrate. 
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You can choose to either import a spectrum or use an existing material in the materials 

database. Clicking Next displays the Substrate Transmittance page. Here you can choose 

a transmittance data file or click Next to move to the Substrate Reflectance page. Here 

you can choose a reflectance data file. Both substrate transmittance and substrate 

reflectance data are imported in the same way as the film data. If you are using existing 

material data, click Next in both pages without choosing any data files. 

After clicking Next in the Substrate Reflectance page, the software will automatically 

find the best set of parameters and present a summary. 

 
 

The RMS difference is between the imported data and the calculated performance 

using the extracted optical constants. The high/low index of the material is with respect to 

the substrate. A high index material has refractive index greater than the substrate. 

Clicking OK will present details of the results. This is the same as having selected 

Extract n&k in “The extraction process in operation” below. Alternate results are 

available by selecting Show Alternatives in the Calculate menu. 
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Each row lists an alternate solution. The Adjustment column indicates the number of 

data points that either needed adjustment or were flagged as bad results. To view an 

alternative result, select the row by clicking in the left cell and then click Load. 

Clicking Cancel during the directed data entry will return you to an empty optical 

data window that has the general appearance of the following figure except that the 

columns will be empty. Note that this view of the data can always be activated by using 

the Data command in the View menu. 

 
 

The menus corresponding to this window are similar to those for other windows with 

the exception of View, Calculate and Create Material and Import in the File menu. 

The data window shows what will actually be used to carry out the calculations. The 

data consist of the maxima and minima of transmittance and/or reflectance with no 

correction for the rear surface, the only requirement is that the rear surface is uncoated. 

Maxima and minima are flagged as corresponding to quarter waves or half waves by the 

codes T-QW, T-HW, R-QW and R-HW. Substrate results can also be entered or they can 

be extracted from an existing material file (see below). These should be either uncoated 

transmittance results, flagged as T-SUB, uncoated reflectance results, flagged as R-SUB, 

or substrate refractive index, flagged as N-SUB. Either of two other flags must also be set 

for each input result. The column with the title Data Source can have either of two 

entries, Measured and Envelope. Measured corresponds to a real maximum or a 

minimum. Envelope indicates a result inserted simply to help the program draw the 

halfwave or quarterwave envelopes. These are interpolated by a cubic spline function and 

sometimes need a little help. Envelope results are intended for this. You will see the form 

of the envelopes when you use Plot Performance (see below) or are using 
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Transmittance or Reflectance in the View menu with Show Envelopes set. R and/or T 

results may be entered in any order. After the editor is closed the results are sorted into 

ascending wavelength. 

If only substrate transmittance data are provided, the substrate will be assumed free of 

absorption. Any actual transmission loss in the substrate will therefore be interpreted as 

lost by reflection at the interfaces and this implies a higher substrate refractive index. If 

substrate values are read from a material file then the extinction coefficient will be 

assumed to be zero. 

Data Entry 

Manual entry of the extrema is accomplished through the Data Window. Select Data 

in the View menu. The table can be edited in the normal way. 

There will be many cases where the data are more involved or less suitable for manual 

entry. Then it is possible to import raw transmittance or reflectance versus wavelength 

data and there are powerful tools for extracting the information necessary for the 

calculations. Each data record should consist of a wavelength value and a value of 

transmittance or reflectance, delimited by either a space or tab character. The 

transmittance and/or reflectance scale should run either from 0 to 100% or from 0 to 1.0. 

Wavelength should be in the same units as those that are current. If this is not the case 

there are two options. If all data including substrate values are to be entered in this way 

then the wavelength scale can be adjusted later once the constants have been extracted. If, 

however, substrate values are to be taken from the current database then the general units 

must be changed to correspond with the data that are to be entered. Once the optical 

constants have been extracted then the general units can be reset. 

The tabs Transmittance or Reflectance show a data display window. Initially this 

window is blank but the Import command in the File menu is now available and permits 

the importing of the reflectance or transmittance data into the window. A typical 

appearance of the window is shown below. Click on the mouse and drag a rectangle 

round one of the extrema on the curve. This defines a search region. Releasing the mouse 

button causes the peak to be located. Wavelength and value are then shown in the boxes 

at the top of the screen. Two other attributes of the extremum are required. One is 

whether the extremum corresponds to a quarterwave or a halfwave. The other is whether 

the point is to be treated as a measured point or an envelope point. Whenever possible, 

these entries will automatically be suggested, but the user must make sure that the entries 

are correct.  
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Once the details are verified, the Add Point button will transfer the data to the data 

window where it will be used for calculating the envelopes. The points identified as 

quarterwaves will be marked with a cross while the halfwaves are marked with a plus.  

Envelope values give the user the capability of altering the shape of the envelopes. 

They are drawn by a cubic spline process and occasionally may need slight adjustment. 

Envelope points can be placed anywhere and are intended to help with the drawing of the 

envelope so that it is improved. They are used in the calculation just as any other point 

but are omitted from the procedure estimating film thickness. To create an envelope point 

anywhere on the diagram use <Alt> + <Shift> <Left Mouse Button>. The resulting 

symbol can be dragged to where it is wanted. Then the Add Point button will enter it as 

an envelope point. 

Colors are used to help identify the various elements. Measured points are in blue, 

envelope points in red. 

To check a point, select it by drawing a box round it. The top of the screen will show 

the appropriate values. To remove a point, first select it and when the values are 

confirmed use the Delete Point button. 

To change a point from envelope to measured and/or vice versa select it and then 

change the Type attribute by using the popup menu. 

The Reflectance tab permits reflectance results to be entered and the Substrate 

Transmittance and Substrate Reflectance tabs allow substrate spectra to be imported and 

displayed. In these cases, no point identification is necessary. It will be automatic when 

the calculation is performed. The measured substrate data must include the rear surface 

reflections. This is necessary for the determination of the internal transmittance of the 

subsrtate. 

Before the calculation is performed some parameters must be set. The Parameters 

command in the Calculate menu displays a dialog box that permits various quantities 

necessary for the extraction to be entered. 
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Approximate Index is required because of multiple solutions. Two possible indices 

usually exist and the program will select that nearer to the entered approximate value. If 

results that are clearly unlikely are obtained, then one of the first things to check is the 

entry under Approximate Index. 

R/T Tolerance is to be given in percent and determines how the program will proceed 

if a valid solution cannot be obtained. The results will first be adjusted within the 

tolerance range (it is actually a little more complicated than that because it is a set of 

intermediate results derived from the input that are adjusted) and if a good solution is 

then achieved they will be flagged as A for adjusted. If even with adjustment a fit cannot 

be obtained then the results will be flagged as B for bad. 

 
 

Film Model permits the choice either of a film model that is inhomogeneous and free 

of absorption or of a model that is homogeneous and absorbing. The choice is valid only 

when transmittance results are being interpreted. When the results are in reflectance only 

the option is ignored and the film model is always an inhomogeneous absorption-free 

film. When both reflectance and transmittance results are available the model is 

automatically set as inhomogeneous and absorbing. 

Incident Angle specifies the incident angle of the spectrometer beam on the thin film 

being measured. All measurements must be conducted at the same incident angle. This 

allows the accuracy of the measurements to be improved when reflectance measurements 

are used. The maximum incident angle that can be used is 45 degrees. 

Polarization specifies the polarization used for oblique measurements. Oblique 

measurements must be conducted with either s-polarized or p-polarized light. The same 

polarization must be used for all measurements. 

Match Extrema needs some explanation. Under normal operation, extrema 

wavelengths are not usually fitted exactly but the reflectance or transmittance figures are 

matched as well as possible and then the thickness is chosen for best fit to the 

wavelengths. It may sometimes be that the extrema wavelengths are judged more reliable 

than the reflectance and transmittance figures. There is therefore an option that first fits 
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the reflectance or transmittance figures and then alters the optical constants to fit the 

wavelengths of the extrema. The positions of the extrema influence the dispersion of the 

indices rather than their absolute level and so the reflectance and/or transmittance figures 

are still important because they determine the level of the optical constants. 

Substrate: Material allows substrate optical constants to be read from an existing 

materials file. The correct material should be selected from the list. 

Substrate: Substrate allows the substrate internal transmittance to be read from an 

existing substrate file. The correct substrate should be selected from the list. This option 

is only available when the Material does not contain internal transmittance information. 

When Use Spectrum is checked, the extraction will use the substrate transmittance 

(and reflectance if present) data in determining the film’s optical constants. If Use 

Spectrum is not checked, the Substrate: Material and Substrate: Substrate information 

will be used in determining the film’s optical constants. 

Single Sided Reflectance. Frequently, monitoring chips that are used for monitoring 

in reflection are ground on the rear surface to eliminate its effect on reflectance 

measurements. This check box becomes available when reflectance measurements are 

present in the results and its selection removes the otherwise automatic rear surface 

correction from the calculations so that coatings deposited on reflection chips may be 

assessed. 

When Smooth Data is checked, the measured transmission data will be smoothed 

before values are extracted for used in optical constant determination. 

The extraction process in operation 

The extraction calculation is launched by selecting Extract n & k. There are two 

stages to the calculation. The first is the interpolation (by cubic spline) of results and the 

calculation of the refractive index of the substrate. If there is no substrate information, 

then an advisory message will appear. 

The subsequent stage of the calculation actually extracts the optical constants and the 

thickness of the film. Here the film model becomes necessary. If the figures consist of 

transmittance only then the film may be assumed to be either homogeneous and 

absorbing, or inhomogeneous and non-absorbing. If the figures are for reflectance only 

then the film is assumed inhomogeneous and non-absorbing. If both transmittance and 

reflectance figures are available then the film is assumed to be both inhomogeneous and 

absorbing. If an exact match of the measured parameters is found impossible then the 

measurements are adjusted in accordance with the entered tolerance range and if a good 

solution is then achieved they will be flagged as A for adjusted. If even with permitted 

adjustment a fit cannot be obtained then results will still be derived but flagged as B for 

bad. 

An information box lists any problems. The example below shows some minor 

problems. The halfwave transmittance points have values slightly greater than the 

transmittances calculated for an uncoated substrate. Corrections were made within the 

allowed adjustment zone until the problem disappeared. Calculated results were flagged 

as "adjusted". Had the corrections eventually exceeded the permitted interval then they 

would have been flagged as "bad." 
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The results of the optical constant extraction are displayed in the form. The 

transmittance and reflectance tabs will show the calculated performance of the extracted 

data. This gives a good idea of the validity of the optical constants that have been 

extracted. These tabs also show the calculated envelopes. 

 
 

The Optical Constants tab presents a table of the derived optical constants and the 

derived film thickness.  
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The data may also be viewed in graphical format on the Optical Constants Graph tab. 

 
 

Creating materials from the results 

Once the calculations have satisfactorily concluded, the material constants must be 

placed in a material table in the database if they are to be preserved for use. The Create 

Material menu accomplishes this. There are three choices, From Inner n, From Outer n, 

and From Mean n. If the model used was homogeneous then there will be no difference 

in these results but they will be distinct if the inhomogeneous model was used. 

If examination of the reflectance and/or transmittance curves show that the extrema 

are not quite matched, we can choose to force the results to match the positions of the 

extrema rather better by choosing Match extrema in the parameters dialog box. This 

option first calculates the optical constants and layer thickness and then forces the 

constants to match the extrema.  

Matching extrema is most useful when dealing with deterioration in reflectance or 

transmittance calibration at one end of the scanned range, as, for example, might happen 

at limit of a given spectrometer. In these cases, the main part of the spectrum is reliable 

and so the optical constants will be largely correct. The wavelength corresponding to the 
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outermost extremum is likely to be accurate although the transmittance or reflectance 

may not be. Then selection of Match extrema can very usefully correct the optical 

constants in the doubtful region without any major effect on those in the reliable zone. 

Some precautions 

Extraction of optical constants is not an operation like calculating the properties of a 

design, which has a single, unambiguous result. It involves fitting a model to a set of data 

and adjusting model parameters until a best fit is obtained. The data are experimental 

measurements and such measurements will suffer from errors, either systematic or 

random. The envelope method provided here with the inclusion of the adjustment zones 

takes care of many of the problems associated with slight data errors but it is still very 

easy to generate data where no adjustment can possibly achieve a fit. Particularly difficult 

problems can arise when the coating is almost a perfect antireflection coating for a high-

index substrate. Here there are two closely-spaced solutions for the model parameters and 

there is really no theoretical way of determining which is correct. Under such 

circumstances the accuracy of a determination can also be very poor. Do remember that 

any determination of optical constants can be only as reliable as the data from which they 

are derived. A common and easily recognizable problem is sets of reflectance and 

transmittance results that add to greater than 100%. A small error, such as that in the data 

shown above, can readily be accommodated, but such errors can often be substantial. 

Calibration and maintenance of the instrument on which the measurements are made, is 

of prime importance. 

Obtaining Optical Constants Of A Substrate 
The optical constants of a substrate may be derived from either transmittance and 

reflectance measurements or reflectance psi and reflectance delta measurements using the 

Substrate n,k & T command in the Tools menu. Once the Substrate n,k & T command 

has been selected, the Extract Substrate Characteristics window will be displayed. This 

window is organized as a series of pages that are changed by using the Back and Next 

buttons. The Close button closes the window. 

The first page that is displayed is the Measurement Type page. Select between 

Spectrometer and Ellipsometer and then click on Next. If Ellipsometer was selected, 

the next two pages will be used to enter the Psi and Delta measurements, otherwise 

Transmittance and/or Reflectance will be entered.  

For the Spectrometer case, clicking on Next displays the Choose Transmittance 

Data page. 
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Click on Choose Data to select the file containing the transmittance data. After 

choosing the file, the Import Editor will appear (see the Importing Data section for more 

information). When the Import Editor has been completed, the units of the data are 

entered in Define Data Source Units. 

 
 

Select the wavelength units either by choosing a pre-defined unit or by entering a 

scale factor. Select either 0 – 1 or 0 – 100% for the Transmittance scale. The plot always 

shows the import data in the current units used by the Essential Macleod. Click on OK to 

continue. 

The plot will now be displayed on the Choose Transmittance Data page.  

The imported data can be removed by clicking on the Clear button. If only reflectance 

data has been measured, click on Next without choosing any data. 

Entering Reflectance data is performed in a similar manner. 
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If only transmittance data or only reflectance data are provided, then the substrate will 

be assumed to be transparent. That is, its internal transmittance is 100% and the 

extinction coefficient is zero. 

The data files containing the measured transmittance and reflectance data are entered 

on this page on the Spectrometer tab. Reflectance psi and delta are entered on the 

Ellipsometer tab. 

Clicking the Next button on the Choose Reflectance Data page will move you to the 

Data Treatment page. The Data Treatment page allows you to smooth the measured data 

and to specify other processing options. 

 
 

Reflectance and Transmittance data may be smoothed by a moving average filter. 

Checking the Smooth Data box causes the data smoothing to be applied to the 

transmittance and reflectance data respectively. The size of the filter is specified in the 

Number of Points box. For ellipsometer data, Exclude Zero Transmittance Data and 

Minimum Internal Transmittance are not available. An option to force the extinction 

coefficient to zero is provided instead. 

If Exclude Zero Transmittance is checked, then any data points with zero 

transmittance will not be used in the optical constant derivation process. 

Check Single-sided Reflectance to specify that the second surface reflection was 

eliminated from the reflectance data. Otherwise it will be assumed that the second surface 

reflection is included in the reflectance data. 

The Minimum Internal Transmittance box is used to specify the minimum internal 

transmittance that will be generated by the optical constant derivation process. If a 

substrate has no measurable transmittance, then it is not possible to uniquely derive 

extinction coefficient and refractive index. This option provides an internal transmittance 

value for use in deriving extinction coefficient and refractive index. Typically if the 

internal transmittance is set to a very small value (such as 1e-250) this will allow the 

derivation process to produce a good refractive index derivation. If the Minimum Internal 

Transmittance is set to zero, the extinction coefficient will be at its maximum value, but 
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the refractive index values of the non-transmitting region will typically be offset relative 

to the refractive index values in the transmitting region. 

Selecting the Next button moves you to the Substrate Optical Constants page. Here 

the thickness of the substrate is specified in the Substrate Thickness box. If the 

measurement was performed at oblique incidence, the Incident Angle and Polarization 

can also be specified. Note that all measurements must be performed at the same incident 

angle and the same polarization. The polarization at oblique incidence must be either s- 

or p-polarization. For ellipsometer data, the polarization option is not available. 

 
 

Use the Create Material button to create a new material file. This new file can be 

saved into the current materials database and is then available for use in the program. 
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STACK  
In earlier versions of the Manual, this chapter on Stack was known as Multicoat. 

Stack calculates the properties of assemblies of coatings and substrates. The system of 

elements is known as a Stack and it consists of a series of Media starting with an 

Incident Medium and ending with an Emergent Medium. Each medium, with the 

exception of the incident medium, may either be uncoated or it may carry one optical 

coating on its front surface, that is, the surface towards the incident medium. When the 

only media present are incident and emergent then the system will appear exactly as a 

single coating on an infinite substrate but usually there will be a number of media with 

associated coatings. 

For example, a system consisting of a single glass plate, with different coatings on 

either side and incident and emergent media of air, would have incident medium of air, 

followed by a medium of glass with a prescribed coating on its front surface, followed by 

an emergent medium of air, also with a coating on its front surface. 

 
 

 
 

Note that the coatings are defined by reference to the appropriate design files. In 

design file b.dds the order of the layers runs from an incident medium of Air to a 

substrate of Glass but in the stack it is being used in the opposite direction with its 

substrate defined as Air and its incident medium as Glass. The coating direction is 

therefore labeled as Reversed. Coating a.dds, on the other hand has the label Forward. 

Media are specified by their optical constants and internal transmittance. The 

interfaces, or boundaries, of the media are assumed either to be sufficiently parallel so 

that all the reflected beams remain within the aperture of the system or sufficiently 

wedged so that the reflected beams are directed outside the system aperture. 
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Nevertheless, in either arrangement, the aperture of the system is such that normal 

incidence in the incident medium implies normal incidence throughout the stack. 

The next figure shows an arrangement of a more complicated stack. Here there are 

seven media and five coatings. The air medium is thought to be sufficiently wide to avoid 

problems of multiple reflections and so it is labeled as Wedged. The other media are 

labeled as Parallel because multiple beam effects do occur. The Stack window shows the 

structure of this more complicated stack. 

 

 
 

 

 
 

In all cases, designs of coatings are already established and the specification of the 

stack simply lists the names of the files in which these designs are already stored. The 

coatings are given the attribute Coating Direction that can be either Forward or 

Reversed. The arrangement in the coating file assumes an order for the layers from 

incident medium through to emergent medium. In a stack, however, the orientation may 

be such that the support (i.e. substrate) for the coating may turn out actually to be the 

incident medium. In other words, the coating may be pointing in the opposite direction. 

Such an orientation is known as Reversed. The normal orientation is known as Forward. 
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These attributes are assigned automatically in the first instance and the designations will 

usually be correct. However a click in the appropriate box will toggle the designation 

should the automatic assignment need to be changed. 

The media have the attribute Medium Type and this can be Incident, Emergent, 

Parallel or Wedged. Incident and Emergent are automatically assigned to the first and 

last media respectively in the stack and these attributes cannot be changed. All other 

media must be either Parallel or Wedged. Parallel implies that all the beams reflected 

backwards and forwards in the medium are within the aperture of the system and so are 

incoherently combined. Wedged implies that the surfaces of the medium depart 

sufficiently from parallelism that the reflected beams within the medium are directed out 

of the aperture of the system. Since the incident medium and emergent medium are semi-

infinite they are neither parallel nor wedged. As with Coating Direction, a click in the 

appropriate box toggles the designation. 

The material files contain refractive index and extinction coefficient information and 

should, theoretically, be capable of yielding an estimate of transmittance once the 

thickness of the medium is defined. However, extinction coefficient is not a useful way of 

specifying transmittance of a massive medium. Internal transmittance is much more 

reliable. Internal transmittance is the transmittance that exists between the inside of the 

front surface and the inside of the rear surface, that is the part of transmittance that relates 

to the medium but excludes reflection losses at the interfaces. A Material, therefore, may 

also include an internal transmittance definition. The internal transmittance can be 

specified as Lossless, i.e. 100% transmittance for all wavelengths, or as a table of values. 

For cases where the extinction coefficient data is better than no data, the internal 

transmittance can be calculated from the extinction coefficient. Media are specified by a 

Material and a thickness. Since the internal transmittance figures relate to one particular 

thickness of material then the actual thickness of material in the stack must also be 

specified. See Internal Transmittance in the Materials Management chapter for more 

information concerning Material documents. 

Internal transmittance 

The losses in a thick plate with flat surfaces are due to a combination of absorption 

and reflection. If we can remove the reflection losses by application of perfect 

antireflection coatings then the resulting transmittance of the plate is the quantity known 

as internal transmittance. The internal transmittance of a completely homogeneous plate 

is related to both absorption coefficient and extinction coefficient and, strictly, can be 

calculated from either. Why when we already have extinction coefficient tabulated for 

our materials do we introduce internal transmittance? The reason is that extinction 

coefficient is not a good parameter for the characterization of relatively thick slices of 

material. Imagine an extinction coefficient at 1000nm of 10-5. In terms of thin films, this 

is extremely small and very difficult to measure with any degree of accuracy. The 

relationship between extinction coefficient and absorption coefficient is  

 

𝛼 =
4𝜋𝑘

𝜆
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where the units of absorption coefficient, , will be the inverse of those of wavelength, . 

Our extinction coefficient gives an absorption coefficient of 1.26cm-1 and an internal 

transmittance of a 1cm thick plate of 28.4%. A change in extinction coefficient to 210-5, 

still very small in thin film terms, changes the transmittance of the plate to 8%. If we are 

calculating the transmittance of a slice of material rather than a thin film either internal 

transmittance or absorption coefficient is a more suitable quantity than extinction 

coefficient. One other point is that extinction coefficient is sometimes measured from the 

surface properties, for example by ellipsometer. Under those circumstances surface 

effects that hardly change the transmittance of the component can have a large effect on 

measured extinction coefficient, which is then a quite misleading quantity to use for bulk 

transmittance calculations. 

Thick media in a Stack or Design, therefore, use internal transmittance as the 

definitive parameter for assessing the transmittance of a medium. This is chosen over 

absorption coefficient, equally suitable, because frequently material data are supplied in 

that form, especially colored filter glasses. 

The conversion from absorption coefficient to internal transmittance in percent is 

 

𝑇𝑖 = 100 exp(−𝛼𝑑) 

  

where d must be expressed in the same units of length as , and is to be entered into the 

substrate file. Usually 1mm is the standard thickness for the files while  will be in cm-1 

and so the value to be entered will be 0.1cm. The tables will usually have units of mm 

and so the value to be entered in the tables will then be 1mm. 

Sometimes the extinction coefficient in published tables has been derived from 

measurements of transmittance of thick samples. In that case the extinction coefficient 

may then be used to derive internal transmittance. We will see later that an optional 

alternative for data entry into the internal transmittance tables is internal density. If 

wavelength is given in nm and the standard thickness for the table is 1mm then the 

conversion from extinction coefficient to internal density is  

𝐷𝑖 = 5.4575 × 106
𝑘

𝜆
 

  

Do make sure, if you are using this expression, that the values are entered into the tables 

as density and not transmittance. 

Transmittance and Density 
Can a transmittance of zero actually exist? Light is attenuated on traversal of a 

medium by a number of processes. It is absorbed and it is scattered and there may even 

be generation of light with either the same or a changed wavelength. Light of wavelength 

1000nm with an irradiance of 1Wm-2 has a photon flux of 43.51022 photons per square 

metre per day. A transmittance of 2.310-24, that is a density of 24.36, will reduce this 

flux to one photon per square metre per day. A further reduction by a factor of 365, that is 

a density increase to 26.2, will reduce the flux to one photon per year and a further 

increase of 2.0 in density to one photon per century. 
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Clearly a density of 30 or so is not something that is susceptible to direct measurement 

at the present time and in practical terms anything that is greater than that in density is for 

all practical purposes equivalent to zero transmittance. 

Internal transmittance is the definitive parameter rather than density because it is 

usually the published parameter and because most often it is the overall transmittance of 

the system that is most important. However there is the problem of how to convert an 

internal transmittance of zero into a value of density. Strictly speaking this should be a 

density of infinity but can we really tell the difference between a transmittance of 

0.000000000000000000000001% and 0.0000000000000000000000001%? We certainly 

cannot measure them, and both will tend to be shown as zero in the tables of results, 

unless the formatting has been changed from the default, but the corresponding densities 

will differ by unity. There is no completely satisfactory way of handling the problem of 

low transmittances and high densities. In the Essential Macleod the convention is that the 

greatest density is 40. Zero transmittance is therefore interpreted as a density of 40. In the 

above example this corresponds to one photon every 1014 years or so. 

For overall transmittances corresponding to densities of less than 40, then, the results 

are considered to represent genuine transmittance. When the density becomes greater 

than around 40, the transmittance is set to zero and the corresponding density to 40. This 

applies equally to stacks or to internal transmittance data. 

This may occasionally cause a problem when internal transmittance data correspond 

to much greater thicknesses than are used in a particular stack. Since the internal 

transmittance is the definitive value it will be interpreted as zero and the density will 

remain at 40 whatever the thickness. 

A related problem can occur when dealing with very high transmittances in extremely 

thick media when the internal transmittance data refer to much thinner samples. 

Caution should be used therefore when thicknesses of substrate or media material in a 

stack are either much less or much greater than in the material tables. It may be necessary 

to set up a new material file where the thickness is much nearer the actual thickness used 

in the calculations. 

Refinement and Synthesis 
Refinement options are described in detail in the Refinement and Synthesis chapter of 

this manual.  For refinement in a stack, however, there are some additional conventions 

that are described here. 

The refinement menu is found under Parameters. Tools exist for entering targets, 

adjusting refinement parameters and performing refinement.  These menus are similar to 

those provided for refinement of single coatings.  The Coating Locked column in the 

stack window specifies that a particular coating in the stack will not take part in the 

refinement.  Only coatings with a Coating Locked value of No will take part in 

refinement. 

Coatings are implicitly linked by name in a stack.  If the same coating design file is 

used on more than one surface in a stack, then refinement will adjust a single copy of the 

design and apply it to all surfaces using the same design name.  If you want to allow 

refinement to treat all coating designs separately, but want to have the same starting 
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point, then the design must be copied to new files, one for each surface that is to have the 

same starting point. 

Stack Menu 
This menu is obtained when the Stack window is active. We illustrate its use with an 

example. 

If in the New... dialog box from the File menu we select Stack and click OK it brings 

up a new Stack window. It may be necessary to drag the right-hand boundary to reveal all 

of the columns. 

 
 

The first three columns apply to the media of the stack. The final three columns are 

concerned with the coatings. Since this is a new stack it is very simple and consists of an 

incident medium of air, a parallel-sided medium of glass and an emergent medium of air. 

There are no coatings. 

We will now calculate the properties of a parallel-sided glass substrate with an 

antireflection coating on each side. 

First we need to create the antireflection coating. We can do this by selecting New 

from the File menu again and creating a design that is shown in the next figure. Note that 

because this is a multiple document interface, it is unnecessary to close the stack window. 

It can remain open. 

 
 

This is an antireflection coating with performance shown in the next figure. 
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Now we will save this design and we can conveniently choose the name ARcoat.DDS. 

If we return to the stack window, by clicking in it or by selecting it from the Window 

menu, we can now complete the new stack. We simply have to add the two coatings. We 

double-click on the Coating File cells in the second and third rows and select the file 

ARcoat.dds. The directions given in the next column should automatically be assigned 

but if they are not as in the figure then they should be changed by clicking in them to 

toggle them. 

This describes a stack consisting of incident and emergent media of air surrounding a 

glass disk with parallel sides that has an antireflection coating given by design file 

ARcoat.dds on either side. The convention in adding coating files to the stack window is 

that the medium on the same row as the coating is taken to be its emergent medium. Row 

2, for example, shows a coating with emergent medium glass and incident medium, from 

the row above, air. This is the normal configuration for an antireflection coating design 

file and so the Coating Direction is listed as Forward. In row 3 the emergent medium is 

air while the incident medium, from the row above, is glass. This means that the Coating 

Direction should be set as Reversed. 

 
 

Now we set the performance parameters by selecting Performance... from the 

Parameters menu. 
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The Stack Performance Parameters dialog box is similar to others in the package. 

Like the corresponding menu for a design with a thick medium, it includes cone and 

bandwidth calculations. See the Coherence, Cone, and Bandwidth section of the Essential 

Macleod Structure chapter for more information. Once the parameters are considered 

satisfactory, the plot and/or table can be calculated. Selecting Plot in the Performance 

menu gives the following graph. This is the reflectance of the glass disk with 

antireflection coating on both sides. 

The stack and its performance can be saved in the normal way. 

 
 

Now let us set up a more complicated stack consisting of two glass substrates 

arranged in series, one coated on either side with the antireflection coating we have been 

using and the other with only one side coated. Air is the incident and emergent medium 

and there is air in between the two substrates. The surfaces of the substrates are parallel 

but the space in between is wedged. 

To do this we load the existing stack and save it as Trial2, say. Then we insert two 

additional media. The new stack is shown in the following window. Note that it may be 

necessary to remove a coating. To do this, select the appropriate cell and press <Del>. 

The entry will change to None. To alter Parallel to Wedged, or vice versa, click in the 

appropriate cell to select it and then click once to change it. 
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The reflectance and the transmittance both as functions of wavelength are shown 

below. The reflectance curve shows almost no reflectance but the transmittance curve 

shows a loss of over 4% in transmission. This is because of the wedging of the space 

between the two substrates. This means that light reflected from the surface of the second 

component does not enter the aperture of the receiver and is therefore lost. The reflected 

light is from the first component and since that is efficiently antireflected, little is 

received and the reflectance is low. The light reflected from the second component, one 

surface of which is uncoated, is lost to the transmitted beam and so the transmittance of 

the overall system is reduced. In the blue region it is reduced a little further by absorption 

in the coatings. Experimenting in this way with wedged and parallel surfaces can help in 

assessing the amount of stray light or veiling glare in transmitting optical systems. If the 

components of an image forming system are all set as wedged, then this will be the 

transmittance of the image-forming light. If now the components are all set to parallel 

and the transmittance reassessed, it will be found to be higher. The increase is due to 

potential stray light. In this particular example, even with one surface untreated, the 

potential stray light is quite small. 
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ANALYSIS AND DESIGN TOOLS 
The tools that are classified under Analysis and Design permit calculations beyond 

straightforward performance and provide aids in the design of certain specific types of 

coating. Analysis facilities that help in understanding designs are admittance diagrams, 

amplitude reflection loci and electric field distribution. Design tools include 

nonpolarizing edge filter design, potential transmittance calculations and induced 

transmission filter design as well as Herpin equivalents. 

The materials used in the Essential Macleod are dispersive. The calculations carried 

out by the Analysis enhancement are almost all with respect to a particular wavelength. 

To gain access to the Analysis and Design tools, a design window must be active. 

Then the Tools menu provides the route to the Analysis and Design tools. 

The Analysis tools are not available when there are thick layers in the design. 

Analysis Submenu (Design) 
The Analysis submenu has six options. Admittance..., Reflection Coefficient..., 

Electric Field..., Absorptance Rate..., Total Absorptance...., and Performance 

Envelope…. These differ from the options in the Essential menu in that they concentrate 

on internal properties of the coatings rather than overall performance. Thus, they are 

collectively referred to as Analysis. 

We deal with each in turn but the details are broadly similar. Selection of the menu 

item brings up a dialog box for modification of the various calculation parameters 

including wavelength, or acceptance of the defaults. This dialog box also includes buttons 

that launch generation of plots or tables. The design used to generate the following plots 

is a simple five-layer quarterwave stack. 

 

Plot and Plot Over 

Note that in all cases the plotting in Analysis is initiated by the Plot button in the 

Parameters dialog box rather than as a menu item. The Plot Over menu command is not 

available in Analysis. To plot a second curve over a first, therefore, the second plot 

should be created on its own in the normal way and then dragged onto the first plot. 
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Active Plots are also available for Analysis functions (except Total Absorptance) by 

clicking the Active Plot button. 

Admittance... 

Selection of this menu item begins the calculation of the variation of optical 

admittance through the coating. In graphical form the results form an admittance locus in 

the complex plane. First a dialog box appears that carries the various parameters that 

must be specified for the calculation. 

 
 

Vertical axis and horizontal axis cover the two coordinate axes. The horizontal scale 

factor is normally fixed equal to the vertical so that circular loci appear truly circular. 

This means that the vertical and horizontal extents of the plot are not independent. 

However this can be changed as detailed below. The Table interval is simply the 

thickness interval between points in the admittance table. However this interval can be 

either fractional or absolute. Fractional means that each thickness increment is the 

thickness of the appropriate layer times the stated interval. Absolute means that the 

thickness increment will be equal to the stated interval. A constant fraction of layer 

thickness is useful when some layers are very thick and considerable time could be 

wasted in unnecessarily detailed calculations of their properties or when some layers are 

very thin and would receive almost no calculation points at all. To avoid awkward 

numbers, the fractional increment is rounded down to the nearest convenient number. 

Incident angle and wavelength are also to be specified. If the angle of incidence is other 

than zero then the polarization may be specified. The full admittance diagram of a 

complicated coating is sometimes virtually impossible to follow because of the way in 

which the loci lie over each other. Thus it is possible to select a restricted range of layers 

for plotting.  This restricted range does not change the locus of any layer. It is simply that 

the layers outside the range do not have their loci plotted although they still take part in 

the calculation.  
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In the tables, admittances are always calculated at the interfaces between layers even 

if they do not correspond exactly to the thickness increments. Reflectance and phase 

changes on reflection are also calculated with the assumption that the incident medium is 

that specified for the coating. 

A feature of the program is that negative thickness increments can be entered in the 

tables. (Note that this does not apply to the plots.) The admittance variation will then be 

calculated as though the layers had negative thickness. This technique is useful for the 

design of systems where there are heavily absorbing layers. If the design is set up with 

the order of layers reversed and the substrate with an admittance equivalent to the desired 

admittance for the coating then a negative increment will draw the admittance diagram 

backwards. This shows the feasibility of the attempted performance. If, for example, the 

locus wanders into the second or third quadrant of the complex plane then the desired 

performance is completely impossible without some substantial changes. 

Note that at oblique incidence it is the modified admittances that are plotted. The 

modified admittances are the result of a normalization of the admittances so that the 

incident medium remains constant in spite of either the tilts or the plane of polarization. 

The use of modified admittances makes the interpretation of the diagram much easier. 

Plots at oblique incidence have full lines for s-polarization and broken lines for p-

polarization throughout the package although these can be altered in any plot by the line 

editor. To activate the line editor the mouse should be double-clicked with the cursor 

inside the plot area. The line that will be edited is that nearest to the cursor.  

A typical plot of the admittance diagram at 30° angle of incidence is shown below. 

Both s- and p-polarizations have been drawn with thicker lines (s-polarization is blue and 

p- is red in the original). The ends of the loci are somewhere off the top of the diagram. 



236  Analysis and Design Tools 

 
 

To resize the plot and allow the loci terminations to be seen the vertical axis can be 

changed. Recalculation is unnecessary.  

With the plot as the active window select Edit and then Parameters....  The Plot 

Parameters dialog box will appear. The vertical scale can then be changed in range to -6 

to 15 (with appropriate change to the interval also). The result is shown below. The 

horizontal axis has shrunk accordingly, although the terminations can now be seen. 

It may be more useful to permit the plot to expand to use up the wide space to the 

right of the window but simply altering the horizontal scale is not useful because the 

admittance locus will not change. An alternative is simply to uncheck the box labeled 1 

to 1 Aspect Ratio in the General area of the Plot Parameters dialog box. This gives the 

result shown in the next figure. Whether or not this will be useful depends on personal 

preference but the facility is there should it be wanted. 
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Admittance loci in structures like quarterwave stacks can vary rapidly from very small 

to very large loops. In extreme cases this can cause problems in plotting because the outer 

right hand part of the loop will be executed at enormous speed compared with the left 

hand part. The adaptive plotting of the package will normally accommodate this but there 

can be cases where even the adaptive plotting is overcome and it is clear to the user that a 

loop has collapsed. If this happens then the Nominal Plot Segment Length in the 

Essential Macleod Options box, activated by General... in the Options menu, must be 

reduced. This is usually set at 0.01, adequate for virtually all cases. If it must be changed 

then the change should be small. 0.001 will usually be as small as ever required. Be 

careful with alterations. A small value means more points and a reduction by a factor of 

ten means ten times as many points in the plot taking ten times as long and ten times the 

storage. Make sure to change the value back to the default of 0.01 immediately it is no 

longer required otherwise all plotting will suddenly become very slow. 

Reflection Coefficient... 

The variation of complex amplitude reflection coefficient, with incident medium for 

the reflection coefficient calculation always equal to the incident medium for the coating, 

gives a locus in the complex plane that is similar in some respects to an admittance locus. 

The variation of reflection coefficient for a dielectric film is circular, just like admittance. 

As with the admittance loci, the Plot Parameters dialog box permits uncoupling of the 

scale factors of horizontal and vertical axes should this be required. 

 
 

Electric Field... 

The performance of a thin film coating depends on interference effects and the 

interference results in standing waves. The variation of electric field amplitude 

accompanying these standing waves can be considerable. Losses due to absorption and 

scattering are highest where the electric field is highest and so the distribution of electric 

field is an important tool in the design and/or analysis of coatings where either losses are 

to be very low or very high. A particular feature of Electric Field... is that absolute 

amplitude values are calculated. Calculations of field through multilayers are frequently 
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normalized to the value at a given interface, principally because so much normalization 

exists in normal calculations that it is difficult to keep track of it. It is not always easy, 

particularly at oblique incidence, to relate these normalized fields to known incident 

irradiances. Here an incident irradiance of 1 watt per square metre measured using a 

detector placed normal to the beam direction is assumed and the electric field amplitude 

is given in volts per metre throughout the multilayer for either s- or p-polarized light. For 

s-polarization the fields are all parallel to the interfaces but for p-polarization there are 

components which are normal to the interfaces. There is not necessarily a simple phase 

relationship between these components and so a calculation of total field is included. The 

Electric Field Parameters dialog box includes the choice of Parallel, Normal or Total 

Field. The Electric Field Intensity can also be calculated and this is defined as the square 

of the electric field amplitude divided by the square of the normal input field amplitude in 

Air which for an incident irradiance of 1 watt per square metre is approximately (27 

V/m)2 

 
 

The Electric Field Parameters dialog box is similar to all the others but there are two 

choices that should be further explained. There are two check boxes Show Medium and 

Show Substrate in the Horizontal Axis section. The standing wave pattern exists also in 

the incident medium. Although there is no standing wave in the substrate, if there is 

absorption or if the calculation is beyond the critical angle then there will be an 

exponential decay. Both these can be shown by ticking the appropriate box. When the 

box is ticked then the depth into either substrate or incident medium can be specified. 

Usually the default value of 0.5 will be adequate. This value is in terms of full waves at 

the reference wavelength. Once the Show Medium and/or Show Substrate boxes have 

been checked it becomes impossible to select a limited range of layers for display. The 

plots of electric field assume incident light coming from the left (as is normal) so that the 

substrate is over on the right. 
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3D Electric Field... 

The 3D Electric Field command extends the Electric Field command so that electric 

field is plotted as a function of a second parameter that is either wavelength or incident 

angle as well as the position in the coating. 

The X axis parameters provide the same control over which part of the deisgn is used 

for the calculation.  Table Interval and Interval type are not included because the 3D 

version does not produce a data table. Instead, Number of Intervals is used to specify the 

total number of points calculated in the X direction. These points are equally spaced 

across the range of X values. 

The Y axis is used to specify the parameter used and the value range. Either 

wavelength or incident angle may be specified. Maximum and minimum values are also 

specified. Number of Intervals specifies the total number of points calculated in the Y 

direction. These points are equally spaced across the range of Y values. 

 
 

 On the Z axis, Incident Angle is only used when the Y axis parameter is Wavelength 

and Wavelength is only used when the Y Axis Parameter is Incident Angle. 
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Absorptance Rate… 

This starts the calculation of the Absorptance Rate of the coating. The absorptance 

rate is given in terms of % Absorptance per unit thickness in the current thickness units. 

Either the absorptance rate or the potential absorptance rate may be plotted. The table 

always shows both absorptance rate and potential absorptance rate. The potential 

absorptance rate is the maximum absorptance rate of the coating if all incident energy 

were either transmitted or absorbed. 

Before the results are presented, a dialog box is displayed in which the various 

parameters for the calculation are specified. 
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The Absorptance Rate Parameters dialog box is similar to the other Analysis dialog 

boxes. The Vertical Axis options allow you to choose between Absorptance Rate and 

Potential Absorptance Rate for the plotted curve (tables always show both Absorptance 

Rate and Potential Absorptance Rate). The Horizontal Axis allows you restrict the range 

of layers for which absorptance rate calculations are performed, or you can show 

absorptance rate in the substrate if desired. The Substrate Depth field allows you to 

specify the distance into the substrate for which absorptance rate calculations will be 

performed in the current thickness units. 

 
 

The plot shows the absorptance rate for an initial antireflection coating design where 

two of the layers have some absorption and the other three do not. 

Total Absorptance… 

The Total Absorptance calculation shows how the absorption of the whole coating is 

split amongst the individual layers of the coating. A dialog box is displayed before the 

calculations are performed so that you may enter desired parameters for the calculation. 
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You can specify a wavelength, frequency or incident angle range for the horizontal 

axis. Where a wavelength or frequency range has been specified, the total absorption will 

be calculated at the Incident Angle in the Calculation box. Where an incident angle range 

has been specified, the total absorption will be calculated at the Wavelength in the 

Calculation box. If there are no selected layers in the design, then the total absorptance 

will be calculated for all layers in the Design. If one or more layers are selected, then the 

total absorptance will only be calculated for the selected layers.  

 
 

The plot shows the total absorptance of each layer of an initial anti-reflection coating 

design. Layers 1 and 3 have no absorptance, but layers 2 and 4 have a small amount of 

absorptance.  

Performance Envelope… 

For a selected layer in the design, Performance Envelope calculates the maximum 

and minimum possible transmittance over all values of thickness of the layer. It also 

calculates the round-trip phase change in the layer. When the round-trip phase change is 

in the immediate vicinity of 0 or 2m, where m is an integer, the coating performance 
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will match the maximum envelope. When the gap between the maximum and minimum 

envelopes is large, the performance will tend to be close to the minimum except when the 

0 or 2m condition is very closely satisfied.  

The performance envelope is very useful for assessing the sensitivity of a design to 

errors in the thickness of the selected layer. Since the performance envelope marks the 

limit of performance whatever the variation in thickness of the selected layer, it 

represents the limit of performance for any possible thickness error, no matter how large, 

in the layer. The crossing points of the round-trip phase change curve with the zero phase 

axis mark those points where the actual performance curve will touch the maximum 

envelope. The slope of the round-trip phase curve at the axis crossing indicates the 

sensitivity of that particular feature to layer thickness. When the slope is very steep the 

change in feature position with layer thickness change will be small. 

To use the performance envelope function, first select the layer for which the 

performance envelope is to be calculated (select the layer by clicking in the gray box at 

the left end of the layer). Now select Performance Envelope from the Analysis sub-

menu of the Tools menu. A dialog box will appear that allows you to adjust the 

parameters for the performance envelope calculation. After setting the parameters, click 

Plot to display a graph or click Table to show a table of values. 

Stress… 

Stress is an exceedingly complex phenomenon and we have no models that can attain 

the same level of success as the model use for the prediction of the optical properties of a 

coating. This tool makes predictions of stress and strain levels based on a very simple 

thermal model. Details of different aspects of the model will be found in: 

Klockholm, Erik, Delamination and fracture of thin films. IBM Journal of Research and 

Development, 1987. 31(5): p. 585-591. 

Suhir, E, Predicted thermally induced stresses in, and the bow of, a circular 

substrate/thin-film structure. Journal of Applied Physics, 2000. 88(5): p. 2363-2370. 

Klein, Claude A, Normal and interfacial stresses in thin-film coated optics: the case of 

diamond-coated zinc sulfide windows. Optical Engineering, 2001. 40(6): p. 1115-1124. 

The substrate is assumed to be in the form of a circle of uniform thickness and to be 

dominant, in much the same way as in the model of optical properties as a function of 

temperature. A change in temperature causes a change in the dimensions of the substrate 

according to its coefficient of expansion. The change in the lateral dimensions are 

impressed on the films, which have themselves changed their dimensions according to 

their expansion coefficients. Any difference in the coefficients leads to a strain in the 

films that, by use of Young’s Modulus and Poisson’s Ratio, can be translated into a 

biaxial stress. This biaxial stress is added to any intrinsic stress already possessed by the 

films at the deposition temperature. For this stage of the stress calculation, each film is 

considered to be independent of any other. The resultant stress, due to all films, acts on 

the substrate in a way similar to surface tension or compression, forcing it into a spherical 

shape that depends on the substrate dimensions and material properties. A uniform 

biaxial compressive or tensile stress in a film will not cause any shear stress at a 

supporting interface. The shear force is everywhere balanced by an opposite and equal 

force that distorts the substrate but applies no shear stress. Any variation in the biaxial 

stress over the surface, however, will immediately translate into a shear stress. Such 
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variation is a maximum at the edge of the film. Here the shear stress at any interface is at 

its peak and can be calculated. The films store strain energy. This strain energy can be 

dissipated as the energy of freshly exposed surfaces in cracking or delamination. The 

probability of such an effect rises with the strain energy. If there is sufficient strain 

energy then the cracking or delamination may occur spontaneously. The initiation of such 

an event usually requires the existence of a sufficiently large defect that can act as a stress 

concentrator. In practice such defects tend to be found at the periphery of a coating where 

the delaminating shear stress is already at a maximum. The intrinsic stress in the model is 

assumed to be a property of the material and the deposition process. We can imagine that 

the film condenses with zero strain at a particular film temperature that we can think of as 

its true deposition temperature. Then the film reaches equilibrium with the substrate. In 

so doing, it acquires the temperature of the substrate but does not change its lateral 

dimensions. The intrinsic stress originates from the resulting strain. We can consider the 

true deposition temperature as an unchanging property of the film material (and its 

deposition technique) but not of its substrate. Knowledge of this property permits the 

calculation of the effect of any change in deposition temperature. The tool implements 

this model. The model is purely elastic and reversible. Plastic behavior is excluded. 

Before the tool can be used, certain data on the thermo-mechanical properties of the 

layer materials and the substrate must be available. These data are entered in the 

Properties tab of the appropriate material document. 

 
 

The first two items are shared with the thermo-optical model. The third item is used 

purely by the thermo-optical models. The lower four items are required for the stress tool. 

Young’s Modulus is assumed to be in units of Gigapascals. These units cannot be 

changed. The Reference Stress and Reference Temperature are parameters defining 

the intrinsic stress in the film with sign convention that tensile stress is positive. They are 

assumed to be measurements of film stress when deposited at the Reference Temperature. 

Sometimes the stress may have been measured at a measurement temperature different 

from the deposition temperature. Provided we know the nature of the substrate on which 
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the measurement was performed, we can derive a corrected Reference Stress by using the 

tool to model the film on the substrate used for the stress measurement, as though the 

measurement temperature were the deposition temperature. This procedure will include 

the necessary correction for the expansion coefficient of the substrate. Note that the 

temperature is stated as Celsius. The surface energy is used in the calculation of 

Cracking Parameter and Delamination Factor. It is rarely known to any great degree of 

accuracy. Values that can be assumed for glass are around 0.5J/m2, for metals 1J/m2 and 

for high-energy solids like the refractory oxides, perhaps 4 or 5J/m2. The presence of 

moisture can actually reduce the high surface energy values by as much as a factor of ten. 

The increased tendency of coatings to delaminate after humidity testing is well known. 

Note that surface energies quoted in erg/cm2 can be converted to J/m2 using the 

conversion that 1 J/m2 = 1000 erg/cm2. 

Once the materials data include the required parameters the tool can be used to 

examine predicted levels of stress in any design. Selection of Stress… in the Analysis 

submenu in Tools activates a dialog where some necessary calculation parameters must 

be entered. The entries in this dialog are stored with the design making it easy to examine 

the effects of variation of just one of the parameters. The dialog is shown next. The 

Temperature is the temperature at which the stress and the other properties are 

calculated. Deposition Temperature is the temperature at which the films were 

deposited with their intrinsic stress. Substrate Thickness and Substrate Diameter are 

the dimensions of the substrate. The substrate material is that named in the design file. 

 
 

Stress is calculated by clicking Table. The table of results that appears has the 

following structure. 
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The upper part of the table exhibits first the input parameters. These are the name of 

the Design, in this case stress test, the Temperature, that is the measurement temperature 

at which the stress is calculated, the Deposition Temperature at which the films were 

deposited and the dimensions of the substrate. Next are four parameters referring to the 

complete substrate-film combination. The Total Strain Energy refers to the total strain 

energy per unit surface area and includes any intrinsic strain energy. This total energy 

takes no account of whether or not it is compressive or tensile. In fact there may be a 

mixture of tensile and compressive strain energy in the layers. This is rather like a spring 

in compression that maintains a parallel attached spring in tension so that the pair are in 

equilibrium with no external force. Although the net force is zero the total stored energy 

is the sum of that in each individual spring. The net stress in the system acts to bend the 

substrate into a dome. This dome has a Radius of Curvature that is positive for a convex 

coated surface (net stress compressive) or negative for a concave coated surface (net 

stress tensile). The Deflection is the position of the center of the substrate surface with 

respect to the plane defined by the periphery and indicates the amount by which the 

substrate departs from its original flatness. The Cracking Parameter is an estimate of the 

ability of the strain energy to supply the required surface energy in a propagating crack 

that extends through the total thickness of the multilayer. A value of unity means that the 

two are fairly well balanced. A value of rather less than unity implies a low likelihood of 

spontaneous cracking while a value elevated above unity suggests that cracking might be 

a matter for concern. The parameter should be thought of simply as a guide and of course 

it depends directly on the surface energy figure entered in the film properties. 

The lower part of the table applies to the individual films and their interfaces. Each 

row refers both to the appropriate film and to its inner interface. The interface in the final 

row, therefore, is the interface with the substrate. Stress in Gigapascal is that in the 

individual film consisting of the intrinsic plus thermal components. The Strain Energy is 

the contribution of the film per unit coated area. The Delamination Factor compares the 

total strain energy per unit area in the outer films with the total surface energy per unit 

area that is required to generate the two surface produced in a delamination. The 

interpretation is similar to that for the Cracking Parameter. A factor rather less than 

unity suggests a diminished probability of spontaneous delamination, unless the adhesion 
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is particularly poor, while a value in excess of unity is a warning sign. The Maximum 

Shear Stress refers to the periphery of the film and applies to its inner interface. The 

final figure represents the substrate-film interface. 

 

Scattering 

This analysis tool predicts the light scattered by a coating. There are two sub-menu 

options: 2d calculation and 3d calculation. The 2d calculation estimates the scatter as a 

function of a single variable and the 3d calculation estimates the scatter as a function of 

two variables. The model used for estimating the scatter is that developed by J. Merle 

Elson (see, for example, “Multilayer-coated optics: guided-wave coupling and scattering 

by means of interface random roughness” in J. Opt. Soc. Am. A Vol. 12 No. 4, pp729-

742, April 1995).  

The model assumes that all surfaces have the same roughness. The roughness on each 

surface may be correlated or uncorrelated. The roughness is described by four 

parameters: short-range rms roughness, short range correlation length, long-range 

roughness and long-range correlation length.  

The roughness properties of the layer surfaces are represented by a correlation 

function which is the sum of an exponential function and a Gaussian function: 
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where 

 𝛿𝐿 is the long range rms roughness 

 𝜎𝐿 is the long range correlation length 

 𝛿𝑆 is the short range rms roughness  

 𝜎𝑆 is the short range correlation length 

There are two cases for the correlation of roughness between each layer surface: 

correlated and uncorrelated. Correlated means that the roughness on each surface is 

identical. Uncorrelated means that the roughness on any layer surface is statistically 

independent of the roughness on any other layer surface. All layer surfaces use the same 

statistical parameters defined above for their roughness properties. 

In purely surface scattering into the plane of incidence (the plane containing the 

incident beam direction and the surface normal), p-polarized incident light induces purely 

p-polarized scattered light, and, similarly, s-polarized incident light produces purely s-

polarized scattered light. Most measurements of the angular distribution of scattered light 

concentrate on such scattering in the plane of incidence. The tool calculates both 

polarizations in this plane. For scattering out of the plane of incidence, this rule is no 

longer true, and there can be mixing of the polarizations. The tool, therefore, also 

includes two special cases of scattering out of the incident plane into the opposite 

polarization. This scattering is calculated in a plane normal to the plane of incidence and 

either from incident p-polarization to scattered s-polarization or incident s-polarization 

into scattered p-polarization. 
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For the calculations, the incident angle, scatter angle and wavelength must be 

specified. For 2d calculations, one of these three parameters will be varied over a defined 

range and the other two will be held constant. For the 3d calculations, two parameters 

will be varied over defined ranges and one will be held constant. The calculated result is 

the Angle Resolved Scatter (ARS). This is given as the ratio of scattered power per unit 

solid angle to incident power. Either ARS or log(ARS) can be plotted. 

Selecting the 2d calculation option displays the following dialog: 

 
 

The Horizontal Axis specifies the independent variable for the calculation and the 

range over which it is to vary. 

 
 

The Vertical Axis tab specifies the scatter output to be plotted. This may be the 

transmitted scatter or the reflected scatter and whether the ARS or its logarithm is plotted. 

The polarization parameter controls the polarization state of the incident beam and output 

scatter beam. There are four possible options: P ->P, P -> S, S -> S, and S -> P.  P -> P 

means that the input beam is p-polarized and the calculations are performed for a p-

polarized output beam in the plane of incidence. S -> S is similar except that both beams 

are s-polarized. P -> S means that the input beam is p-polarized, and the calculations are 

performed for an s-polarized output beam. The plane of the output beam is 90 degrees to 

the plane containing the incident beam, the plane of incidence. S -> P is similar except 

that s-polarization is incident and p-polarized scattered light is calculated in the plane at 

90 degrees to the plane of incidence. 
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The Roughness tab specifies the statistical properties of the surface roughness. 

Clicking Plot causes a plot of both the correlated and uncorrelated scattering to be 

produced for the design. 

The first of the following plots shows the calculated scatter for the 49 layer longwave 

pass filter with a p-polarized 600nm input beam at normal incidence. 

Selecting the 3d calculation displays a dialog with similar options except that two 

independent axes may be specified. The second figure below shows the same calculation 

but including variation in incident angle. 
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Design Tools Submenu (Design) 
The Design Tools submenu has four options. Edge Filter..., Equivalent Layer..., 

Induced Transmission Filter Design... and Symmetrical Periods…. These assist in 

creating designs for certain specific types of coating. 

Edge Filter... 

Edge filters based on quarterwave stacks show quite large polarization splitting at 

elevated angles of incidence and, indeed, this behavior is used in the construction of plate 

polarizers. Conventional edge filters can be considered to be based on a series of 

symmetrical periods [see Equivalent Layer... for more details on symmetrical periods] of 

form (0.5HL0.5H) or (0.5LH0.5L). No amount of adjustment of relative thicknesses of 

high and low index materials in such stacks will eliminate the polarization splitting, 

although it can be slightly varied. The next most complicated symmetrical period based 

on two materials is of form (aAbBcAbBaA) where A and B indicate high and low index 

material or vice versa. Such symmetrical periods do include the possibility of elimination 

of polarization splitting by relative adjustment of the factors a, b and c. Although 

symmetrical periods with greater numbers of layers are also capable of adjustment, the 

best performance is usually to be found with the five-layer period. Edge Filter... is an 

option for the automatic design of such symmetrical periods.  

Because the edge filter design will be placed in the active design window, overwriting 

whatever design is already there, the first operation in the design of a completely new 

filter should always be to activate a new design window by choosing New... from the File 

menu. Then select the Edge Filter... option. The Edge Filter Design dialog box appears. 

Most of the items that are required are obvious. The bottom three require further 

explanation. There are eight possible configurations [although the solutions may not be 

distinct] but no analytical expression for the solutions which must be found by an 
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automatic search of a region. Once a solution is found it can be assessed both in terms of 

the width of the rejection zone and the width of the pass region. A merit function that is a 

simple combination of these two attributes allows solutions to be compared and the best 

selected. No account is taken of the equivalent admittance in the pass region which 

controls the amplitude of the ripple in the raw design. The three parameters control the 

width of the search region and the search step. [It is difficult to define exactly the search 

parameter. It is, in the first instance, the value a of the multiplication parameter for the 

outermost layers. But then for each value of a, a value of b has to be found that will make 

the edges for both polarizations coincide. Then all three parameters a, b and c must be 

scaled to make the edge coincide with the reference wavelength.] The upper limit must be 

greater than the lower limit but not greater than 2. The lower limit is constrained to be in 

the range 0 to 1. The search step must be in the range 0.0001 to 1 but the smaller the 

search step the longer the search takes. A value of 0.05 with a search region of 0.1 to 1 is 

usually quite adequate. Increasing the range to 0 to 2 is usually ineffective because the 

solutions that are included in the extra region are normally of the type 

(.5cAbB2aAbB.5cA). 

 

Once these parameters are entered, the calculation can be launched. A short delay 

(depending on the range and interval set for the search) follows and then the new design 

is entered in the design table. Simultaneously, a formula is entered in the formula dialog 

box so that it can subsequently be used as the core of a more complicated filter. 

An example may help. Select a new design and then activate the Edge Filter Design 

dialog box. Complete the parameters exactly as in the example above. This is an edge 

filter that is to be matched for 45° in air and is composed of SiO2 and TiO2. It is to be a 

shortwave pass filter and the edge is at 510nm. The substrate will be glass, although this 

does not affect the design process and, in fact, the substrate will be whatever is currently 

listed in the active design window. Next click the Make Edge Filter button. After a short 

pause while the calculations are performed, the design window rapidly fills with the new 

design. 
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To calculate the performance of the design, first make sure that both planes of 

polarization are required at an angle of incidence of 45°. Then select Plot. The result is 

shown below. 

 
 

With the design window active, select Formula... in the Edit menu. The Formula 

dialog box shows the formula. 
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The option does not consider the ripple performance of the filter at all. Usually, for a 

shortwave pass filter in the visible and/or near infrared, the outer layer should be of low 

index. However the resulting design can readily be refined to improve the ripple 

performance. This is most easily performed with only a few layers unlocked on either 

side of the multilayer.  
 

Equivalent Layer... 

The product matrix of a symmetrical series of layers can be put in the form of the 

matrix of a single layer. This equivalent single layer possesses the attributes known as the 

equivalent optical admittance and equivalent phase thickness of the symmetrical system. 

These attributes may also be known as the Herpin equivalents after the name of an early 

pioneer. The equivalence is not a physical one but is limited to only those operations that 

involve multiplication of the characteristic matrices of the layers. In particular it cannot 

be used to represent the tilted behavior of the coating. The equivalence does, however, 

extend to absorbing layers but has not been much used for absorbing coatings. Here we 

are concerned with dielectric layers only. The advantage of this technique is that 

structures consisting of repeated symmetrical periods of the same kind behave simply as 

thicker thin films of the same equivalent admittance. Because the symmetrical system is 

often repeated many times in a single design it is frequently referred to as a symmetrical 

period, or sometimes a Herpin period. 

Equivalent Layer... calculates the equivalent admittance, E, and equivalent phase 

thickness, , of any symmetrical series of dielectric (i.e. transparent) layers. The layers 

are specified, as normal, by a material and a thickness and the program strips off any 

extinction coefficient before making the calculations. The module also ignores any angle 

of incidence that may be entered. Only the normal incidence equivalent parameters are 

calculated. 

The equivalent admittance and phase thickness exhibit regions where they are both 

real and regions where they are both imaginary, but with dielectric materials there are no 

regions where one is real and the other imaginary. The real regions correspond to 

dielectric behavior and it is these regions that are plotted or tabulated. Regions where the 

equivalent parameters are imaginary are ignored. In these regions of imaginary equivalent 
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constants the assembly behaves like a metal rather than a dielectric and as the 

symmetrical period is repeated in the design, the reflectance rises towards 100%. 

The equivalent phase thickness, , is multi-valued and the value chosen is that closest 

to the total phase thickness of the original symmetrical period.   is dimensionless but like 

normal phase thicknesses it is most readily interpreted if in units of  radians. The units 

of  are therefore . For example when the vertical scale of the plot shows a value of 1.0 

for  then the actual dimensionless value of  is . 

A simple example should help to make the operation clear.  

The symmetrical period concerned is specified as a selected series of layers in a 

design. The design may have additional layers but the calculation will be concerned only 

with those layers that are selected. 

First, with the design window active, select Formula and in the dialog box enter the 

details shown. 

 
 

This should give the corresponding design shown below. 

 
 

Select the three layers by first placing the mouse over the selection box of layer 1. 

This is the small square cell at the extreme left-hand side. Click once in the box to select 

the layer. With the shift key depressed, repeat the operation in the selection box of layer 

3. This should highlight all three layers. Now, from the Tools menu, select Design Tools 
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and, finally from the submenu, Equivalent Layer.... The dialog box that appears is shown 

next. 

 
 

This will select either a table or a plot. In either case the imaginary results will not be 

recorded. Let us choose a plot because that will be easier to interpret. 

The number of points is preset at 100 but can be altered as required. The horizontal 

axis is wavelength and that must be specified. The vertical axis or axes are automatically 

determined but can be changed later by the Edit commands. 

Enter the values shown in the box above and then select Plot. The curves are 

reproduced below. The gaps in the two curves represent regions where the parameters are 

imaginary and therefore potential high reflectance zones. 

 
 

When Create Material is checked, a Material window populated with the optical 

constants of the equivalent material will appear. 
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Induced Transmission Filter Design... 

This option calculates design parameters of induced transmission filters. The user is 

prompted to enter the details of the absorbing layer followed by the dielectric layers to be 

used on either side of the absorbing layer. The program then displays the optimum 

admittance required at the rear (exit) interface, the potential transmittance and the 

thickness of the matching layer required on either side of the absorbing layer. To 

complete the matching, the combination of matching layer / absorbing layer / matching 

layer should be treated as a slab of material of the real admittance given by the entry 

Intercept (so called because it is given by the intercept of the admittance locus with the 

real axis). This can readily be achieved by a series of quarterwave layers.  

The selection of the menu item activates a dialog box that asks for the input 

information. The peak wavelength of the filter, the incident medium material, the incident 

angle and the polarization are asked for first. The polarization may be set either to s or p 

should the incident angle be non-zero. Note that the incident angle is measured in the 

incident medium. Even if there is to be a cover cemented over the filter, if the incident 

angle is ultimately referred to air then that should be entered rather than glass. Next the 

details of the absorbing layer, that is the material and the thickness are required. This is 

the layer that is to have maximized transmission. Finally the material for the matching 

layer must be entered. This material will be assumed perfectly dielectric. Any extinction 

coefficient will be stripped off before the calculations are performed. Finally, calculations 

are initiated by pressing the Calculate button. 

 
 

The results are shown in a scrolling text box. The peak wavelength and the reference 

wavelength are considered to be the same. The optimum exit admittance and the potential 

transmittance are both listed. Note that the optimum exit admittance will normally be in 

the first quadrant. Finally the details of the matching layer are displayed, the optical 

thickness and the intercept. The optical thickness is referred to the peak wavelength as 

reference. The intercept is the admittance on the real axis, where, either the locus of the 

matching layer must start, if the optimum exit admittance is to be achieved by the given 



Analysis and Design Tools  257 

phase thickness, or the locus of the matching layer added to the front surface of the 

absorbing layer must terminate. The results in the text box can be copied to the clipboard 

by selecting them with the mouse and pressing <Ctrl>+C. In this particular case they are: 

 
Potential Transmittance: 74.07% 
Intercept: 0.104545 
Absorbing Layer n: 0.0510 
Absorbing Layer k: 2.9600000 
Physical Thickness: 80.000000 
Optimum exit admittance: 0.31707 + i3.04661 
Matching Layer Refractive Index: 2.1445 
Optical Thickness: 0.15292420 

The Make design button transfers the results into the active design file but the results 

do not appear until the Close button is clicked (see below). The design will be completed 

in the usual way by the addition of an appropriate series of quarterwaves between the 

incident medium and layer 1 and between layer 3 and the substrate. 

 
 

Symmetrical Periods Design…  

It can be readily shown that any combination of thin films which is symmetrical, that 

is one in which the sequence of layers is unchanged when they are listed in reverse order, 

can be represented by a single equivalent film having an optical admittance and phase 

thickness which can be calculated from the parameters of the individual layers.  The 

symmetrical periods design tool will calculate the thicknesses of a 3-layer symmetrical 

period so that its equivalent film has a desired optical admittance and phase thickness. 

The tool is available, when a design window is active, by selecting Symmetrical 
Periods from the Design Tools sub-menu of the Tools menu. When selected, the 

following form is displayed. 
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A symmetrical period is constructed by entering the details of the equivalent layer and 

then clicking the Make Symmetrical Period button. If a symmetrical period can be 

constructed, then the layers of the symmetrical period will be placed on the clipboard 

ready for pasting into a design and the window will be closed. 

The equivalent layer properties are specified by the Equivalent Admittance and 

Equivalent Optical Thickness fields. The Reference Wavelength field specifies the 

wavelength at which the equivalent layer properties are desired. The Inner Material 

specifies the material to be used for the middle layer of the 3-layer structure. The Outer 

Material specifies the material to be used for the first and last layers of the 3-layer 

structure. 

The tool treats all materials as dielectric, that is, any extinction coefficient associated 

with either of the two materials will be ignored.  After clicking Make Symmetrical 

Period, the Results box will be filled with the solutions. Double-clicking on a solution 

will copy the layers to the clipboard ready for pasting into a design. 

 Sensitivity Submenu (Design) 
The tools in this submenu calculate the sensitivity of a design to various kinds of 

error. Three types of sensitivity can be calculated: Macleod Turning Point, Independent 

and Distribution. Note that the Macleod Turning Point sensitivity applies exclusively to a 

series of quarterwaves or exact multiples of quarterwaves. The results will be 

meaningless if some layers are of non-integral thickness. 

Macleod Turning Point 

The Macleod Turning Point sensitivity analysis provides a measure of how difficult 

each layer in a design is to manufacture. Macleod Turning Point displays a graph 

showing how critical each layer is in meeting the final transmittance or reflectance 

magnitude at the reference wavelength. Larger values mean that the production of the 

layer will be more difficult. For more information on the calculation method see “Turning 

value monitoring of narrow-band all-dielectric thin-film optical filters” in Optica Acta 

1972 Vol. 19 No. 1 pp1-28. The implementation in the Essential Macleod removes the 

sign and so all values will be positive. 
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The picture above shows the Macleod Turning Point Sensitivity for a small single 

cavity filter design for infra-red applications. The chart shows that the most sensitive 

layer in terms of achieving the desired transmittance at the reference wavelength is the 

low index layer that is deposited after the cavity. The layer next to the incident medium 

(layer 1 in the chart above) does not have a sensitivity value because the sensitivity 

calculation for a layer requires the refractive index of the next layer to be deposited. 

The Macleod Turning Point Sensitivity only produces correct results for layers that 

are an integer multiple of one quarterwave thick. It is acceptable for a design to have, say, 

an antireflection coating as the first few layers next to the substrate followed by 

quarterwave layers followed by non-quarterwave layers. The sensitivity results will only 

be valid for the quarterwave layers.  

Independent 

The Independent sensitivity analysis is a Monte Carlo method of assessing the 

sensitivity of each layer to thickness or refractive index errors. The tool generates a set of 

designs with errors according to the supplied error parameters. The merit figure of each 

design is calculated (using the refinement targets) and normalized by taking the Merit 

Function Power’th root of the merit figure (the Merit Function Power is specified in the 

refinement parameters). The tool produces one of two kinds of plots. If Plot Absolute 

Merit Figure is checked then the minimum, lower quartile, upper quartile and maximum 

merit figures  for each layer are plotted. Otherwise it plots, for each layer, the difference 

between the upper quartile merit figure and the lower quartile merit figure. The larger this 

number, the more sensitive the layer is to errors. 

The Independent sensitivity analysis uses the same error parameters as the Errors tool 

(see page 92) and has an extra parameter Ideal Design Only. If Ideal Design Only is 

checked, the sensitivity is calculated by taking the original design and randomly altering 

each layer Number of Cases times. The plot is then generated from these results. 
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When a coating is manufactured it is very unlikely that all the layers except one will 

have the correct thickness and refractive index. When Ideal Design Only is not checked, 

the analysis models this situation by first creating a design where all the layers have been 

perturbed according to the error parameters. Each layer is then perturbed Number of 

Cases times. The normalized merit figures are stored for each layer perturbation. This 

process is repeated so that a total of Number of Cases designs are created and each layer 

in each of these designs is perturbed Number of Cases times. This process takes more 

time than the ideal design only case, but gives a more robust indication of the sensitivity 

of the design. 

The figure below shows a sample plot when Plot Absolute Merit Figure is not 

checked. 

 
 

The figure below shows a sample plot when Plot Absolute Merit Figure is checked. 
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The horizontal line shows the normalized merit figure of the ideal design. For each 

layer, the top and bottom of the lines show the maximum and minimum merit figures, 

and the top and bottom of the rectangles show the upper and lower quartile merit figures. 

 

Distribution 

The Distribution sensitivity analysis displays the variation of the merit figure as each 

layer is varied in thickness or refractive index. The size of the variation is determined by 

the error parameters. These are the same parameters as used in the Errors command (see 

page 92). For each layer the error term is varied from –2 standard deviations to +2 

standard deviations. This range is divided into Number of Steps intervals. For each point 

the Merit Figure is calculated (using the current refinement targets) and normalized by 

taking the Merit Function Power’th root of the merit figure (the Merit Function Power is 

specified in the refinement parameters).  

 
 

The results of these calculations can be plotted on either a contour plot or a 3D plot 

The figure below shows both kinds of plots for the same 4 layer AR used in the 

Independent sensitivity example above. These plots show that the sensitivity of the 
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design is greatest for the second layer. They also show that the design is optimal (within 

the range of layer variations) since the merit figure only gets worse as the layer 

thicknesses are moved away from the design values. 
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REVERSE ENGINEER 
Reverse Engineer is a tool to help you determine what was actually manufactured and 

how it compares to your design. To use Reverse Engineer you need the design that you 

expected to make and at least one spectrophotometer measurement of the manufactured 

part or one record of the ellipsometric parameters ψ (psi) and Δ (delta) in reflectance. 

Introduction 
Reverse Engineer operates by successively refining the desired design with varying 

constraints determined by the user so that the performance of the design better matches 

the measured performance of the part. 

Reverse Engineer keeps a history of each step performed. You can go back to a 

previous step and continue working from that step, or you can compare the results of one 

set of steps with another set to decide if one solution is more likely than another. 

There are many reasons why a manufactured part does not provide the expected 

optical performance. Reasons include random errors in the process, incorrect tooling 

factors, tooling factor changes with deposition, refractive index variation and incorrect 

thickness termination. The process of reverse engineering attempts to identify the 

reason(s) why a part does not have the desired performance by analysis of optical 

measurements made on the part. Although Reverse Engineer can look at variations in 

absorption through material models, generally, if materials are absorbing more than 

usual, then this should be fixed (by, for example, adjusting oxygen flow) before using 

Reverse Engineer. 

The analysis is essentially a controlled optimization of the expected design using the 

measured optical performance as the targets for the optimization. In Reverse Engineer, 

the optimization is called Adjustment. The design is modified during Adjustment so that 

its performance better matches the measured performance. Generally, there will be 

different sets of modifications that can be made to the design that will result in the 

design’s performance being equally similar to the measured performance. This multiple 

solution problem means that steps have to be taken to control the adjustment so that it is 

directed to the more likely solutions. A solution that has large random changes to several 

layers is usually less likely than a solution that has consistent change in the layer 

thicknesses. 

Three basic parameter types are controlled by Reverse Engineer: Layer thickness, 

Packing density and Layer inhomogeneity. To model consistent changes in the 

manufactured part, such as tooling factor increasing with deposited thickness, a one, two 

or three parameter model can used. The Constant model uses a fixed offset and represents 

situations such as the tooling factor being a different value from the one used by the 

deposition controller. The Linear model provides a linear function relating the change in 

the parameter as a function of design thickness. This will represent linearly increasing (or 

decreasing) parameters. The NonLinear model provides a quadratic function to model 

non-linear relationships between a parameter and deposited thickness.  

Reverse Engineer can also adjust Materials that have been specified using a non-

tabular model such as Cauchy, Sellmeier, Drude, Lorentz and Drude-Lorentz. With the 

Function enhancement, other user-defined material models can be used to specify the 
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index dispersion properties of a material used in the design. When a material model is 

used, it calculates the refractive index and extinction coefficient values used by Reverse 

Engineer. The optical constant data specified by the material in the design is not used. 

For more information on user-defined material models, see the Material Model section in 

the Scripting Language Help. 

The parameter models can be selectively applied to the different materials used in the 

design. For example, in a design using SiO2 and TiO2, a Linear model could be applied 

to SiO2 Layer thicknesses only and the TiO2 may not have any models applied to it. 

During adjustment, the optimization would attempt to find a solution using only a linear 

change in SiO2 tooling factor.  

For modeling random changes in layer parameters, each parameter type can be 

allowed to independently vary for each layer. Since the layer parameters vary 

independently, there is no corresponding model to be applied. The choice is simply to 

allow a layer parameter to vary or not. 

In addition to the adjustment of layer properties, Reverse Engineer also permits the 

adjustment of the measured data, that is, the wavelength, transmittance and/or reflectance 

information. This data may only be varied using a one, two, or three-parameter model. 

For best results, measurements must always be made as accurately as possible on a 

calibrated and maintained spectrometer. Any errors in measurement will, in general, 

increase the uncertainty in any results obtained. The adjustment of measured data should 

only be used as a last resort in attempting to determine the source of the manufacturing 

errors. 

Another source of control over the optimization process is provided by the sequence 

of adjustments made to the design. In a manufactured part where the errors consist of a 

tooling factor variation and some small random errors due to noise in the system, the best 

results are likely to be obtained by first looking for a tooling factor variation that best fits 

the data, followed by determining how much random variation will complete the fit. The 

Action for each material/layer controls the use of the parameters during adjustment. There 

are four types of Action available: Not Used, Adjust, Reset & Adjust and Lock. Not 

Used, means that the parameter does not take part in adjustment and is value is such that 

the design is not modified by it. Adjust means that the parameter does take part in 

adjustment and if the parameter has been adjusted in a previous adjustment, the starting 

point for the next adjustment will be the ending point of the previous adjustment. Reset & 

Adjust performs the same function as Adjust except that the parameter is reset to its 

initial value where it did not modify the design. Lock means that the parameter does not 

take part in the next adjustment, but the parameter retains the value it had at the end of 

the last adjustment. 

The sequence of adjustments to make the design match the measurements would be: 

set each material’s model order to Linear (to look for a linear tooling factor variation), set 

each material’s action to Adjust, and then adjust the design. At the end of this adjustment, 

set each material’s Action to Lock (to retain the adjusted tooling factor values), set each 

layer’s thickness action to Adjust and then adjust the design. This prevents the tooling 

factor from changing and provides an estimate of the amount of random variation needed 

to make the design match the measured data. This can be compared with the expected 

random variation to see if it is plausible. 
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If the sequential adjustment and use of Locks were not used, then the adjustment 

would be free to vary the random thickness parameters by larger values and use less 

variation in the material’s tooling factor. The design could still match the measured data, 

but the results would be less plausible because of the increased random variation. 

The results of adjustment can be seen in both tabular and graphical form. The design 

display shows the changes made to each layer by the adjustment process for both the 

systematic material changes and the random per layer changes. Graphically, the 

systematic changes can be plotted as a function of deposited thickness. The random 

changes can also be plotted on bar charts together with the systematic changes. 

Operation 
To start Reverse Engineer, from the File menu, select New and then Reverse Engineer. 

A blank Reverse Engineer window will appear together with an initial data window 

where you can enter information needed to start reverse engineering. 

 
 

A file chooser will appear so you can select the design file containing the design that 

was made.  If, after having chosen a design, you want to change the design file, click 

Browse to open the file chooser again. Click Next to continue. 
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The substrate on which the design was deposited must now be defined. This 

information will be used instead of the corresponding data in the design file for 

performance calculations in Reverse Engineer. The Substrate Material is the material file 

containing the refractive index information and internal transmittance data for the 

substrate. If the internal transmittance data is undefined in the Material file, Substrate 

Bulk will be visible and specifies the substrate file containing the internal transmittance 

data for the substrate. The Measurement Medium is the material file containing the data 

corresponding to the medium in which the measurements took place. This will usually be 

Air. The Substrate Type refers to the treatment of multiple beams in the substrate. If all 

light reflected in the substrate and coating finally impinge on the measuring device’s 

detector, then the Substrate Type should be set to Parallel. If the reflected light does not 

reach the detector (for example, it leaves the aperture of the system on reflection from the 

rear surface of the substrate), then the Substrate Type should be set to Wedged.  Where 

reflectance has been measured and the substrate has a ground rear surface or the 

reflection from the rear surface has been removed by other means, Wedged should also 

be used to indicate that only the reflectance of the coating has been measured. 

Once this information has been completed, click Add Measurement to add the 

measurement data. 
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To add a spectrum, click Choose Data to select the file and specify the wavelength 

and measurement data to be used. This data will appear in the table to the left of the 

Choose Data button (the data cannot be edited). The remainder of the form is used to 

specify the measurement parameters. Incident Angle and Polarization define the angle of 

the beam with respect to the normal to the coating and the polarization state of the beam. 

For coatings where the cone angle of the measuring beam has a significant impact on the 

measurement, enter the cone semi angle of the beam.  Substrate Type can be either 

Parallel or Wedged. These have the same meanings as for Thick Layers in the Design 

editor. Typically Parallel will be used when second surface effects are included in the 

measurement and Wedged will be used when the second surface effects have been 

eliminated by, for example, grinding the rear surface. For normal incidence 

measurements, the Polarization does not affect the calculations and can be ignored. For 

oblique incidence magnitude measurements, it is recommended that a p or s-polarized 

beam is used. The light beam in most spectrometers has more energy in one polarization 

direction than the other. Using Mean polarization when the beam’s polarization is not 

controlled could lead to additional errors in the results. 

If you have taken more than one measurement, the additional measurements can be 

added, one at a time, by clicking the Add Another Measurement button. 

When the last measurement has been specified, click Finish to exit the data entry 

stage. The figure below shows the Reverse Engineer window with a design and 

transmittance measurement loaded. 
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In the Design section, the details of the design and substrate can be seen. The substrate 

details can be edited if necessary. The Transmittance section shows the measured 

performance and that predicted from the design. 

 
 

In the figure below, the plot is zoomed to show the differences between the measured 

data and the predicted performance at the short wavelength end of the plot. 
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The black line shows the predicted performance and the purple crosses show the 

measured performance. From the measured data you can select a subset of the data to be 

used during adjustment. Using a smaller number of data points increases the speed of 

adjustment, but sufficient data points need to be used to ensure that the shape of the 

predicted curve cannot be substantially different to the measured curve and still match all 

the selected data points. The check boxes Show Use Points and Show Ignored Points 

show you points which will be used in adjustment and which points will not. The purple 

colored points are used in adjustment and the blue colored points will be ignored during 

adjustment. To select a range of points, drag a box around the points. Click Use Points to 

mark the selected points as used during adjustment. Click Ignore Points to mark the select 

points as ignored during adjustment. You can also select Use All Points to put all the 

measured data points into the set to be used for adjustment or Ignore All Points to remove 

all the points from the set used for adjustment. After using Ignore All Points, you will 

need to add some points before adjusting the design. Finally, Use Interval is used in 

conjunction with the box to the right of the button. Enter a whole number into the box 

and click Use Interval. If you entered 10, every tenth point will be added to the set used 

for adjustment and all other points will be removed from the set. 

The top of the window shows the RMS difference between the measured data points 

and the predicted data points. If the data points match perfectly, this value will be zero. 

From the Adjust menu, click Parameters. The adjustment parameters window will appear 

in the bottom right corner of the Essential Macleod window. You can move the window 

to a different location if you wish. This window is used to select the kinds of changes that 

will be permitted during adjustment. 
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The parameters window has five sections: Material, Layer, Spectrum, Material Models 

and History are available. The Material section is used to specify the systematic changes 

that can be made to the design. The changes are specified per material used in the design. 

For convenience, the last row labeled All can be to set the same parameter for all 

materials. The Layer section is used to control the adjustment of each layer independently 

of the other layers. The Spectrum section is used to control the adjustment of the spectra. 

The Material Models section is used to define which materials will use a model rather 

than the material data specified in the Design. This section is also used to create material 

data from the adjusted model that can be stored in the materials database. The final 

section, History, provides a record of the adjustments made to the design.  

One reason for production errors is incorrect tooling factor. The Thickness Action and 

Order in the Material section can be used to search for incorrect tooling factor. To search 

for a constant offset in tooling factor, change the thickness action in the All row to Adjust. 

The Order should be left at Constant. 

 
 

Click Adjust to begin the adjustment. The RMS difference value will be updated as the 

adjustment progresses. To show that the adjustment is running a bar to the right of the 

RMS value will appear and change in size. At the end of adjustment, the bar will 

disappear. The plot is only updated at the end of adjustment as shown in the figure below. 
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The match between the measured data and the modified prediction is now so good that 

there is no value in attempting to improve the match. We can now look at the results of 

the adjustment. We can see the results in terms of changes to the layers by selecting the 

Design section of the window as shown below. The Systematic Thickness Change 

column shows that the TiO2 layer thicknesses have been increased by 10%, and that the 

SiO2 layer thicknesses have been decreased by 10%. 
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Alternatively, the tooling factor as a function of design thickness can be plotted. With 

the Reverse Engineer window selected, select Systematic Thickness from the Results 

menu. The scaling factor will be plotted. 

 

 
 

Another output format, which has more value when there are random variations, is a 

bar chart of the changes. From the Results menu, select Random Thickness. 

 

 
 

In this case, the bars are all constant length. If there were some random variation as 

well, red bars to the side of the blue bars would indicate the amount of random variation 

in comparison to the systematic variation. 

 

Menu Commands 
 

This section describes the menu commands specific to Reverse Engineer. 
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File Menu 

Import 

When the Design section is displayed, this command allows you to load a design into 

Reverse Engineer for adjustment. Generally, this command will not be used, because the 

design will already have been imported during initial data entry. 

 

Measurements Menu 

Add Transmittance 

The Add Transmittance command will add a transmittance measurement to the set 

measurements loaded into Reverse Engineer. When you click this command, you be 

asked to select the file containing the measurement data. After this, you will be asked to 

define the wavelength and transmittance column. Finally you have to select the scale 

range of the transmittance measurement, either 0-1 or 0-100%. The transmittance 

measurement will appear in a new section of the Reverse Engineer window. In that 

window you can set the Incident Angle and polarization used for the measurement. 

Add Reflectance 

Add Reflectance performs the same function as Add Transmittance except that it loads 

reflectance curves. 

Add Reflectance Psi 

Add Reflectance Psi performs the same function as Add Transmittance except that it 

loads reflectance psi curves. 

Add Reflectance Delta 

Add Reflectance Delta performs the same function as Add Transmittance except that it 

loads reflectance delta curves. 

Delete Measurement 

This command removes the measurement in the displayed section from the loaded 

measurement set.  

 

Adjust Menu 

Parameters 

This command displays the adjustment parameters in a window at the bottom right of 

the Essential Macleod window. From this window, you control the parameters that are to 

be used during the adjustment of the design. This window also keeps a history of the 

adjustments previously made and the RMS difference that was achieved. 
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Control Parameters 

This command provides control over the parameters that limit the adjustment process. 

These parameters are not normally changed, but occasionally, modifying these 

parameters will improve the performance of Reverse Engineer. 

 
 

The following control parameters are available: 

Material Starting Increment Section 

Thickness: The adjustment process starts by creating a set of designs clustered 

around the starting point. This value specifies the proportional amount of thickness that is 

added to the starting point to generate the cluster for thickness values. 

Density: This parameter performs the same function as Starting Material Thickness 

Increment, for the Material Density parameters, except that the value is an absolute 

amount added to the starting value of packing density.. 

Inhomogeneity: This parameter performs the same function as Starting Material 

Thickness Increment, for the Material Inhomogeneity parameters except that the value is 

an absolute amount added to the starting value of inhomogeneity factor. 

Layer Starting Increment Section 

Thickness: This parameter specifies the amount of thickness added to the design 

when creating the initial cluster for random thickness changes. 

Density: This parameter specifies the amount of packing density added to the design 

when creating the initial cluster for random density changes. 

Inhomogeneity: This parameter specifies the amount of inhomogeneity factor added 

to the design when creating the initial cluster for random inhomogeneity changes. 

Spectra Starting Increment Section 

Wavelength: This parameter specifies the proportional amount of wavelength change 

made when creating the initial cluster. 

Transmittance: This parameter specifies the proportional amount of transmittance 

change made when creating the initial cluster 

Reflectance: This parameter specifies the proportional amount of reflectance change 

made when creating the initial cluster 
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Optimizer: General Section 

Simplex: When selected, simplex optimization will be used. 

Differential Evolution: When selected, differential evolution optimization will be 

used. 

<S> will appear in the title bar when Simplex is chosen and <DE> will appear when 

Differential Evolution is chosen 

Optimizer: Simplex Section 

Number of Iterations: The maximum number of cycles of simplex optimization 

before adjustment will halt. If this value is reached, a message will be displayed. 

Limiting Range for Merit Function: When the difference between the best and worst 

performances generated during adjustment is less than this value, the adjustment will 

stop. 

Optimizer: Differential Evolution Section 

Number of Iterations: The maximum number of cycles of differential evolution 

optimization before adjustment will halt. If this value is reached, a message will be 

displayed. 

Merit Function Limit: When the best performance generated during adjustment is less 

than this value, the adjustment will stop. 

Population Scale Factor: This determines the size of the population of candidate 

designs for the Differential Evolution optimization. The larger this number, the bigger the 

population size. An increased population size has a better chance of finding a good 

solution, but at the expense of increased adjustment time. 

Maximum Change Section 

Thickness: This parameter specifies the maximum change in thickness allowed for 

the design. This value applies to the combined thickness change from systematic effects 

and random effects. 

Density: This parameter specifies the maximum change in density allowed for the 

design. This value applies to the combined density change from systematic effects and 

random effects 

Inhomogeneity: This parameter specifies the maximum change in inhomogeneity 

allowed for the design. This value applies to the combined inhomogeneity change from 

systematic effects and random effects 

Wavelength: This parameter specifies the maximum change in wavelength allowed 

for the measurements.  

Transmittance: This parameter specifies the maximum change in transmittance 

allowed for the measurements.  

Reflectance: This parameter specifies the maximum change in reflectance allowed 

for the measurements.  
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Model Increment: Cauchy Section 

A: This parameter specifies the default starting increment for the A parameter.  

Model Increment: Sellmeier Section 

A: This parameter specifies the default starting increment for the A parameter.  

B: This parameter specifies the default starting increment for the B parameter.  

Model Increment: Drude Section 

A: This parameter specifies the default starting increment for the A parameter.  

B: This parameter specifies the default starting increment for the B parameter.  

C: This parameter specifies the default starting increment for the C parameter.  

These defaults apply to both the Drude and Drude-Lorentz material models.  

Model Increment: Lorentz Section 

A: This parameter specifies the default starting increment for the A parameter.  

B: This parameter specifies the default starting increment for the B parameter.  

C: This parameter specifies the default starting increment for the C parameter.  

D: This parameter specifies the default starting increment for the D parameter.  

These defaults apply to both the Lorentz and Drude-Lorentz material models.  

Model Increment: k Cauchy Section 

A: This parameter specifies the default starting increment for the A parameter of the 

extinction coefficient Cauchy model.  

Model Increment: k Exp Section 

A: This parameter specifies the default starting increment for the A parameter of the 

extinction coefficient exponential model.  

B: This parameter specifies the default starting increment for the B parameter of the 

extinction coefficient exponential model.  

 

Results Menu 

This menu provides graphical output of the adjustment results. 

Systematic Thickness 

Systematic Density 

Systematic Inhomogeneity 

These three commands display the systematic variations of Thickness, Packing 

Density and Inhomogeneity for each material on separate plots. 
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Random Thickness 

Random Density 

Random Inhomogeneity 

These three commands display the random variation and systematic change to each 

layer in Thickness, Packing Density and Inhomogeneity on separate bar chart plots. The 

systematic and random changes are shown in separate bars so that their relative sizes may 

be easily compared. 

Spectra 

This command plots the variation in the measurement parameters that have been used 

in the adjustment.  

Adjustment Parameters Window 
The adjustment parameters window provides the control over the adjustment process. 

For each parameter, there are four kinds of action that can be specified: Not Used, 

Adjust, Reset & Adjust and Lock. Not Used means that the parameter does not modify the 

design. Adjust means that the parameter is modified by the adjustment process and that 

the starting point for the parameter is the value it had at the end of the previous 

adjustment. For the first adjustment, the value of the parameter is such that it does not 

modify the design. Reset & Adjust is the same as Adjust except that the parameter is reset 

to its initial value before the first adjustment each time an adjustment is made. Lock 

means that parameter keeps the value it had at the end of the previous adjustment and is 

not modified during adjustment. 

In the Material and Spectrum sections, an order is also specified for each parameter. 

The possible orders are Constant, Linear, and NonLinear. A Constant order means that a 

constant offset that is independent of thickness or wavelength is applied to the parameter. 

A Linear order means that an offset that varies linearly with thickness or wavelength is 

applied to the parameter. A NonLinear order means that an offset that varies quadratically 

with thickness or wavelength is applied to the parameter. 

To change the values of the Action or Order, click in the cell until the desired value 

appears. Once the values have been set, click the Adjust button to begin adjustment of the 

design. Clicking the Close button will close the Adjustment Parameters window. 

Material Section 

This section controls the systematic variations applied to the design. For each material 

used in the design, the thickness, density and inhomogeneity variations are controlled by 

the order of the model. 

At the bottom of the list of materials is the special name All. Changing the parameters 

of All changes all the material parameters of the same kind to the same value. 

Layer Section 

This section controls the random variations applied to each in the design. Only the 

Action can be set since there is no relationship between the changes in layers. At the 
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bottom of the layer column is the special name All. Changing the Action in this row 

makes all the layers have the same action. 

Spectrum Section 

This section controls the variations applied to the magnitude measurements. The 

ellipsometric parameters psi and delta cannot be adjusted. Only systematic variations may 

be applied to the measurements, and the variations are assumed to be consistent across all 

measurements of the same type. The wavelength can also be modified and the 

modifications are applied to the wavelengths of all measurements. 

Material Models Section 

This section controls the variations applied to the materials. Clicking in the Action 

cell will change how the material is used in adjustment in the same way as for the other 

parameters. If Function is not present, the then Script Name will show <Internal>. If 

Function is present, it will be possible to select a script that will provide a material model, 

otherwise one of the internal material models must be used. If the material already uses a 

non-tabular model, then this model will used during adjustment. If the material is only 

defined by a tabular model, then one of the other models must be selected before 

adjustment. Reverse Engineer does not modify the existing material, but makes a copy of 

the material and makes changes to the copy. This copy can be edited by clicking the 

Show button in the Parameters column. This will display a Material window. The name 

of the Material will be the same as in the Material column with “(RE)” appended. In this 

window, you can change the material model used and the parameters. In addition to the 

parameters for the particular material model, there are also the increment parameters. For 

example, in the Lorentz model, the Material parameters include A Inc, B Increment, C 

Increment and D Increment: 

 
 

When these increment parameters are left blank, the default parameters specified in 

the Control Parameters will be used, otherwise the increments in the material will be 

used. When the selected optimizer is Simplex, the increments are used in the usual way to 

add offsets to each parameter to form the initial simplex. When the selected optimizer is 
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Differential Evolution, the increments are used together with the parameters to create the 

initial range for each of the parameters: (parameter – increment) to (parameter + 

increment). 

After each adjustment has completed, the Material window can be used to see the 

current state of the Material definition, by making the Material window active and using 

the plot commands to view the refractive index dispersion. Between adjustments, the 

material data can be edited. The new edited data will be used in the next adjustment. 

 

History Section 

This section records all the adjustments made to the design. The RMS difference and 

the parameters used are stored for each adjustment. Double-clicking on an entry in the 

history will restore the state of Reverse Engineer to that entry. This means that you can 

easily backtrack to earlier point if you need to try an alternative set of adjustments, but do 

not need to go back to the beginning. 
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REPORT GENERATOR 
 

Introduction 
The Report Generator is used to make customized printouts of data contained in 

Essential Macleod files.  Data can be printed from associated files as well as the data 

contained in the file to be printed. For example, the report for a Stack can include listings 

of the designs used in the Stack. Additionally, the report can include plots and tables, 

such as the reflectance spectrum of a Design. 

A Report is created by applying a Report Template to an Essential Macleod file. To 

apply a report template to an open Essential Macleod file such as a Design, select either 

Preview Report or Print Report from the File menu. Selecting Preview Report will cause 

the report to be displayed in a print preview window. Selecting Print Report will cause 

the report to be printed on the currently selected printer.  

The Report Template describes the format of the printed output and the information to 

be extracted or calculated by the Essential Macleod. Report template files are text files 

and can be edited with any text editor as well as being edited by the Essential Macleod. 

Report template files have the extension .rpx.  

The text in a report template is either text that is to be printed directly without 

interpretation, or it is an instruction that is replaced by data from the Essential Macleod. 

Instructions begin with the character sequence “%<” and end with the character sequence 

“%>” For example, a report template file that contains the line 

 
%<Design Layers%> 

 

when applied to a Design will print out the layers used in the design as they appear on the 

screen. 

Instructions 
An instruction consists of a list if items separated by space characters. Where an item 

contains spaces (such as a font name), it must be enclosed in double-quotes (“), for 

example, “Times New Roman”.   

Page Layout Instructions 
Page layout instructions control the general features of the page. This includes the 

orientation of the page and the font used. 

 

%<Portrait%>: Forces portrait orientation of the paper. If a page has been started, this 

will take effect at the next page 

%<Landscape%>: Forces landscape orientation of the paper. If a page has been started, 

this will take effect at the next page 
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%<Header HeaderText%>: The header is set to be HeaderText. This has the same 

formatting rules as the standard header specified in the options. If this header is not 

present, then the standard header is used. 
 

%<Footer FooterText%>: The footer is set to be FooterText 
 

%<NewPage%>: Starts a new page. 
 

%<Font Parameters%>: Modifies the font. The parameters are: 
Bold 

 

NoBold 
 

Italic 
 

NoItalic 
 

Underline 
 

NoUnderline 
 

StrikeThru 
 

NoStrikeThru 
 

Size: Followed by the size in points 
 

Name: Followed by the font name in quotes 

 

For example 

 
%<Font Arial Size 15%> 

 

sets the font to be Arial at a size of 15 points 

 

%<HeaderFont Parameters%>: As for Font but controls the font used for the header and 

footer. 

 

%<Graphic <Filename> Parameters%>: prints the graphic is the specified file on the 

page. The following file formats are supported: bmp, gif, jpg, wmf (Windows Metafile) 

and emf (Enhanced Metafile). The following parameters are available: 

 

Width: Specifies the width in inches 
 

Height: Specifies the height in inches 
 

Center: Horizontally centers the graphic 
 

Left: Places the graphic at the left margin 
 

Right: Places the graphic at the right margin 

 
%< LeftHeaderGraphic <Filename> %> 
%< CenterHeaderGraphic <Filename> %> 
%< RightHeaderGraphic <Filename> %> 
%< LeftFooterGraphic <Filename> %> 
%< CenterFooterGraphic <Filename> %> 
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%< RightFooterGraphic <Filename> %>: These six commands specify the graphics to 

be used in the header and footer. The first two words of the command give the location of 

the graphic. The graphics take effect at the next header for the header commands and at 

the next footer for the footer commands. The same file formats as for the Graphic 

command above are supported. If these commands are not present, then the standard 

header and footer graphics as specified in options will be used. The header graphics are 

aligned so that the bottom edge of each graphic is aligned with the bottom of the header. 

The footer graphics are aligned so that the top edge of each graphic is aligned with the 

top of the footer. If both text and graphic headers and footers have been specified, then 

the text component will overwrite the graphic component. 

Common Parameters for Plots and 3D Plots 
Plots and 3D plots have a common set of parameters in addition to particular parameters 

for each kind of document. The instructions will include either the item Plot or the item 

Plot3D. When one of these appears in the instruction, the following items can be used to 

modify the appearance of the plot: 

 

NoTitle: Removes the title from the plot 
 

Width: Specifies the width in inches 
 

Height: Specifies the height in inches 
 

Center: Horizontally centers the plot 
 

Left: Places the plot at the left margin 
 

Right: Places the plot at the right margin 

Common Parameters for Tables 
Tables have a common set of parameters in addition to particular parameters for each 

kind of document. The instructions will generally include the item Table, but other items 

such as Layers in a Design instruction also produce tables that can be controlled by these 

common parameters. When this item appears in the instruction, the following items can 

be used to modify the appearance of the table:  

 

MaxFontSize: This parameter specifies that the table should be adjusted to fit the page 

width The parameter following MaxFontSize must be a number that specifies the 

maximum font size that may be used. 

MinFontSize: This parameter specifies that the table should be adjusted to fit the page 

width The parameter following MinFontSize must be a number that specifies the 

minimum font size that may be used. If the table needs a smaller font to be displayed 

on one page, then the table will be broken up and displayed on several pages. 

Iteration Instructions 
Many documents make use of several other documents. For example, a design 

typically uses several materials and a Stack typically uses several designs. The iteration 

instructions provide a means for printing information from the sub-documents. The 
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iteration loop begins with a %<ForEach… >% and ends with a %<Next…>% instruction. 

The report generator performs the instructions in the loop for each sub-document of the 

type named in the ForEach instruction. Each time the report generator begins an iteration, 

the next sub-document in the list will be the document whose contents will be printed. 

The following iteration instructions are recognized: 

 

%<ForEachMaterial%> … %<NextMaterial%>: Iterates over the materials used. Can be 

used in Designs, Stacks, vStacks, Machine Configurations and Reverse Engineers, 

 

%<ForEachSubstrate%> … %<NextSubstrate%>: Iterates over the substrates used. Can 

be used in Stacks and Machine Configurations, 
 

%<ForEachDesign%> …%<NextDesign%>: Iterates over the designs used. Can be used 

in Stacks, vStacks. 

 

%<ForEachChip%> … %<NextChip%>: Iterates over the chips used in a Runsheet. 

 

%<ForEachMeasurement%> … %<NextMeasurement%>: Iterates over the measured 

spectra in a Reverse Engineer. 

 
%<ForEachScript ScriptName EntryPoint%> … %<NextScript ScriptName 

EntryPoint%>: Iterates over a range defined in a script. For each iteration, the EntryPoint 

is called in the script ScriptName. More information on using ForEachScript is in the  

Report Generator section of the Scripting Language Help. 

 

For example, the template fragment 

 
%<ForEachMaterial%> 
%<Material Title%> 
%<NextMaterial%> 

 

in a design report template will print out a list of the materials used in the design. 

The Targets Instruction 
 
%<Targets Parameter%> prints the target tables.  
 
This instruction is only available in Designs, Stacks, and vStacks. The parameters are: 
 

Standard: Prints the standard targets 
 

Color: Prints the color targets 
 

Thickness: Prints the thickness targets (only for designs) 
 

The common table parameters described above may also be used 
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Material Report Templates 
Templates for materials can contain the page layout instructions described above and 

the material instruction used as many times as necessary to print the desired information 

about the material. The material instruction may also be used in a template for any file 

that uses materials, such as Design and Stack files, inside a %<ForEachMaterial%> … 

%<NextMaterial%> loop. The material instruction has the form: 

 
%<Material Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

Parameters 
 

Plot: Prints a plot of the material 

Wavelength: Specifies that the plot will use a wavelength axis 

Frequency: Specifies that the plot will use a frequency axis 

The common plot parameters described above may also be used 
 

Table: Prints the table of data 

The common table parameters described above may be used 
 

Notes: Prints the notes 
 

PoissonsRatio: Prints the value or “undefined” 
 

LinearExpansionCoefficient: Prints the value or “undefined” 
 

ThermalIndexCoefficient: Prints the value or “undefined” 
 

YoungsModulus: Prints the value or “undefined” 
 

ReferenceStress: Prints the value or “undefined” 
 

ReferenceTemperature: Prints the value or “undefined” 
 

SurfaceEnergy: Prints the value or “undefined” 
 

Title: Prints the name of the material 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 
 
 

Substrate Report Templates 

Templates for substrates can contain the page layout instructions described above and 

the substrate instruction used as many times as necessary to print the desired information 

about the substrate. The substrate instruction may also be used in a template for any file 

that uses substrates, such as Stack files, inside a %<ForEachSubstrate%> … 

%<NextSubstrate%> loop. The substrate instruction has the form: 
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%<Substrate Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

Parameters 

 

Plot: Prints a plot of the substrate 

Wavelength: Specifies that the plot will use a wavelength axis 

Frequency: Specifies that the plot will use a frequency axis 

The common plot parameters described above may also be used 
 

Table: Prints the table of data 

The common table parameters described above may be used 
 

Notes: Prints the notes 
 

Thickness: Prints the thickness 
 

ThicknessUnit: Prints the thickness units 
 

Title: Prints the name of the substrate 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 

 

Design Report Templates 

Templates for designs can contain the page layout instructions described above, the 

design instruction used as many times as necessary to print the desired information about 

the design. The design instruction may also be used in a template for any file that uses 

designs, such as Stack and vStack files, inside a %<ForEachDesign%> … 

%<NextDesign%> loop. The design instruction has the form: 

 
%<Design Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

To print out information about the targets, use the Target instruction described above. 

A design template may also contain a %<ForEachMaterial%> … %<NextMaterial%> 

loop to print out information about the materials used in the design. 

Parameters 

 

Layers: Prints the layers in the design 
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Show: Forces the only columns named after the Show command to be displayed 

in the report regardless of whether they are displayed on the screen or not. 

 

The following are the names of the columns for use with Show  
 

MediumType LayerNumber 
PackingDensity Material 
RefractiveIndex ExtinctionCoefficient 
OpticalThickness PhysicalThickness 
GeometricThickness MediumThickness 
Locked Link 
VoidMaterial VoidDensity 
InhomogeneityFactor MinimumPhysicalThickness 
MaximumPhysicalThickness  

 

For example 
 
%<Design Layers Show LayerNumber Material PhysicalThickness %> 
 

will cause only the layer number, material and physical thickness to be printed. 

Plot: Prints a plot 

Performance: Plots the performance of the design 

Errors: Plots the variation in the performance given by the error 

parameters stored in the design 
 

Admittance: Plots the admittance locus of the design 
 

ReflectionCoefficient: Plots the reflection coefficient locus of the design 
 

ElectricField: Plots the electric field of the design 
 

AbsorptanceRate: Plots the absorptance rate of the design 
 

TotalAbsorptance: Plots the total absorptance of the design 
 

Color: Plots the color of the design 

Errors: Plots the variation in color given by the error parameters stored 

in the design 
 

Index: Plots the index profile of the design 

The common plot parameters described above may also be used 
 

Table: Prints a table 

Performance: prints the performance table 
 

Color: prints the color table 
 

Admittance: Prints a table of admittance data 
 

ReflectionCoefficient: Prints a table of reflection coefficient data 
 

ElectricField: Prints the electric field data 
 

AbsorptanceRate: Prints the absorptance rate data 
 

TotalAbsorptance: prints the total absorptance data 
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The common table parameters described above may also be used 

 

Plot3D: Prints the 3D plot of the design.  

The common plot parameters described above may also be used 
 

Notes: Prints the notes 
 

IncidentAngle: Prints the incident angle 
 

ReferenceWavelength: Prints the reference wavelength 
 

IncidentAngleUnit: Prints the units of the incident angle 
 

WavelengthUnit: Prints the units for wavelength 
 

MatchAngle: Prints the match angle 
 

MatchAngleKLimit: Prints the extinction coefficient limit used in Match Angle 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
 

Filename: Prints the complete filename of the design 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 
 

The following instructions can also be used in a design report template: 

 

%<ForEachMaterial%>: Begins a loop iterating over each material used in the design 
 

%<NextMaterial%>: Ends the loop iterating over each material 
 

%<Material Parameter%>: Prints information about the current material as selected by 

ForEachMaterial.  
 

For example: 

 
%<ForEachMaterial%> 
%<Material Title%> 
%<Material Plot Wavelength NoTitle, Width 6 Height 4%> 
%<NextMaterial%> 
 

will print out the name and a plot of the material’s optical constants for each material 

used in the Design 

 

%<Targets Parameter%>: Prints information about the design’s targets. The options for 

targets are defined above. 
 

Stack Report Templates 

Templates for stacks can contain the page layout instructions described above, the 

stack instruction used as many times as necessary to print the desired information about 

the stack. The stack instruction has the form: 



Report Generator  289 

 
%<Stack Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot or table and how the plot and table 

are formatted. 

To print out information about the targets, use the Target instruction described above. 

A stack template may contain a %<ForEachMaterial%> … %<NextMaterial%> loop to 

print out information about the materials used in the stack. This will include all the 

materials used in all the designs present in the stack. It may also contain a 

%<ForEachSubstrate%> … %<NextSubstrate%> loop to print out information about the 

substrates used in the stack. Information about the designs used in the stack are printed 

out using the  %<ForEachDesign%> … %<NextDesign%> loop. 

Parameters 

 

Media: Prints the Stack table 
 

Show: Forces the columns named after the Show command to be displayed in 

the report regardless of whether they are displayed on the screen or not. 
 

The following are the names of the columns for use with Show  

 
MediumType MediumMaterial 
MediumSubstrate MediumThickness 
CoatingFile CoatingDirection 
CoatlingLocked  

 

For example  
 
%<Stack Media Show MediumMaterial MediumThickness CoatingFile %> 
 

will cause the material, thickness and coating file columns to be printed. The 

other columns will not be printed. 
 

The common table parameters described above may also be used 
 

Plot: Prints the plot 

Performance: Plots the performance of the stack 

Errors: Plots the variation in the performance given by the error 

parameters  
 

Color: Plots the color of the stack 

Errors: Plots the variation in color given by the error 

The common plot parameters described above may also be used 
 

Plot3D: Prints the 3d plot 

The common plot parameters described above may be used 
 

Table: Prints a table 
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Performance: Prints the performance table 
 

Color: Prints the color table 

The common table parameters described above may also be used 
 

Notes: Prints the notes 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
 

Filename: Prints the complete filename of the stack 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 
 

The following instructions can also be used in a Stack report template: 

 

%<ForEachMaterial%>: Begins a loop iterating over each material used in the stack 
 

%<NextMaterial%>: Ends the loop iterating over each material 
 

%<Material Parameter%>: Prints information about the current material as selected by 

ForEachMaterial. The options are as defined for materials above 
 

%<ForEachSubstrate%>: Begins a loop iterating over each substrate used in the stack 
 

%<NextSubstrate%>: Ends the loop iterating over each substrate 
 

%<Substrate Parameters%>: Prints information about the current substrate as selected 

by ForEachSubstrate. The options are as defined for substrates above 
 

%<ForEachDesign%>: Begins a loop iterating over each design used in the stack 
 

%<NextDesign%>: Ends the loop iterating over each design 
 

%<Design Parameters%>: Prints information about the current design as selected by 

ForEachDesign. The options are as defined for designs above 
 

%<Targets Parameters%>: Prints information about the stack’s targets. The options for 

targets are defined above. 
 
 

vStack Report Templates 

Templates for vstacks can contain the page layout instructions described above, the 

vstack instruction used as many times as necessary to print the desired information about 

the vstack. The vstack instruction has the form: 

 
%<vStack Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot or table and how the plot and table 

are formatted. 
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To print out information about the targets, use the Target instruction described above. 

A vstack template may contain a %<ForEachMaterial%> … %<NextMaterial%> loop 

to print out information about the materials used in the vstack. This will include all the 

materials used in all the designs present in the vstack. Information about the designs used 

in the vstack are printed out using the  %<ForEachDesign%> … %<NextDesign%> loop. 

Parameters 

 

Media: Prints the vStack table 
 

Show: Forces the columns named after the Show command to be displayed in 

the report regardless of whether they are displayed on the screen or not. 
 

The following are the names of the columns for use with Show 
 

FrontMaterial BackMaterial 
SurfaceAngle TransferMode 
CoatingFile CoatingDirection 
CoatingLocked ExitBeamAngle 
IncidentAngle EmergentAngle 

 

For example, 
 
%<vStack Media Show FrontMaterial BackMaterial SurfaceAngle TransferMode 
CoatingFile IncidentAngle %> 
 

will produce a six column table when printed in the report. 

The common table parameters described above may also be used 
 

Plot: Prints the plot 

Performance: Plots the performance of the vstack 

Errors: Plots the variation in the performance given by the error 

parameters  
 

Color: Plots the color of the vstack 

Errors: Plots the variation in color given by the error 

The common plot parameters described above may also be used 
 

Plot3D: Prints the 3d plot 

The common plot parameters described above may be used 
 

Table: Prints a table 

Performance: Prints the performance table 
 

Color: Prints the color table 

The common table parameters described above may also be used 
 

Notes: Prints the notes 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
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Filename: Prints the complete filename of the vstack 
 

Layout: Prints the vstack layout 

Width: The next parameter specifies the width in inches 
 

Height: The next parameter specifies the height in inches 
 

The aspect ratio of the layout is kept the same as in the screen display. The 

layout is adjusted to fit the width and height specified. 

 

The following instructions can also be used in a vStack report template: 

 

%<ForEachMaterial%>: Begins a loop iterating over each material used in the vstack 
 

%<NextMaterial%>: Ends the loop iterating over each material 
 

%<Material Parameter%>: Prints information about the current material as selected by 

ForEachMaterial. The options are as defined for materials above 
 

%<ForEachDesign%>: Begins a loop iterating over each design used in the vstack 
 

%<NextDesign%>: Ends the loop iterating over each design 
 

%<Design Parameters%>: Prints information about the current design as selected by 

ForEachDesign. The options are as defined for designs above 
 

%<Targets Parameters%>: Prints information about the vstack’s targets. The options for 

targets are defined above. 
 

Machine Configuration Report Templates 

Templates for machine configurations can contain the page layout instructions 

described above, the Machine instruction used as many times as necessary to print the 

desired information about the machine configuration. The machine instruction has the 

form: 

 
%<Machine Parameter%> 
 

where the parameter is selected from the list below. For tables, additional parameters may 

be added to control how the table is formatted. 

A machine configuration template may contain a %<ForEachMaterial%> … 

%<NextMaterial%> loop to print out information about the materials used in the vstack. 

This will include all the materials used in all the designs present in the vstack. 

Information about the substrates used in the machine configuration are printed out using 

the  %<ForEachSubstrate%> … %<NextSubstrate%> loop. 

Parameters 

 

Sources: Prints the sources table 

The common table parameters described above may be used 
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Chips: Prints the chips table 

The common table parameters described above may be used 
 

CrystalToolingErrors: Prints the crystal tooling errors table 

The common table parameters described above may be used 
 

OpticalToolingErrors: Prints the optical tooling errors table 

The common table parameters described above may be used 
 

PackingDensityErrors: Prints the packing density errors table 

The common table parameters described above may be used 
 

DepositionRateVariation: Prints the deposition rate variation table 

The common table parameters described above may be used 
 

Notes: Prints the notes 
 

Monitoring: Prints the monitoring type 
 

IncidentAngle: Prints the incident angle 
 

IncidentAngleUnit: Prints the units for the incident angle 
 

DepositionMedium: Prints the deposition medium 
 

ThicknessScaleFactor: Prints the thickness scale factor 
 

ThicknessUnits: Prints the units for thickness 
 

ResetToolingFactor: Prints the reset option, either “Yes” or “No” will be printed 
 

GratingCalibrationFactor: Prints the grating calibration factor 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
 

Filename: Prints the complete filename of the machine configuration 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 
 

The following instructions can also be used in a Machine Configuration report template: 

 

%<ForEachMaterial%>: Begins a loop iterating over each material used in the machine 

configuration 
 

%<NextMaterial%>: Ends the loop iterating over each material 
 

%<Material Parameter%>: Prints information about the current material as selected by 

ForEachMaterial. The options are as defined for materials above 
 

%<ForEachSubstrate%>: Begins a loop iterating over each substrate used in the 

machine configuration. 
 

%<NextSubstrate%>: Ends the loop iterating over each substrate 
 

%<Substrate Parameters%>: Prints information about the current substrate as selected 
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by ForEachSubstrate. The options are as defined for substrates above 
 

Runsheet Report Templates 

Templates for runsheets can contain the page layout instructions described above, the 

Runsheet instruction used as many times as necessary to print the desired information 

about the runsheet. The runsheet instruction has the form: 

 
%<Runsheet Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

A runsheet template may also contain a %<ForEachChip%> … %<NextChip%> loop 

to print out signal plots for each different chip used in the runsheet. 

Parameters 

 

Plot: Plots the runsheet signal 

Wideband: Generates the wideband plot 
 

Narrowband: Generates the single wavelength plot 
 

Chip: Generates the plot for the chip selected by ForEachChip below 
 

AllChips: Generates the plot for all chips 

The common plot parameters described above may also be used 
 

Table: Prints the runsheet table 
 

Show: Forces the columns named after the Show command to be displayed in 

the report regardless of whether they are displayed on the screen or not. 
 

The following are the names of the columns for use with Show 
 

Chip LayerNumber 

Source Material 

Thickness Wavelength 
Bandwidth ChipOpticalThickness 
MonitorSpectrum SimulationSpectrum 
ZeroOffset Gain 
MonitorType InitialSignal 
StartAt FirstMaxima 
FirstMinima LastMaxima 
LastMinima FinishAt 
FinalSwing Peaks 
NumberOfPeaks InitialDirection 
DesignRefractiveIndex DesignPhysicalThickness 

 

For example 
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%<Runsheet Table Show Chip Source Wavelength StartAt Peaks %> 
 

will print out a five column runsheet 

The common table parameters described above may also be used 

 

Notes: Prints the notes 
 

Design: Prints the filename of the design used 
 

Machine: Prints the filename of the machine configuration used 
 

Polarization: Prints the polarization of the optical signal  
 

MonitorMode: Prints the monitor mode (Transmittance, Reflectance, Back Reflectance) 
 

WavelengthInterval: Prints the wavelength interval used for the calculations 
 

WavelengthScaleFactor: Prints the wavelength scale factor 
 

UsePreviousExtremum: Prints the use previous extremum option, either “Yes” or “No” 

is printed 
 

OneWavelengthPerChip: Prints the one wavelength per chip options, either “Yes” or 

“No” is printed 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
 

Filename: Prints the complete filename of the machine configuration 
 

Script: Runs the specified script and inserts the result into the report. See the Report 

Script section below for more information. 
 
 

The following instructions can also be used in a Runsheet report template: 
 

%<ForEachChip%>: Begins a loop iterating over each chip used in the runsheet 

%<NextChip%>: Ends the loop iterating over each chip 

 

For example: 

 
%<ForEachChip%> 
%<Runsheet Plot Narrowband Chip%> 
%<NextChip%> 
 

will produce a separate plot for each chip in the runsheet. 

 

%<Design Parameter%>: Prints design information for the design used in the runsheet 
 

%<Machine Parameter%>: Prints machine configuration information for the machine 

configuration used in the runsheet 
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Optical Constant Report Templates 

Templates for optical constants can contain the page layout instructions described 

above, the OpticalConstant instruction used as many times as necessary to print the 

desired information. The OpticalConstant instruction has the form: 

 
%<OpticalConstant Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

Parameters 

 

Plot: Prints a plot 

Transmittance: Prints the transmittance plot 
 

Reflectance: Prints the reflectance plot 
 

SubstrateTransmittance: Prints the substrate transmittance plot 
 

SubstrateReflectance: Prints the substrate reflectance plot 
 

OpticalConstants: Prints the optical constants plot 

The common plot parameters described above may also be used 
 

Table: Prints a table 

Data: Prints the extrema data points 
 

OpticalConstants: Prints the optical constant data 

The common table parameters described above may also be used 
 

Notes: Prints the notes 
 

FilmThickness: Prints the film thickness 
 

ApproximateIndex: Prints the approximate film thickness 
 

Tolerance: Prints the R/T tolerance 
 

IncidentAngle: Prints the incident angle 
 

IncidentAngleUnit: Prints the units of incident angle 
 

Polarization: Prints the polarization of the measuring light 
 

SingleSidedReflectance: Prints the single sided reflectance option, either “Yes” or “No” 

is printed 
 

UseSpectrum: Prints the use spectrum option, either “Yes” or “No” is printed 
 

SmoothData: Prints the smooth data option, either “Yes” or “No” is printed 
 

SubstrateThickness: Prints the thickness of the substrate 
 

SubstrateThicknessUnit: Prints the units for the substrate thickness 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 



Report Generator  297 

extension. 
 

Filename: Prints the complete filename. 
 

The following instructions can also be used in a Optical Constant report template: 

 

%<SubstrateSubstrate Parameter%>: Prints Substrate data for the substrate used. 

Options are defined in substrate above 
 

%<SubstrateMaterial Parameter%>: Prints Material data for the material used in the 

substrate. Options are defined in material above 

 

Reverse Engineer Report Templates 

Templates for reverse engineering can contain the page layout instructions described 

above, the Reverse Engineer instruction used as many times as necessary to print the 

desired information. The Reverse Engineer instruction has the form: 

 
%<ReverseEngineer Parameter%> 
 

where the parameter is selected from the list below. For plots and tables, additional 

parameters may be added to control the kind of plot and how the plot and table are 

formatted. 

Parameters 

 

Plot: Prints a plot 

Measurement: Plots the current measurement plot. The current plot is 

controlled by the ForEachMeasurement loop 
 

SystematicThickness: plots the systematic thickness variation of the 

adjustment 
 

SystematicPackingDensity: plots the systematic packing density variation of 

the adjustment 
 

SystematicInhomogeneity: plots the systematic inhomogeneity variation of the 

adjustment 
 

RandomThickness: plots the random and systematic thickness variation of the 

adjustment 
 

RandomPackingDensity: plots the random and systematic packing density 

variation of the adjustment 
 

RandomInhomogeneity: plots the random and systematic inhomogeneity 

variation of the adjustment 
 

Spectra: plots the variation in the measurements used in the adjustment 
 

The common plot parameters described above may also be used 
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Table: Prints the design and adjustment table 

 

Show: Forces the only columns named after the Show command to be displayed 

in the report regardless of whether they are displayed on the screen or not. 

 

The following are the names of the columns for use with Show  
 

LayerNumber PackingDensity 
Material RefractiveIndex 
ExtinctionCoefficient OpticalThickness 
PhysicalThickness GeometricThickness 
Locked Link 
VoidMaterial VoidDensity 
InhomogeneityFactor MinimumPhysicalThickness 
MaximumPhysicalThickness MinimumOpticalThickness 
MaximumOpticalThickness SystematicThickness 
SystematicPackingDensity SystematicInhomogeneity 
RandomThickness RandomPackingDensity 
RandomInhomogeneity  

 

For example 
 
%<ReverseEngineer Table Show LayerNumber SystematicThickness 
RandomThickness %> 
 

will cause only the layer number, systematic thickness changes and random 

thickness changes to be printed. 

 

The common table parameters described above may also be used 
 
 

RMSDifference: Prints the RMS Difference 
 

MediumMaterial: Prints the name of the medium material 
 

SubstrateMaterial: Prints the name of the substrate material 
 

SubstrateBulk: Prints the name of the substrate internal transmittance data 
 

SubstrateType: Prints whether the calculations are performed using a parallel substrate 

(“Parallel”) or a wedged substrate (“Wedged”). 
 

SubstrateThickness: Prints the thickness of the substrate. 
 

SubstrateThicknessUnit: Prints the units of substrate thickness 
 

IncidentAngle: Prints the incident angle 
 

IncidentAngleUnit: Prints the incident angle units 
 

Polarization: Prints the polarization state of the measurement. 
 

MagnitudeType: Prints the type of measurement (“Transmittance” or “Reflectance”) 
 

Title: Prints the title of the file. This is the name of the file excluding the path and the 

extension. 
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Filename: Prints the complete filename. 
 

The following instructions can also be used in a Optical Constant report template: 

 

%<SubstrateBulk Parameter%>: Prints Substrate data for the substrate used. Options 

are defined in substrate above 
 

%<SubstrateMaterial Parameter%>: Prints Material data for the material used in the 

substrate. Options are defined in material above 

 

%<MediumMaterial Parameter%>: Prints Material data for the material used as the 

medium. Options are defined in material above 

 

%<Material Parameter%>: Prints Material data for the current material in the 

ForEachMaterial loop. Options are defined in material above 

 

%<ForEachMaterial%>: Begins a loop iterating over each material used in the Reverse 

Engineer 
 

%<NextMaterial%>: Ends the loop iterating over each material 
 

%<ForEachMeasurement%>: Begins a loop iterating over each measurement in the 

Reverse Engineer 
 

%<NextMeasurement%>: Ends the loop iterating over each measurement 

 

Report Scripts 

If you have the Function Enhancement, you can, for supported files, write scripts to 

create plots, tables and text to be included in a report. The report template can contain an 

instruction to call a script and put the result of that script into the report. The general 

syntax of the instruction is: 

 
 %<FileType Script ScriptName EntryPoint ReturnType Parameters%> 

 

 

The FileType names the type of the data file that script will be using. It is one of Material, 

Substrate, Design, Stack, MachineConfiguration, Runsheet. ScriptName is the filename 

containing the script. EntryPoint is the name of the function to call in the script. 

ReturnType is the type of data that will be returned by EntryPoint. ReturnType is one of 

Plot, Table, String. Parameters are any parameters appropriate to the ReturnType. If the 

ReturnType is Plot, then appropriate parameters are any of the common parameters for 

plots (see above). If the ReturnType is Table, then appropriate parameters are any of the 

common parameters for tables (see above). When the ReturnType is String, there are no 

parameters. 

 

When a ScriptName appears for the first time in a report template, the subroutine 

InitializeReport in the script will be called. This subroutine does not have to be defined, 

but if it is defined, its instructions will be performed. These can include performing 
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common calculations, collecting parameters from the user via a dialog, setting up data 

etc. 

 

For an EntryPoint with a ReturnType of Plot, the entry point must be defined as a 

function: 

 
Function EntryPointName As Object 

 

The function must return a PlotCreator object e.g. 

 
Set EntryPointName = myPlotCreator 

 

For an EntryPoint with a ReturnType of Table, the entry point must be defined as a 

function: 

 
Function EntryPoint As Object 

 

The function must return a Table object e.g. 

 
Set EntryPointName = myTable 

 

For an EntryPoint with a ReturnType of String, the entry point must be defined as a 

function: 

 
Function EntryPointName As String 

 

The function must return a string e.g. 

 
EntryPointName = “Hello World” 

 

For more information on scripts and the objects referenced here, please see the Scripting 

Help section of the online Help available in the Help menu of the Essential Macleod. 

Some Examples 

Design Report Template 

This is a simple template that will show the performance of the design followed by its 

structure. 

The report template is: 

 

%<Portrait%> 
%<Font Size 18 Bold Name Arial%> 
%<Design Title%> 
%<Font Size 12 NoBold Name "Times New Roman"%> 
This design is stored in %<Design Filename%> 
 
%<Design Plot Performance NoTitle Width 6 Height 4%> 
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%<Design Layers%> 
 

Sample Output 

 

 
 

Runsheet Report Template 

 
%<Landscape%> 
%<Font Size 18 Bold %> 
%<Runsheet Title%> 
%<Font Size 8.25 NoBold %> 
This Runsheet is stored in %<Runsheet Filename%> 
 
%<Runsheet Table MinFontSize 4 %> 
 
%<Runsheet Plot NoTitle NarrowBand AllChips Width 6 Height 4%> 
%<NewPage%> 
%<Design Title%> 
%<Design Plot Performance NoTitle Width 6 Height 4%> 
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%<Design Layers%> 
 

Sample Output 

This template results in a multi-page output: 
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vSTACK 
vStack is the tool that calculates the properties of assemblies of coatings and substrates 

where the substrates are not necessarily parallel-sided. The system of elements is known 

as a vStack and it consists of a series of Surfaces. Each surface may be uncoated or it 

may carry one optical coating. When there is only one surface then the system will appear 

exactly as a single coating on an infinite substrate but usually there will be a number of 

surfaces with associated coatings. vStack assumes that all beam directions and surface 

normals are coplanar. 

The calculations performed by vStack apply to the path of a single beam through the 

assembly. This is in contrast to the Stack system where multiple reflections may be taken 

into account. The path of the beam is defined by the list of surfaces. The terms incident 

and emergent can be confusing since the surfaces may operate in transmission or 

reflection and the beams may not emerge in what has been called the emergent medium. 

We therefore use the terms front material and back material to refer to the two media on 

either side of each surface. The light is incident in the front material. 

The transfer mode of a surface defines how the beam it is treated at the surface. There 

are eight transfer modes: Transmit, Reflect, Perfect Reflect, Rotate 0, Rotate 90, Rotate 

180, Rotate –90, and Perfect Retro. Transmit and Reflect both calculate the effect of the 

front and back surfaces and the coating (f any) on the beam. For a surface that has 

transfer mode equal to Transmit the transmitted beam is taken and the reflected beam is 

discarded. The transmitted beam exits the surface in the back material. For a surface that 

has transfer mode equal to Reflect, the reflected beam is taken and the transmitted beam 

is discarded. The reflected beam exits the surface in the front material. The exit material 

for the beam depends on the transfer mode. The Perfect Reflect transfer mode behaves as 

a perfect reflector – 100% of the incident beam is reflected. Perfect Reflect does not 

require any front/back material definitions - the definitions from the surrounding surfaces 

are used. The Perfect Retro transfer mode behaves as a perfect retro-reflector – 100% of 

the incident beam is reflected back along the same path on which the beam entered the 

retro-reflector.. Perfect Retro does not require any front/back material definitions - the 

definitions from the surrounding surfaces are used.  

The Rotate transfer modes rotate the beam about its axis. The convention for the 

rotation is that looking along the direction of the beam a positive rotation is counter-

clockwise. Rotate 0 has no effect on the beam and is included to make easy to turn beam 

rotation off without removing a surface. Rotate 90 rotates the beam 90 degrees counter-

clockwise. The output p-polarization component is the input s-polarization component. 

The output s-polarization component is the negative of the input p-polarization 

component. Rotate 180 rotates the beam 180 degrees. The output p-polarization 

component is the negative of the input p-polarization component. The output s-

polarization component is the negative of the input s-polarization component. Rotate –90 

rotates the beam 270 degrees (or 90 degrees clockwise).  The output p-polarization 

component is the negative of the input s-polarization component. The output s-

polarization component is the input p-polarization component. The Rotate transfer modes 

do not require any front/back material definitions – the definitions from the surrounding 

surfaces are used. 
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The light enters the assembly in the front material of the first surface in the list. The 

beam exits the assembly through either the front or back material of the last surface 

depending upon the transfer mode of the last surface. 

As substrates are now not necessarily parallel-sided, there has to be a method of 

specifying the angular relationship between surfaces and the various beam directions. We 

therefore set up a global reference direction that does not vary throughout the entire 

system. All directions are then specified with respect to this reference direction. 

Surface

Front
material

Surface
normal

Beam
angle

Global
reference
direction

Incident
beam

Global
reference
direction

Incident
beam

Surface
normal

Surface
angleSurface

Back
material

Incident
side of
surface

 

This figure shows the various directions associated with a single surface. First of all 

we have a global reference direction that applies to the entire system and does not change 

from one surface to another. Each individual surface has a surface normal directed into 

the surface from the front material and out of the surface into the back material, following 

the same convention as the z-axis for a coating on a single surface. Finally there is the 

direction of the incident beam. The surface angle specifies the angle that the surface 

normal makes with the reference direction. Imagine that the surface normal is first placed 

in coincidence with the reference direction so that the directions are identical. Now let the 

surface normal be rotated into its correct orientation. The angle of rotation is the surface 

angle. It is positive if the rotation is counterclockwise and negative if clockwise - the 

normal sign convention for angles. The beam angle is determined similarly. The beam is 

imagined coincident with the reference direction and then is rotated to the correct 

position. The angle of rotation, following the same sign convention, is the beam angle. In 

the diagram the surface angle shown is positive and the beam angle negative. 

With the reference direction constant, this procedure is then repeated for each 

subsequent surface in the vStack. 

Note that the user need specify a beam angle only for the original direction of the light 

in the front material in the first surface of the vStack. This material is the incident 

medium for the entire system. The program takes care of all subsequent beam angles. An 

output parameter calculated and presented by the program is the beam angle in the final 

output medium. 

vStack can operate with either a distance between surfaces specified in the Beam 

Distance column or with an unspecified distance between surfaces (Beam Distance left 

blank). When a Beam Distance is specified, the distance is from the surface on the 
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current row to the surface on the next row in the direction of the beam. Where the 

distance between surfaces is unspecified, vStack does not take into account any 

absorption in material between the surfaces. Where the distance between surfaces is 

specified, vStack will calculate the absorption in the material and include it in the 

performance results. It uses the real refractive indices at the appropriate wavelength and 

Snell’s Law to calculate the beam direction. For unspecified Beam Distances, vStack also 

assumes that the path of the beam is geometrically valid – that is the path of the beam 

described is the actual path taken for the range of input beam angles used. Where Beam 

Distances have been specified, vStack will check for geometric validity. A graphical tool, 

described later, is supplied to help the user verify the specification of the vStack.  

Absorption in a coating is included in the calculations using the extinction coefficients 

of the films in the normal way, and any extinction coefficient of the back material will be 

automatically included when calculating the performance of the coatings. Thus an 

internally reflecting prism surface that is coated with opaque aluminum will be correctly 

modeled if the surface is considered uncoated with a back material of aluminum and a 

transfer mode of “Reflect.” It will not be correctly modeled if the transfer mode is 

changed to “Transmit.” In that case the aluminum will need to be included in the surface 

coating and the back material changed to “Air.” 

A coated surface is specified by giving the filename of a coating and providing a 

coating direction. Coating direction may be either forward or reverse. A forward coating 

direction specifies that the layer next to the medium in the design is next to the front 

material of the surface. A reverse direction specifies that the layer next to the medium in 

the design is next to the back material of the surface. For refinement control a coating 

may also be specified as locked. This prevents refinement from altering the coating. 

A vStack system may contain both reflecting and transmitting elements. Also there is 

only a single path through the system. This means the performance terms Transmittance 

and Reflectance become confusing, so vStack calculates Throughput which is defined as 

the ratio of the intensity of the beam exiting the vStack system to the intensity of the 

beam entering the vStack system. vStack also calculates the ellipsometric parameters for 

the system, Psi and Delta. 

While the beam is confined to the plane of the instrument there is no mixing of the 

initially p- and s-polarized light. Each could be followed through the system completely 

separately. For Transmit, Reflect and Perfect Reflect surfaces, all p-polarized light 

entering the surface leaves the surface p-polarized and all s-polarized light entering the 

surface leaves the surface p-polarized. For rotator surfaces, all p-polarized light is 

converted into s-polarized light (for 90 and –90) and all s-polarized light is converted in 

to p-polarized light (for 90 and –90) When the beam direction is tilted out of the plane of 

the instrument this is no longer true. The plane of incidence is then rotated with respect to 

the plane of the instrument and there is now a mixing of the two principal polarizations. 

Some light that was originally s-polarized emerges finally from the system as p-polarized 

and some p-polarized light becomes s-polarized. We call this polarization leakage. The 

angle of tilt of the beam out of the plane of the instrument we call the skew angle and the 

sense is such that the rotation vector for a positive angle is along the positive p-direction. 

For a small skew angle the magnitude of the leakage is proportional to the square of the 

skew angle and so we define a polarization leakage coefficient with units of magnitude 

per unit skew angle2, for example %/deg2. The leakage coefficients can be either from p- 
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to s-polarization or vice versa. These coefficients are not necessarily equal. There is a 

constant phase relationship between the orthogonally polarized primary and leakage light 

and so we define also an appropriate Delta value. VStack will also calculate the total 

phase change contribution of all the coatings in the model. This does not include any 

phase effects caused by the substrates. Although this phase calculation is incomplete for 

the modeled system, it does provide information about the contribution of the coatings to 

wavefront distortion. 

The complete set of parameters is then: 

Throughput 

Psi 

Delta 

p-s Leakage Coefficient 

s-p Leakage Coefficient 

p-s Delta 

s-p Delta 

Phase 

Psi is defined as: 

arctan (
√𝑝 − 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 𝑚𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒

√𝑠 − 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 𝑚𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒
) 

Delta is defined as: 

(𝑝 − 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 𝑝ℎ𝑎𝑠𝑒) − (𝑠 − 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑡𝑝𝑢𝑡 𝑝ℎ𝑎𝑠𝑒) 

For reflecting surfaces, the ellipsometric convention is used. That is, at normal 

incidence, the Delta of a reflecting surface is 180 degrees. The absolute phase of the 

throughput polarizations is not available. 

p-s Leakage is the proportion, for unit skew angle, of light exiting the vStack with s-

polarization that entered the vStack with p-polarization. 

s-p Leakage is the proportion, for unit skew angle, of light exiting the vStack with s-

polarization that entered the vStack with s-polarization. 

p-s Delta is defined as: 

(𝑝 − 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 𝑝ℎ𝑎𝑠𝑒) − (𝑝 − 𝑠 𝑙𝑒𝑎𝑘𝑎𝑔𝑒 𝑝ℎ𝑎𝑠𝑒) 

 

s-p Delta is defined as: 

(𝑠 − 𝑝 𝑙𝑒𝑎𝑘𝑎𝑔𝑒 𝑝ℎ𝑎𝑠𝑒) − (𝑠 𝑡ℎ𝑟𝑜𝑢𝑔ℎ𝑝𝑢𝑡 𝑝ℎ𝑎𝑠𝑒) 

 

Example 1: A Single Substrate Coated Both Sides 
 This example models a parallel sided glass substrate that has been coated on both 

sides with a 1 layer anti-reflection coating. This system can also be modeled by Stack for 

comparison of result. When modeling with Stack, be sure to set the medium to wedged to 

eliminate multiple reflections. 
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In vStack, this system is modeled with two surfaces. The first surface represents the 

beam entering the glass substrate through the coating and the second surface represents 

the beam exiting the glass though the second coating. The diagram above also shows the 

chosen reference direction for specifying the surface angles and the beam angle. The 

vStack shown below models this system. 

 
 

The first line of Example 1 represents the first interface that the beam passes through. 

The beam is initially in the front material – Air, then passes through the coating “one 

layer ar.dds” and then into the back material – Glass. The second line represents the 

second interface that the beam passes through. This time the front material is Glass. This 

is the material that already contains the beam from the first surface and so should match 

the back material of the first surface. On transition through the interface, the beam exits 

in Air. The coating on the second surface has a direction of reverse because the layer next 

to the medium in the design “one layer ar.dds” should be next to the Air. Click Draw 

Layout in the Tools menu and the following layout is drawn. 
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The black circle indicates the starting point of the light beam. The red lines show the 

interfaces. The small red line perpendicular to the large red line defines the front side of 

the interface. Solid black lines indicate unspecified beam distances and dashed black 

lines indicate specified beam distances. The lengths in the diagram will be proportional to 

the actual beam distances. 

 The throughput of this system is shown below. 

 
 

For a beam angle of zero, there is no polarization sensitivity and all curves follow the 

same path. The next plot shows the throughput of the system at 510 nm as the beam angle 

is varied from –30 to +30 degrees. As the surfaces of the system are parallel, there is no 

difference in performance between positive and negative beam angles. 
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Example 2: A Single Reflecting Substrate 
 This example models a single reflecting surface. This system can also be modeled by 

the design editor for comparison of results.  

Air

Aluminum

Coating

Reference Direction

Beam

Surface normal  
 

In this case, we are only interested in the reflected signal from the first surface, so 

only one surface is needed to model this system. 

 
 

The curve below shows the performance of this overcoated aluminum reflector. 
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In this case, the throughput is describing the reflection performance of the system at 

normal incidence. 

Example 3: Total Internal Reflection in an Uncoated 
Prism 

This example calculates the single beam performance of a right-angle prism. The 

layout is shown below. 

 

Air

Reference Direction

Beam

Surface normal

Surface normals

Glass

 
 

This is modeled as shown below. 
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If the beam is to enter the prism normal to the first surface, then the beam angle must 

be set to the same value as the surface angle - -45 degrees (or 315 degrees). The 

throughput of this system is the same as the throughput through a parallel-sided sheet of 

glass.  Using the Draw Layout command with a Beam Angle of –45 gives the following 

diagram. 

 
 

A more interesting case is to examine the throughput as the beam angle is varied. The 

plot below shows the variation of throughput as the beam is varied +/-45 degrees about 

the normal to the first surface. This corresponds to a beam angle range of –90 to 0 

degrees, with –90 representing a beam flowing vertically down through the first interface 

and 0 representing a horizontal beam flowing into the first interface.  The plot shows the 

throughput of the initial beam angles (starting at –90) at very low values. This happens 

because the beam strikes the second surface below the critical angle and so most of the 

energy is actually transmitted through the interface and only a small quantity is reflected. 

As the beam angle increases, the angle of the beam striking the second surface moves 

beyond the critical angle, and the second surface reflects the beam. 
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As the beam angle increases still further, the second surface still provides total 

internal reflection, but the increasing incident angle at the first and third surfaces causes 

the s- and p-polarizations to deviate from the mean throughput. 

Note that the beam always passes through the three surfaces in the model whereas in a 

real system it may not. For example if the beam always entered the prism at the point 

shown in the layout diagram above, a beam with angle –90 degrees would enter the prism 

and the reflected energy would actually exit through the first surface and not the third. 

The throughput of this beam can be modeled by setting the surface angle of the third 

surface to be 135 degrees (180 degrees away from the first surface because the beam is 

travelling from glass to air) 

Refinement and Synthesis 
Refinement options are described in detail in the Refinement and Synthesis chapter of 

this manual.  For vStack refinement, however, there are some additional conventions that 

are described here. 

The refinement menu is found under Parameters. Tools exist for entering targets, 

adjusting refinement parameters and performing refinement.  These menus are similar to 

those provided for refinement of single coatings.  The Coating Locked column in the 

vStack window specifies that a particular coating in the vStack will not take part in the 

refinement.  Only coatings with a Coating Locked value of No will take part in 

refinement.  

Coatings are implicitly linked by name in a vStack.  If the same coating design file is 

used on more than one surface in a vStack, then refinement will adjust a single copy of 

the design and apply it to all surfaces using the same design name.  If you want to allow 

refinement to treat all coating designs separately, but want to have the same starting 

point, then the design must be copied to new files, one for each surface that is to have the 

same starting point. 

vStacks additionally support Co-Refinement. Co-Refinement is the capability of 

simultaneous refinement of more than one vStack. A vStack models the path of a single 

beam through a system. If a beamsplitter is being modeled, then two vStacks are 

required. One vStack will model the transmitted path and the other will model the 
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reflected path. Without co-refinement, the beamsplitter coating cannot be refined in a 

single vStack because only the transmitted beam or the reflected beam can be defined. 

With co-refinement the filename of the transmitted beam model is given in the reflected 

beam vStack. Whenever the reflected beam vStack is refined, the transmitted beam 

vStack will also be refined. Co-refined vStacks are only loaded from the main vStack. If 

a vStack in the co-refinement list also has vStacks listed in its co-refinement list, these 

vStacks will NOT be co-refined. 

The co-refinement list is displayed and edited by clicking Co-refinement in the 

Refinement sub-menu of the Parameters menu of the vStack. The following dialog is 

displayed: 

 
 

To add a vStack to the list, click Add. A file chooser will be displayed. Select the file 

to be added and click Open. To remove a file from the list, select the file in the list and 

click Delete. Clicking OK will update the vStack with the changes. Clicking Cancel will 

close the dialog and discard any changes. 

vStack Menu 

This menu is obtained when the vStack window is active. We illustrate its use with an 

example. 

If in the New... dialog box from the File menu we select vStack and click OK it brings 

up a new vStack window. It may be necessary to drag the right-hand boundary to reveal 

all of the columns. 

 
 

The first four columns apply to the media of the vStack. The final three columns are 

concerned with the coatings. Since this is a new vStack, it is very simple and consists of a 
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single interface. There are no coatings. We will construct the chevron filter that is 

developed in the Function chapter, but we will use vStack to calculate its properties. An 

11-layer Zr02/SiO2 quarterwave multilayer at a reference wavelength of 300nm and a 

match angle of 45 degrees is used to provide the basic reflector. This filter is used on the 

four surfaces of the filter as shown below 

Air

Reference Direction

Beam

Glass

Coating

 
 

We first create the reflector coating as below: 

 
 

This coating is then saved in the file “chevron coating”. 

In vStack we will now create the four surfaces and apply the coating to the four 

surfaces. Click the new vStack window. The first row already has the glass and air 
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materials correctly set up. The coating for the first surface is added to the interface by 

double-clicking in the Coating File. This will cause a file chooser to be displayed. Select 

the chevron coating file. You can either double-click the file name or click Open to add 

the coating file to the vStack. There are two ways that the coating can be applied to the 

surface. The layer next to the medium in the design can go next to the front material of 

the surface or it can go next to the back material. These two possible orientations are 

controlled by the value in the Coating Direction column. When the direction is set to 

Forward, the layer next to the medium in the design is next to the Front Material in the 

vStack. When the direction is set to Reverse, the layer next to the medium in the design is 

next to the Back Material in the vStack.  

The angle of the first surface now needs to be defined. Referring to the layout diagram 

above, the surface angle (the angle of the normal to the surface) of the first surface is –45 

degrees (or 315 degrees) relative to the reference direction. Enter the value into the 

Surface Angle column. 

When the light beam strikes the surface, there are two resultant beams – the 

transmitted beam and the reflected beam. The beam that we wish to use is the reflected 

beam. Click in the Transfer Mode cell until Reflect is visible. This instructs vStack to 

take the reflected beam from this interface.  

The first interface of the chevron filter should look like the figure below 

 
 

To complete the chevron filter, we need to add the three remaining interfaces. With 

the Essential Macleod in insert mode (the panel at the bottom of the Essential Macleod 

window shows the value Insert), press <Enter> repeatedly until a new line is created in 

the vStack window. This line can be edited in the same way as the first line. The only 

difference is the change in the surface angle. For the second interface, the surface angle is 

135 degrees as can be seen from the layout diagram above. The third and fourth 

interfaces are entered in the same manner. The completed chevron filter should look like 

the figure below 
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We check that the vStack has been correctly defined by using the Draw Layout 

command. Click the Tools menu and select Draw Layout. 

 
 

The light beam starts at the black circle. A red line represents each interface. A small 

red line perpendicular to the large red line defines the front surface of the interface. 

Comparing the layout to the picture at the start of this section, we can see that the filter 

has been correctly defined in vStack. 

If the Auto Draw Layout command in the Tools menu is checked, then the layout will 

be updated after each change to the vStack. 

The incident and emergent angles of the beam on each of the coatings can also be 

displayed. From the File menu, select Display Setup >. A sub-menu will appear. Select 

Beam Angle Data and click Close. This will cause three columns to be added to the 

vStack window. These columns show the beam angle of the light exiting the surface, as 

well as the incident and emergent angles of the beam with respect to the normal to the 

surface. 

 
 

Now we set the performance parameters by selecting Performance... from the 

Parameters menu. 
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The vStack Performance Parameters dialog box is similar to others in the package. 

Once the parameters are considered satisfactory, the plot and/or table can be calculated. 

Selecting Plot in the Performance menu gives the following graph. This is the 

transmission (throughput) of the chevron filter. 

The vStack and its performance can be saved in the normal way. 

 
 

 

The impact of errors on the performance of a vStack can be assessed in a similar way to 

that of a Design. vStack has its own set of errors independent from those attached to a 

Design. The errors are specified as statistical parameters to be applied to the layers in the 

Designs used by vStack. Where a Design is used more than once in a vStack, the same 

perturbed Design will be used at each surface in the vStack, that is, the errors will be 

100% correlated for each Design appearing more than once in the vStack. (To consider 

the zero correlation case, create a copy of the Design for each time it appears in the 

vStack and change the designs in vStack so that each surface has its own separate copy of 

the Design.) 

 

The plot below shows the results of 1% standard deviation errors applied to ZrO2 and 2% 

standard deviation errors applied to SiO2 for the chevron filter. 
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FUNCTION 
The Function Enhancement adds the potential to carry out a virtually unlimited range 

of extra calculations. Coatings may be used under special conditions of illumination. 

Thermal emittance or absorptance may be needed. Performance may be required of 

combinations of coated components with differing angles of incidence, where some are 

transmitting and some reflecting, and where source or receiver may have a particular 

spectral variation. The core tools can provide the performance data needed for such 

calculations, but performing them can be tedious and clumsy in contrast with the 

simplicity of carrying out the basic performance assessments. Function is designed to 

performs such calculations. It has two separate features. Operations use a simple macro 

language for rapid, straightforward manipulations that take table files and reference files 

as input. Scripts use a powerful version of BASIC that can define most of the entities in 

the Essential Macleod as objects. Operations are quicker and easier to write but are more 

limited in their capabilities than scripts. 

In appearance and operation, Function is similar to the rest of the package You can 

check whether or not the Function Enhancement is present by starting the Essential 

Macleod and selecting About The Essential Macleod… in the Help menu. The 

information box that appears should list Function against the Options. If, however, you 

have just received the Function Enhancement as an upgrade to an existing installation 

then you will need to obtain a new Site Key. 

Scripts 
A script can be called whenever a document that supports a script is open and active 

or when the application window is empty. Scripts are called through the Script Manager, 

opened by clicking Scripts in the Tools menu. The Script Manager shows the available 

scripts and a series of options permitting running, editing or creating new scripts, and 

manipulating the list. Most scripts supplied with the Essential Macleod also have help 

files in pdf format that describe their function and use. The Help button accesses them, 

provided a pdf reader is present. Frequently used scripts can be given their own menu 

entry in the Tools menu. See the Scripts topic in the help for more information. The 

scripting language is fully described in the Scripting Language User Guide. This is 

accessible through the item Essential Macleod Help in the Macleod folder in the Start 

Menu, or through Scripting Help in the Help menu whenever a script is open for editing. 

The help for scripts is in the Scripting Language book at the bottom of the contents list. 

The remainder of this chapter deals with Operations. 

Function Menu 
The screen layout is exactly similar to that of the Essential Macleod. Apart from 

Scripts in the Tools menu, the only immediately visible differences when the 

Application window is active are in the File menu where there is an additional item Open 

Function. The menu item New... in the File menu has, in fact, also changed with the 

addition of Operation as one of the choices. We deal with the Options menu first. 
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Options Menu (Application) 

General 

The General option has already been described in connection with the Core Program 

but some mention is necessary in connection with Function. Function operates on the 

basis of instructions that frequently include reference data. A set of instructions is known 

as an Operation and is stored in an Operation file. Reference data are stored in Reference 

files. The folder where these Operation and Reference files are stored is known as the 

Reference Folder. Since the files are identifiable by their extensions, any folder is capable 

of serving as the reference folder. We suggest however, that a separate standard folder be 

maintained containing a complete set of reference and operation files.  Those necessary 

for a project may then be copied into the local project database that may also contain 

materials, substrates, designs and other data files and that may then be declared as the 

reference folder. This will insulate the standard folder from any local changes. As always, 

a small amount of effort on the part of the user in maintaining order will pay off 

handsomely. 

Note that the color functions in the Core Program require the existence in the current 

reference folder of a number of color reference files. These must also be present in the 

reference folder should it be different from the standard one. 

The usual folder will be …\References\ and this will have been automatically created 

and supplied with some standard files during installation. If Function has just been 

installed as an upgrade then the new references and operations supplied with it will have 

been installed in a separate reference folder usually with the name …\References0\. This 

new folder will contain also the necessary standard color files - although any local 

changes made by the user will not be included. 

The reference folder is specified in the General Options dialog box by entering it in 

the appropriate field.  

 
 

Reference files are exactly what their name suggests. They contain data that is 

necessary for the calculations that will be carried out. Since their data is of a more or less 

permanent nature, they are called reference files. Typical reference files contain the 
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tristimulus functions, the spectral variation of standard illuminants, and so on. They can 

be examined and edited, but this should not be done casually. 

Operation files contain instructions for performing calculations. They consist of a set 

of functions that are specified in a form that will be described, along with a list of 

reference files and other constants that will be used, and a list of the data that will be 

manipulated. To perform an operation, its instruction file must be loaded and then 

executed. A number of useful operations is provided with the enhancement and some of 

these will be described in greater detail shortly. 

Open Function... 

Open Function in the File menu permits the selection either of operation files or of 

reference files according to the List Files of Type drop down menu. The extensions that 

apply are .opn and .ref respectively. 

Note that this is the only way of loading a reference file for examination or plotting or 

for editing. Reference files are by their very nature to be preserved and so their 

manipulation is deliberately made less convenient than other files. 

 
 

An Example: Chevron Filter 
When an image is not necessary, a useful type of filter particularly in the ultraviolet 

part of the spectrum is based on a chevron arrangement. The overall filter works in 

transmission but its mode of operation consists of four successive reflections at 45. The 

filter is shown schematically in the figure below. 
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Filter coating

Substrate

 
 

The substrates are opaque so that the product of the four reflections gives the 

performance of the device. 

The Core Essential Macleod does not handle this type of calculation. We now show 

how readily it may be performed by Function. 

We will calculate the overall performance of the filter and then make a further 

calculation of the spectral variation of the output of the filter when illuminated by a 

source with given spectral characteristics. For simplicity, we will assume a D65 source, 

which represents daylight in the middle of the day. 

First we design the filter. This is an 11-layer quarterwave stack centered at 300nm 

corrected by Match Angle for 45, and constructed from silica and zirconia on a substrate 

of glass. The glass can be chosen to be sufficiently absorbing across the ultraviolet, 

visible and near infrared or the individual components can consist of slices of glass with 

blackened rear surface arranged back-to-back. The successive reflections are at 45 and 

so polarization must be taken into account in the calculations although we shall assume 

unpolarized light from the source. The filter and its performance are shown next. The 

results for s- and p-reflectance are calculated at 45 from 200 to 1000nm at intervals of 

10nm and the table is saved under the arbitrary name a.tbl. 
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The D65 illuminant curve is shown next. This is stored in table ILLUMD65.ref and 

the values are given every 5nm. 
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Now to calculate the performance of the filter we must find the product of four such 

mirrors. We must derive the results for s- and p-polarizations separately and then, for 

unpolarized light, calculate the mean. 

The results are in percentage and if we want to have the final figures also in percent 

then we multiply the characteristics together but we must also correct by multiplying the 

product by 0.000001. The calculation can be written as: 

 

𝑇𝑝 = 0.000001 × 𝑅𝑝
4 

   

with a similar one for Ts. Then the results should be combined as 

 

𝑇 = 0.5 × (𝑇𝑝 + 𝑇𝑠) 

   

Then, when we have finally calculated T we can multiply it by the relative output of the 

source to give the final characteristic of the filter. 

In each of these expressions the quantities are functions of wavelength and so we have to 

repeat each of the operations for each wavelength point. 

Next we multiply each of the final transmittance values by the spectral output of the 

source at the appropriate wavelength. This can be written as 

 

𝑅𝜆 = 𝐶 × 𝑆𝜆 × 𝑇𝜆 

   

where C is a constant that normalizes the result. We shall assume 0.01 for C. Since the 

D65 illuminant curve and the filter are both functions of wavelength, for every 

calculation corresponding to equation  each of the quantities must be referred to the same 

wavelength. 

An Operation consists of one or more Functions. Each Function is an expression like 

the equations above but the quantities in the Function are assumed to be arrays rather 



Function   325 

than simple variables. Further, so that multiplications and other similar operations can be 

carried out correctly, the arrays are first interpolated, completely automatically, so that 

the wavelength values are identical. 

Setting Up the Operation 

We first open the New submenu under File and choose Operation. A new Operation 

form opens. Since this is a new operation all entry screens are blank. This first one, 

shown here, is the description screen that will contain a description of the operation. The 

other screens for entry can be selected by clicking on the appropriate tab. We first type in 

a description of the operation for future reference. This can be quite long if necessary. 

 
 

Now select the Operations tab to pass to the entry of the Operation. A blank table appears 

with three empty columns and rows labeled M1 to M9. These should be completed as 

follows. 

 

Name Heading 
Independent 
Variable In 

Value 

M1 Tp F0 C1*(F0^C2) 

M2 Ts F0 C1*(F1^C2) 

M3 Tmean F0 C3*(M1+M2) 

M4 Rel Output F0 C4*(R0*M3) 

M5  F0 #M1#M2#M3#M4 

 

F0 and F1 up to F9 indicate columns in data files. In this particular case, F0 is the p-

reflectance of the basic filter at 45. F1 is the s-reflectance of the same coating. C1, C2 up 

to C9 indicate constants. Here C1 is 0.000001, C2 is 4, C3 is 0.5 and C4 is 0.01. R0 to R9 

indicate reference files and here R0 is the reference file containing the D65 light source 

data. The first function is labeled M1 and calculates the p-transmittance of the overall 

filter by taking the result F0, that is the p-reflectance of the single coating and raising it to 

the power C2, that is 4. The result is then corrected so that it is in percent by multiplying 

by C1, that is 0.000001. Although there is only one result at each wavelength point, 

nevertheless we have to state the definitive source of the wavelength values to be used for 

the calculations and that is given as the same file, F0. Although F0 indicates the p-

reflectance column, when it is entered into the Independent Variable In column it is 

taken to mean the independent variable in the same file from which F0 is taken. The 

independent variable is always in column 1. The next function, labeled M2 repeats the 

calculation but for s-polarization. In the third function the symbols M1 and M2 indicate 

the results of the first and second function respectively. Their sum is multiplied by C3, 
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that is 0.5, to find the mean. The mean transmittance, in M3, is then multiplied by the 

source spectral output given by R0 and normalized by further multiplying by C4, or 0.01. 

Then function M5 simply means consolidate the results in functions M1 to M4 in one 

single table of results. To do this all results and the table should have the same 

independent variable and this is satisfied because all have F0 as the definitive table of 

wavelengths. The appearance of the table at this stage is shown in the figure. 

 
 

Now we need to put in the constants. Select the Constants tab and complete the table 

of constants as shown in the next figure. Note that we are omitting C0 as a designation 

for a constant. C0 has a special meaning. It is a constant that is entered at run time and 

the cell labeled value should actually be completed with the string that will be displayed 

when entry of the constant is invited. 

 
 

The reference file R1 is next. Select the References table by clicking on the tab. To 

select the file for R1 simply double-click in the cell next to R1 and a selection box will 

appear. illumd65.ref is the correct file here. 

 

Finally select Bindings so that the files F0 and F1 can be specified. They are actually 

columns in the same table. The Default Column can be used as a prompt to remind you of 

the particular variable that is represented by F0 and F1. If the entry coincides with the 

heading of one of the table columns, then that column will automatically be identified for 
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confirmation. Clicking in the Filename cell brings up the usual selection box and clicking 

in the column cell permits choice of column in the same way as when plotting from a 

table. The appropriate table in this case is a.tbl with columns 2 and 4 as shown. 

The assignments that have now been made will be preserved when the Operation is 

saved but they can also be changed by the user at will. 

 
 

Finally we want to run the Operation. Execute is the appropriate menu and the 

command Run. 

The table that appears is shown next. We save it under the name Results.tbl and we 

are ready to plot the curves in the usual way. 
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The filter response curve is as follows 

 
 

And the filter relative output 

 
 

This is badly affected by the abrupt drop in output from the D65 illuminant at 300nm so 

the response curve is rather narrow compared with the filter response. Also the source 

peak emphasizes the minor leaks at 400nm, 500nm and 700nm that can just be seen in the 

plot. A simple redesign of the original filter to reduce the long wavelength ripple would 

take care of this problem. The advantage of having the Operation established is that a 

return to the design for some refinement could be followed by the calculation of a fresh 

table, saved under the same name as before. Then the Operation can be re-executed with 

no further changes. 

Note the usefulness of the ability to define the independent variable scale. For 

example, to calculate the ratios of the total in-band and out-of-band powers in the filter 

output we first set up two data files with the appropriate scales. We can do this by taking 

the results file and deleting all wavelengths outside the band, and then saving it as a new 

file, inband.tbl, say. We have to make a decision on what we mean by in-band and the 

results will be quite a sensitive function of this choice. Here we take the entire band of 

the filter between the first minima on either side, the range 250nm to 370nm inclusive. 
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We then define F0 as the complete performance of the filter in Column 5 of results.tbl, 

Rel Output in the table of results, and we define F1 as the new file with only the in-band 

wavelengths. Next we need three functions. 

 

Name Heading 
Independent 
Variable In 

Value 

M1 Ttotal F0 OI:F0 

M2 Tinband F1 OI:F0 

M3 Ratio  (M1-M2)/M2 

 

OI: is an operator that means integral. Since it has only one argument it is known as a 

unary operator. Here in the first function M1, it operates on F0 and integrates it over the 

range of variable given in the independent variable column of the same file. The second 

function looks similar and it is except that the range of the independent variable for the 

integration is now F1, the file defining the in-band power. Next we subtract the in-band 

power from the total and take the ratio with the in-band power to give the final result. 

(We must do it this way because we cannot integrate over two noncontiguous regions in 

one operation, which we would need to do to get the out-of-band power directly). 

There are different ways of defining stray light. There might be a fixed wavelength 

interval in a specification and we might be attempting to design a filter system to meet 

that specification. Then we can set up a file that lists the specified in-band wavelengths 

instead of taking them from the filter curve we have just derived. 

More about Operations 
We look further at the Function tab of the Operation. 

The first column is the Name of the function. There are nine possible functions and 

their names are always of the form M* where * indicates an integer from 1 to 9 inclusive. 

The functions are always evaluated in the order M1 to M9. There can be up to nine 

functions in an operation. 

The second column is the Heading. In this set of functions some of the headings are 

blank. Functions that have blank headings are evaluated only for the purposes of 

subsequent calculations but the results are not preserved after the operation is completed.  

The Heading is also the label that will be attached to the results that are preserved. 

Independent Variable In is the next column. The functions represent manipulations 

that are to be performed on tables of values rather than individual numbers. An 

expression like A*B, for example, would mean the product of the values entered in two 

different tables. If we visualize A and B as two columns of data in cells then the formula 

means that in each row the value in the cell in column A would be multiplied by the value 

in the cell in column B. The cell values will normally be functions of the same 

independent variable, and the values that are being multiplied together must refer to the 

same independent variable values otherwise nonsense will result. In many thin film (and 

other) calculations that have to be dealt with by Function, the existing values may not 

always correspond to identical values of independent variable. Imagine a response curve 

that is given every 3nm over the range 300 to 700nm and that this response curve must be 

multiplied by a source output curve that is given every 5nm over the same range. Clearly 
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one set of values cannot be simply multiplied by the other. First one set must be 

interpolated to fit exactly with the intervals of the second. Function does this completely 

automatically. All that is required is that the definitive set of independent variables must 

be defined and this is the purpose of the Independent Variable In column. The entry in 

the column will be either F* or R* where * indicates a single digit and F* indicates the 

independent variables in a table file and R* in a reference file. These files will be further 

defined in either References or Bindings. 

The final column in this screen is the Value of each function. Each entry is in the form 

of an expression that must be evaluated to yield the Value. These expressions involve a 

number of entities that we will describe shortly but each function may be thought of as a 

simple statement in a computer program. An example might be 

Row M1      OI:(R1*R2*F1) 

Translated, this means that the result, designated by M1, is equal to the integral over 

the range of the appropriate independent variable of the product of the data in reference 

file R1, that in reference file R2 and that in data file F1. F* always indicates a data file, R* 

a reference file and C* a constant. 

Note that there is no hierarchy in the operators. The order should be determined by 

brackets and there is virtually no limit to the nesting that can be accommodated. 

Constants are defined by setting the numbers against C1 to C9 under Constants. One 

constant, however, is a little different. C0 is by convention reserved for a constant that 

will be set when the operation is executed. The entry that is to be made against it in the 

table will be in the form of a text string that will be used as a prompt for a value to be 

inserted. The operation for construction of a black body curve, makebb.opn, is an 

example of the use of a constant entered at execution time - in that case the black body 

temperature. 

The reference files are listed under References. 

Finally Bindings shows the particular data files that are to be used. To identify the 

data that are to be used in the various calculations, both a file and a column within the file 

must be identified for each entry in the Bindings table. This can be done either before 

starting execution by filling in the blanks in the table or by answering prompts once 

execution begins. If the latter course is selected then the prompts will use the text in the 

Default Column together with the appropriate F* to help identify the file. Once the file is 

identified and loaded, if one of the column headings matches the Default Column text 

then that column will be highlighted for selection. Clicking in the Column cell is one 

way of choosing the table column to be used. The other is to execute the operation by 

choosing Run... (or pressing F5) from the Execute menu. 

Once the calculations begin the progress is shown in a new window. Usually these 

will appear so quickly that there will be no time to follow them. This is not a problem. 

The rapid movement of the information shows that calculations are proceeding. Should 

the operation hang at some point then the halted display will give a good indication of the 

point where trouble occurred. For trouble-shooting of the results a Single Step command 

is provided. This will step through the instructions one by one giving also the opportunity 

to examine intermediate results. 

In the calculation the function expressions F1, F2, R1, R2… are replaced by symbols 

A1, A2, A3… These indicate arrays in which the values have been appropriately 
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interpolated. The various stages of the calculations are taken in turn with some of the 

arrays receiving the intermediate results while the others are discarded. Only if the values 

are constant will the A be replaced by a C. Note that the integer parts of the array and 

constant names are not necessarily related to those in the original expressions. They are 

chosen simply in order of creation. 

Writing an Operation 
Writing an operation is fairly straightforward. Each operation consists of a series of 

functions, up to nine in number, that manipulate data files, reference files and constants. 

Each function consists of an expression that represents the particular calculation it has to 

perform. The function is identified by a name of the form M*, where * is a digit, and 

possibly by a heading. A heading indicates that the results are sufficiently important to 

deserve saving at the end of the operation. The absence of a heading indicates that the 

results are to be considered intermediate only. 

The parameters of the mathematical expression consist of arrays of data, operators, 

constants and brackets. Arrays of data are represented by the symbols F1, F2 etc, or R1, 

R2 etc. F1 represents data in a data file that will be chosen when the operation is 

performed. R1 represents data in a reference file that will be identified when the 

operation is created. The symbols *, +, -, / and ^ have their usual meaning. They are 

binary operators; because they indicate an operation involving two arrays of data. A 

rather special binary operator is the comma. It indicates arc tangent of the quotient of the 

quantities on either side of it. F1,F2 for example, means arc tan(F1/F2). The reason for 

the use of the comma is to preserve the quadrant of the result, which is assigned on the 

basis of the signs of F1 and F2 separately. Both F1 and F2 positive implies first quadrant, 

both negative means third quadrant, F1 negative and F2 positive is fourth quadrant and 

F1 positive and F2 negative is second quadrant. Then there is a series of unary operators; 

that involve the transformation of a single array of data. These all have the form O#: 

where # indicates a letter and they include operators such as OS: for sum. Brackets are 

used to define the hierarchy of calculation. In the absence of brackets this is principally 

from left to right but on occasion this may not be so. Brackets should, therefore, be freely 

used. C1, C2 and so on represent constants. M1, M2 and so on represent the results of the 

functions. The result of an earlier function can be used in a later one simply by including 

the appropriate M1, M2 etc. 

One version of the C symbol and one of the M symbol have special meaning. The 

symbol C0 is reserved for a constant that will be input when the operation is being 

performed. The symbol M0 means the independent variable of the particular function. It 

is used, for example, to extract the wavelength so that it can be used as a variable in a 

calculation. The operation that creates the output of a black body source, supplied with 

the program, shows an example of this. The M symbol can also be used to indicate that 

the independent variable should, after calculations are completed for a particular 

function, be replaced by the dependent variable of a previous calculation. 

The various symbols are listed in the following table. In all cases * indicates a numerical 

digit and # a single letter. 
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Symbol Meaning 

Arrays of data 

M* 

The result of a particular function. 

Used in the independent variable column indicates that the independent 

variable of M* should be used for the calculation but then should be replaced 

in the table of results by the dependent variable M* 

M0 The independent variable in the given function 

R* A reference file 

F* An array of results in a table file 

C* A constant 

Binary operators 

* Multiplication 

+ Addition 

- Subtraction 

/ Division 

^ Exponentiation 

, Arc tangent 

% Search for level from beginning 

@ Search for level from end 

Unary operators 

OD: Derivative 

OI: Integral 

OS: Sum 

OV: Mean 

ON: The number of values 

OL: Log (natural) 

OE: Exponential 

OQ: Square root of absolute value 

OP: Principal value in the range -180° to +180° 

OB: Principal value in the range 0 to 360° 

OG: Absolute value 

OH: Sine 

OU: Cosine 
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Symbol Meaning 

O>: Maximum value 

O<: Minimum value 

 

 

Notes: The derivative at a point is given by the difference between the values of the 

independent variables on either side divided by the corresponding difference 

between the independent variables. At the beginning or end of a table the 

missing point is replaced by the point in question. 

 

The integrals are evaluated by the trapezoidal rule. 

 

Search for level from beginning and Search for level from end operators  

These operators are used to find the value of the independent variable at 

which the dependent variable has a specified value. Search for level from 

beginning starts at the beginning of the table and returns the first matching 

value. Search for level from end starts at the end of the table and returns the 

first matching value. For example, the operation C1%F1 with Independent 

Value in F1 returns the Independent Value of the first point in F1 where its 

value is equal to C1 

 

A particularly useful aspect of the M symbol is the way in which it can be used to 

connect the variation of two dependent variables, each dependent on the same 

independent variable. An example of this occurs in delvspsi, an operation for the 

rearrangement of the ellipsometric parameters  (psi) and  (delta). Although these 

parameters are calculated in the Core Essential Macleod there is no facility for tabulating 

or plotting  against  in the Core. Both  and  are calculated as functions of a third 

variable, wavelength, layer thickness or angle of incidence. Often the variation of one 

with respect to the other, especially as the thickness of a layer increases, is what is 

required. This is achieved by the use of two functions. The first calculates  as a function 

of the original independent variable and also corrects the principal value range to 0 to 

360. This correction could be removed or changed. The second function then sets  

against the dependent variable of the first function by placing M1 in the Independent 

Variable In column. 

 

Name Heading 
Independent 
Variable In 

Value 

M1 Della F0 OB:F0 

M2 Psi M1 F1 

 

A very simple example of the use of this Operation might be  and  for a silicon film 

deposited over a glass substrate at a wavelength of 500nm and angle of incidence of 70. 

We would like to construct a plot of  against . The design is set up as shown and then 

Reflectance Delta is chosen in the Parameters dialog to be tabulated as a function of the 

thickness of layer 1. 
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= 
 

This is calculated over the range 0 to 250nm of layer 1 to give the table of results, 

which we save in file sipd.tbl. 

 
 

F0 is now set to column 2, Reflectance Delta and F1 to column 3, Reflectance Psi. 

Then we execute the Operation to obtain two tables. The first table we discard. The 

second table, which has Delta in the first column and Psi in the second, we keep by 

saving as pd.tbl. 

 
 

The first value of Delta in the table is actually zero as calculated, but, when we plot 

this, it places the first point over to the left of the remainder of the curve. So we adjust it 

by toggling the read only status of the table using the table Edit menu and then changing 

the first entry from 0.0000 to 360. This is the table that we show here. 
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Finally we plot the result using the Plot Column command in the File Menu to give 

the curve shown. 

 
 

A Further Example 
To end this introduction to Function, we consider the generation of a simple operation. 

Let us calculate the effect of three reflections in series at coated mirrors in an optical 

instrument. We assume that the light path remains in the horizontal plane, as in many 

optical instruments and that the three reflections making up the light path follow the 

shape of the letter W. Since oblique incidence is involved we will have to keep track of 

the p- and s-performance separately. We will calculate both the reflectance and the phase. 

Absolute phase is, of course, meaningless in this operation, but we are interested in the 

relative phase shift between s- and p-polarization. We will use the ellipsometric 

convention to express the difference in phase between the components. 

p

p
p

p

p
s

s

s s s

 
 

The arrangement of the beams and the various reference directions associated with the 

three reflections are shown in the figure. The convention shown on the rays is the normal 

thin films convention that is followed throughout the package. The ellipsometric 

convention is shown to the right of the final ray and there is a difference of 180° in the 

positive direction for p-polarized light. 

We are going to include the possibility of different angles of incidence for each 

reflection and so we assume three table files, each with data applying to one reflection. 
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As far as the operation is concerned, each separate set of data will be considered as a 

different data file, even although they may actually be different columns in the same file. 

Since we have three p-reflectances, three s-reflectances, three p-phases and three s-

phases we have twelve data files in all. One operation can have only ten files, F0 to F9, 

and so for reflectance and phase we must use two operations. One can be for reflectance 

and the other for phase. 

Again we emphasize that the absolute phase shift for either s- or p-polarization is lost 

because we cannot include the total paths but the difference between s- and p-polarization 

will be valid and this is really what we require from the calculations. 

We first consider reflectance. For convenience we show the entire operation in tabular 

form below. This is entered into a new operation form by following these instructions. 

We first select Operation from the New... menu item in the File menu. 

The data files can be designated F1, F2 to F6 and we will assume that the independent 

variable, wavelength, is defined by file F1. The s-polarized reflectance we can denote by 

R(S) and this will be given by the product of the s-polarization reflectances for each of 

the three reflections. A similar expression will exist for the p-polarized reflectance, R(P). 

But the tables will be given in percentages and the final answer should be also given as a 

percentage. This implies that we must also correct the result by dividing by the square of 

100 so that the product of three hundred percent reflections will be simply one hundred 

percent. Thus 

R(S)=C1*(F1*F3*F5) 
R(P)=C1*(F2*F4*F6) 

where the files containing the s-polarization results are F1 for the first reflection, F3 for 

the second and F5 for the third, and, correspondingly, for p-polarization, F2, F4 and F6. 

C1 is a constant with value 0.0001. To enter this function, we select New... from the File 

menu and specify Function in the resulting dialog box. As the description (the first radio 

button in the Function window) we simply enter: 

Triple reflection - R(S) and R(P) 

Next we must enter the functions themselves. These must be of the form: 

 

Name Heading 
Independent 
Variable In 

Value 

M1 R(S) F1 C1*(F1*F3*F5) 

M2 R(P) F1 C1*(F2*F4*F6) 

 

The files for the independent variables must also be entered. The independent variable 

values can be in any of the existing data files, in a new data file, in any reference file, or 

the appropriate function may have a single value as result, in which case there will be no 

independent variable. Here, existing files are F1 to F6 and any of these can be entered. A 

new file would be indicated by any of F7 to F9, a reference file by R1 to R9. The names 

of the data files will be entered when the operation is performed but any reference file 

names will form part of the stored operation. For the current operation, F1 is a good 

choice for both functions. 
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Next the constants must be entered. There is only one in this operation, C1, which has 

a value of 0.0001.  

There are no reference files in this operation and so we can safely ignore that screen. 

Finally select Bindings so that the prompts for the various data files can be set up. 

These prompts are quite arbitrary and are intended to act as a reminder of the particular 

data that should be input for the correct implementation of the operation. However, data 

files may have many columns and if the prompt corresponds to the heading above a 

particular column, then the program will automatically suggest that particular column as 

the correct one. This can save a great deal of time when the operation is being set up to be 

performed. Therefore the heading for the column in the Bindings table is Default 

Column although any text string can be entered. We choose entries of R(S) for F1, F3 

and F5 will have and R(P) for F2, F4 and F6. 

Once all the prompts have been entered, then a name must be chosen for the operation 

file where the operation will be saved. This can conveniently be TRIPLER. 

 

TRIPLER 

Description 

Triple reflection - R(S) and R(P) 

Functions 

Name Heading 
Independent 
Variable In 

Value 

M1 R(S) F1 C1*(F1*F3*F5) 

M2 R(P) F1 C1*(F2*F4*F6) 

Constants 

Name Value 

C0  

C1 0.0001 

Bindings 

Name Default Column Filename Column 

F0    

F1 R(S)   

F2 R(P)   

F3 R(S)   

F4 R(P)   

F5 R(S)   

F6 R(P)   

 

Next we consider phase shifts. The next table shows the details of the operation that 

must be entered. 

For the net phase shifts, p and s, we simply add the separate phase shifts. It is 

convenient to have them correspond to a principal range and the operator OP: or OB: will 

perform this. However, absolute phase shift calculated in this way is essentially 

meaningless in the context of three reflections of this kind, particularly because there is 

an uncontrolled path between each mirror and this is not and cannot be taken into 

account. This uncontrolled path will, nevertheless, be exactly the same for p as for s-
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polarization and so the figures we have for absolute phase shifts are completely valid for 

the calculation of p-shift relative to s-shift. So we calculate the absolute shifts due to the 

three reflections, but then use the results in the assessment of DELTA, the ellipsometric 

parameter given by the difference p-s. The operation for phase calculation is shown in 

the  table below and this must be entered in the same way as the reflectance operation and 

stored in the file TRIPLEPH. 

 

TRIPLEPH 

Description 

Triple reflection - PH(S), PH(P) and DELTA 

Functions 

Name Heading 
Independent 
Variable In 

Value 

M1  F1 OP:(F1+F3+F5) 

M2  F1 OP:(F2+F4+F6+C1) 

M3 DELTA F1 OP:(M2-M1) 

Constants 

Name Value 

C0  

C1 180 

Bindings 

Name Default Column Filename Column 

F0    

F1 PH(S)   

F2 PH(P)   

F3 PH(S)   

F4 PH(P)   

F5 PH(S)   

F6 PH(P)   

 

We are now ready to calculate some actual performance figures. We can choose as 

reflector, aluminum protected by a halfwave of silicon dioxide at 510nm. 

Let the wavelength range be 400nm to 1000nm calculated every 10nm, and let the 

angle of incidence of the first reflection be 45°, of the second, 30° and of the third, 25°. 

We set up the calculation parameters for reflectance phase, over the given wavelength 

range, for 45° angle of incidence and then we calculate the table of results and save it in a 

table file called PROTAL45. In the table of reflectance phase the values of reflectance 

will also be given. If, however, reflectance is selected in the Parameters dialog box then 

reflectance and transmittance will be in the table, and this is not what we want. Then we 

change the angle of incidence to 30°, and calculate the new table, saving the table file as 

PROTAL30. Finally we use angle of incidence 25° and generate the table PROTAL25. 

Now we make the Operation TRIPLER active. We choose the table files as shown in the 

following screen and we can set them up during execution or before. Note that clicking in 

the appropriate table cell brings up a dialog box for choosing the appropriate entity. 
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By selecting Run from the Execute menu we launch the calculations. The results of 

the calculations are saved as prals.tbl, for s-polarization and pralp.tbl for p. The plots 

can then be produced using Plot Column... from the File menu  

 
 

To plot one curve over the other on the same graph, save the curve to be added, make 

the first plot window active by clicking in it and then select the menu item Add Line...to 

add the newly saved plot to the first one.  
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The reflectance figures are quite low and also quite typical of actual instrumental 

performance with three reflections. 

These two operations can be used over and over again with different reflectors, with 

different angle of incidence and so on. If they have been saved complete with the 

bindings then the procedure of generating data and calculating can be speeded up. 
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RUNSHEET 
A Runsheet is a plan for the control of the deposition of a given coating. It lists the 

expected progress of the signals that are to be used for tracking the progress of the 

deposition. These signals are normally the output of a monitor that is either a quartz 

crystal or an optical system or perhaps both. 

A Runsheet refers to the production of a particular coating on a given machine. The 

coating is defined by reference to a normal design file. The significant details of the 

machine to be used for the production are specified in a document, known as a Machine 

Configuration. 

You can check whether the Runsheet Enhancement is present by starting the Essential 

Macleod and selecting About The Essential Macleod… in the Help menu. The 

information box that appears should include Runsheet in the Options list. 

Machine Configuration 
The submenu activated by New in the File menu contains an item, Machine 

Configuration. Selection opens a blank Machine Configuration document. It should be 

completed with the necessary details of the sources and monitoring system of the plant. 

The example we will show has both optical and crystal monitoring. Either or both of 

these options may be chosen when the configuration form will show only the appropriate 

sections. There are four tabs, General, Sources, Monitoring Chips and Wideband. 

Monitoring Chips is not accessible when only crystal monitoring is checked. If the 

Simulator enhancement is installed, then more tabs will be visible. The Simulator section 

contains details on these tabs. 

General Tab 

Plant Configuration 

 
 

Incident angle applies solely to the optical monitor. Polarization of the light for 

oblique incidence is important and is specified in the Runsheet. 

Deposition medium will normally be air (which counts also as vacuum) but the 

possibility exists to choose any material from the current database. 
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Monitoring Capability 

This must be Optical, Crystal or both. It is not possible to choose neither. 

Crystal Controller 

The film thickness units used by the crystal controller will often be different from 

those in the package. Frequently they are in kÅ. They must be specified through the 

Thickness Scale Factor and the Thickness Symbol boxes in exactly the same way as in 

General Units. The scale factor is one Machine Unit expressed in terms of the 

fundamental unit, the metre. For kÅ the Thickness Scale Factor will be 1E-07. The 

mass calibration of the crystal will normally be handled by the crystal equipment. 

However, if the crystal monitor lacks these facilities, the Thickness Scale Factor 

together with the individual crystal tooling factors can accommodate the entire 

calibration. Variations in density can also be included in the tooling factors. If optical 

thickness is specified in the design then, of course, the packing density will be included 

in the conversion from optical to physical thickness for the Runsheet calculations. 

However, this will not necessarily represent the entire correction for quartz crystal signal 

because the crystal thickness conversion ratio will remain constant in the Runsheet but 

will be altered in reality because of the different density of the deposit. 

Dynamic Tooling Factor 

The amount of material deposited on the particular sensor, monitoring chip or crystal, 

may not be identical to the corresponding amount deposited on the batch of coatings in 

production. Much of this difference is due to the geometry of the machine and it may be 

intentional. A greater thickness on the sensor can actually improve the sensitivity and 

accuracy of monitoring. The tooling factor is defined as the ratio of the rate of deposition 

on the monitor chip to that on the batch substrates. A Dynamic Tooling Factor, 

described in greater detail shortly, is a function of the total amount of material deposited. 

Dynamic Tooling Factors can help to compensate for such effects as source depletion 

during a production run. 

Reset for Each Layer is important only when dynamic tooling factors are used. It has 

no effect if tooling factors are constant. The calculation involves integration of a 

tabulated function. This calculation can be reset for each layer or can apply without 

resetting to all layers in sequence deposited from that particular source. 

Tooling Scale Factor is another scale factor. This time it applies to the thickness 

values that are held in the Dynamic Tooling Factor files. It is not used if dynamic tooling 

factors are not used. 

Tooling Unit Symbol is the symbol that represents the thickness units used in the 

Dynamic Tooling Factor files. 
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Sources Tab 

 
 

Sources: The sources are designated by names or numbers. Material can, as usual, be 

entered manually selected from the drop-down list. Optical Tooling Factor expresses the 

difference between the thickness deposited on the monitoring substrate or chip and the 

actual substrates carried in the coating jig. A tooling factor greater than unity indicates 

that the deposit on the monitoring chip is greater than the amount deposited on the 

substrates. It is the factor by which the thickness of the layer must be multiplied to give 

the monitor thickness. The Crystal Tooling Factor is similarly interpreted. Sources may 

have varying distributions during the run. This can be accommodated by constructing a 

dynamic tooling factor. Dynamic tooling factors are described in detail later and involve 

a table file that is entered in the Tooling Factor cell. The Deposition Rate column is used 

by Simulator and is not used by Runsheet. Line Color is used to specify the color on the 

runsheet plots. To choose the color to be used for each source, double-click in the Line 

Color cell. A color picker will appear. Select the desired color and click OK. 

Monitoring Chips Tab 

There may be many different monitoring chips. Here we see just three. They may be 

designated in any way, but a name that includes an indication of the type of chip is most 

useful. Note the glass chip, GlassAl, with opaquely coated rear surface. The rear surface 

of the chip can have a Perfect AR, to remove any reflection, can be uncoated or otherwise 

treated, or can have a massive thickness of any of the existing materials added to the rear 

surface. Usually the coating on such a chip will be metallic and the chip will be used in 

the deposition of an absorbing film. The example shown has an aluminized rear surface. 

Each chip may have internal transmittance that is different from unity. Internal 

transmittance is stored in material files. For older materials databases, the internal 

transmittance data was stored in a separate Substrate file. In this case, it will be possible 

to select a Substrate file in the Substrate column. Chip thickness is given in the same 

units as are used in specifying substrates (millimetres in the standard version) although 

chip thickness is unimportant when the Material is lossless. 
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There can be as many machine configurations as the user wishes but it is not possible 

to have more than one configuration specified in a single Runsheet. 

Wideband Tab 

The Wideband tab specifies the wavelength range and interval to be used for 

wideband optical monitor calculations.  

 
 

For wideband calculations, wavelengths from Start Wavelength to End Wavelength 

incrementing by Wavelength Interval will be used. 

Run Sheet 

Global Defaults 

The Run Sheet… item in the Options menu activates a Run Sheet Defaults window 

with three tabs. [In a Runsheet that has been configured by Monitorlink for a particular 

controller there may be extra tabs]. Global defaults are to be entered here. 
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Machine Configuration 

 
 

The Machine Configuration tab permits choice of a default machine configuration. 

The example shown has no default. If a machine configuration has been chosen and now 

no default is required then the Remove button will return the selection to <none>. 

Signal Parameters 

 
 

The Signal Parameters tab for the regular Runsheet asks for Default Wavelength, 

Bandwidth, and Wavelength Interval. The bandwidth is the spectral width of the 

detecting system, filter or other type of monochromator, that will be used. The 

wavelength interval is, strictly, not a parameter of the particular machine or monitoring 

system but of the calculation to be performed. It is the interval between those points 

within the bandwidth of the monitor that will be calculated. The example shown lists 1nm 

for a bandwidth of 10nm. This means that eleven equally-spaced points will be used in 

the calculation of the effect of the 10nm bandwidth. This is more than adequate for most 

purposes. The Wavelength Interval should usually be set somewhat less than the Default 

Bandwidth. Note that the minimum number of points that will be calculated, even if the 

interval is set to be large, will be three, one at either end of the band and one in the 
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middle. Default Spectrum allows you to specify a spectral profile instead of a 

wavelength and bandwidth 

One Wavelength per Chip sets the default behavior of the Runsheet to force the 

monitoring signal conditions to be identical for all layers deposited on the same witness 

chip. 

Monitor Mode 

 
 

Monitor Mode is transmittance, reflectance or back reflectance. 

Peak Display 

 
 

You can specify the characters to use for indicating the signal peaks in the Peak 

Display page. There are two sets of characters to specify. The first set controls the 

characters used in the Runsheet window and in printed Runsheets. You can choose a font 

and then choose characters from that font. This allows, for example, the use of arrows to 

show positive and negative peaks. The second set controls the characters to be used when 

exporting the Runsheet data to comma separated values file. Here you can only select 

standard characters. 
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Wideband 

 
 

The Wideband tab specifies the default wavelength range for new Machine 

Configuration files for wideband calculations. 

Wavelength Search 

 
 

The Wavelength Search tab specifies the tolerances to be used during wavelength 

search. The Final Swing Tolerance specifies the accuracy of the match of the requested 

final swing value to the actual final swing value. The wavelength search function will 

stop when the calculated final swing is within the Final Swing Tolerance value of the 

requested final swing. The wavelength search function will also stop when the monitor 

wavelength is within Wavelength Tolerance of the wavelength of the requested final 

swing. 
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Runsheet 

 
 

The Runsheet tabs provides controls for the formatting the data that appears on the 

Runsheet and how the dynamic tooling factor tables are interpreted. The format specifiers 

follow the same rules as those used in General Units and described in the Units section 

(see page 32). The Dynamic Tooling Factor Convention controls how the dynamic 

tooling factor tables are interpreted. For more information on dynamic tooling factor see 

page 360. 

Display Setup 

 
 

The standard Runsheet has many columns, many of which are probably not required 

for the majority of Runsheets. This tab controls which columns are initially displayed 

when a new Runsheet is created. Once the Runsheet is displayed, the columns displayed 

in that Runsheet can be switched on and off through the Display Setup command in the 

File menu. 
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Active Plot 

 
 

The Active Plot tab controls the default ranges for Runsheet variables in Active Plot. 

All the ranges are controlled by multipliers of the initial values. For example, if a 

Monitor Wavelength variable for a layer was added to a Runsheet Active Plot where the 

Monitor Wavelength was 510 and the Multiplier for Maximum Value was 1.1, the upper 

limit of the range would be 561. 

The speed and change increments can also be controlled. When the >, <, >>, << 

buttons are held down, the Minimum Delay specifies the minimum time period in ms 

before the variable is incremented and the plot then updated. If the plot update takes 

longer than the Minimum Delay, then the next plot update will start immediately after the 

completion of the current plot update.  

Each time the > and < buttons increment the value, the value is changed by Increment 

Proportion of the difference between the maximum and minimum values shown on the 

Active Plot. The default value is 0.01. That is, the value will change by 1% of the range 

between the minimum and maximum values.  

Each time the >> and << buttons increment the value, the value is changed by Fast 

Increment Proportion of the difference between the maximum and minimum values 

shown on the Active Plot. The default value is 0.1. That is, the value will change by 10% 

of the range between the minimum and maximum values.  

Overplot 

The Overplot tab controls the default overplot for each layer in optical thickness units 

at the monitoring wavelength. Default Overplot Thickness controls the overplot for 

regular plots and Default Active Overplot Thickness controls the overplot for Active 

plots. 
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Creating a Run Sheet 

To create a Runsheet, select the Run Sheet option in the New submenu. A blank 

Runsheet appears with any global defaults assigned to it. As it is created, the Runsheet is 

quite broad and will probably need the horizontal scroll bar that is provided. 

 
 

The commands that we need to proceed are in the Edit and Runsheet menus for the 

Runsheet. These commands are described below. 

Edit Menu (Runsheet) 

Parameters...  
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To specify the design for the Runsheet, click the Browse… button or double-click in 

the Design box. A file chooser will be displayed. Select the design file to be used and 

then click OK. The filename will be displayed in the Design box. 

To choose a machine configuration, click the Browse… button  or double-click in the 

Machine box. A file chooser will be displayed. Select the machine configuration to be 

used and then click OK. The file name of the machine configuration will be displayed in 

the Machine box. 

For oblique incidence monitoring, a polarization can be specified. Select the down 

arrow in the Polarization box. A list of the polarization options will appear. Choose the 

desired polarization by clicking on it. 

The Runsheet can calculate monitoring signals for transmittance monitoring, 

reflectance monitoring, or back reflectance monitoring. Monitor Mode selects 

transmittance, reflectance or back reflectance monitoring. 

Wavelength Interval is the wavelength step used in the calculation of monitor 

response over the bandwidth listed against each layer in the Runsheet. This command 

applies a local default the interval to all layers in the Runsheet. No changes are made to 

the global defaults. 

The Wavelength Scale Factor specifies the units used for wavelength in any tables 

used for defining monitoring spectrum. The scale factor is applied in the same way as for 

general units. For example, if the scale factor is 1e-9, then the wavelength units of all 

monitoring spectrum tables will be nanometres. If the scale factor is 1e-06, then the 

wavelength units of all monitoring spectrum tables will be microns. 

When Use Previous Extremum is checked, the Runsheet will use the extrema from 

previous layers when calculating the Final Swing. Previous extrema are only used when 

the layers are on the same chip and the monitoring wavelengths and bandwidths (or 

spectra) are identical.  

When One Wavelength per Chip is checked, the Runsheet will force all layers 

deposited on the same witness chip to have the same signal conditions, i.e. the monitoring 

wavelength and bandwidth will be the same. 

Overplot Thickness is the thickness beyond the cut-point for which the signal is 

plotted on regular plots. Overplot Active Thickness is the thickness beyond the cut-point 

for which the signal is plotted on Active plots. Overplotting helps to determine if the cut-

point is near to an extremum or near to some other feature that might cause problems 

during production. 

 

When Deposition Begins at Medium End is checked, the design will be loaded into 

the Runsheet with the layer next to the incident medium being the first layer to be 

deposited. Otherwise the design is loaded so that the layer next to the substrate is the first 

layer to be deposited 
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Global Edit 

 
 

Global Edit provides a convenient means for modifying several layers of a Runsheet 

at once. If no layers are selected, the global edit applies to all layers in the Runsheet. If 

one or more layers are selected, then the global edit applies only to the selected layers. 

Each box on the Global Edit form corresponds to the column of the same name in the 

Runsheet. Leaving the box blank will leave the contents of the column undisturbed. 

When a value is entered into the box, the values in the corresponding column will be 

replaced with the value in the box. Monitor Spectrum has a special case. If you wish to 

delete the current Monitor Spectrum entry, click the Delete button next to the Monitor 

Spectrum box.  

Clicking OK causes the global edit to be applied to the Runsheet. Clicking Cancel 

aborts the global edit operation. 

Runsheet Menu (Runsheet) 

Calculate 

This option causes the optical information in the Runsheet to be calculated. The 

values are displayed in the right-hand part of the table. 

Plot One Chip 

This option causes the signal variation of the layers deposited on a single chip to be 

plotted. The chip that is plotted is determined by the location of the currently selected 

cell. The first chip on or above the row containing the selected cell will be plotted. If 

there is not a selected cell, then the first chip in the Runsheet is plotted. 

Plot All Chips 

This option plots the optical signals for all chips on the same plot. 

Plot Selected Layers 

This option plots the optical signals for selected layers only. Layers may be selected 

by clicking in the small leftmost cell of a row. The layer is selected when the row has a 
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black background. Holding the <shift> key down whilst selecting another layer causes all 

layers between the first selected layer and the new selection to also be selected. 

Wideband Plot One Chip 

This option plots the expected spectra at the end of deposition of each layer that is 

deposited on the same chip. The chip that is plotted is determined by the location of the 

currently selected cell. The first chip on or above the row containing the selected cell will 

be plotted. If there is not a selected cell, then the first chip in the Runsheet is plotted. The 

wavelength range to be used in the plot is determined by the Wideband parameters in the 

Machine Configuration. 

Wideband Plot All Chips 

This option plots the expected spectra at the end of deposition of each of the layers in 

the Runsheet. The results for each chip in the Runsheet are shown in separate plots. The 

wavelength range to be used in the plot is determined by the Wideband parameters in the 

Machine Configuration. 

Wideband Plot Selected Layers 

This option plots the expected spectra at the end of deposition of each selected layer in 

the Runsheet. The wavelength range to be used in the plot is determined by the Wideband 

parameters in the Machine Configuration. 

Wideband Slope Plot One Chip 

This option plots the first derivative of the expected spectra with respect to thickness 

at the end of deposition of each layer that is deposited on the same chip. The chip that is 

plotted is determined by the location of the currently selected cell. The first chip on or 

above the row containing the selected cell will be plotted. If there is not a selected cell, 

then the first chip in the Runsheet is plotted. The wavelength range to be used in the plot 

is determined by the Wideband parameters in the Machine Configuration. 

Wideband Slope Plot All Chips 

This option plots the first derivative of the expected spectra with respect to thickness 

at the end of deposition of each of the layers in the Runsheet. The results for each chip in 

the Runsheet are shown in separate plots. The wavelength range to be used in the plot is 

determined by the Wideband parameters in the Machine Configuration. 

Wideband Slope Plot Selected Layers 

This option plots the first derivative of the expected spectra with respect to thickness 

at the end of deposition of each selected layer in the Runsheet. The wavelength range to 

be used in the plot is determined by the Wideband parameters in the Machine 

Configuration. 

Active Plot One Chip 

This option begins Active Plot for the signal variation of the layers deposited on a 

single chip. The chip that is used is determined by the location of the currently selected 

cell. The first chip on or above the row containing the selected cell will be used. If there 

is not a selected cell, then the first chip in the Runsheet is used. 
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Active Plot All Chips 

This option begins Active Plot for the optical signals on all chips. 

Active Plot Selected Layers 

This option begins Active Plot for the selected layers only. Layers may be selected by 

clicking in the small leftmost cell of a row. The layer is selected when the row has a 

black background. Holding the <shift> key down whilst selecting another layer causes all 

layers between the first selected layer and the new selection to also be selected. 

Export Signal One Chip 

This option creates a csv file containing the signal variation of the layers deposited on 

a single chip. The chip that is used is determined by the location of the currently selected 

cell. The first chip on or above the row containing the selected cell will be used. If there 

is not a selected cell, then the first chip in the Runsheet is used. 

Export Signal All Chips 

This option creates a csv file containing the signal variation for all chips. 

Export Signal Selected Layers 

This option creates a csv file containing the signal variation for the selected layers 

only. Layers may be selected by clicking in the small leftmost cell of a row. The layer is 

selected when the row has a black background. Holding the <shift> key down whilst 

selecting another layer causes all layers between the first selected layer and the new 

selection to also be selected. 

 

Zero Offset and Gain 
These columns provide linear conversion of the signal values. The diagram shows the 

nature of the conversion. 

Offset

Gain=Slope

Uncorrect ed

signal

Correct ed

Signal
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We can write the expression for the conversion as 

 

𝑆𝑐𝑜𝑟𝑟 = 𝐺𝑎𝑖𝑛 × 𝑆𝑢𝑛𝑐𝑜𝑟𝑟 − 𝑂𝑓𝑓𝑠𝑒𝑡 

   

Note that a positive offset moves the corrected signal downwards, that is towards zero if 

the signal is positive. 

As an example we can look at the first layer of the design in the example below. The 

total excursion of the signal is 24.4579%. A gain of 2.044 will convert this to an 

excursion of 50% but the starting signal will move to 188.034%. To make the signal start 

at 80%, say, we need an offset of 108.034. Putting these figures into the Runsheet yields 

the following curve for the first layer. The excursion is now 50% as required. 

This control reproduces the effect of the corresponding controls on a deposition 

monitor. It is useful only if the monitor controls are well calibrated. 

 
 

In addition to entering actual gain and zero offset values, you can enter desired signal 

values and Runsheet will calculate the required gain and zero offset values for you. There 

are two modes for gain and zero offset calculations: Set Gain from One Point and Set 

Gain from Two Points. These modes are set in the Edit menu.  

When the mode is Set Gain from One Point, the zero offset is always zero and the 

gain can be determined from a single point. To calculate a gain, Select Calculate from the 

Runsheet menu. After the signal values have been calculated, choose a signal value that 

you wish to define. You may choose any non-blank signal value in the columns: Start At, 

First Maximum, First Minimum, Last Maximum, Last Minimum or Finish At. In the 

appropriate cell, type in the signal value that you wish to have and then press <Enter>. 

The gain for that layer will be adjusted to give the desired signal value. If you wish to 

apply the gain and zero offset to other layers, click the right mouse button when the 

mouse is over the layer. A popup menu will appear which has the command apply gain 

and a sub-menu. The sub-menu allows you to copy the zero offset and gain to all layers 

on the same chip, all layers in the Runsheet or selected layers. 
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When the mode is Set Gain from Two Points, the zero offset may be non-zero. In this 

case you need to enter two points to define the zero offset and gain. The two points are 

selected in the same way as for Set Gain from One Point. When the first point has been 

selected and a new value has been entered, the background of the cell will change to red 

to indicate that first point has been entered. When the second point has been entered, the 

zero offset and gain will be calculated and applied to the layer(s). The second point does 

not have to be on the same layer or even the same chip as the first point. The Apply Gain 

popup menu can be used to copy the zero offset and gain values to other layers in the 

Runsheet. 

Zero Offset and Gain are not applied to wideband calculations. 

Wavelength Search 
Often the properties of a Runsheet are determined by specifying a monitoring 

wavelength and bandwidth and then calculating the signal and final swing values. 

Another approach is to specify a desired final swing value and then determine the 

monitor wavelength that will give the desired final swing. In Runsheet, the Wavelength 

Search function provides the ability to find a monitoring wavelength for a layer that will 

cause termination at a desired final swing. 

To use the wavelength search, first enter the desired final swing value into the 

appropriate final swing cell. Next, with the mouse pointer in the final swing cell, right-

click the mouse to display the wavelength search menu. There are two options on this 

menu: Find Next Wavelength and Find Previous Wavelength. Find Next Wavelength 

will search for the next monitoring wavelength greater than the current monitoring 

wavelength that will give the desired final swing value. Find Previous Wavelength will 

search for the next monitoring wavelength less than the current monitoring wavelength 

that will give the desired final swing value. When the search stops, the Runsheet will be 

calculated. The displayed final swing value may not be the same as requested, but it will 

normally be close to the requested value. The difference is controlled by the wavelength 

search parameters in the Runsheet global defaults (Options menu -> Runsheet) 

 

Exporting a Runsheet 
The narrowband data in a Runsheet may be exported to a file in comma separated 

value format by choosing CSV file… from the Export sub-menu of the File menu. This 

format is easily imported by spreadsheets for further processing and formatting. 



Runsheet   357 

An Example 

 

The Runsheet illustrated above carries a design of a single-cavity narrowband filter at 

700nm. The design formula is: 

Air | (HL)^5 (LH)^5 | Glass 

 

 with Na3AlF6 as low index and ZnS as high index layers. The calculated performance of 

the filter is shown next. 

 
 

The default settings in the optical Runsheet are a monitoring wavelength of 700nm 

with a bandwidth of 10nm. The same glass monitoring chip is used for the entire coating 

and the optical tooling factors are unity and transmittance monitoring is selected. This, 

therefore represents direct optical monitoring where the control is exercised on the actual 

component that is being produced, which is normal for narrowband filter production. 

Selecting Plot One Chip from the Runsheet menu produces the plot of the monitoring 

signal. 
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From layer 15 onwards the signal is not at all what should be expected. The problem is 

the optical bandwidth of the monitoring system. By layer 15 the characteristic curve of 

the coating is narrower in its spectral features than the monitoring system. 

We can vary the monitoring bandwidth and produce a series of curves of gradually 

decreasing bandwidth to show the effect. Note that the smaller bandwidths use 

wavelength interval of 1/10th of their width rather than 1nm. 

The monitoring system bandwidths from bottom curve to top curve were 10, 3, 1 and 

0.1nm. Even the 1nm width shows a falling off of contrast in the final layer although the 

extremum is in the correct sense and at the correct position. Note the spurious peaks, 

extremum reversal and lack of contrast. These effects are well known to manufacturers of 

narrowband filters. But they may also occur in other types of filter. 
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Monitor chips may be inserted anywhere in the sequence of layers. Each chip is 

assumed to be fresh and to carry all layers from the point of insertion to the next listed 

chip. Thus inserting a Glass chip in layers 9 and 13 leads to the following signals. 

 
 

Note that since this starts on an uncoated substrate the contrast in layer 9 (the first in 

the graph) is larger than in the full coating. Layer 12, though, now may not be giving a 

very useful signal. We can therefore insert yet another Glass chip at layer 11 and the plot 

for layers 11 and 12 then becomes as shown. 

 
 

Selecting Calculate from the Runsheet menu inserts the appropriate values into the 

Runsheet table. The values listed give information on the starting values, on the terminal 

values and on the intervening extrema. One column is headed Final Swing. Often, 

absolute values are difficult to obtain in monitoring. The part of the signal between the 

final extremum and the termination point is therefore compared with the total swing of 

the coating, expressed as a percentage and listed in the Final Swing column. If there is no 

extremum during the layer then the difference between zero and the starting point is used 

as a measure of the total swing. The complete sequence for the narrowband filter on one 

monitoring chip with a monitoring bandwidth of 1nm is shown next. The sheet (shown 

overleaf) has been scrolled to the extreme right to show the Peaks column. 
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The sequence of extrema in each layer is given in the final column, Peaks. Each 

minimum is denoted by a  and each maximum by a . If a layer starts or finishes at an 

extremum then it will be listed and also flagged with an asterisk. 

 

For quartz crystal only operation of the Runsheet, the columns that are shown are 

limited to Layer, Source, Design Material and Crystal Thickness. Calculation is initiated 

whenever the Runsheet receives either a design file or a machine configuration from the 

Edit menu that completes the set. Again, as in the case of optical monitoring, the results 

in the Runsheet are not automatically changed whenever the design or machine 

configuration is changed. To change the results a selection from the Edit menu must be 

made even if it is simply a repeat selection of the choice already stated. 

Dynamic Tooling Factors 
The tooling factor definition is based on a correct design thickness deposited on the 

batch substrates. The batch thickness is therefore exactly the design thickness. The 

tooling factor then is defined as the ratio of the rate of deposition on the monitor to the 

rate of deposition on the batch substrates. A tooling factor less than 1.0 means that less is 

being deposited on the monitor than on the batch. The Runsheet will always show the 

monitor signal to give the correct batch thickness. 

The tooling factor can be constant or dynamic, that is variable. If it is a constant then 

throughout the deposition the monitor thickness is building up at a rate that is given by 

the batch rate times the tooling factor and so the monitor thickness is given simply by the 

total batch thickness, that is the design thickness, times the tooling factor. For example, a 

constant tooling factor of 0.5 and a design thickness of 100nm would give a monitor 

thickness of 50nm. 

There are two types of dynamic tooling factor available in the Essential Macleod. 

The first type simulates a variable source distribution that can be a depletion effect or, 

possibly, a variation as it gradually reaches equilibrium. The tooling factor is still the 

relative rate of deposition but now it is a function of the batch, i.e. design, thickness. The 

ratio of the actual monitor layer thickness to the batch thickness depends on the way the 

distribution has varied during the deposition of the complete layer. Since the dynamic 

tooling factor gives the instantaneous rate, the ratio of the complete thicknesses is given 

by the integral, or mean, of the dynamic tooling factor over the thickness interval 

concerned. 
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The second is a simpler concept where a separate tooling factor applies to each layer 

in the design. It is described at the end of this section. 

Both these tooling factors are defined in a table subject to certain conventions that 

permit the Runsheet to identify the nature of the data. We begin by considering the first 

type of dynamic tooling factor associated with source depletion or stabilization. 

The dynamic tooling factor is defined in the table with the convention that the factor is 

constant beyond the upper and lower limits of thickness expressed in the table. It is 

assumed to be a linear function in between the values that are listed. 

If the cumulative thickness is used to derive the values for the tooling factor then it 

can represent source depletion because successive layers all deposited from the same 

source move further and further along the curve of tooling factor against thickness. 

However, it is also possible that the source is permitted to cool between layers and the 

variation in factor is really due to a gradual reaching of equilibrium of the source through 

the thickness of the individual layer only. Either of these possibilities for dynamic tooling 

factor can be set up in the machine configuration. 

To set up a dynamic tooling factor the information must first be placed in a table. Use 

the New command from the File menu to create a new table. The program will ask how 

many columns are required. If it is simply a crystal tooling factor or an optical one then 2 

columns would be correct. If both crystal and optical factors are to be included in the 

same file then 3 columns should be chosen. A new table will appear with the required 

number of columns. Next the nature of the columns must be established. Under the Edit 

menu choose Columns. A dialog box appears. Here the most important parameter is 

Type. For column 1 choose thickness as type and, although not strictly necessary, it is 

useful to use Thickness also as the heading. Format can also be chosen if desired. See the 

description earlier or the help file for a description of the various format instructions. 

(Briefly the format will be similar to ##0.000 or 0.0000E+00 where 0 indicates a digit 

that must be present and # one that is only present if the number has a digit in that 

position.) Use Next to move to the second column. Here choose Crystal Tooling Factor or 

Optical Tooling Factor, as appropriate, as type. This permits the machine configuration to 

recognize the data as of the correct kind. Once the columns are prepared the data may be 

entered in the usual way. Remember that table files are eventually set to Read Only when 

saved. If you must reedit data later remember to reset the Read Only status in the Edit 

menu otherwise although changes may appear to be made they will not be registered. 

The tooling factor file can be saved using any appropriate name and that of the particular 

material should be quite appropriate. The extension for the file will be .tbl because it is a 

regular table file and it can be plotted in the normal way if required. 

The data may need to be converted before entry. Note that it is the instantaneous ratio 

of deposition rates that is to be stored in the table, that is the dynamic tooling factor. If 

the existing data refers to total layer thicknesses then they must be converted. This is 

straightforward. Let us assume that we have the results of a series of tests where different 

thicknesses were deposited, each starting afresh with a full source and we assume that the 

changes are sufficiently slow for a linear law to be appropriate for the tooling factor 

variation in between the data points. We represent the design thicknesses by a1, a2 ... and 

the monitor thicknesses as T1, T2 ... Then if f1, f2 ... are the dynamic factors we have: 
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𝑇1 = 𝑓1𝑎1 

 𝑇2 = 𝑇1 + 0.5(𝑎2 − 𝑎1)(𝑓1 + 𝑓2) 

 𝑇3 = 𝑇2 + 0.5(𝑎3 − 𝑎2)(𝑓2 + 𝑓3) 

   

These equations can readily be solved to give: 

 

𝑓1 =
𝑇1

𝑎1

 

𝑓2 =
2(𝑇2 − 𝑇1)

(𝑎2 − 𝑎1)
𝑓1 

𝑓3 =
2(𝑇3 − 𝑇2)

(𝑎3 − 𝑎2)
𝑓2 

  

and so on. Essentially, we differentiate the curve of monitor against batch thicknesses.  

Now we need to set up a machine configuration that will include the factors. 

The New command in the File menu sets up a blank machine configuration for us. 

This can either be quartz crystal or optical or both. Assume for the moment quartz 

crystal. The sources must be numbered and assigned a material. Then there is the column, 

Crystal Tooling Factor. This can either be a number or a file name. For a number, click 

once in the column cell to activate it and enter the factor. For a file, make sure that the 

cell is not active by clicking elsewhere if necessary, and then double-click in it. A 

selection box for the appropriate file will appear. Next we must decide whether or not the 

dynamic tooling factors should be on the basis of the cumulative thickness that has been 

deposited - source depletion - or should be applied to each layer independently - source 

stabilization. There is a check box in the first tab of the machine configuration form 

labeled Reset for each Layer. If this box is unchecked we have the cumulative case. If 

the box is checked each layer is treated independently. This setting applies to all sources 

that use dynamic tooling factors. 

Finally save the machine configuration under an appropriate name. Note that the 

program will check for a valid tooling factor by examining the column types as the file is 

saved and will display an error message if a correct column does not exist. 

Let us emphasize once again that the tooling factor tables are intended to represent the 

instantaneous distribution from the source, i.e. what the source is doing at a particular 

instant rather than the sum total of what it has done from the beginning. Thus the total 

thickness of a layer is given by the integral of the dynamic tooling factor as a function of 

theoretical thickness. The reason we have adopted this technique is mainly because it is 

closer to the physical behavior of the system. A source that reaches a stable distribution, 

for example, will be represented by a stable tooling factor. This would not be the case if 

the integral of the tooling factor were used. It is much easier to see whether a proposed 

table appears realistic when dynamic factors rather than their integrals are used. 

The points in the table are linearly interpolated. The tooling factors beyond the final 

one and before the first one are assumed to be constant. 
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The alternative type of dynamic tooling factor simply specifies the tooling factor to be 

used for each layer deposited by a source. To use this new tooling factor type, create a 2 

column table. The first column is the layer number and the second column is the tooling 

factor to be used for that layer. The type of the first column must be set to “Layer 

Number” and the type of the second column must be either “Optical Tooling Factor” or 

“Crystal Tooling Factor”. See earlier in this section for more information on creating 

tooling factor tables. Setting the first column type to “Layer Number” means that the 

tooling factor will be selected according to layer number, and does not depend on the 

Dynamic Tooling Convention setting. Instantaneous or Absolute tooling factor tables can 

be used together with Layer Number tooling factor tables in the same Machine 

Configuration. 

Spectral Weight Data 
An optical monitoring source for Runsheet may be defined in two ways. It can either 

be specified as a center wavelength and bandwidth using the Monitor Wavelength and 

Monitor Bandwidth columns, or it can be specified using a spectral weight file using the 

Monitor Spectrum column.  

A spectral weight file is a table of wavelengths and weight values. The weight values 

define the relative system response at the corresponding wavelength. The total response 

is determined by calculating the signal level at each wavelength and then multiplying this 

value by the weight. The resulting values are then summed and normalized such that the 

signal with no monitoring chip or layers present will be 100%. 

Defining the Spectral Weight Table 
To create a table, select Table from the New sub-menu of the File menu. You will be 

asked to specify the number of columns required. This will normally be two, one for the 

wavelength and one for the spectral weight. Clicking OK will display a blank table with 

the requested number of columns. 

Next define the titles and content of each of the columns of the table. This is done 

with the Edit Columns option in the Edit menu. 

 
 

A column is defined by three parameters: Heading, Format, and Type. Heading is the 

text that will be displayed as the column header, Format is used to format the values in 

each row of the column and Type  defines the data that is in the column. For the varying 
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parameter tables, the type must be correctly defined. The Previous and Next buttons are 

used to move to the other columns in the table. The first column must be of type 

Wavelength and the column containing the weight data (usually the second column) must 

be of type Spectral Weight. You may use any values you like for the Heading and Format 

(see the Table Window chapter for more information). Once the columns have been 

defined, you can enter the wavelength values and weights in the table and then save it. 

To instruct Runsheet to use the spectral weight file, double-click in the Monitor 

Spectrum cell. This will cause a file chooser to be displayed. Select the spectral weight 

file and then click OK. The units of wavelength in the spectral weight must also be 

defined. All spectral weight files used in a single Runsheet must have the same 

wavelength units. These units are defined by the Wavelength Scale Factor command in 

the Edit menu of the Runsheet. The scale factor is the relationship of the spectral weight 

wavelength unit to one metre. For example, if the spectral weight wavelength units are in 

nanometres, then the scale factor is 1E-9. You may use several different spectral weight 

files in a single Runsheet and you may also mix spectral weight files with Monitor 

Wavelength/Bandwidth definitions.  

Active Plot 
Runsheet supports a specialized form of the Active Plot window (see the Active Plot 

chapter). Runsheet’s Active Plot is customized for runsheet data and so has a different set 

of parameters available. The general concept is the same as for designs: changing the 

value of a parameter updates the plot with the new signal data. 

The Active Plot is started by selecting one of the active plot options from the 

Runsheet menu: Active Plot One Chip, Active Plot All Chips and Active Plot Selected 

Layers. These options correspond to the regular plot options in the Runsheet menu. As 

for the Design Active Plot, parameters must be added to the Active Plot before changes 

can be made and this is achieved using the Add menu. 

Add Menu 

This menu contains all the options for adding variables to the Active Plot window. 

Variables are always added to the end of the existing variables. 

Selected Monitor Wavelengths 

Adds Monitor Wavelength variables for each of the selected rows in the Runsheet. 

All Monitor Wavelengths 

Adds Monitor Wavelength variables for all rows in the Runsheet. 

Selected Monitor Bandwidths 

Adds Monitor Bandwidth variables for each of the selected rows in the Runsheet. 

All Monitor Bandwidths 

Adds Monitor Bandwidth variables for all rows in the Runsheet. 

Selected Tooling Factors 

Adds Tooling Factor variables for each of the selected rows in the Runsheet. 
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All Tooling Factors 

Adds Tooling Factor variables for all rows in the Runsheet. 

Active Menu 

Freeze 

The Freeze command saves the current plot curves and starts a new set of curves the 

next time a variable changes value.  

Update Runsheet 

This command updates the design in the Runsheet window with the runsheet that has 

the performance shown in the Active Plot window. 

Copy Runsheet 

This command copies the runsheet that has the performance shown in the Active Plot 

window to the clipboard. 

The Update and Copy commands do not save any tooling factor changes, since the 

tooling factors are contained within the Machine Configuration file and not the Runsheet. 
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SIMULATOR 
The Simulator enhancement to the Essential Macleod has the capability of modeling 

the behavior of optical and crystal monitoring. This capability is provided by the 

Simulator command in the New sub-menu of the Essential Macleod. The New sub-menu 

may be found by clicking on the File menu.  

To use the Simulator you must have already produced and saved a calculated 

Runsheet. Also the design and machine configuration used by the Runsheet must still be 

present. 

General Page 
After selecting the Simulator option from the New menu, the Simulator form will be 

displayed. The form is split into several tabbed pages that deal with different aspects of 

setting up the monitor model. The first page that is displayed is the General page. 

 
 

When the model is Run, the program will create a number of designs, one for each run, 

and will place the designs in the folder designated by the Output Folder box. Typically 

the Output Folder will specify a new folder that will be created if necessary by the 

program. If the Output Folder exists and contains designs, the designs may be 

overwritten by the Simulator. The Simulator creates designs with names “1.dds”, “2.dds”, 

“3.dds”, and so on up to the number of runs specified. Existing files with these names 

will be overwritten. Double-clicking in the Output Folder will display a folder chooser. 
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With the folder chooser, you can choose an existing folder or create a new folder by 

clicking Make New Folder. After selecting the folder, click OK and the path will be 

entered into the Output Folder box. You can also add a new folder name to the text in the 

Output Folder box. It is also possible to type a complete folder path into the Output 

Folder box without using the folder chooser. 

The model also needs to have a Runsheet that specifies how the design is to be made. 

This is contained in a calculated Runsheet. The Run sheet box is used to specify the 

Runsheet file to be used. You can either enter the Runsheet file name directly by typing 

the path into the Run sheet box, or you can double-click in the Run sheet box to display 

a Windows open file dialog. This can be used to select the file and enter it into the Run 

sheet box. 

The Thermal Profile specifies a temperature profile to be used during the simulation. 

This may either be a constant temperature offset or it may vary as a function of layer 

number. For a constant temperature offset, enter the offset in degrees Kelvin. The offset 

may be positive or negative. For profiles that vary as a function of layer number, a table 

must first be created that specifies the variation of temperature offset. The table must 

contain at least two columns. The first column in the table must specify layer number and 

another column must specify the temperature at the given layer number. The heading for 

this column must be set to “Deposition Temperature Offset”. Other columns may be 

present in the table.  

 
 

An example profile is shown above. Temperature offsets need not be specified for all 

layers. For layers in between specified layers, the temperature will be linearly 
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interpolated from the data in the specified layers. Layers before the first specified layer 

will be deposited at the temperature of the first specified layer and layers after the last 

specified layer will be deposited at the temperature of the last specified layer. Layers are 

numbered from the substrate with the layer next to the substrate being numbered 1. Once 

the table has been created and saved, double-click in the Thermal Profile box. A file 

chooser will be displayed. Select the table file and then click Open. You can also type the 

path to the table file directly into the Thermal Profile box. 

The Number of Runs box specifies how many different simulated deposition runs 

will be made. A successful model run will produce this number of designs in the Output 

Folder. 

If a valid layer number (layer number 1 is next to the substrate) is entered into Stop at 

Layer, then the simulation will pause at the specified layer number. 

If Display Signal Plot is checked, then a stripchart-like display will be presented 

showing signal variation against time. The production of this display takes a significant 

amount of the computer’s time and is probably best used only to check that the design is 

being “deposited” correctly. If Display Signal Plot is not checked, then the display will 

still appear, but it will not be updated in as much detail by the computer. 

When Display Signal Plot is checked, you can check or clear Pause at the end of 

each layer. When checked, the Simulator will stop at the end of each layer and wait for 

you to press the Continue button on the Simulator run form (see below). You can also 

toggle layer pausing on the Simulator run form. 

The Run button is used to start the monitoring process. 

Signal Errors Page 
The Signal Errors page allows the specification of errors in the signal measurement by 

a mean and standard deviation. These errors are applied to the calculated signal before 

the signal is used by the optical monitor part of the model.  

 
 

For each signal measurement, an error value is randomly selected from a population 

with a mean and standard deviation. The mean and standard deviation may either be 

constant or they may vary as a function of wavelength. If the error value lies outside two 

standard deviations from the mean, then another error value is selected until it lies within 

two standard deviations of the mean. (The two standard deviation limit applies to all 
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random number selections in the Simulator). After selection, the random number is added 

to the calculated signal value to provide the value to be used by the monitoring process. 

The error parameters are expressed in terms of absolute transmittance or reflectance in 

units of percent (%). 

For constant mean or standard deviation, the value is simply entered into the 

appropriate text box. Where the mean or standard deviation varies as a function of 

wavelength, the variation is defined in a table (see Defining Varying Parameter Tables) 

and the filename of the table is entered into the text box. The filename may either be 

typed directly into the text box, or you can double-click in the text box. This will cause a 

file chooser to be displayed. Select the file with the chooser and then click OK. This will 

store the filename in the text box. 

Where a table has been specified for either the mean or standard deviation, the 

Wavelength Scale Factor for the wavelength column must be specified. The Wavelength 

Scale Factor relates the units of wavelength in the table to 1 metre. For example if the 

units in the table are nanometres, then the Wavelength Scale Factor is 1E-9. If tables are 

used for both mean and standard deviation, then the wavelength units must be the same. 

This is most easily achieved by specifying the mean and standard deviation in the same 

table. 

Wavelength Errors Page 
The Wavelength Errors page allows the specification of errors in wavelength setting 

by a mean and standard deviation. 

 
 

A wavelength error value is generated in the same way as a signal error value is 

generated each time a new wavelength is set. The model assumes that once a wavelength 

is set, it does not change. The wavelength error is added to the desired wavelength to 

result in an actual wavelength used for measurement. The units of wavelength are always 

nanometres. Errors in bandwidth are assumed to never occur. Mean and Standard 

Deviation for wavelength errors may only have constant values. 

The wavelength setting errors are not applicable where a spectral weight file has been 

used to define the light source in Runsheet. If you wish to model the performance of an 

optical monitor with a known source spectrum such as the output of a source lamp and 

narrowband filter, or model the output of a monochromator which has harmonic and 

other leaks, then a spectral weight file can be used to describe the spectrum used in the 
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monitoring process. The spectral weight file to be used is specified in the Runsheet. If a 

spectral weight file was specified for the Runsheet calculations (in the Monitor Spectrum 

column) and no spectral weight file was specified for simulation, then the Monitor 

Spectrum file will be used for the simulation. Where a file for use in simulation has been 

specified (in the Simulation Spectrum column) then this file will be used for the 

simulation. See Defining Varying Parameter Tables for information on defining spectral 

weight files. 

Optical Monitor Parameters Page 

The Optical Monitor Parameters page contains parameters that control how the optical 

monitor model recognizes peaks and troughs in the monitoring signal. 

 
 

Simulator provides two kinds of optical monitor: An overshoot monitor and a peak 

monitor. The overshoot monitor is designed for monitoring non-quarterwave designs 

where layers are not cut at an extremum. The peak monitor is designed to cut at extrema 

and so is only appropriate for quarterwave type designs. 

Overshoot Optical Monitor 

The overshoot optical monitor operates by counting peaks regardless of their sign. 

After the required number of peaks have been counted, the monitor will stop deposition 

as soon as the signal reaches the specified (in the Runsheet) proportion of the last seen 

peak to peak excursion. In order to detect a peak, the model must see the signal move to 

an extremum and then move away. A peak is recognized when signal has moved away 

from the peak by the Minimum Overshoot proportion. 

To reduce the probability of recognizing false peaks caused by signal noise, the 

Minimum Signal Change parameter specifies a minimum absolute signal change that 

must occur before peak recognition is enabled. This minimum value is applied to signal 

changes as the signal moves towards the extremum and signal changes as the signal 

moves away from the extremum. 

The Maximum Thickness Ratio parameter prevents Simulator from indefinitely 

depositing material in conditions where the overshoot monitor will never terminate a 

layer. This may happen, for example, when the peak-to-peak signal variation is less than 

the Minimum Overshoot value. Once Simulator has deposited (Maximum Thickness 
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Ratio * design layer thickness), Simulator will cut the layer regardless of the state of the 

overshoot monitor. 

The Minimum Monitoring Thickness Ratio specifies the thickness at which the 

optical monitor will start monitoring. The thickness at which monitoring will start is 

given by the ratio value * the design layer thickness or the ratio value * the thickness of 

one quarterwave which ever is the smaller. This value is used to prevent the monitor from 

recognizing peaks near the start of a layer that should not be counted. 

As an example consider a signal which starts at 45% rises to a peak of 67% and then 

falls. The minimum signal change is set to 2% and the minimum overshoot is 4%. The 

Runsheet specifies that the cut should be made at a final swing of 22%. At the start of 

deposition when the signal is 45%, the peak detection is disabled. When the signal 

reaches 47% peak detection is enabled. If signal were to fall back below 47%, peak 

detection would be disabled. As the signal rises to its maximum of 67%, the optical 

monitor maintains a record of the peak signal seen. As the signal starts to fall, peak 

detection is temporarily disabled until the signal has fallen by at least 2% (i.e. when it 

falls below 65%). When signal falls below 65%, the monitor then waits for the signal to 

fall below the minimum overshoot which is at a signal level of: 

 67 – (67-45) *0.04 = 66.12% 

Since this has already occurred when the 2% minimum signal change has been 

satisfied, the peak is recognized and logged as soon as the 2% minimum signal change 

has been met. 

If the Runsheet called for a single quarterwave of material to be deposited, the 

deposition would stop at this point. For the final swing of 22%, the monitor would wait 

until the signal had fallen to  

 67 – (67-45)*0.22 = 62.16% 

before stopping deposition for the layer. 

Peak Optical Monitor 

The peak optical monitor operates by sampling the signal data and looks for a zero 

slope in the signal. The zero slope is detected by comparing the latest signal value with a 

previous signal value. The peak monitor contains several features to minimize false peak 

recognition. Firstly the measured signal is passed through a mean filter. The size (in 

number of samples) of this filter is specified in the Filter Size (#samples) parameter. 

Initially, while the filter is filling up with samples, there will be no output values. Once 

the filter is full, for each sample read in, the filter will output a value that is the mean of 

the last filter size of samples read in. Also the oldest sample will be discarded to make 

room for the next sample. Thus this filter provides a moving average of the input signal 

data. 

Values generated by the mean filter are entered into a buffer. The size of this buffer is 

specified in the Buffer Size (#samples) parameter. The slope comparison is performed 

by comparing the oldest entry in the buffer with the newest. This comparison is only 

performed when the buffer has filled up with samples. Once the buffer has filled up, the 

oldest sample is discarded to make room for the next sample. The slope (as measured by 

the difference between the oldest and newest values) is compared to the required Slope 
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value. When the slope in the buffer has exceeded the required Slope a user-specified 

Match Count number of times, the peak is recognized.  

To use the Peak Optical monitor, deposition rate data must have been specified in the 

Machine Configuration file,  the Use Rate Data box must be checked on the Calculation 

tab, and a Sampling Rate must also be defined. 

Crystal Monitor Parameters Page 
The Crystal Monitor Parameters page controls the errors applied to layers when 

deposited using the crystal monitor model. 

 
 

For crystal monitoring, errors on one layer are assumed to be independent of errors 

present in deposited layers. You can define two sets of parameters for layer errors. The 

Mean Thickness Error and Thickness Error Standard Deviation are parameters for 

absolute errors that are independent of thickness. For these parameters the generated  

random error is added to the final layer thickness to produce the deposited layer 

thickness. 

Mean Proportional Thickness Error and Proportional Error Standard Deviation are 

parameters for proportional errors whose absolute magnitude is defined by the thickness 

of the layer. For proportional errors, the Layer thickness is modified as follows: 

Deposited Layer Thickness = Layer Thickness * (1 + Random Error) 

Where both Absolute and Proportional thickness errors have been defined, the 

Absolute errors are applied first and then the Proportional errors are applied. 

Calculation Page 
The calculation page provides control over the calculations performed by Simulator. 
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Plot Update Interval controls the rate at which the optical monitor signal plot is 

updated in terms of thickness of deposited material. Larger values cause the plot to be 

updated less frequently. This causes the simulation to run faster. 

Deposition Increment defines the amount of material that is deposited at each 

simulation step. Increasing this value will cause the simulation to run faster but at the 

expense of less accurate deposition results. 

The effect of variations in the deposition rate may be examined by defining deposition 

rate information in the Machine Configuration file (see below) and by checking Use Rate 

Data. When Use Rate Data is checked, a sample of the current optical signal will be 

taken every Sampling Interval seconds. 

 

Packing Density Errors 
Packing Density Errors have a more complicated specification than Wavelength and 

Signal Errors. Two error terms may be applied: A material error and a layer error. The 

material error is generated and applied once for each material for each “deposition” run. 

The layer error is generated and applied for each layer in each “deposition” run. These 

two error terms are set for each source and, for this reason, they are defined in the 

machine configuration. 

 
 

Material Mean Error and Material Standard Deviation specify the parameters for 

generating the material errors. These values are always constants. The Layer Mean Error 

and Layer Standard Deviation specify the parameters for generating the Layer Errors. 

These may either be constant or vary as a function of deposited thickness. The deposited 
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thickness may either be the thickness deposited from the source (select On Source in the 

Variation Dependence column), or the thickness deposited from all the sources (select On 

Total in the Variation Dependence column. The thickness units used for the tables 

defining the variation of layer parameters are those of the dynamic tooling factor 

thickness units and are specified on the General tab. For information on defining the 

tables see Defining Varying Parameter Tables. 

Packing density errors are proportional errors. The packing density of the “deposited” 

layer is given by (1.0 + M + L) * (actual packing density) where M is the material error 

and L is the layer error. 

Tooling Factor Errors 
Tooling Factor Errors are specified and applied in the same way as Packing Density 

Errors except that they modify the final thickness of the layers and not the packing 

density. Furthermore, separate tooling factor errors are specified for optical monitoring 

and for quartz crystal monitoring. These errors are specified in the machine configuration 

on the Optical Tooling Errors tab and on the Crystal Tooling Errors tab. 

 

 

Deposition Rate Variation 

 
 

Variations in deposition rate are modeled in the Deposition Rate Variation tab of a 

Machine Configuration. Deposition rates for each source are defined in the Sources tab, 

the Deposition Rate Variation tab then specifies, for each source, parameters for varying 

the rate. The deposition rate varies linearly from one rate to another. At the start of a 

layer, the deposition rate is given by the deposition rate defined on the Sources tab + an 

offset given by a random number drawn from a population with a mean given by Rate 
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Mean Error and a standard deviation given by Rate Standard Deviation. This rate will 

change linearly until it reaches a new rate. The new rate is given by the source deposition 

rate + another offset given by a new random number. The time at which the new rate is 

reached is given by a random time value drawn from a population with mean Mean 

Change Interval and standard deviation Change Standard Deviation.  

When the simulation has reached the new rate, another time value is generated and a 

new rate to be achieved at that time value is also generated. Deposition then continues 

with the deposition rate linearly varying such that the new rate at the new time is met. 

Executing the Model 

Once all the model parameters have been established, the model can be executed by 

clicking the Run button. This will show the monitoring progress screen that provides 

details about the progress of the model.  

 
 

The monitoring progress screen provides information for layers that are optically 

monitored. Signal shows the instantaneous signal level in the Simulator. Previous 

Extremum, Current Extremum and Swing show information about the state of the 

optical monitor. Current Extremum shows the value of the most recently recognized 

extremum. Previous Extremum shows the value of the extremum that was recognized 

before the current extremum. Swing indicates the current signal level expressed as a 

percentage of the range between Previous Extremum and Current Extremum i.e. 

𝑆𝑤𝑖𝑛𝑔 = 100
𝑆𝑖𝑔𝑛𝑎𝑙 − 𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐸𝑥𝑡𝑟𝑒𝑚𝑢𝑚

𝑃𝑟𝑒𝑣𝑖𝑜𝑢𝑠 𝐸𝑥𝑡𝑟𝑒𝑚𝑢𝑚 − 𝐶𝑢𝑟𝑟𝑒𝑛𝑡 𝐸𝑥𝑡𝑟𝑒𝑚𝑢𝑚
 

 

Peak, Trough and Proportion provide information about the recent history of the 

monitoring signal. Peak is the highest signal value seen since the last Trough. Trough is 

the lowest signal value seen since the last Peak. Proportion is the current signal level 

expressed as a proportion of the Peak to Trough range. 
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The Show Signal checkbox turns the signal plot and information on and off. Turning 

the display off causes the simulation to run faster at the expense of not being able to see 

the signal variation during layer deposition. When deposition rate is being used, the 

Show Rate checkbox controls the display of deposition rate information. 

Cancel stops the simulation and returns you to the Simulator parameters window. Any 

runs that have been completed will be saved and are available for analysis. 

Pause At The End Of Each Layer toggles between continuous simulation and 

stopping at the end of each layer. When Pause At The End Of Each Layer is checked, 

the simulation will stop at the end of each layer. Press the Continue button to continue 

the simulation. 

To pause simulation at a particular layer, enter the layer number into the Stop at 

Layer box. When Simulator reaches the layer, it will stop deposition and await the next 

command. 

Terminate Now allows you to force termination of a layer at the point when you click 

the button. This can be used to simulate a manual monitoring technique or to force the 

simulation to move on to the next layer because the optical monitor has not correctly 

recognized the end of a layer. 

After Simulator has completed, the performance of all of the designs produced can be 

displayed by selecting Plot from the Performance menu. The Parameters menu allows 

you to alter the performance parameter that is calculated. All the designs produced by 

Simulator are stored in the Output Folder. The designs can be individually opened and 

examined. 

Defining Varying Parameter Tables 
Many of the parameters that can be defined in Simulator can be expressed as function 

of some independent variable as well as having a constant value. These functions are 

defined by creating a table and entering data values. The table is then saved and the file 

name is entered into the appropriate text box on the Simulator parameters form. Tables 

may also be specified in a Machine Configuration and a Runsheet. 

Where varying parameters can share a common independent variable such as mean 

and standard deviation, they can be defined in a single table. A type indicator is used to 

define the data that is contained in each column of the table. 

To create a table, select Table from the New sub-menu of the File menu. You will be 

asked to specify the number of columns required. This should be the number of 

dependent variables required plus one for the independent variable. Clicking OK will 

display a blank table with the requested number of columns. 

Next define the titles and content of each of the columns of the table. This is done 

with the Edit Columns option in the Edit menu. 
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A column is defined by three parameters: Heading, Format, and Type. Heading is the 

text that will be displayed as the column header, Format is used to format the values in 

each row of the column and Type defines the data that is in the column. For the varying 

parameter tables, the type must be correctly defined. The Previous and Next buttons are 

used to move to the other columns in the table. 

The independent variable in a varying parameter table must always be in the leftmost 

column. This is usually of type Wavelength or Thickness. The dependent variables may 

be in any of the remaining columns and must have their types correctly set. 

The following table lists the Simulation parameters, the corresponding table column 

types and the independent variable type. 
 

Simulation Parameter Table Column Type 

Independent 

Variable 

Type 

Signal Mean Error1 Signal Mean Error Wavelength 

Signal Standard 

Deviation1 
Signal Standard Deviation Wavelength 

Optical Tooling Factor:  

Layer Mean Error2 
Optical Tooling Factor Mean Error Thickness 

Optical Tooling Factor:  

Layer Standard Deviation2 
Optical Tooling Factor Standard Deviation Thickness 

Crystal Tooling Factor:  

Layer Mean Error2 
Crystal Tooling Factor Mean Error Thickness 

Crystal Tooling Factor:  

Layer Standard Deviation2 
Crystal Tooling Factor Standard Deviation Thickness 

Packing Density:  

Layer Mean Error2 
Packing Density Mean Error Thickness 

Packing Density:  

Layer Standard Deviation2 
Packing Density Standard Deviation Thickness 

Monitor Spectrum3 Spectral Weight Wavelength 
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Simulation Spectrum3 Spectral Weight Wavelength 

 

1) This parameter is found in Simulator 

2) This parameter is found in Machine Configuration 

3) This parameter is found in Runsheet 

 

Once the columns have been defined, the values may be entered by typing values into 

the cells of the table. Complete tables may also be pasted in from the clipboard. 

External Tab: Altering the Monitoring Algorithm 
When the enhancements Simulator and Function are both enabled, a script can be 

written that provides the monitoring algorithm to be used by Simulator. Script support is 

provided for narrow-band and wide-band optical monitoring. Layers monitored by crystal 

do not use scripts. When a script is used with Simulator, the script implements various 

functions that will be called by Simulator during execution of the simulation. As each 

function is called, various variables will contain updated values of simulation parameters. 

These values are to be used by the monitoring algorithm in the script as necessary. The 

script also has access to the Simulator data and through the Simulator object, the 

Runsheet data, the Machine Configuration data, the Design data and Materials data. 

 

The Browse button in the External Tab of Simulator accesses the Scripts folder and 

permits entry of the monitoring script name in the Monitor Script field. Full instructions 

on preparing the script and using it with Simulator are in the Scripting Manual that is 

contained in the Help Manual. 
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DWDM ASSISTANT 
The DWDM Assistant designs bandpass filters using the method of symmetrical 

periods. The DWDM Assistant is started by clicking on DWDM Assistant in the Tools 

menu. 

The DWDM Assistant is organized as a series of tabbed pages. The first four pages 

are used to enter the specification of the bandpass filter and to provide constraints on the 

design process. Once all the information has been entered, you click the Generate button. 

The DWDM Assistant then starts the process of designing the filters. Properties of the 

generated designs are displayed in the last tabbed page. A particular design can be 

examined in detail by double-clicking on the desired row in the Results page. 

The DWDM Assistant limits itself to the design of the quarterwave layers in the filter. 

Often a simple anti-reflection coating is applied to the front of the coating or to the 

substrate before the quarterwave layers are deposited. This anti-reflection coating is 

easily designed by using refinement to adjust the thicknesses of the anti-reflection coating 

layers to give the best transmittance. 

Specification Page 
After selecting the DWDM Assistant option from the Tools menu, the DWDM 

Assistant form will be displayed. The form is split into several tabbed pages that deal 

with different aspects of setting up design process. The first page that is displayed is the 

Specification page. 

 
 

The filter is specified in terms of center wavelength, a minimum bandwidth, up to 

three maximum bandwidths and a ripple performance. The minimum bandwidth is the 

bandwidth at the outermost peaks of the filter. In general, a bandwidth specified at a 

specific transmission level (such as –0.3dB or –0.5dB) will be slightly wider than the 

minimum bandwidth value. Each maximum bandwidth is specified at a particular 

transmission level. This allows you to enter specifications with multiple bandwidth 

limits. If you have less than three maximum bandwidth specifications, the remaining 

bandwidth specifications should be empty. The ripple specification may be given for a 

different width than the minimum bandwidth. This allows you to specify a filter with a 

ripple requirement over a narrower range than the minimum bandwidth. The ripple is 
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measured as the difference between the highest and lowest transmittance in the ripple 

bandwidth. The ripple bandwidth is always centered over the center wavelength. 

Materials Page 
The materials page is used to enter details of the materials to be used in the design. 

Material 1 and Material 2 specify the thin-film materials to use. It does not matter which 

box is used to define the high index material or the low index material. Time per 

Quarterwave 1 and Time per Quarterwave 2 specify the deposition time in arbitrary time 

units for a quarterwave of material 1 and material 2 respectively. These rates are used to 

estimate a total deposition time for each candidate design. The results can be sorted based 

on deposition time (as well as other parameters). 

 
 

Limits Page 
The limits page controls the extent of the search for bandpass filter designs. 

 
 

The Minimum Filter Order and Maximum Filter Order control the size of the largest 

cavities in the bandpass design. The size of a cavity is the filter order multiplied by one 

half-wave thickness. Cavities may be made from either high index material or low index 

material. 
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The Minimum Layers in Reflector and Maximum Layers in Reflector control the 

range of the number of layers between each cavity in the filter that form the reflectors 

either side of the cavity. 

The Minimum Number of Repetitions and Maximum Number of Repetitions 

control the limits on how much the central symmetrical period may be repeated. The 

more times the central period is repeated, the steeper the sides of the filter. 

A basic filter is constructed by repeating a central period a certain number of times 

and then providing matching structures to match the central period to the substrate and to 

the medium. This basic design may be sufficient to meet the ripple specification. If 

Always Reduce Ripple is not checked, then this design will be entered into the results 

table as a candidate design. If Always Reduce Ripple is checked, then regardless of the 

ripple performance of the design, the DWDM Assistant will always attempt to add extra 

matching structures to improve the ripple further. 

If the DWDM Assistant is adding extra structures to improve the ripple performance, 

there will, in general, be several structures that improve the ripple sufficiently to meet the 

ripple specification. If Only Keep Best Design After Ripple Reduction is checked then 

only the best design from the ripple reduction will be kept and entered into the Results 

page. If Only Keep Best Design After Ripple Reduction is not checked, then all designs 

generated during ripple reduction that meet the ripple specification will be entered into 

the results page. 

Sort Page 

 
 

The Sort page specifies how the candidate designs are to be sorted on the Results 

page. Candidate designs may be sorted by up to four parameters. The sort parameter is 

chosen from the selection offered after Sort By. The direction may also be specified. If 

Ascending is selected, then the smallest value of the chosen parameter will be displayed 

first. If Descending is selected, then the largest value of the chosen parameter will be 

displayed first. The Results page can be re-sorted after generating the designs by altering 

the Sort page and then clicking Resort. 
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Results Page 
The Results page displays all the candidate designs generated by the DWDM 

Assistant. Once all the parameters have been entered, click Generate to start the design 

process. The Results page will be automatically selected and the DWDM Assistant will 

enter designs as they are completed. You can stop the design process at any time by 

clicking the Halt button.  

 
 

The sample results page above shows some candidate designs. The leftmost untitled 

column shows the index of the main cavities. If H is displayed, then the cavities are made 

from high index material, and if L is displayed, then the cavities are made from low index 

material. The Delta Ripple column indicates the sensitivity of the design to a change in 

tooling factor. The thickness of the L layers is made slightly thicker and the thickness of 

the H layers is made slightly thinner. The Delta Ripple is the difference between the 

ripple of this new design and the ripple of the original design. A smaller Delta Ripple 

indicates a lower sensitivity. 

To look at a design in more detail, double-click in the gray selection column of the 

appropriate row at the left side of the page. This will cause a design to be generated 

containing the candidate design. The design below was generated by double-clicking on 

the highlighted row in the above results page. 
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This design has the performance shown below: 

4 
 

Zooming in on the performance in the passband, we can see we could improve the 

overall transmittance by adding an anti-reflection coating to the design. 
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Candidate designs produced by the DWDM Assistant can be saved by clicking the 

Save button. The candidates may be subsequently restored by clicking the Load button. 
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MONITORLINK for EDDY LMC-10 

Modifications to Runsheet 

Runsheet Defaults 

The Run Sheet… item in the Options menu activates a Run Sheet Defaults window 

with, normally, three tabs. However, in a Runsheet that has been configured by 

Monitorlink to suit a particular controller there may be an extra tab. The figures below 

show the regular window followed by that for the Eddy LMC-10 Controller, where there 

is an extra tab, Warnings. 

Please note that this description is devoted purely to the features of the enhancement 

to the Essential Macleod. It is no substitute for the manual for the monitor. 

The Machine Configuration tab is unchanged. 

 
 

The Signal Parameters tab shows two extra items. The regular Runsheet asks for 

Default Wavelength, Bandwidth and Wavelength Interval. These are described in the 

earlier section devoted to Runsheet. The two extra items are Auto-select Initial Signal 

and Default Initial Signal. The Eddy LMC-10 operates on the basis of a signal that varies 

between 0 and 1000 units, preferably between, say, 100 and 900 units. There is no offset 

and the gain is varied to adjust the signal level. In the mode of operation that yields 

programs for the Eddy controller, the gain and zero offset columns are therefore 

suppressed. The Runsheet generator is set automatically to vary the gain with the option 

either of a given level for the starting signal, or a maximum signal excursion which is 

determined by making the largest signal coincide with the upper limit. When Auto-select 

Initial Signal is checked, Runsheet maximizes the upper signal level. When Auto-select 

Initial Signal  is unchecked the initial signal level is set to coincide with the Default 

Initial Signal Level. In either case, however, adjustments will be made if the signal for at 

least part of the layer is outside the allowed range. 

Monitor Mode, the next tab, is simply transmittance or reflectance as before. 
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Warnings relate to various signal levels and termination conditions. Single-

wavelength monitoring processes give best precision when there is an overshoot that is 

reasonably large but not too large. The default values are simply suggestions. The signal 

levels shown of 100 and 900 units are chosen to be comfortably within the 0 to 1000 limit 

of the Eddy LMC-10 Controller so that an unexpectedly large signal excursion can still 

be accommodated. 

 
 

Machine Configuration 

There are some additions to the Machine Configuration. The first is in the Edit menu 

that now has two additional items, Eddy Machine Configuration and Generic Machine 

Configuration. The first gives the special form of the configuration for use with the Eddy 

monitor while the second gives the configuration already described in the Runsheet 

section of the manual. 

 
 

There are two differences in the Eddy version. The first is that a Grating Calibration 

Factor is to be entered. This tells the system the order of diffraction that is being used in 

the grating monochromator. 

Then in the Sources tab there is an extra column, Initial Signal. This is an initial 

signal that is set against each source of material and overrides the global default if 

entered. 
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The Edit menu has a new item, Load Eddy Materials. The Eddy controller stores 

information about the materials and sources that are available. Each source is numbered 

and the name of the material is attached, together with other operating details. The Eddy 

Editor can download this information and edit it and can also store it in .edm files. In fact 

it is possible to maintain many such files. The Load Eddy Materials menu item opens a 

given Eddy materials file and loads the sources and material names into the Machine 

Configuration Sources tab. It attempts also to map these names to the existing Essential 

Macleod active materials database. The appearance of the sources table in a new machine 

configuration is shown next. The Source column shows the Eddy source number 

together with the name and in the Material column the suggested mapping to the current 

database. All that remains to be done to complete the table is entry of the various tooling 

factors. 

 
 

Runsheet 
There is a new menu, Eddy. The commands in this menu are described below. 

Program Parameters asks for information that is for use by the Eddy controller itself. 
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Program Number will identify the program once it is completed.  

Chip temperature is purely for use by the controller. 

Overshoot is the percentage overshoot that must be measured by the controller before 

it recognizes a peak. This parameter has an immediate influence on the generation of the 

Runsheet, which will give a warning should any layer be requiring a termination with 

smaller overshoot. 

Noise Rejection Level is also an Eddy controller parameter that has an influence on 

the Runsheet generator. Here the total signal swing must exceed a value that is related to 

the Noise Rejection Level. Again a warning will be given should the necessary condition 

be infringed. 

Note that the presence of these warnings will prevent the exporting of an Eddy 

program. The warnings must first be cleared. 

In the same menu there is also the item Warnings… These are warnings identical in 

type to those in the global Runsheet options but here they are local ones that apply to all 

layers in the particular active Runsheet only. Some of them are related to the Program 

Parameters just mentioned but here they are more of the nature of desirable targets. 

They will, of course, trigger warnings just like the others and will prevent export of the 

program but they can be changed if necessary. 

 
 

Show Percent Values and Show Signal Level Values change from one style of 

presentation to the other. The percent values correspond to the generic Runsheet while 

the signal level values correspond to the special form for the Eddy controller. The form of 

the Runsheet with the signal level values selected is shown in the next figure.  
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In fact, this design as it stands is not very suitable for monitoring all on one substrate. 

Warning messages similar to the following are received. 

 
 

We need to change the monitoring arrangement to use more chips and either to change 

the tooling factor to move the layer thicknesses away from quarterwaves or to change the 

wavelength for the same reason. Here we make a small adjustment to the wavelength. 

With some trial and error we reduce this to 605nm and we deposit only two layers on 

each chip, the first being of high index.  

The cut ranges from 6% to 27%(layer 10, the cavity layer) and now the program can 

be exported. 
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The Eddy LMC-10 Monitorlink Editor 
The appearance of the Eddy Editor Application window is shown in the following 

figure. 

 
 

The Menus are described in detail in the Help facility, accessed by selecting Contents 

or Search for Help on… in the Help menu. 

Programs and materials may be stored on the actual controller itself or in a series of 

files on disk. The File menu concerns those programs and material lists that are actually 

saved on disk. The Eddy menu concerns those materials and programs that are stored in 

the controller. The Options menu sets up the details of the serial port for communication 

with the Eddy controller. The usual settings will be the default ones that are shown in the 

Serial Port Options dialog that follows. 

 
 

The Password items concern the putting and getting of data to and from the Eddy 

controller. 

The principal menu items from the point of view of the control programs are in the 

File menu. Here programs may be loaded from the Essential Macleod by selecting Open 

Program… when a selection box for programs exported from the Essential Macleod is 

presented. Two such programs are shown following. The first is a simple program 

representing a five-layer antireflection coating. The second is the narrowband filter 

program that we have been using as an illustration. These programs can be edited in the 

Eddy Editor in the normal way. Note the toggling of insert and overstrike modes by 

pressing the insert key as in the Essential Macleod. The Drop Chip column should be 

considered as referring to the action before the start of deposition of the particular layer. 

Therefore the entry On means that a fresh chip will be used while Off means that 

deposition will continue on the existing chip. 
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Programs can also be entered manually. The New submenu under the File menu 

allows a new set of materials or a new program to be created. The following figure shows 

a materials list. Each material has a number, from 1 to 99, and a name, the number being 

the definitive identifier. A and B Outputs and Inputs determine the power, configuration, 

shutters return signals and so on connected with the particular source. E Gun Voltage is a 

number from 1 to 10 denoting the voltage in units of 1000V for an electron beam source. 

 
 





Monitorlink for Inficon XTC  395 

MONITORLINK for INFICON XTC 

Introduction 
Monitorlink for the Inficon XTC deposition controller provides facilities for 

converting an Essential Macleod design into a XTC deposition specification. This 

deposition specification is uploaded by a separate program into the XTC controller. For 

specific details about the XTC controller, please refer to the XTC manual. 

The mapping of Essential Macleod materials into film parameters for the XTC is 

defined once by the user. Thereafter, the Essential Macleod automatically converts 

materials and layer thicknesses into the correct film parameters for the XTC. 

Monitorlink provides facilities for managing the film specifications. Films may be 

added and deleted from the file. Designs may also be edited directly in terms of the XTC 

film parameters. Complete film definitions may be downloaded from the XTC and saved 

on a disk. 

Using Monitorlink for XTC 
The Monitorlink facilities are provided through the Tools menu and through the File 

menu of a design. The Tools menu provides a sub-menu: XTC, and this has three options: 

Open Film Parameters, Open Deposition File and New Deposition File. 

Defining a Material Mapping 

The material mapping defines the relationship between materials in the Essential 

Macleod and film parameters in the XTC controller. It is assumed that the only difference 

between layers of the same material is that the thickness may vary. All other parameters 

are constant. If the other film parameters are not the same for films of different 

thicknesses, then either a new material can be created in the Essential Macleod which is 

then given the different set of parameters, or the film definition can be edited manually. 

Each materials database has its own mapping from materials to film parameters. 

Each material in the Essential Macleod has its own set of film parameters. When 

Open Film Parameters is selected a material chooser is displayed.  

Select the material whose film parameters you wish to define or edit and then click 

OK. The film editor then appears. All of the XTC film parameters may be edited. 
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Once all of the XTC film parameters have been edited, the film parameters may be 

saved by selecting Save from the File menu. Whenever a design containing layers using 

this material is converted to an XTC film specification, these parameters will be used in 

the controller file. 

Converting an Essential Macleod Design 

In order to convert an Essential Macleod design into an XTC film specification, the 

film parameters for each of the materials used must have been previously defined. The 

design is converted by simply selecting XTC Deposition File from the Export sub-menu 

of the File menu. This will create a new XTC film specification for the design. 

 
 

When a design contains repeating layers of the same material and thickness such as a 

quarterwave stack, Monitorlink converts the design into film specifications for each of 

the unique layer material and thickness combinations, and then writes a deposition 

sequence instruction for an operator to follow. 

 
 

The contents of this file can then be saved ready for uploading to the XTC controller 

by the XTC communications program – XTC Editor. 

Open Deposition File will open an existing deposition file for editing in the Essential 

Macleod, and New Deposition File will create a new deposition file which can be filled 

with film specifications. In addition to the film specifications and the process definition 

parameters, the process and film specifications have an extra parameter Copy to XTC. 
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When this parameter is checked, the XTC editor will upload the specification to the XTC 

controller. If Copy to XTC is not checked, then the XTC editor will not upload the film 

specification or process definition to the XTC controller. 

The XTC Editor 
The XTC Editor provides facilities for maintaining and editing complete XTC film 

specifications. It also provides communications facilities for uploading and downloading 

film specifications to and from the XTC controller. 

 
 

A serial cable (not provided) is required to allow the XTC editor to communicate with 

the XTC controller. The XTC manual contains details on the specification of this cable. 

The XTC Editor can open film specifications saved in the Essential Macleod. These 

specifications can then be uploaded to the XTC. 

Before a film specification can be uploaded, or downloaded, the serial link 

information must be specified. This is performed by selecting Options. The Port 

Number is the serial port number used on the computer. The Baud Rate must be the 

same as defined on the XTC.  

 
 

Once the Options have been set up, the XTC Editor is ready to communicate with the 

XTC controller. To upload a film specification to the XTC controller, select Send to XTC 

from the File menu. 
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Progress in sending the film specifications to the XTC is shown. When completed, the 

progress form disappears. If there are any problems in sending the data, an error message 

will be displayed. Often the problem can be resolved by checking the serial cable 

connecting the computer to the XTC and resetting the XTC by turning it off and then on 

again. Occasionally, it may be necessary to restart the XTC editor to clear the problem. 

Films may be downloaded from the XTC by selecting Get from XTC from the File menu. 

A new film specification window will be created containing the downloaded data. This 

can be saved to disk in the usual manner.
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MONITORLINK for APPLIED VISION 
PLASMACOAT 

Introduction 
Monitorlink for Applied Vision Ltd’s PlasmaCoat coating system provides facilities 

for converting an Essential Macleod design into a PlasmaCoat production specification. 

This production specification is automatically placed, by the Essential Macleod, into the 

Players.dat file used by the PlasmaCoat system. 

The mapping of Essential Macleod materials into control parameters for the 

PlasmaCoat system is defined once by the user. Thereafter, the Essential Macleod 

automatically converts materials and layer thicknesses into the correct control parameters 

for the PlasmaCoat system. 

A pre-deposition phase may also be specified. The pre-deposition phase may be used, 

for example, to perform substrate cleaning or deposition of a thin adhesion layer. The 

predeposition phase is always inserted in the production specification before the design’s 

layers are specified. 

Monitorlink provides facilities for managing the contents of the Players.dat file. 

Production specifications may be added and deleted from the file. Designs may also be 

edited directly in terms of the PlasmaCoat control parameters. 

Using Monitorlink for PlasmaCoat 
The Monitorlink facilities are provided through the Tools menu and through the File 

menu of a design. The Tools menu provides a sub-menu: PlasmaCoat, and this has three 

options: Open Materials, Open Predeposition Phase and Open Design File. 

Defining a Material Mapping 

Open Materials displays a window that defines the mapping between the Essential 

Macleod materials and the PlasmaCoat control parameters. Each materials database has 

its own mapping from materials to control parameters. 

 
 

Each line in the Materials display defines a mapping from a single material to the 

PlasmaCoat control parameters. For a description of the PlasmaCoat parameters, please 

refer to the PlasmaCoat documents. 
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Defining a Predeposition Phase 

Open Predeposition Phase displays the predeposition phase that will be applied to all 

designs that are converted from the Essential Macleod format. The predeposition phase is 

defined as a sequence of PlasmaCoat control parameters that are executed starting with 

the top row and then proceeding down the list. A predeposition phase need not be 

defined, in which case, only the design’s layers will be present in the resulting Players.dat 

file. 

 
 

The figure above shows a predeposition phase consisting of thirty seconds of substrate 

cleaning. 

Converting an Essential Macleod Design 

In order to convert an Essential Macleod design into a PlasmaCoat specification, the 

PlasmaCoat players.dat file must first be loaded into the Essential Macleod. This is 

achieved through the Open Design File menu option. After the user has selected the 

Players.dat file to be loaded, a list of the designs contained in the Players.dat file is 

displayed 

 
 

With the design file loaded, an Essential Macleod design may be added to the 

PlasmaCoat design list. Also, designs may be edited, deleted and renamed. 

As an example, a small quarterwave stack will be added to the design file. The design 

is shown below 
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To convert the design, select Export in the File menu and then select PlasmaCoat 

Design. You will then be asked to enter the name of the design to be used in the 

PlasmaCoat file. By default, this name will be the same as the name of the Essential 

Macleod design. 

 
 

After clicking OK, the design will be converted and loaded into the PlasmaCoat 

designs window. At this stage the PlasmaCoat design has not been saved to disk. You 

will be informed of the total thickness of the design and the deposition time including any 

predeposition phase. 

 
 

The PlasmaCoat specification of the design can now be viewed by double-clicking on 

the design name in the PlasmaCoat Designs window. 
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This window shows the quarterwave stack converted to a PlasmaCoat specification 

The predeposition phase defined above has also been added to the PlasmaCoat 

specification. 

The set of PlasmaCoat designs can be saved to disk by the Save command, or the 

Save As command if a new file name is desired, in the File menu. 
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MONITORLINK for LEYCOM IV with OMS3000 

Introduction 
The Monitorlink for Leycom IV with OMS3000 provides the ability to create a 

process data file for import into the remote control software for the Leycom IV. 

Modifications to Runsheet 

This Monitorlink converts data held in Runsheet and its associated Machine 

Configuration into a process data file suitable for import into the remote control software 

for the Leycom IV. 

To start the export, select the Leybold IV/OMS3000 command in the Export menu, 

which is a sub-menu of the File menu. The export parameters form will be displayed.  

 
 

The form must be completed with the extra information required to complete the 

export process. Three types of witness chip are supported: TGW6, TGW50 and 

TGW100. The TGW6 has six chips that may be reused during the deposition process. 

The TGW50 has 50 chips, but the chips may not be reused during the deposition process. 

The TGW100 has 100 chips, but the chips may not be reused during the deposition 

process. The Filename is the name of the file that will contain the process data. Click 

Choose to specify the filename. 

Clicking the OK button will cause the Runsheet to be checked for errors. If there are 

no errors, the process data file will be written. Clicking the Cancel button will abort the 

export process. 

The process data file is built as follows: The step number always starts at 1. The layer 

set name used in the process data file will be the name of the source in the machine 

configuration used by the Runsheet. The optical thickness is the value given in the 

Optical Thickness on Monitor Chip column of the Runsheet. This is the optical thickness 

at the monitoring center wavelength. The refractive index at the monitoring center 

wavelength is the refractive index to be used by the optical monitor. The witness chip 

column contains the chip number to be used when the TGW6 magazine has been 

specified. When the TGW50 or TGW100 magazines have been specified, the witness 

chip column contains a 1 to indicate that a new chip is required and a 0 where the chip is 

not changed. 
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MONITORLINK for INFICON IC/5 

Introduction 
Monitorlink for the Inficon IC/5 deposition controller provides facilities for 

converting an Essential Macleod design into an IC/5 process specification. This process 

specification is uploaded by a separate program into the IC/5 controller. For specific 

details about the IC/5 controller, please refer to the IC/5 manual. 

The software assumes that, normally, all layer parameters in the IC/5 apart from 

thickness are the same for each layer of the same material in the Essential Macleod. Thus, 

when a design is exported to the IC/5, the Essential Macleod will look up layer 

parameters according to the material used for each layer and add in the thickness of each 

layer. Conversion to kiloAngstrom units is performed automatically. The mapping of 

Essential Macleod materials into layer parameters for the IC/5 is defined once by the 

user. Each materials database contains its own set of layer parameters. If you have several 

IC/5 controllers that use different layer parameters for the same material, then you should 

set up a separate materials database for each IC/5. Using the correct materials database 

before exporting a design will ensure that the correct layer parameters are used. 

If you already have layer parameters setup in the IC/5 controller, you can download 

them using the IC/5 and save the process data to disk. In the Essential Macleod, you can 

open the process data file and copy a layer parameter set. To associate the layer 

parameter set with a particular material, open the IC/5 material parameters for the 

material and then use the paste command in the edit menu. All the parameters apart from 

the layer thickness will be copied into the material information. See below for more 

information. 

Monitorlink provides facilities for managing the film specifications. Films may be 

added and deleted from the file. Designs may also be edited directly in terms of the IC/5 

film parameters. Complete process definitions may be downloaded from the IC/5 and 

saved on a disk. 

Using Monitorlink for IC/5 
The Monitorlink facilities are provided through the Tools menu and through the File 

menu of a design. The Tools menu provides a sub-menu: IC/5, and this has three options: 

Open Material Parameters, Open Process File and New Process File. 

Defining a Material Mapping 

The material mapping defines the relationship between materials in the Essential 

Macleod and layer parameters in the IC/5 controller. It is assumed that the only 

difference between layers of the same material is that the thickness may vary. All other 

parameters are constant. If the other layer parameters are not the same for layers of 

different thicknesses, then either a new material can be created in the Essential Macleod 

which is then given the different set of parameters, or the layer definition can be 

manually edited. Each materials database has its own mapping from Essential Macleod 

materials to IC/5 layer parameters. 
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To modify the layer parameters for a particular material, select Open Material 

Parameters from the IC/5 sub-menu of the Tools menu. A material chooser is then 

displayed.  

Select the material whose layer parameters you wish to define or edit and then click 

OK. The layer editor then appears. All of the IC/5 layer parameters (apart from thickness) 

may be edited. 

 
 

Once all of the IC/5 layer parameters have been edited, the layer parameters may be 

saved by selecting Save from the File menu. Whenever a design containing layers using 

this material is converted to an IC/5 layer specification, these parameters will be used in 

the process file. 

Converting an Essential Macleod Design 

In order to convert an Essential Macleod design into an IC/5 film specification, the 

layer parameters for each of the materials used must have been previously defined. The 

design is converted by simply selecting IC/5 Deposition File from the Export sub-menu 

of the File menu. This will create a new IC/5 process specification for the design. 
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The contents of this file can then be saved ready for uploading to the IC/5 controller 

by the IC/5 communications program – IC/5 Editor. 

Open Process File will open an existing process file for editing in the Essential 

Macleod, and New Process File will create a new process file which can be filled with 

layer specifications. 

The IC/5 Editor 
The IC/5 Editor provides facilities for maintaining and editing complete IC/5 process 

specifications. It also provides communications facilities for uploading and downloading 

process specifications to and from the IC/5 controller. 

A serial cable (not provided) is required to allow the IC/5 editor to communicate with 

the IC/5 controller. The IC/5 manual provides the specification of this cable. 

The IC/5 Editor can open process specifications saved in the Essential Macleod. These 

specifications can then be uploaded to the IC/5. 

 
 

Before a layer specification can be uploaded, or downloaded, the serial link 

information must be specified. This is performed by selecting Options. The Port 

Number is the serial port number used on the computer. The Baud Rate must be the 

same as defined on the IC/5.  
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Once the Options have been set up, the IC/5 Editor is ready to communicate with the 

IC/5 controller. To upload a layer specification to the IC/5 controller, select Send to IC/5 

from the File menu. 

 
 

Progress in sending the process specification to the IC/5 is shown. When completed, the 

progress display disappears. If there are any problems in sending the data, an error 

message will be displayed. Often the problem can be resolved by checking the serial 

cable connecting the computer to the IC/5 and resetting the IC/5 by turning it off and then 

on again. Occasionally, it may be necessary to restart the IC/5 editor to clear the problem. 

Process specifications may be downloaded from the IC/5 by selecting Get all processes 

from IC/5 from the File menu. A new Process specification window will be created for 

each downloaded process. These can be saved to disk in the usual manner. 
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MONITORLINK for Sycon STC 

Introduction 
Monitorlink for the Sycon STC deposition controller provides facilities for converting 

an Essential Macleod design into a STC deposition specification. This deposition 

specification is uploaded by a separate program into the STC controller. For specific 

details about the STC controller, please refer to the STC manual. 

The mapping of Essential Macleod materials into film parameters for the STC is 

defined once by the user. Thereafter, the Essential Macleod automatically converts 

materials and layer thicknesses into the correct film parameters for the STC. 

Monitorlink provides facilities for managing the film specifications. Films may be 

added and deleted from the file. Designs may also be edited directly in terms of the STC 

film parameters. Complete film definitions may be downloaded from the STC and saved 

on a disk. 

Using Monitorlink for STC 
The Monitorlink facilities are provided through the Tools menu and through the File 

menu of a design. The Tools menu provides a sub-menu: STC, and this has three options: 

Open Film Parameters, Open Deposition File and New Deposition File. 

Defining a Material Mapping 

The material mapping defines the relationship between materials in the Essential 

Macleod and film parameters in the STC controller. It is assumed that the only difference 

between layers of the same material is that the thickness may vary. All other parameters 

are constant. If the other film parameters are not the same for films of different 

thicknesses, then either a new material can be created in the Essential Macleod which is 

then given the different set of parameters, or the film definition can be edited manually. 

Each materials database has its own mapping from materials to film parameters. 

Each material in the Essential Macleod has its own set of film parameters. When 

Open Film Parameters is selected a material chooser is displayed.  

Select the material whose film parameters you wish to define or edit and then click 

OK. The film editor then appears. All of the STC film parameters may be edited. 
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Once all of the STC film parameters have been edited, the film parameters may be 

saved by selecting Save from the File menu. Whenever a design containing layers using 

this material is converted to an STC film specification, these parameters will be used in 

the controller file. 

Converting an Essential Macleod Design 

In order to convert an Essential Macleod design into an STC film specification, the 

film parameters for each of the materials used must have been previously defined. The 

design is converted by simply selecting STC Deposition File from the Export sub-menu 

of the File menu. This will create a new STC film specification for the design. 

 
 

When a design contains repeating layers of the same material and thickness such as a 

quarterwave stack, Monitorlink converts the design into film specifications for each of 

the unique layer material and thickness combinations, and then writes a deposition 

sequence instruction for an operator to follow. 

 
 

The contents of this file can then be saved ready for uploading to the STC controller 

by the STC communications program – STC Editor. 
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Open Deposition File will open an existing deposition file for editing in the Essential 

Macleod, and New Deposition File will create a new deposition file which can be filled 

with film specifications. In addition to the film specifications, there is an extra parameter 

Copy to STC. When this parameter is checked, the STC editor will upload the 

specification to the STC controller. If Copy to STC is not checked, then the STC editor 

will not upload the film specification to the STC controller. 

The STC Editor 
The STC Editor provides facilities for maintaining and editing complete STC film 

specifications. It also provides communications facilities for uploading and downloading 

film specifications to and from the STC controller. 

A serial cable (not provided) is required to allow the STC editor to communicate with 

the STC controller. The STC manual contains details on the specification of this cable. 

The STC Editor can open film specifications saved in the Essential Macleod. These 

specifications can then be uploaded to the STC. 

 
 

Before a film specification can be uploaded, or downloaded, the serial link 

information must be specified. This is performed by selecting Options. The Port 

Number is the serial port number used on the computer. The Baud Rate must be the 

same as defined on the STC.  
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Once the Options have been set up, the STC Editor is ready to communicate with the 

STC controller. To upload a film specification to the STC controller, select Send to STC 

from the File menu. 

 
 

Progress in sending the film specifications to the STC is shown. When completed, the 

progress form disappears. If there are any problems in sending the data, an error message 

will be displayed. Often the problem can be resolved by checking the serial cable 

connecting the computer to the STC and resetting the STC by turning it off and then on 

again. Occasionally, it may be necessary to restart the STC editor to clear the problem. 

Films may be downloaded from the STC by selecting Get from STC from the File menu. 

A new film specification window will be created containing the downloaded data. This 

can be saved to disk in the usual manner
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MONITORLINK for SC Technology 820 

Introduction 
Monitorlink for the SC Technology 820 optical monitor provides adds monitoring 

data to be used by the SC Technology 820 to the Runsheet file. For specific details about 

the 820 optical monitor, please refer to the SC Technology 820 manual. 

Using Monitorlink for SC Technology 820 
The data that are used by the SC Technology 820 are held in the Runsheet file. 

The wavelengths that are to be used are specified by the Machine Configuration used 

by Runsheet. In the Machine Configuration Editor, you can specify the wavelength range 

on the Wideband tab. 

The Runsheet menu in the Runsheet editor contains commands for plotting the 

spectral data. These commands are discussed in the Runsheet chapter of this manual. 
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MONITORLINK for LEYBOLD LMR & LDD 
Compatible Systems 

Introduction 
Some Leybold coating machines (including the SYRUSpro and Helios) support 

communication of monitoring information and material dispersion data via two Leybold 

defined file formats: Leybold Monitoring Report and Leybold Dispersion Data. The 

Essential Macleod can import and export both of these Leybold formats. 

Materials 
Material dispersion data are communicated in the Leybold Dispersion Data file. This 

file normally has a .ldd extension. To create an ldd file from an existing material, open 

the material. From the File menu, select Export and then Leybold LDD… A file chooser 

will be displayed. Enter the name of the ldd file and click Save. This will write the 

material data into the file in the ldd format. 

The data in an ldd file can also be imported as a new material. To open an ldd file, 

select Open from the File menu. A file chooser will be displayed. Change the Files of 

type to All files (*.*). Select the ldd file and click Open. The ldd material data will appear 

in a new material window. 

Runsheet 
Runsheet data are communicated in the Leybold Monitoring Report file. This file 

normally has a .lmr extension. To create an lmr file from an existing runsheet, open the 

runsheet. From the File menu, select Export and then Leybold LMR… A file chooser will 

be displayed. Enter the name of the lmr file and click Save. This will write the runsheet 

data into the file in the lmr format. Note: In use, the XML schema file (.xsd extension) 

that is used by, and supplied with, the Leybold software, should be in the same folder as 

the LMR file. 

The data in an lmr file can also be imported into the Essential Macleod. The lmr file 

contains material data and the design. To open an lmr file, select Open from the File 

menu. A file chooser will be displayed. Change the Files of type to All files (*.*). Select 

the lmr file and click Open. The window below will appear. 
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The buttons on this window are used to open the various elements of the lmr file. To 

open a material definition in the list, select the material by clicking on it and then click 

Open Material to display the data in a new material window.  
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MONITORLINK for Laser Zentrum Hannover 
Broadband Optical Monitor 

Introduction 
Data can be loaded into the Laser Zentrum optical monitor from a Spektrum formatted 

file. As well as design information, this format can include optical monitor parameters 

such as Rate, Gamma, History, and Delay for each material and up to five wavelength 

ranges with weights where the optical monitor is to collect data. All this information can 

be stored by the Essential Macleod and exported from a Runsheet. A Spektrum file can 

also be exported from the Design window, but in this case the Runsheet-related 

information cannot be included. 

Machine Configuration 
The Machine Configuration is used to store the material-related optical monitor 

parameters: Rate, BBM-CalcPar, Gamma, History and Delay. The Deposition Rate data 

is taken from the Machine Configuration’s Deposition Rate column in the Sources tab. 

The other information is entered via a separate dialog. To enter this information, select a 

source by clicking in the gray box at the left end of the appropriate Source row. Then 

from the Edit menu select Edit User Data… The Edit User Data window will appear. 

 

For each parameter, enter its name in the Name column and the value to be associated 

with the parameter in the Value column. During export, these values will be written to the 

Spektrum file along with the material data. Note that the names must be exactly as 

written here. Any other name/value pairs will not be exported. 

The full bandwidth of the optical monitor must be specified on the Wideband tab of 

the Machine Configuration. Wideband Available must also be checked. The Wavelength 

Interval is not exported but is used during wideband calculations in Runsheet. 

Runsheet 
The optical monitor can measure spectral data from up to five wavelength regions per 

layer.  These wavelength regions can be defined in Runsheet using the Wavelength 

Range columns.  Each of the five wavelength range column sets can be individually 

displayed using the Display Setup command in the File menu. There are three columns 
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in each column set: Wavelength Start, Wavelength End and Weight. For more 

information about these parameters, please consult the optical monitor’s manual. Values 

entered in these columns will be exported to the Spektrum file. Additionally, the 

Wideband plotting commands in the Runsheet menu will show the locations of the 

wavelength ranges on the plots. Wavelengths within the specified ranges will be shown in 

the usual colors. Wavelengths outside all ranges will be shown using a faded color with 

boundary markers at each wavelength edge. 

To export the Runsheet, select Spektrum Design… from the Export menu located in 

the File menu and provide the requested filename.  
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THE ESSENTIAL MACLEOD LICENSE SYSTEM  

Introduction 
The Essential Macleod has a built-in licensing system. When the Essential Macleod is 

fully licensed, it operates invisibly. After initial installation of the Essential Macleod, the 

software is licensed for a 15-day period. This allows you to use the software as soon as 

you have installed it, and allows time for you to obtain the full license. When the 

software is not fully licensed, you will be reminded, each time you start the Essential 

Macleod, of the number of days left on the initial license. There are two types of license 

available: a Transferable License or a Fixed License. A transferable license can be moved 

from one computer to another (by following the instructions below). A fixed license 

cannot be transferred from one computer to another, but you can make a backup copy of 

the license. A fixed license is only available for certain computers. Availability can only 

be determined after the key request has been made. 

Obtaining a Full License 
To obtain a Full License, you must register the Essential Macleod. Thin Film Center 

will then supply you with a key that must be entered into the Essential Macleod. Once the 

key has been successfully entered, the program will be fully licensed. Telephone, fax or 

e-mail can be used for transferring the information between you and Thin Film Center. 

To register the Essential Macleod either click Request Key… on the Limited License 

message that appears when you start the Essential Macleod, 
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or select Register from the Options menu of the Essential Macleod. 

The registration window will appear. The registration window contains a series of 

pages to be read and completed. The first page contains the license agreement. When you 

register the software, you accept the terms of the license agreement. 

 
 

Click Next to advance to the next page. On this page and the next three pages you will 

be asked to enter your user information and any comments. You will also be shown 

information that will be included with the registration data. The final page presents you 

with several options for sending the data to Thin Film Center. 

 
 

Depending upon the setup of your computer, some of these options may not be 

available. 

You can click the Internet button to send the data to Thin Film Center. Print will print 

out the data on your printer together with the fax number. Copy to Clipboard will put the 

registration data onto the clipboard so that you can paste it into another document. The 

best method for registration is send the data via the Internet, either by using the Internet 

button or by copying the data into a message in your e-mail program. 

When you have sent the registration to Thin Film Center, you will receive a Site Key. 

This is a set of letters and digits that must be entered into the Essential Macleod. To enter 
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the key, either select Have Site Key from the Limited License message that appears when 

you start the Essential Macleod or select License from the Options menu. The license 

form will appear. 

 
 

The form gives information about the status of your license. Paste or enter the Site 

Key into the Site Key field on this form and then click Validate. If you use the Paste 

button, the key will automatically be validated after it has been pasted. You will then get 

a message stating that the Site Key was accepted. Click OK in this message and then click 

Close in the License window. You can now use the Essential Macleod.  

If you urgently need a key, you can contact Thin Film Center by telephone. As it can 

be difficult to correctly hear letters spoken over the telephone, we recommend the use of 

the international phonetic alphabet. When you are asked to read out the Site Code, please 

click Show Code Words. This will display a window that has the Site Code written out 

as words. 

 
 

Please read these words, one line at a time, to the Thin Film Center representative. If 

you are not familiar with the phonetic alphabet, you can click Enter Key by Words. This 
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will display a window containing buttons labeled with the words that you will hear when 

the key is being read to you. 

 
 

As you hear each word, click the button labeled with the word. If you make a mistake, 

you can click the Back button to erase the last entered character. When you have 

completed entering the Key, click OK. The window will close and the Site Key field will 

have the key entered into it. Click Validate. You will then get a message stating that the 

Site Key was accepted. Click OK in this message and then click Close in the License 

window. 

A Site Key can only be used once. After you have entered the Site Key, the Site Code 

will change and the key will not work.  

Transferring the License to another Computer 
An Essential Macleod transferable license may be transferred from one computer to 

another. The transfer process can be performed using a folder that is accessible to both 

computers (if the computers are networked), or it can be performed using a removable 

storage device. 

The license transfer process starts at the computer that is to receive the license. With 

the Essential Macleod running and no windows open on the Essential Macleod 

background window, select License from the Options menu. Then select Start Transfer 

on the License form that appears. The Start Transfer form will appear.  

To start the license transfer, either select Transfer License from the Limited License 

message that appears when you start the Essential Macleod or select License from the 

Options menu, and then click the Into Computer button. The Transfer License In form 

will appear. 
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Enter the folder that is to be used for the license transfer and then select Next. If 

successful, the following window will appear 

 
 

You can either leave the Essential Macleod running while you get the license from the 

other computer, or you can click Continue Later to suspend the Transfer In process. This 

allows you to stop the Essential Macleod. You can continue the Transfer In process at 

another time. 

Now move to the computer from which the license will be taken. If a removable 

storage device was used for the transfer process, insert the device into the computer. Run 

the Essential Macleod. With no windows open on the Essential Macleod desktop, select 

License from the Options Menu. Select Out of Computer on the license form.  
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Transferring out a license from the Essential Macleod is password protected (On first 

installation of the Essential Macleod, the password is blank and so you can leave the 

password field blank). Change the transfer folder if necessary and then click Next. The 

license will now be moved to the transfer folder. It cannot be moved back from the 

transfer folder to the computer, it can only be moved to the unlicensed computer. 

 

Now move back to the computer that is to receive the license. If a removable storage 

device was used for the transfer process, insert the device into the computer. If you left 

the Essential Macleod running at Transfer License In (Step 2 of 3), click Next to transfer 

the license into the computer. 

If you stopped the Essential Macleod during the transfer in process by clicking the 

Continue Later button, start the Essential Macleod and click the Transfer License 

button on the Limited License message. The Transfer License In form will be displayed. 

 
 

Click the Continue Transfer button. 
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Enter the transfer folder and select Next. The computer should now have the Essential 

Macleod license. 

If you have started a transfer but decide not to complete it, you can click Begin a new 

Transfer, This will discard the current transfer information. If you have already 

transferred a license out of a computer and you select this option, and accept the 

warnings, you will lose the license – it cannot be recovered. 

Changing the Password 
The password for transferring out a license may be altered through the Change 

Password form. After all windows in the Essential Macleod have been closed, and only 

the Essential Macleod background window is visible, select Change Password from the 

Options menu. To change the password, you need to enter the current password and then 

the new password twice. Select OK to change the password or select Cancel to stop the 

password from changing. 

 

On first installation, the password is blank. 

Backing and Restoring a Fixed License 
A Fixed license can be backed up to a separate location and restored to the computer 

in the event that the license data is lost.  

With the Essential Macleod running and no windows open on the Essential Macleod 

background window, select License from the Options menu. Then click Backup 

License (Backup License will only be available if you have a fixed license). A folder 

chooser will appear. Select the folder where you want the license to be saved. This can be 

a location on your computer, removable storage or an accessible network location. Click 

OK. A message will state that the license has been successfully backed up. 

If the license is not present, you will see the Limited License message when you start 

the Essential Macleod. Click the Restore License button. A folder chooser will appear. 
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Select the location of the backup copy of the license and click OK. When the license is 

successfully restored, the Essential Macleod will start. 

Warning 
This warning only applies to transferable licenses. 

The licensing process maintains four files in a license folder. The location of the 

license folder depends upon when the Essential Macleod was first installed and how the 

computer is setup. The location of the files is given at the end of the installation. These 

files are named essental.41s, essental.ent, essental.key and essental.rst. These files 

should not be touched. If they are deleted, then the license will be lost. If this happens, 

please contact Thin Film Center for assistance. 

Some disk defragmenter programs, particularly Norton Speed Disk (version 4 and 

greater) will move system files as well as ordinary files. Before using your defragmenter, 

please configure it so that it does not move the essental.ent, essental.key, essental.rst and 

essental.41s files in the license folder.  Consult your de-fragmenter software manual for 

more information about preventing files from being re-located. Please contact Thin Film 

Center if you have any questions. (Telephone: +1 520 322 6171, e-mail: 

info@thinfilmcenter.com
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